Specifications subject to change without notice.
SAFETY PRECAUTIONS

(Read these precautions before using.)

When using Mitsubishi equipment, thoroughly read this manual and the associated manuals introduced in this manual. Also pay careful attention to safety and handle the module properly.

These precautions apply only to Mitsubishi equipment. Refer to the CPU module user's manual for a description of the PC system safety precautions.

These SAFETY PRECAUTIONS classify the safety precautions into two categories: "DANGER" and "CAUTION".

⚠️ DANGER
Procedures which may lead to a dangerous condition and cause death or serious injury if not carried out properly.

⚠️ CAUTION
Procedures which may lead to a dangerous condition and cause superficial to medium injury, or physical damage only, if not carried out properly.

Depending on circumstances, procedures indicated by ⚠️ CAUTION may also be linked to serious results.

In any case, it is important to follow the directions for usage.

Store this manual in a safe place so that you can take it out and read it whenever necessary. Always forward it to the end user.

PRECAUTIONS WHEN PERFORMING THE TEST OPERATION

⚠️ DANGER

- Read the manual carefully and fully understand the operation before the test operation (ON/OFF of bit devices, modifying current value of a word device, modifying timer/counter setting, modifying the current value, or modifying the current value of a buffer memory) of the user created monitor screen, system monitor, special function module monitor, and circuit monitor.
- In addition, never modify data in a test operation to a device which performs a crucial operation to the system.
- It may cause an accident by a false output or malfunction.
<table>
<thead>
<tr>
<th>Print Date</th>
<th>Manual Number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sep. 1997</td>
<td>IB (NA)-66793-A</td>
<td>First printing</td>
</tr>
<tr>
<td>Dec. 1997</td>
<td>IB (NA)-66793-B</td>
<td><strong>Correction</strong>&lt;br&gt;Section 1.4, 1.7, 4.5, 8.2, 10.4, 12.5, 14.1, 14.2, 14.3, 14.4, 22.7&lt;br&gt;<strong>Addition</strong>&lt;br&gt;Section 4.3, 10.3, 12.2, 13.2, 16.1, 16.3, 20.2, 20.3, 20.4, 20.5, 20.6, 23.1, 23.2, 24.1, 24.2. Appendix 1&lt;br&gt;Section 1.5&lt;br&gt;Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSYP (Version B and Later)&lt;br&gt;Section 1.6&lt;br&gt;Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSYP (Version D and Later)&lt;br&gt;Appendix 5&lt;br&gt;Diagrams Provided for the Touch Switch, Lamp Display and Panel Kit Functions</td>
</tr>
<tr>
<td>Feb. 1998</td>
<td>IB (NA)-66793-C</td>
<td><strong>Correction</strong>&lt;br&gt;Section 8.2, 9.1, 9.3, 16.1, 17.1, 24.5&lt;br&gt;<strong>Partial addition</strong>&lt;br&gt;Section 1.8, 9.2, 9.5, 10.4.2, 13.5, 15.8, 24.2&lt;br&gt;<strong>Addition</strong>&lt;br&gt;Section 1.7&lt;br&gt;Functions Added in Version E and later</td>
</tr>
<tr>
<td>Oct. 2000</td>
<td>IB (NA)-66793-D</td>
<td><strong>Correction</strong>&lt;br&gt;Section 9.1, 10.4, 14.3, 16.1, 22.4</td>
</tr>
<tr>
<td>Jun., 2004</td>
<td>IB (NA)-66793-E</td>
<td><strong>Partial correction</strong>&lt;br&gt;About manuals&lt;br&gt;<strong>MODEL CODE change</strong>&lt;br&gt;Changed from 13J927 to 10D176</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.
Introduction

Thank you for purchasing the Mitsubishi Graphic Operation Terminal.

Before using the equipment, please read this manual carefully to develop full familiarity with the functions and performance of the graphic operation terminal you have purchased, so as to ensure correct use.

Please forward a copy of this manual to the end user.

Contents

1. Overview ........................................................................ 1-1 to 1-22

1.1 Structure and Guide to the Use of This Manual ....................... 1- 2
1.2 Configuration of This Manual ............................................ 1- 4
1.3 Abbreviations and Symbols Used in This Manual ..................... 1- 6
1.4 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version A and Later) ............... 1- 8
1.5 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version B and Later) ................ 1-13
1.6 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version D and Later) ............... 1-15
1.7 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version E and Later) ................ 1-18
1.8 About Supported CPU ................................................... 1-22

2. Where to Start .................................................................... 2-1 to 2-9

2.1 Getting Ready to Start Monitoring with the GOT ..................... 2- 1
2.2 Using the Panel Kit to Shorten Data Creation Time ................. 2- 4
2.3 Checking the Volume of Data While Creating Screen Data ........ 2- 5
2.4 Creating Data as a Team .................................................. 2- 7
2.5 Using Previously Created GOT Data .................................... 2- 8

3. Creating Data ..................................................................... 3-1 to 3-15

3.1 Creating the First Screen .................................................. 3- 1
3.2 Creating the Next Screen/Opening a Screen to Edit ................. 3- 2
3.3 Overlapping/Lining Up Open Screen Windows ....................... 3- 3
3.4 Making the Screen Window to be Edited the Active Window ........ 3- 5
3.5 Closing the Screen Window from the Application Window ........ 3- 7
3.6 Storing Project Data on a Hard Disk or Floppy Disk ............... 3- 9
3.7 Exiting the Graphics Software Program ................................ 3-12
3.8 Opening Project Data Stored on a Hard Disk or Floppy Disk ........ 3-13
3.9 Opening Previously Created GOT Data ............................... 3-14

4. What to Do First .................................................................. 4-1 to 4-10

4.1 Setting the GOT Type ....................................................... 4- 1
4.2 Specifying the PC Type ..................................................... 4- 2
4.3 Setting Screen Switching Devices ........................................ 4- 3
4.4 Setting the Operation Environment for the Graphics Software .... 4- 6
4.5 Registering a Password for the Project Data ......................... 4- 8
4.6 Registering a Title and ID Number for the Project Data ............ 4-10
## 5. Drawing Canvas Graphics and Preparing to Enter Sprite Settings 5-1 to 5-5

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying a Grid on the Screen Window</td>
<td>5-1</td>
</tr>
<tr>
<td>Deleting the Tool Bar and Status Bar from the Application Window</td>
<td>5-2</td>
</tr>
<tr>
<td>Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set</td>
<td>5-3</td>
</tr>
<tr>
<td>Enlarging / Reducing the Screen Window</td>
<td>5-5</td>
</tr>
</tbody>
</table>

## 6. Drawing Canvas Graphics 6-1 to 6-26

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figures and Text Characters That Can Be Drawn</td>
<td>6-1</td>
</tr>
<tr>
<td>Memory Required for Figures and Text Characters</td>
<td>6-4</td>
</tr>
<tr>
<td>Overlapping Graphics</td>
<td>6-5</td>
</tr>
<tr>
<td>Setting Attributes for Graphics</td>
<td>6-6</td>
</tr>
<tr>
<td>Items to Know before Starting to Draw</td>
<td>6-8</td>
</tr>
<tr>
<td>Drawing Figures and Text Characters</td>
<td>6-10</td>
</tr>
<tr>
<td>Drawing Straight Lines</td>
<td>6-10</td>
</tr>
<tr>
<td>Drawing Continuous Lines</td>
<td>6-11</td>
</tr>
<tr>
<td>Drawing Rectangles</td>
<td>6-12</td>
</tr>
<tr>
<td>Drawing Polygons</td>
<td>6-13</td>
</tr>
<tr>
<td>Drawing Circles</td>
<td>6-14</td>
</tr>
<tr>
<td>Drawing Ovals and Painted Ovals</td>
<td>6-15</td>
</tr>
<tr>
<td>Drawing Circular Arcs</td>
<td>6-16</td>
</tr>
<tr>
<td>Drawing Oval Arcs</td>
<td>6-17</td>
</tr>
<tr>
<td>Painting Areas within a Line and Polygons</td>
<td>6-18</td>
</tr>
<tr>
<td>Entering Text</td>
<td>6-21</td>
</tr>
<tr>
<td>Pasting Graphics Data in Other Formats (BMP File Format)</td>
<td>6-24</td>
</tr>
</tbody>
</table>

## 7. Editing Canvas Graphics after Drawing Them 7-1 to 7-31

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the Cursor to the Graphic Editing Cursor</td>
<td>7-1</td>
</tr>
<tr>
<td>Selecting the Graphic or Text to Edit</td>
<td>7-2</td>
</tr>
<tr>
<td>Selecting a Single Graphic or Character</td>
<td>7-2</td>
</tr>
<tr>
<td>Selecting a Single Graphic or Character from Overlapped Graphics</td>
<td>7-3</td>
</tr>
<tr>
<td>Selecting Multiple Graphics or Characters from a Group in a Screen Window</td>
<td>7-4</td>
</tr>
<tr>
<td>Selecting Disparate Multiple Graphics or Characters in a Screen Window</td>
<td>7-6</td>
</tr>
<tr>
<td>Deleting One or More Selected Graphics</td>
<td>7-7</td>
</tr>
<tr>
<td>Deleting One of Several Selected Graphics</td>
<td>7-8</td>
</tr>
<tr>
<td>Correcting Graphics or Characters</td>
<td>7-9</td>
</tr>
<tr>
<td>Changing the Attributes of a Graphic</td>
<td>7-9</td>
</tr>
<tr>
<td>Changing the Attributes of a Character</td>
<td>7-10</td>
</tr>
<tr>
<td>Changing Graphic and Character Attributes Simultaneously</td>
<td>7-10</td>
</tr>
<tr>
<td>Changing the Size of a Straight Line or Circular Arc after Drawing It</td>
<td>7-11</td>
</tr>
<tr>
<td>Changing the Length of a Specified Segment of a Continuous Line or Polygon</td>
<td>7-12</td>
</tr>
<tr>
<td>Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction</td>
<td>7-14</td>
</tr>
<tr>
<td>Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Corner Axis</td>
<td>7-15</td>
</tr>
<tr>
<td>Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Center Axis</td>
<td>7-16</td>
</tr>
</tbody>
</table>
7.3.9 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle without Changing the Horizontal to Vertical Proportion ........................................... 7-17
7.3.10 Deleting Graphics and Characters ................................................................. 7-18
7.3.11 Cutting Graphics and Characters and Storing Them on the Clipboard .......... 7-19
7.3.12 Flipping, Reversing, and Rotating Graphics 90° ........................................ 7-20
7.3.13 Rotating Text ..................................................................................................... 7-20
7.4 Editing Graphics and Characters ........................................................................... 7-21
  7.4.1 Moving Graphics and Characters ................................................................. 7-21
  7.4.2 Copying Graphics and Characters .............................................................. 7-22
  7.4.3 Pasting Graphics and Characters Stored on the Clipboard ....................... 7-23
  7.4.4 Changing the Order of Overlapped Graphics or Characters .................... 7-23
  7.4.5 Copying and Pasting Figures and Texts as a Group .................................... 7-24
  7.4.6 Undoing the Previous Operation ................................................................... 7-26
7.5 Editing Several Graphics .................................................................................... 7-26
  7.5.1 Grouping Several Graphics and Characters ................................................ 7-26
  7.5.2 Ungrouping Graphics and Characters .......................................................... 7-27
  7.5.3 Centering Several Graphics .......................................................................... 7-28
  7.5.4 Aligning Several Graphics along the Top or Bottom .................................... 7-28
  7.5.5 Aligning Several Graphics along the Left or Right ........................................ 7-29
  7.5.6 Aligning Several Graphics along the Left or Top at Even Intervals ............ 7-30
7.6 Editing Graphics and Sprites Simultaneously ..................................................... 7.31

8. Before Entering Sprite Settings .............................................................................. 8-1 to 8-7
  8.1 Types of Sprite Functions .................................................................................... 8-1
  8.2 Memory Required for Sprites and Maximum Settings ...................................... 8-5
  8.3 Overlapping Canvas Graphics and Sprites ....................................................... 8-6
  8.4 Entering Settings for Overlapped Sprites ......................................................... 8-6
  8.5 Types of Attributes That Can be Set with Sprites ............................................. 8-7

9. Devices That Can be Set with Sprites and Their Access Ranges ............................. 9-1 to 9-22
  9.1 Names of Devices That Can be Monitored ....................................................... 9-1
  9.2 Monitoring Special Function Modules .............................................................. 9-7
  9.3 Access Ranges for Data Link Systems that can be Monitored when Using the MELSEC-ACPU and QnACPU ......................................................... 9-8
  9.4 Access Ranges for Network Systems that can be Monitored when Using the MELSEC-ACPU and QnACPU ......................................................... 9-10
  9.5 Access Ranges for CC-Link Systems that can be Monitored when Using the MELSEC-ACPU and QnACPU ......................................................... 9-21
  9.6 Monitor Access Range during Connection with MELSEC-FXCPU and PCs of Other Manufacturers ................................................................. 9-22

10. Common Operations Used in Setting Sprites ...................................................... 10-1 to 10-16
  10.1 Setting Devices for Monitoring .................................................................... 10-1
  10.1.1 Ranges for Device Names and Device Numbers to be Set ......................... 10-2
  10.2 Setting Data Expressions (Other Than Numeric Input Function) ................... 10-3
    10.2.1 Items to Know before Setting Data Expressions .................................... 10-3
    10.2.2 Types of Expression Procedures That Can be Set .................................. 10-3
    10.2.3 Setting Data Expressions (Other Than Numeric Input Function) .......... 10-6
  10.3 Setting Data Expressions (Numeric Input Function) ....................................... 10-8
    10.3.1 Types of Expression Procedures That Can be Set with the Numeric Input Function ... 10-8
    10.3.2 Setting Data Expressions (Numeric Input Function) ............................... 10-10
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.4</td>
<td>Setting Display Conditions</td>
<td>10-12</td>
</tr>
<tr>
<td>10.4.1</td>
<td>Items to Know before Setting Display Conditions</td>
<td>10-12</td>
</tr>
<tr>
<td>10.4.2</td>
<td>Setting Up Displays When Setting Several Sprites on One Screen</td>
<td>10-13</td>
</tr>
<tr>
<td>10.4.3</td>
<td>Setting Display Conditions</td>
<td>10-14</td>
</tr>
<tr>
<td>10.5</td>
<td>Setting Display Ranges (Comparative Equations)</td>
<td>10-15</td>
</tr>
<tr>
<td>11.</td>
<td>Setting Data Display Functions</td>
<td>11-1 to 11-25</td>
</tr>
<tr>
<td>11.1</td>
<td>Setting the Numeric Value Display Function</td>
<td>11-1</td>
</tr>
<tr>
<td>11.2</td>
<td>Setting the ASCII Display Function</td>
<td>11-8</td>
</tr>
<tr>
<td>11.3</td>
<td>Setting the Clock Display Function</td>
<td>11-12</td>
</tr>
<tr>
<td>11.4</td>
<td>Specifying the Data List Display Function</td>
<td>11-16</td>
</tr>
<tr>
<td>12.</td>
<td>Setting the Message Display Functions</td>
<td>12-1 to 12-42</td>
</tr>
<tr>
<td>12.1</td>
<td>Registering Comments to Display with the Comment Display Function</td>
<td>12-1</td>
</tr>
<tr>
<td>12.1.1</td>
<td>Registering Comments</td>
<td>12-1</td>
</tr>
<tr>
<td>12.1.2</td>
<td>Deleting Registered Comments</td>
<td>12-4</td>
</tr>
<tr>
<td>12.1.3</td>
<td>Copying a Registered Comment to Another Comment Number</td>
<td>12-5</td>
</tr>
<tr>
<td>12.1.4</td>
<td>Using Data in Text File Format as Comment Data</td>
<td>12-6</td>
</tr>
<tr>
<td>12.2</td>
<td>Setting the Comment Display (Bit Function)</td>
<td>12-9</td>
</tr>
<tr>
<td>12.3</td>
<td>Setting the Comment Display (Word Function)</td>
<td>12-15</td>
</tr>
<tr>
<td>12.4</td>
<td>Setting the Alarm List Display (System Alarms) Function</td>
<td>12-23</td>
</tr>
<tr>
<td>12.5</td>
<td>Setting the Alarm List Display (User Alarms) Function</td>
<td>12-27</td>
</tr>
<tr>
<td>13.</td>
<td>Setting Moving Screen Display Functions</td>
<td>13-1 to 13-53</td>
</tr>
<tr>
<td>13.1</td>
<td>Registering Parts (Graphics) Displayed in the Parts Display and Parts Movement Display</td>
<td>13-1</td>
</tr>
<tr>
<td>13.1.1</td>
<td>Useful Information When Utilizing and Registering Parts</td>
<td>13-1</td>
</tr>
<tr>
<td>13.1.2</td>
<td>Registering Parts</td>
<td>13-2</td>
</tr>
<tr>
<td>13.1.3</td>
<td>Reading Out Registered Parts</td>
<td>13-3</td>
</tr>
<tr>
<td>13.1.4</td>
<td>Deleting Registered Parts</td>
<td>13-4</td>
</tr>
<tr>
<td>13.1.5</td>
<td>Changing a Part Name Assigned When a Part was Registered</td>
<td>13-5</td>
</tr>
<tr>
<td>13.2</td>
<td>Setting the Parts Display (Bit Function)</td>
<td>13-6</td>
</tr>
<tr>
<td>13.3</td>
<td>Setting the Parts Display (Word Function)</td>
<td>13-14</td>
</tr>
<tr>
<td>13.4</td>
<td>Setting the Parts Movement Display Function</td>
<td>13-24</td>
</tr>
<tr>
<td>13.5</td>
<td>Setting the Lamp Display (Bit Function)</td>
<td>13-30</td>
</tr>
<tr>
<td>13.6</td>
<td>Setting the Lamp Display (Word Function)</td>
<td>13-36</td>
</tr>
<tr>
<td>13.7</td>
<td>Setting the Panel Meter Display Function</td>
<td>13-43</td>
</tr>
<tr>
<td>14.</td>
<td>Setting Graph Display Functions</td>
<td>14-1 to 14-31</td>
</tr>
<tr>
<td>14.1</td>
<td>Setting the Trend Graph Display Function</td>
<td>14-1</td>
</tr>
<tr>
<td>14.1.1</td>
<td>Setting the Line Graph Display Function</td>
<td>14-10</td>
</tr>
<tr>
<td>14.3</td>
<td>Setting the Bar Graph Display Function</td>
<td>14-17</td>
</tr>
<tr>
<td>14.4</td>
<td>Setting the Level Display Function</td>
<td>14-24</td>
</tr>
</tbody>
</table>
### 15. Setting the Touch Key Functions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.1 Items to Know before Setting the Touch Key Functions</td>
<td>15-1</td>
</tr>
<tr>
<td>15.2 Common Settings for Touch Key Functions</td>
<td>15-3</td>
</tr>
<tr>
<td>15.2.1 Setting Key Graphics</td>
<td>15-3</td>
</tr>
<tr>
<td>15.2.2 Setting the Run Timing for Specified Movements</td>
<td>15-7</td>
</tr>
<tr>
<td>15.2.3 Setting Display Positions, Display Sizes, and Effective Areas</td>
<td>15-9</td>
</tr>
<tr>
<td>for Key Graphics</td>
<td></td>
</tr>
<tr>
<td>15.3 Setting Touch Key (Bit) Functions</td>
<td>15-11</td>
</tr>
<tr>
<td>15.4 Setting Touch Key (Word) Functions</td>
<td>15-16</td>
</tr>
<tr>
<td>15.5 Setting Touch Key (Base Switching) Functions</td>
<td>15-21</td>
</tr>
<tr>
<td>15.5.1 Switching to the Screen of the Previously Displayed Base Screen Number</td>
<td>15-21</td>
</tr>
<tr>
<td>15.5.2 Switching to the Screen of the Specified Base Screen Number</td>
<td>15-25</td>
</tr>
<tr>
<td>15.5.3 Switching to the Screen of a Base Screen Number by Turning the Specified Bit Device ON/OFF</td>
<td>15-28</td>
</tr>
<tr>
<td>15.5.4 Switching to the Screen of a Base Screen Number Using the Current Value of the Specified Word Device</td>
<td>15-33</td>
</tr>
<tr>
<td>15.5.5 Switching the Base Screen Using a Sequence Program</td>
<td>15-39</td>
</tr>
<tr>
<td>15.6 Setting the Touch Key (Window Switching) Functions</td>
<td>15-40</td>
</tr>
<tr>
<td>15.6.1 Changing to the Screen of the Specified Window Number</td>
<td>15-40</td>
</tr>
<tr>
<td>15.6.2 Changing to the Screen of a Window Screen Number by Turning the Specified Bit Device ON/OFF</td>
<td>15-42</td>
</tr>
<tr>
<td>15.6.3 Changing to the Screen of a Window Screen Number Using the Current Value of the Specified Word Device</td>
<td>15-44</td>
</tr>
<tr>
<td>15.6.4 Changing the Window Screen Using a Sequence Program</td>
<td>15-46</td>
</tr>
<tr>
<td>15.7 Setting the Touch Key (Expansion) Functions</td>
<td>15-47</td>
</tr>
<tr>
<td>15.8 Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys</td>
<td>15-50</td>
</tr>
</tbody>
</table>

### 16. Setting Data Input Functions

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>16.1 Setting the Numeric Input Function</td>
<td>16-1</td>
</tr>
<tr>
<td>16.2 Key Window Operations</td>
<td>16-12</td>
</tr>
<tr>
<td>16.3 Setting the ASCII Input Function</td>
<td>16-17</td>
</tr>
<tr>
<td>16.4 Creating Keys to be Input</td>
<td>16-24</td>
</tr>
</tbody>
</table>

### 17. Displaying Window Screens

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.1 Window Screen Operations</td>
<td>17-1</td>
</tr>
<tr>
<td>17.2 Setting the Size of the Window Screen</td>
<td>17-4</td>
</tr>
<tr>
<td>17.3 Setting the Initial Display Position for the Window Screen</td>
<td>17-5</td>
</tr>
<tr>
<td>17.4 Precautions When Base Screens Touch Keys, and Window Screens are Overlapped</td>
<td>17-6</td>
</tr>
</tbody>
</table>

### 18. Operations Using the Panel Kit

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.1 Items to Know When Using the Panel Kit</td>
<td>18-1</td>
</tr>
<tr>
<td>18.2 Registering Drawn Graphics and Sprite Settings in a Panel Kit</td>
<td>18-2</td>
</tr>
<tr>
<td>18.3 Reading a Registered Panel Kit</td>
<td>18-4</td>
</tr>
<tr>
<td>18.4 Deleting a Registered Panel Kit</td>
<td>18-5</td>
</tr>
<tr>
<td>18.5 Changing the Registered Library Nomo or Panel Kit Name</td>
<td>18-6</td>
</tr>
</tbody>
</table>
### 19. Editing Set Sprites

<table>
<thead>
<tr>
<th>19.1</th>
<th>Changing the Cursor to the Sprite Editing Cursor</th>
<th>19- 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.2</td>
<td>Selecting the Sprite to Edit</td>
<td>19- 2</td>
</tr>
<tr>
<td>19.2.1</td>
<td>Selecting a Single Sprite</td>
<td>19- 2</td>
</tr>
<tr>
<td>19.2.2</td>
<td>Selecting Several Overlapped Sprites in a Screen Window</td>
<td>19- 3</td>
</tr>
<tr>
<td>19.2.3</td>
<td>Selecting Disparate Several Sprites in a Screen Window</td>
<td>19- 5</td>
</tr>
<tr>
<td>19.2.4</td>
<td>Deleting One or More Selected Sprites</td>
<td>19- 6</td>
</tr>
<tr>
<td>19.2.5</td>
<td>Deleting One of Several Selected Sprites</td>
<td>19- 7</td>
</tr>
<tr>
<td>19.3</td>
<td>Editing a Sprite Using the Same Procedures as Graphic Editing</td>
<td>19- 8</td>
</tr>
<tr>
<td>19.3.1</td>
<td>Correcting the Data of a Set Sprite</td>
<td>19- 8</td>
</tr>
<tr>
<td>19.3.2</td>
<td>Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction</td>
<td>19- 9</td>
</tr>
<tr>
<td>19.3.3</td>
<td>Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis)</td>
<td>19-10</td>
</tr>
<tr>
<td>19.3.4</td>
<td>Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis)</td>
<td>19-11</td>
</tr>
<tr>
<td>19.3.5</td>
<td>Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction without Changing the Proportion</td>
<td>19-12</td>
</tr>
<tr>
<td>19.3.6</td>
<td>Deleting a Set Sprite</td>
<td>19-13</td>
</tr>
<tr>
<td>19.3.7</td>
<td>Cutting the Set Sprite and Storing it on the Clipboard</td>
<td>19-14</td>
</tr>
<tr>
<td>19.3.8</td>
<td>Changing (Moving) the Display Position of the Set Sprite</td>
<td>19-15</td>
</tr>
<tr>
<td>19.3.9</td>
<td>Copying a Set Sprite</td>
<td>19-16</td>
</tr>
<tr>
<td>19.3.10</td>
<td>Pasting a Sprite Stored on the Clipboard</td>
<td>19-17</td>
</tr>
<tr>
<td>19.3.11</td>
<td>Copying and Pasting Sprites as a Batch</td>
<td>19-18</td>
</tr>
<tr>
<td>19.3.12</td>
<td>Grouping Several Sprites in One Group</td>
<td>19-21</td>
</tr>
<tr>
<td>19.3.13</td>
<td>Ungrouping Sprites</td>
<td>19-21</td>
</tr>
<tr>
<td>19.3.14</td>
<td>Aligning Several Sprites along the Top or Bottom</td>
<td>19-22</td>
</tr>
<tr>
<td>19.3.15</td>
<td>Aligning Several Sprites along the Left or Right</td>
<td>19-22</td>
</tr>
<tr>
<td>19.3.16</td>
<td>Aligning Several Sprites along the Left or Top at Even Intervals</td>
<td>19-23</td>
</tr>
<tr>
<td>19.3.17</td>
<td>Displaying Numeric or ASCII Displays in Block Format</td>
<td>19-23</td>
</tr>
<tr>
<td>19.4</td>
<td>Selecting Several Sprites and Correcting Sprites from a List</td>
<td>19-24</td>
</tr>
<tr>
<td>19.5</td>
<td>Correcting, Utilizing, and Deleting Set Sprites from a List</td>
<td>19-25</td>
</tr>
<tr>
<td>19.6</td>
<td>Batch Changes to Monitor Devices Set Using Sprites</td>
<td>19-26</td>
</tr>
</tbody>
</table>

### 20. Operations Subsequent to Screen Creation

<table>
<thead>
<tr>
<th>20.1</th>
<th>Assigning a Title to the Screen Data</th>
<th>20- 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.2</td>
<td>Viewing an Image of the Created Screen Data</td>
<td>20- 2</td>
</tr>
<tr>
<td>20.3</td>
<td>Viewing the Monitor Device Specified by a Sprite</td>
<td>20- 4</td>
</tr>
<tr>
<td>20.4</td>
<td>Viewing the Image and Device for the Created Screen Data</td>
<td>20- 6</td>
</tr>
<tr>
<td>20.5</td>
<td>Viewing an Image for a Still Screen (Canvas Screen)</td>
<td>20- 8</td>
</tr>
<tr>
<td>20.6</td>
<td>Viewing Sprite ID Numbers Set Using Sprites</td>
<td>20-10</td>
</tr>
</tbody>
</table>

### 21. Editing in Screen Units/Single-Project Units

<table>
<thead>
<tr>
<th>21.1</th>
<th>Copying Other Screen Data to the Project Data being Edited</th>
<th>21- 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>21.2</td>
<td>Combining Data Created by More than One Person</td>
<td>21- 4</td>
</tr>
<tr>
<td>21.2.1</td>
<td>Items to Know before Creating Data as a Team</td>
<td>21- 4</td>
</tr>
<tr>
<td>21.2.2</td>
<td>Combining Data Created by More than One Person</td>
<td>21- 6</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>21.2.3</td>
<td>Combining Parts Data</td>
<td>21-6</td>
</tr>
<tr>
<td>21.2.4</td>
<td>Combining Comment Data</td>
<td>21-8</td>
</tr>
<tr>
<td>21.3</td>
<td>Copying the Created Screen Data to Another Screen Number</td>
<td>21-10</td>
</tr>
<tr>
<td>21.4</td>
<td>Deleting the Created Screen Data in Screen Number Units</td>
<td>21-11</td>
</tr>
<tr>
<td>21.5</td>
<td>Changing the Screen Number of the Created Screen Data</td>
<td>21-12</td>
</tr>
</tbody>
</table>

### 22. Alarm History Display Functions 22-1 to 22-25

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.1</td>
<td>Summary of Alarm History Display Functions</td>
<td>22-1</td>
</tr>
<tr>
<td>22.2</td>
<td>Things to Know in the Beginning</td>
<td>22-2</td>
</tr>
<tr>
<td>22.3</td>
<td>Outline of Procedures</td>
<td>22-5</td>
</tr>
<tr>
<td>22.4</td>
<td>Setting Common Settings</td>
<td>22-7</td>
</tr>
<tr>
<td>22.5</td>
<td>Setting Display Contents</td>
<td>22-12</td>
</tr>
<tr>
<td>22.6</td>
<td>Setting the Touch Keys for Alarm History Display Function</td>
<td>22-20</td>
</tr>
<tr>
<td>22.7</td>
<td>Formatting Memory Card for the Alarm History Display Function</td>
<td>22-25</td>
</tr>
</tbody>
</table>

### 23. Setting the Operation Panel Functions 23-1 to 23-8

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.1</td>
<td>Things to Know before Setting the Operation Panel Functions</td>
<td>23-1</td>
</tr>
<tr>
<td>23.2</td>
<td>Setting Action to the Operation Panel Keys</td>
<td>23-3</td>
</tr>
<tr>
<td>23.3</td>
<td>Setting Key Code to the Operation Panel Keys</td>
<td>23-5</td>
</tr>
<tr>
<td>23.4</td>
<td>External I/O Function</td>
<td>23-7</td>
</tr>
</tbody>
</table>

### 24. Other Sprite Functions 24-1 to 24-20

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>24.1</td>
<td>Setting the Hard Copy Function</td>
<td>24-1</td>
</tr>
<tr>
<td>24.2</td>
<td>Setting Devices to Check GOT Operation (System Information)</td>
<td>24-4</td>
</tr>
<tr>
<td>24.3</td>
<td>Setting the Observe Status Function</td>
<td>24-12</td>
</tr>
<tr>
<td>24.4</td>
<td>Setting the Test Function</td>
<td>24-19</td>
</tr>
<tr>
<td>24.5</td>
<td>Setting the Display Speed Acceleration Function</td>
<td>24-20</td>
</tr>
</tbody>
</table>

### Appendices A-1 to A-20

<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Key Code Table</td>
<td>A-1</td>
</tr>
<tr>
<td>2</td>
<td>Screen Creation Form</td>
<td>A-2</td>
</tr>
<tr>
<td>3</td>
<td>Display Speeds for Spirites</td>
<td>A-5</td>
</tr>
<tr>
<td>4</td>
<td>Functions Added to SW3NIW-A8GOTP, A8SYSP and Before</td>
<td>A-8</td>
</tr>
<tr>
<td>5</td>
<td>Diagrams Provided for the Touch Switch, Lamp Display and Panel Kit Functions</td>
<td>A-13</td>
</tr>
</tbody>
</table>
About manuals

The following product manuals are available. Please use this table as a reference to request the appropriate manual as necessary.

### Related manuals

<table>
<thead>
<tr>
<th>Manual Name</th>
<th>Manual No. (Model Code)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A870GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66628 (1DM050)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A870GOT main module, as well as the hardware configuration, procedures for installing optional modules, operation in on-line mode, error codes, and troubleshooting guidelines. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>A850GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66669 (1DM038)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A850GOT main module, as well as the hardware configuration, procedures for installing optional modules, operation in on-line mode, error codes, and troubleshooting guidelines. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>A852GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66767 (1DM042)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A852GOT main module, as well as the hardware configuration, procedures for installing optional modules, operation in off-line mode, error codes, and troubleshooting guidelines. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>A853GOT Graphic Operation Terminal User's Manual</td>
<td>IB-66785 (1DM044)</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A853GOT main module, as well as the system configuration. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual (Introductory Manual)</td>
<td>IB-66792 (1DM177)</td>
</tr>
<tr>
<td>This manual is designed for the first-time user of the GOT. It describes how to create monitor scenes with the A8GOTP, how to send monitor data to the GOT, and what the various screen displays mean. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual (Startup Manual)</td>
<td>IB-66791 (1DM179)</td>
</tr>
<tr>
<td>This describes the configuration of the A8GOTP system, precautions regarding the configuration, and the specifications of the various functions, as well as the installation procedures, startup procedures, screen configurations, and basic operation procedures. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>Manual Name</td>
<td>Manual No.</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66794</td>
</tr>
<tr>
<td>(Data Transmission/Debugging/Document Creation Manual)</td>
<td></td>
</tr>
<tr>
<td>This describes the following items.</td>
<td></td>
</tr>
<tr>
<td>(1) Procedures for downloading project data to the GOT and uploading data</td>
<td></td>
</tr>
<tr>
<td>from the GOT</td>
<td></td>
</tr>
<tr>
<td>(2) Procedures for installing the operating system in the GOT</td>
<td></td>
</tr>
<tr>
<td>(3) Procedures for using the A8GOTP as a virtual PC and for debugging the</td>
<td></td>
</tr>
<tr>
<td>GOT</td>
<td></td>
</tr>
<tr>
<td>(4) Procedures for outputting created monitor data as a completed document</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>SW3NIW-A8GOTP Graphic Settings Software Package Operating Manual</td>
<td>IB-66795</td>
</tr>
<tr>
<td>(Report Functions Manual)</td>
<td></td>
</tr>
<tr>
<td>This describes procedures to draw grid lines, set and edit report data</td>
<td></td>
</tr>
<tr>
<td>using the report function. (Sold separately)</td>
<td></td>
</tr>
<tr>
<td>GOT800 Series Operating Manual</td>
<td>IB-66796</td>
</tr>
<tr>
<td>(Expanded Functions Manual)</td>
<td></td>
</tr>
<tr>
<td>This describes the operation procedures for using system monitor functions,</td>
<td></td>
</tr>
<tr>
<td>monitor functions for special function modules, and the dedicated monitor</td>
<td></td>
</tr>
<tr>
<td>screens used with the circuit monitor functions.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>Other's Programmable Controller · Bar-Code Connection System Manual</td>
<td>IB-66797</td>
</tr>
<tr>
<td>This describes the system configurations and setting method when GOT is</td>
<td></td>
</tr>
<tr>
<td>connected to other's programmable controller · bar-code.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1

Overview
1. Overview

This manual explains the following procedures:
- How to create monitor screens
- How to draw canvas graphics (still images) and how to enter settings for sprites (moving images)
- How to actually display these screens and images on the GOT

- How to create the screen
- What to do first
- Editing the created data

- Drawing and editing canvas graphics
- Setting and editing sprites
- Window screens
- Displaying data created with sprite settings on the GOT

Creating screens to be displayed on the GOT

Creating the first screen
1.1 Structure and Guide to the Use of This Manual

When this graphics software is purchased, it comes with six operating manuals. Manuals are categorized according to the purpose for which they are used. Please read the manual that corresponds to your particular objective in order to become familiar with the operations and functions of the software.

**SW2NIW-A8GOTP Operating Manual**

- Install the graphics software in the computer.
- Start up the graphics software.
- Learn fundamental information and basic operations for the graphics software.
- Create simple graphics, monitor using the GOT, and learn the flow of a series of operations.
- Actually create screens for monitoring using the GOT.
  - Drawing graphics
  - Sprite settings
- Edit the data which has been created.
- Create report data when executing the report function
  - Drawing grid lines
  - Report data setting
  - Report data editing
1. Overview

- Install the OS program and communications driver in the GOT.
- Download created graphics to the GOT.
- Debug graphics between the computer and GOT.
- Create data documents.

• Monitor circuits.
• Monitor the system.
• Monitor the special module.

Each GOT User's Manual

- Install optional modules in the GOT.
- Connect the GOT and PC CPU.
- Find out how to attach the GOT and its external dimensions.
1.2 Configuration of This Manual

Chapter 1. Overview
- Describes the contents of the manual and the terms and abbreviations used in the manual.

Chapter 2. Where to Start
- Describes the procedures for creating screens to be monitored, and convenient functions which you should know about before creating monitor screens.

Chapter 3. Creating Data
- Describes how to create new data, open and close screen windows, save project data, and exit the graphics software program.

Chapter 4. What to Do First
- Describes how to enter settings for the operation environment and for the data common to all of the screens, which have to be entered before creating the monitor screen data.

Chapter 5. Drawing Canvas Graphics and Preparing to Enter Sprite Settings
- Describes functions which make it easier to draw canvas graphics and enter sprite settings.

Chapter 6. Drawing Canvas Graphics
- Describes the various types of graphics which can be drawn, and how to draw them.

Chapter 7. Editing Canvas Graphics after Drawing Them
- Describes methods for correcting and editing graphics after you have drawn them.

Chapter 8. Before Entering Sprite Settings
- Describes the types of sprites that can be set, and explains items that you should know before entering sprite settings.
Chapter 9. Devices That Can be Set With Sprites and Their Access Ranges
- Describes devices that can be monitored using sprites, and the access ranges for monitoring based on the type of connection being used with the GOT.

Chapter 10. Common Operations Used in Setting Sprites
- Describes how to enter settings that are requisite for sprites, and how to enter settings for data operation functions.

Chapter 11. Setting Data Display Functions
Chapter 12. Setting the Message Display Function
Chapter 13. Setting Moving Screen Display Functions
Chapter 14. Setting Graph Display Functions

Chapter 15. Setting the Touch Switch Functions
Chapter 16. Setting Data Input Functions
- Explain how the various displays are produced on the GOT by entering settings for the sprites, as well as the various items that are set using the sprites.

Chapter 17. Displaying Window Screens
- Describes how to display window screens and how to move the position at which a window screen is displayed.

Chapter 18. Operations Using the Panel Kit
- Describes how to use the panel kit provided with the graphics software.

Chapter 19. Editing Set Sprites
- Describes how to correct and edit sprites for which settings have been entered.

Chapter 20. Operations Subsequent to Screen Creation
- Describes how to assign a name (title) to a screen which has been created, and how to view images in order to see how the screen data which has been created will actually appear on the GOT.

Chapter 21. Editing in Screen Units/Single-Project Units
- Describes how to edit project data which has been created, and how to change the order of the numbers of the screens which have been created.

Chapter 22. Setting the Alarm History Display Function
Chapter 23. Setting the Operation Panel Function
Chapter 24. Setting Other Sprite Functions
- Describes how to set up the alarm history function, functions available when using the operation panel, the hard copy function, the system information function and the status monitor function.
1.3 Abbreviations and Symbols Used in This Manual

The following abbreviations and symbols are used in this manual.

<table>
<thead>
<tr>
<th>Abbreviation/Terminology</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics software</td>
<td>This refers to the SW3NIW-A8GOTP graphic settings software.</td>
</tr>
<tr>
<td>Report graphics software</td>
<td>This refers to the SW3NIW-A8GOTP report data creation software.</td>
</tr>
<tr>
<td>Computer</td>
<td>This refers to a peripheral device in which the graphics software has been installed.</td>
</tr>
<tr>
<td>A870GOT</td>
<td>This indicates the A870 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A850GOT</td>
<td>This indicates the A850 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A851GOT</td>
<td>This indicates the A851 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A852GOT</td>
<td>This indicates the A852 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A853GOT</td>
<td>This indicates the A853 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A85□</td>
<td>This refers to the A850GOT/A851GOT/A852GOT/A853GOT.</td>
</tr>
<tr>
<td>GOT</td>
<td>This refers to all of the above GOT.</td>
</tr>
<tr>
<td>Conventional GOT</td>
<td>This indicates the A77GOT (S3/S5)/A64GOT.</td>
</tr>
<tr>
<td>Canvas graphics</td>
<td>This indicates graphics and text data for still images.</td>
</tr>
<tr>
<td>Sprite</td>
<td>This refers to setting data used for moving images.</td>
</tr>
<tr>
<td>Screen data</td>
<td>This is the data specified for graphics and sprites, in modules of one screen.</td>
</tr>
<tr>
<td>Common screen data</td>
<td>This is the data for the specified GOT type and screen switching device.</td>
</tr>
<tr>
<td>Comment data</td>
<td>This is character string data created in order to display comments with the message display function.</td>
</tr>
<tr>
<td>Parts data</td>
<td>This is graphic data registered in order to display graphics with the part display function.</td>
</tr>
<tr>
<td>Title data</td>
<td>This is title data that comes with each of the various screens.</td>
</tr>
</tbody>
</table>
### Abbreviation/Terminology

<table>
<thead>
<tr>
<th>Abbreviation/Terminology</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project data</td>
<td>This refers to all of the data that has been created, and all of the data saved in the specified directory.</td>
</tr>
<tr>
<td>Report data</td>
<td>This is the data created with the report graphics software.</td>
</tr>
</tbody>
</table>

### Symbol

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>This indicates a command on a menu.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>This is the icon for the Tool Bar 1.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>This indicates a dialog box tab.</td>
</tr>
<tr>
<td>&quot; &quot;</td>
<td>This indicates a command name in a dialog box.</td>
</tr>
<tr>
<td>[ ]</td>
<td>This indicates a displayed dialog box.</td>
</tr>
<tr>
<td><code>&lt; &gt;</code></td>
<td>This indicates an item in a dialog box for which a setting can be entered.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>This indicates a command button in a dialog box.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>These indicate keys on the computer keyboard.</td>
</tr>
<tr>
<td><strong>POINT</strong></td>
<td>This indicates that the information is particularly important.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>This indicates an item which can be referenced in this manual.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>Refer to other related manuals.</td>
</tr>
</tbody>
</table>
1.4 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version A and Later)

The new functions added to SW3NIW-A8GOTP and SW3NIW-A8SYSP since SW2NIW-A8GOTP and SW2NIW-A8SYSP (software version J or later) are described below.

1 A new connection mode has been added.

① CC-Link can be connected.

CC-Link connection is now possible by installing A8GT-J61BT15 CC-Link communication module to A870GOT or A850GOT.

![Diagram of CC-Link connection](image.png)
② Connection to a Yasukawa Electric-made PC and a microcomputer (RS-232C communication) is feasible.

In addition to the RS-422 communication, connection with a Yasukawa Electric-made PC and with a microcomputer is possible via the RS-232C communication.

③ Allen-Bradley-made PC can be connected.

Connection to an Allen-Bradley-made PC (via RS-232C) is now possible.
2 Grid size and grid color setting functions are available while drawing.
Formerly, the grid size and grid line were fixed to 16-dot units and provided only in white. It is now possible to set the grid size in the range of 2 to 64 dots by dot units and also change the grid color.
See Section 5.1, Displaying a Grid on the Screen Window.

3 The function to display details of the alarm list (user alarm) has been added.
The detailed display screen of a specified device which became ON can be displayed.
See Section 12.5, Setting the Alarm List Display (User Alarms) Function.

4 The outline font display function has been added.
The characters displayed on the GOT monitor have been enhanced by the adoption of outline fonts.
(Outline fonts can be applied to characters of double size or larger in both height and width.)

Sprite functions that can use the outline fonts include the following:
- Fixed characters on the canvas
- Numerical characters for numerical displays and data displays
- Messages for the comment display and alarm list (user alarm) display
- Graphic characters (symbols) in the lamp display, panel indicator display and touch key function
- Numerical characters for the numerical input function
- Messages for the alarm history display
The operation panel function has been added.

Writing to a device and switching the screens can be performed from the operation panel. The operation panel can be used as a numeric keypad for the numeric input function.

See Chapter 23, Setting the Operation Panel Functions.

Password function has been added to the switching of utility screen.

The password function prompts to enter password when accessing project data and verifies it when switching the utility screen.

See Section 4.5, Registering a Password for the Project Data.
Detailed display function by one-touch operation has been added to the alarm history function.

By touching on a displayed item, the detailed display screen from the alarm history function is displayed.

See Chapter 22, Alarm History Display Functions.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECK</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 5 error</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Logging report function has been added to the report function.

In addition to the real time report function, the logging report function, which stores acquired data to a memory card, summarizes the acquired data and prints them out, has been added.
1.5 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version B and Later)

The following functions added in SW3NIW-A8GOTP and SW3NIW-A8SYSP version B and later.

1. Bar code reader connection

Connection of a bar code reader to the GOT makes it possible for the PC CPU to control data read via the bar code reader.

Make and models of supported bar code readers:
- HC61TR TYPE:A, manufactured by Tohken, Inc.
- OPT-5125-RS232C(H), manufactured by Optoelectronics, Inc.

<table>
<thead>
<tr>
<th>Device No.</th>
<th>+0 No. of bytes</th>
<th>+1 Data</th>
<th>+2 Data</th>
<th>+3 Data</th>
<th>+4 Data</th>
<th>+5 Data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>9</td>
<td>3231H</td>
<td>3433H</td>
<td>3636H</td>
<td>3837H</td>
<td>2039H</td>
</tr>
</tbody>
</table>

* Note that the bar code reader cannot be connected when the MELSECNET/B or /II is connected.

2. Additional special module (temperature-control module) that can be monitored

Special module monitoring is now possible via the temperature-control module. The operation status and alarm details of the temperature-control module can be monitored.

Temperature-control modules that can be monitored:
- A1S64TCTT-S1
- A1S64TCTTBW-S1
- A1S64TCRT-S1
- A1S64TCRTBW-S1
Improved numeric input function

Formerly, when a decimal value (data type: real) was converted to an integer via the written word operation expression of the numeric input function and then stored in the PC CPU, there would in some cases be an occurrence in which the value stored in the PC CPU differed from the actual input value, depending on the input value.

To avoid this, it was necessary to modify the written word operation expression as shown in the figure below:

<table>
<thead>
<tr>
<th>Decimal digits: 2</th>
<th>Written word operation expression: $SW \times 100$</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input value</strong></td>
<td><strong>Internal processing of the GOT</strong></td>
</tr>
<tr>
<td>9 . 9 . 5</td>
<td>To treat 9.95 as a floating point real number,</td>
</tr>
<tr>
<td></td>
<td>$9.949999 \ldots \times 100 = 994.9999999 \ldots$</td>
</tr>
<tr>
<td></td>
<td>$\downarrow$ (Truncate below decimal point)</td>
</tr>
<tr>
<td></td>
<td>994 (The value stored in the PC CPU)</td>
</tr>
</tbody>
</table>

(Modify the written word operation expression)

<table>
<thead>
<tr>
<th>Decimal digits: 2</th>
<th>Written word operation expression: $(SW + 0.001) \times 100$</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input value</strong></td>
<td><strong>Internal processing of the GOT</strong></td>
</tr>
<tr>
<td>9 . 9 . 5</td>
<td>To treat 9.95 as a floating point real number,</td>
</tr>
<tr>
<td></td>
<td>$(9.9499999999 + 0.001) \times 100 = 995.999999999 \ldots$</td>
</tr>
<tr>
<td></td>
<td>$\downarrow$ (Truncate below decimal point)</td>
</tr>
<tr>
<td></td>
<td>996 (The value stored in the PC CPU)</td>
</tr>
</tbody>
</table>

By using the SW3NIW-A8GOTP and SW3NIW-A8SYSP version B and later, an accurate value can be stored in the PC CPU without modifying the written word operation expression.

Furthermore, this product allows the use of conventional data created by modifying the written word operation expression, without changing the setting.

See Section 10.3, Setting Data Expression (Numeric Input Function).
1.6 Functions Added in SW3NIW-A8GOTP and SW3NIW-A8SYSP (Version D and Later)

The following functions are added in SW3NIW-A8GOTP and SW3NIW-A8SYSP version D and later.

1. **Improved communication speed**

In addition to the conventional communication speed (9600 bps, 19200 bps), 38400 bps is supported.

The same amount of screen data can be downloaded in approximately half the time formerly required.

2. The screen switching device can be processed using BCD data when connecting to the OMRON-made programmable controller

It is now possible to process the screen switching device using BCD data when connecting the OMRON-made programmable controller.

See Section 4.3, Setting Screen Switching Devices

3. **Additional supported printers**

In addition to the conventional printers that conform to the ESC/P24-J84 protocol, Hewlett Packard printers (PCL command compatible, no color support) have been added.

Users residing outside Japan no longer need to obtain printers conforming to the ESC/P24-J84 standard, which are available only in Japan.

* Be aware that Hewlett Packard printers cannot be used when the Japanese language is specified in drawing software.

See Section 24.1, Setting the Hard Copy Function.
Off-part and comment display function of the part and comment display (bit) function

Off-parts and comments can be displayed when placing a sprite on the canvas screen via the part and comment display function (when a bit device is selected as the monitoring device). Using this function, the monitor screen can be created while confirming the completed image.

(Example) When the following setting is made for the comment display (bit) function:
- On comment: Operating
- Off comment: Stopped

 Displays the off comment in the sprite frame

stopped

(Canvas screen)

 Displays the sprite frame only

(Canvas screen)

See Section 12.2, Setting the Comment Display (Bit) Function.
See Section 13.2, Setting the Parts Display (Bit) Function.

The preview number specification function of the part and comment display (bit) function

The specification of part numbers and comment numbers during screen preview is now possible in the part and comment display function (when a bit device is selected as the monitoring device). Using this function, the display contents of screen preview can be selected as the user desires.

See Section 12.2, Setting the Comment Display (Bit) Function.
See Section 13.2, Setting the Parts Display (Bit) Function.

Additional function that saves the window size for screen preview

When the window size is changed during screen preview, the changed size can be stored and the window will be opened with the saved size for the next screen preview. This eliminates a cumbersome window size change operation, and the user can open the window with the desired size from the next time on by changing the size just once.

See Chapter 20, Operations Subsequent to Screen Creation.

Additional function that sets the read cycle of system information

The read cycle of the read device set in the system information can be set within the range of one to five seconds (in one-second increments). The user can set a desired read cycle that best fits the individual system, thus allowing a wider selection of systems to be built.

See Section 24.2, Setting Devices to Check GOT Operation (System Information).
"Do Not Move" setting for input cursor movement

As an input cursor movement method, "not to move the input area" has been added.

For example, to input values in the same area repeatedly, unnecessary cursor movements can be avoided by specifying the "Do Not Move" option.

See Chapter 16, Setting Data Input Functions.

Additional basic diagrams for touch switches and panel kits

In addition to the conventional basic diagrams for touch switches and panel kits, the following diagrams have been added.

By providing a wide variety of basic diagrams for touch switches and panel kits, graph frames and switch diagrams can be drawn in a more convenient manner.

Added touch switch

```
<table>
<thead>
<tr>
<th>SWITCH 46</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>
```

Added panel kits

```
<table>
<thead>
<tr>
<th>FRAME 61</th>
<th>FRAME 62</th>
<th>FRAME 63</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FRAME 64</th>
<th>FRAME 65</th>
<th>FRAME 66</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>METER 72</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>
```

See Appendix 5, Diagrams Provided for the Touch Switch, Lamp Display and Panel Kit Functions
1.7 New Functions Added to SW3NIW-A8GOTP and SW3NIW-A8SYSP Version E or Later

The new functions added to SW3NIW-A8GOTP and SW3NIW-A8SYSP version E or later are described below.

A new connection type is supported

The CC-Link connection (intelligent device stations) is now supported.

An A870GOT, A810GOT or A850GOT with the communication driver "CC-Link(ID)" preinstalled can be used as the CC-Link system intelligent device station (occupies one station, four stations can be selected) by installing the A8GT-J61BT13 CC-Link communication module (hereinafter referred to as A8GT-J61BT13), for control monitoring, watchdog monitoring and data input.
Faster communication speed is achieved when connected to an FX2N series
The communication speed when connected to an FX2N series has been improved.
The monitoring speed is approximately twice faster than the conventional speed.

Section Appendix 3 Display Speed for Sprite

A key code used for two-point simultaneous touch is added for the touch switch function
The key code [FFFFD] is added to the key codes [FFFF] and [FFFE], which have been used for the touch switch function.

<table>
<thead>
<tr>
<th>Key code</th>
<th>FFFF</th>
<th>FFFE</th>
<th>FFFD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Enable two-point simultaneous touch</td>
<td>Disable two-point simultaneous touch</td>
<td></td>
</tr>
</tbody>
</table>

In addition, the [FFFE] and [FFFFD] have additional functions as shown below besides the function to disable the two-point simultaneous touch.

- Touch switch action when the [FFFE] key code is set (ON has priority)

1. Move finger on the GOT screen surface (from outside to inside of touch key area)
   - Touch switch turns ON
   - Continuously move finger on the GOT screen surface to the touch key valid area
2. Move finger on the GOT screen surface (from inside to outside of touch key area)
   - Touch switch remains ON
   - Continuously move finger on the GOT screen surface out of the touch key valid area
• Touch switch action when the [FFFF] key code is set (OFF has priority)

1. Move finger on the GOT screen surface (from outside to inside of touch key area)
   - Touch switch does not turn ON
   - Continuously move finger on the screen surface to the touch key valid area

2. Move finger on the GOT screen surface (from inside to outside of touch key area)
   - Touch switch turns OFF
   - Continuously move finger on the screen surface out of the touch key valid area

3. When two-point simultaneous touch is performed
   - Touch switch turns OFF
   - Keep touching the screen surface in the touch key valid area
   - Touch a point outside the touch key valid area

☞ Section 15.8 Setting a key code for a touch switch, Settings to disable simultaneous touch of touch switches

4. Applicable CPU type has been added
   The following PC CPU is now supported by GOT:
   • "MELSEC-A series "A1FXCPU"

☞ Section 1.8 Applicable CPUs

5. In the report function, a new mode that initializes the number of page break lines after a print job is canceled, has been added

<table>
<thead>
<tr>
<th>Item</th>
<th>Report format</th>
<th>Page break before printing</th>
<th>Cancel trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting contents</td>
<td>Real time, continuous</td>
<td>No</td>
<td>Has been set</td>
</tr>
<tr>
<td></td>
<td>(print multiple data items)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

It is possible to set the report function so that the number of page break lines is initialized when a print job is canceled under the above conditions.
6  New barcode reader model is supported

A barcode reader model manufactured by Keyence, Inc. is now supported besides those manufactured by Token and Opt Electronics, which have been supported conventionally, for the barcode connection function in which the data read by a barcode reader can be stored in the PC CPU.

This broadens the selection of barcode reader models.

<table>
<thead>
<tr>
<th>Model</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCD-6100RMG</td>
<td>Token, Inc.</td>
</tr>
<tr>
<td>OPT-5125-RS232C (H)</td>
<td>Opt Electronics, Inc.</td>
</tr>
<tr>
<td>BL-500 series</td>
<td>Keyence, Inc.</td>
</tr>
</tbody>
</table>
### 1.8 About Supported CPU

The CPUs that can be monitored to GOT are shown below.

| Large type MELSEC-A QnA series CPU | Q2ACPU, QACPU-S1, Q2AHCPU, Q2AHCPU-S1  
|-------------------------------------|--------------------------------------------------  
| Q3CPU, Q4ACPU                      | Q4ACPU                                             
| A2UCPU, A2UCPU-S1                  | A3UCPU, A4UCPU                                    
| A2CPU, A2CPU-P21/R21               | A2ACPU-S1, A2ACPU-P21/R21                         
| A3ACPU, A3ACPU-P21/R21             | A3NCPU, A2NCPU, A2NCPU-P21/R21, A2NCPU-S1,       
| A2NCPU-S1, A2NCPU-P21/R21          | A3NCPU, A3NCPU-P21/R21                            
|                                       | (Version L or later for AnNCPU with link, version H or later  
|                                       | for AnNCPU without link)*5                       |
| Compact type MELSEC-A QnA series CPU | Q2ASCPU, Q2ASCPU-S1, Q2ASHCPU, Q2ASHCPU-S1,     
|                                      | A2ASCPU, A2ASCPU-S1                              
|                                      | A1SCPU, A1SCPU-24-R2, A1SHCPU*4                  
|                                      | A2SCPU (Version C or later)*5, A2SCPU-S1*,      
|                                      | A2SHCPU*, A2SHCPU-S1*                             
|                                      | A1SICPU-S3, A1SICPU*, A0J2HCPU (Version E or   
|                                      | later), A2CCPU (Version H or later)*1, A2CCPU    
|                                      | A2CCUCPU24*, A2JCUP*2                            
|                                      | A1FXCPU*6                                         |
| FA controller*3                     | LM610, LM7600, LM8000                            |
| Multi-axis controller CPU           | A273UCPU, A273UHCPU                              
|                                      | A373UCPU, A373UCPU-S3                           
|                                      | A171SCPU (-S3)                                   
|                                      | A171SHCPU*1                                      
|                                      | A172SHCPU*1                                      |
| MELSEC-FX series CPU               | FX0 series, FX0n series, FX0s series, FX1 series, 
|                                      | FX2 series, FX2c series, FX2n series             |
| PLC by Omron                       | C200H series, C200HS series, C200Hx series,     
|                                      | CQM1 series, C1000H series, C2000H series,      
|                                      | CV1000 series*4                                  |
| Yasukawa Electric-made PC           | GL60S, GL60H, GL70H, GL120, GL130               |
| Microcomputer connection            | Personal computer, microcomputer board, PC, etc. |
| Allen-Bradley-made PC               | SLC 5/03, SLC 5/04                              |

*1. Calculator link connections are not available.  
*2. Bus connections are not available for A2C or A2JCUP.  
*3. Connection type is MELSECNET connection only.  
*4. For CV1000, use the PC version V1 or later.  
*5. The data cannot be written to the CPU whose version is before what is indicated in ( ).  
  (Versions do not matter in bus connections.)  
*6. The available connection type is the CPU direct connection only.
Chapter 2

Where to Start
2. Where to Start

2.1 Getting Ready to Start Monitoring with the GOT

This section explains the procedure up to the point where you can start monitoring with the GOT.

1. First, design the screen.

• To design the layout of the screen you want to create, use the graphics paper provided in Appendix 2.

2. Install the graphics software and boot it.

• Install the graphics software in the computer you're using, and boot the software program.
3) Enter settings for common screen data.

- Enter settings for the operation environment in which the graphics software is to be used, and then for the GOT type for the project data to be created, and the screen switching device.

See Chapter 4, What to Do First.

4) Draw the canvas graphics on the screen, and enter sprite settings.

- Draw the canvas graphics and enter the sprite settings, based on the screen design.

See Chapters 5 to 24.
5. Install the OS program and the communications driver in the GOT, and download the project data.

- Install the operating system program and the communications driver, which are necessary in order to use the GOT for monitoring. Then download the project data you have created.

6. Begin monitoring with the GOT.

- Connect the PC CPU and the GOT, and begin monitoring.
2.2 Using the Panel Kit to Shorten Data Creation Time

- The panel kit can be used to create three-dimensional switch graphics and graph display boxes. The panel kit contains these and many other forms. The graphic to be used can be selected and pasted on the screen, which greatly reduces the amount of time required to create data.

  See Section 18.3, Reading a Registered Panel Kit.

- The panel kit makes it easy to enter sprite settings. It contains all of the various types of sprite data with the settings for required items (including graphics). The sprite for which a setting is to be entered is selected and settings entered for monitor devices and the display position.

  See Section 18.3, Reading a Registered Panel Kit.
2.3 Checking the Volume of Data While Creating Screen Data

The amount of data that can be downloaded to the GOT is limited to the values noted below.

Be aware of the memory capacity for the storage of screen data, as the storage capacity decreases as shown below when OS extensions are installed:

The available GOT built-in memory when OS extensions are installed is as follows:

(a) In the case of A870GOT (built-in memory capacity: 768k bytes + capacity of extension memory cassette)

1. When an optional driver (optional function) is installed to
   - If OS extensions are not installed:
     GOT built-in memory capacity - 0 byte = Available memory capacity
   - If one of OS extensions is installed:
     GOT built-in memory capacity - 256 bytes = Available memory capacity
   - If two of OS extensions are installed:
     GOT built-in memory capacity - 384 bytes = Available memory capacity

2. When no optional driver (optional function) is installed to GOT
   - If OS extensions are not installed:
     GOT built-in memory capacity - 0 byte = Available memory capacity
   - If one OS extension is installed:
     GOT built-in memory capacity - 0 byte = Available memory capacity
   - If two OS extensions are installed:
     GOT built-in memory capacity - 256 bytes = Available memory capacity
   - If three OS extensions are installed:
     GOT built-in memory capacity - 384 bytes = Available memory capacity

(b) In the case of A85□GOT (capacity of built-in memory: 768k bytes with A85□GOT; 2816k bytes with A85□GOT-M3)

1. When an optional driver (optional function) is installed to GOT
   - If OS for extension is not installed:
     GOT built-in memory capacity - 0 byte = Available memory capacity
   - If OS for system monitor function is installed:
     GOT built-in memory capacity - 256 bytes = Available memory capacity

2. When no optional driver (optional function) is installed to GOT
   - If OS for extension is not installed:
     GOT built-in memory capacity - 0 byte = Available memory capacity
   - If OS for system monitor function is installed:
     GOT built-in memory capacity - 0 byte = Available memory capacity

2 - 5
With the graphics software, data can be created while checking the current volume of data.

1. On the Communication menu, select [Download] and then [Monitor Data].
2. The "Monitor Data Download" dialog box is displayed.

The total amount of data can be checked here.
2.4 Creating Data as a Team

Project data can be created by dividing up the work among a number of people. The graphics software supports the method of data creation shown below, which enables data created by a number of people to be assembled into a single element of project data afterwards. This is an extremely convenient feature.

See Section 21.2, Combining Data Created by More Than One Person.
2.5 Using Previously Created GOT Data

Previously created GOT data with the SW-□-AGOTP can be read using the graphics software, and used as GOT data.

See Section 3.9, Opening Previously Created GOT Data.

### Data interchangeability

The following symbols apply to data read with the graphics software:

- **O**: Previously created GOT data can be read and used just as it is
- **X**: Some of the data will be different from the data previously created with the GOT
- **△**: This function does not exist on the GOT, so the data will be deleted.

<table>
<thead>
<tr>
<th>Previously created GOT data</th>
<th>Status after conversion</th>
<th>Differences with previously created GOT data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch key function</td>
<td>Switch function</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>Device reading</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Key code setting</td>
<td></td>
</tr>
<tr>
<td>Device writing with operation panel</td>
<td>Switch function</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Device writing</td>
<td></td>
</tr>
<tr>
<td>Numeric input function</td>
<td>Numeric values</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>Numeric display</td>
<td>Numeric values</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>Block data display</td>
<td>Numeric values</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>Clock display</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Character string display</td>
<td>Bit devices</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Word devices</td>
<td>O</td>
</tr>
<tr>
<td>Alarm list display *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error warning display</td>
<td>Display</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>Move</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Trace</td>
<td></td>
</tr>
<tr>
<td>Part display</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level display</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Trend graph display</td>
<td>Scroll</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>Overlap</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Batch display</td>
<td>X</td>
</tr>
<tr>
<td>Bar graph display</td>
<td>Normal</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Accumulated</td>
<td>X</td>
</tr>
<tr>
<td>Curve graph display</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Spline graph display *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scatter graph display</td>
<td>Sample batch display</td>
<td>X</td>
</tr>
<tr>
<td>Circle (Column) graph display</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station no. switching function *1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1. This function is not supplied with the A64GOT.
### Previously created GOT data

<table>
<thead>
<tr>
<th>Graphics</th>
<th>Status after conversion</th>
<th>Differences with previously created GOT data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Straight line</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Continuous line</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Rectangle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filled rectangle</td>
<td>△</td>
<td>Converted to fill pattern in graphics software</td>
</tr>
<tr>
<td>Polygon</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circle</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Circular arc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elliptical arc</td>
<td>△</td>
<td>Elliptical circles with 16 horizontal/vertical dots or less cannot be displayed with the GOT</td>
</tr>
<tr>
<td>Painting</td>
<td>△</td>
<td>Converted to fill pattern in graphics software</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Characters</th>
<th>Status after conversion</th>
<th>Differences with previously created GOT data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>△</td>
<td>Attribute: Backward rotation is converted to forward rotation, and becomes graphic character</td>
</tr>
<tr>
<td>Part</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>O</td>
<td>Comment No. 0 is deleted</td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen/station no. switching device</td>
<td>△</td>
<td>Station no. switching device is deleted</td>
</tr>
<tr>
<td>Report *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Announce *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timed action *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snapshot *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special key *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation panel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System information *1</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Printer type *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backlight off time *1</td>
<td>X</td>
<td>Deleted, because it is set by the GOT main unit</td>
</tr>
<tr>
<td>Password</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>GOT type</td>
<td>△</td>
<td>The GOT types have been changed as shown A77GOT (S3, S5) → A870GOT-TFT, STN A64GOT → A85□GOT-STN, L</td>
</tr>
</tbody>
</table>

*1. This function is not supplied with the A64GOT.

#### 2 Restrictions on GOT data created with conventional software packages

Data created with the following software programs cannot be read with the graphics software.

- SW□□□□-AD57GP
- SW□□□□-GOTP

#### 3 Precautions regarding display colors when using data previously created with the GOT

If canvas graphics or sprites drawn or set in previously created GOT data are displayed in gray, this will be converted to beige when opened using the graphics software.
Chapter 3

Creating Data
3. Creating Data

3.1 Creating the First Screen

- When is this function used?
  - When creating a new screen
  - When closing the project data currently being created and creating different project data

**POINT**
Only one project can be created and edited with the graphics software.

When the graphics software is booted, one new screen is created as a base screen, so the first screen can be created just as it is.

The procedure below is used to close the current project data which is open, and create new project data.

1. On the Project menu, select [New] and then [Close].
2. A message dialog box is displayed. Follow the guide messages in the dialog box. If the already open project data has not been saved to a hard disk or floppy disk, the data is first saved, before the new data can be created.
   
   If no file name has been assigned to the already open project data, a name must be assigned and the data saved.
   
   If a file name has already been assigned to the open project data, the previous data will be overwritten.
3. The project data which is already open will be closed, enabling a new first base screen to be created.
3.2 Creating the Next Screen/Opening a Screen to Edit

- When is this function used?
  - To create the next new screen
  - To open the editing screen window in order to edit a screen

1. Select [Load] on the Screen menu.
2. The "Load Screen" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to set</th>
<th>Contents of setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Screen type&quot;</td>
<td>Using the radio button, select the type of screen to be opened.</td>
</tr>
<tr>
<td>&quot;Load No.&quot;</td>
<td>To create the next new screen, or edit a screen, use the spin box to specify the screen number.</td>
</tr>
<tr>
<td>&quot;Screen title list&quot;</td>
<td>To open the screen to be edited, select the screen number with the text box.</td>
</tr>
<tr>
<td>[Set title]</td>
<td>To specify a title, click on [Set title]. See Section 20.1, Assigning a Title to the Screen Data.</td>
</tr>
</tbody>
</table>

3. The application window for the selected screen number opens, so you are ready to create or edit the screen.

**POINT**

Up to ten screens (base screens + window screens) can be opened in the application window.
3.3 Overlapping/Lining Up Open Screen Windows

When is this function used?

- To change the order in which windows open in the application window are displayed

1. On the Screen menu, select [Cascade] / [Tile].

2. The screen windows are displayed either superimposed on each other, or lined up next to each other.

Overlapping display

Screen windows are displayed stepwise, from the upper left to the lower right of the screen.
Lined up display

Screen windows are displayed next to each other, without overlapping.
3.4 Making the Screen Window to be Edited the Active Window

- When is this function used?
  - When you want to make one of the screen windows open in the application window active

Up to ten screen windows can be opened in the application window, but only one screen at a time can be edited. There are two ways to make a window active:

- Select the screen to be made active from the Screen menu commands.
- Click anywhere on the window to be made active.

1. Selecting the screen from the Screen menu commands

   1. On the Screen menu, the screen number and title of the window currently open in the application window are displayed as commands. Select the command for the name of the screen to be made active.

<table>
<thead>
<tr>
<th>Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear (L)</td>
</tr>
<tr>
<td>Clear and Load (N)</td>
</tr>
<tr>
<td>Store (S)</td>
</tr>
<tr>
<td>Store As (A)</td>
</tr>
<tr>
<td>Scr. Utilize/Delete (U)</td>
</tr>
<tr>
<td>Preview (V)</td>
</tr>
<tr>
<td>Redisplay (D)</td>
</tr>
<tr>
<td>Cascade (C)</td>
</tr>
<tr>
<td>Tile (T)</td>
</tr>
</tbody>
</table>

   Indicates the currently active window

   -B-1 MONITOR Screen 1
   -B-2 MONITOR Screen 2
   W-1 MONITOR Screen 3

   2. The selected screen becomes active.

2. Click anywhere on the screen window.

   1. Clicking anywhere on a screen window makes it the active screen. If the window to be made active is hidden behind another window, use the overlap/line up function to overlap windows or line them up next to each other.

   2. The clicked window becomes the active window.
3. Creating Data

Switch with the window switch button

Screen window for editing can be switched by clicking on the window switch button.
### 3.5 Closing the Screen Window from the Application Window

**When is this function used?**

- To close a screen window from the application window (when more than one screen window is open in the application window)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Make the screen window to be closed the active window, and then select [Clear] / [Clear and Load] on the Screen menu.</td>
<td></td>
</tr>
<tr>
<td>2. If [Clear] is selected, the specified window is closed, and the foremost window becomes active.</td>
<td></td>
</tr>
<tr>
<td>If [Clear and Load] is selected, the &quot;Open Edit Screen&quot; dialog box is displayed.</td>
<td></td>
</tr>
<tr>
<td>See Section 3.2, Creating the Next Screen/Opening a Screen to Edit.</td>
<td></td>
</tr>
</tbody>
</table>

The screen data in the screen window that is closed is saved in a temporary area.

- To save screen data that has been created or edited to the temporary area without closing the screen window, select [Store].
• What is the temporary area?

This is an area where the screen data from a screen window that has been closed is stored temporarily. The location where the data is to be saved (drive and file name) can be freely selected by the user before the screen data is created.

See Section 4.4, Setting the Operation Environment for the Graphics Software.

The screen data is only stored in the temporary area if the screen window is closed from the application window. All of the data created and/or edited in the application window is stored in the main memory of the computer.

---

Data in the temporary area should be handled this way:

• In the application window, open the screen window for the screen data stored in the temporary area, and make any necessary corrections.

↓

• After correcting the data, suppose you want to return it to its original status.

↓

• The original data has been stored in the temporary area, so opening that screen window again returns the data to its original status.
3.6 Storing Project Data on a Hard Disk or Floppy Disk

When is this function used?

- To store project data that has been created or edited on a hard disk or floppy disk

When project data is stored, the possibilities noted below may apply.

Select the appropriate command on the Project menu, and save the project data to the hard disk or floppy disk.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Command to select</th>
</tr>
</thead>
<tbody>
<tr>
<td>The created project data is being saved to a hard disk or floppy disk for the first time.</td>
<td></td>
</tr>
<tr>
<td>Project data already stored on a hard disk or floppy disk is opened and edited, and the edited project data is saved under a different file name.</td>
<td>Save As on the Project menu</td>
</tr>
<tr>
<td>Project data already stored on a hard disk or floppy disk is opened and edited, and is backed up under a different file name.</td>
<td></td>
</tr>
<tr>
<td>Project data already stored on a hard disk or floppy disk is opened and edited, and the edited project data is saved under the current file name.</td>
<td>Save on the Project menu</td>
</tr>
</tbody>
</table>

In order to minimize the chances of losing data if a power failure or a system error occurs, project data should be saved periodically.

1. **Save As**

   1. Select Save As on the Project menu.
2. The “Save As” dialog box is displayed.

In the “Directories” list box, select the drive to which the data is to be saved.

In the “Directories” list box, specify the directory containing the file name under which the data is to be saved. If a new directory name is being created, click on MkDir [M]. This displays the “Make Directory” dialog box.

Using the “Name” text box, input the directory name.

(Example)

\MONIMA

Click on OK in the “Make Directory” dialog box.

The “Save As” dialog box is displayed.

Select file type from the “Save File as Type” list box. When using data created by GOT with version J or a later version of SW2NIW-A8SYSP OS or SW3NIW-A8SYSP OS, select “SW2SYSP, version J or later, SW3”. When OS prior to SW2NIW-A8SYSP version J has been installed, select “None of the above”.

Click on OK in the “Save As” dialog box.
3. The project data is saved to the specified directory, so that it is available once more for editing. The file extension is fixed as "a8gotp.got".

The directory name and file name must conform to the rules for making such names under MS-DOS.

2) Save
1. Select [Save] on the Project menu.
2. Follow the instructions in the message dialog box which appears.
3. The project data overwrites any previous data stored under that file name, and the data is available once more for editing.

- How is data saved to a hard disk or floppy disk?

When data is saved to a hard disk or floppy disk, the graphics software saves the data as described below.

① Screen data stored in the temporary area is saved to the hard disk or floppy disk.

② Screen data in the main memory of the computer (screen data for which the screen window has not been closed from the application window) is saved to a hard disk or floppy disk.

If there is screen data in the internal memory that has the same screen number as that in the temporary area (even though the data itself may be different), the screen data in the internal memory is saved to the hard disk or floppy disk.
3. Creating Data

3.7 Exiting the Graphics Software Program

When is this function used?

- When exiting the graphics software

1. Select [Exit] on the Project menu.

2. When the message dialog box is displayed, follow the instructions in the box. If the project data in the open window has not been saved to a hard disk or floppy disk, it will be saved at this point. After the data has been saved, the graphics software is exited.

   If no file name has been assigned to the project data in the open window, assign a file name under which the data is to be saved.

   If a file name has been assigned to the project data in the open window, saving the data overwrites any data previously stored under that file name.

3. The graphics software is exited.
3.8 Opening Project Data Stored on a Hard Disk or Floppy Disk

When is this function used?
- To open project data stored on a hard disk or floppy disk, so that it can be edited using the graphics software

1. Select [Open] on the Project menu.

2. When the message dialog box is displayed, follow the instructions in the box. If the project data in the currently open window has not been saved to a hard disk or floppy disk, it will be saved at this point. After the data has been saved, the "Open" dialog box is displayed.

If no file name has been assigned to the project data in the open window, assign a file name under which the data is to be saved.

If a file name has been assigned to the project data in the open window, saving the data overwrites any data previously stored under that file name.

3. The "Open" dialog box is displayed.

![Open dialog box]

- In the "Drives" list box, select the drive containing the project data.
- In the "Directories" list box, specify the name of the directory containing the project data to be opened.
- Click on [OK].

4. The specified project data is opened, so that the data in the first base screen can be edited.
3.9 Opening Previously Created GOT Data

- **When is this function used?**
  - To open previously created GOT data in the graphics software program

1. On the Project menu, select [Import File] and then [AGOTP Data].

2. When the message dialog box is displayed, follow the instructions in the box. If the project data in the currently open window has not been saved to a hard disk or floppy disk, it will be saved at this point. After the data has been saved, the "Open" dialog box is displayed.

   If no file name has been assigned to the project data in the open window, assign a file name under which the data is to be saved.

   If a file name has been assigned to the project data in the open window, saving the data overwrites any data previously stored under that file name.

3. The "Open" dialog box is displayed.

   In the "Drives" list box, select the drive containing the previously created GOT data.

   \[
   \text{In the "Directories" list box, specify the name of the directory containing the previously created GOT data to be opened.}
   \]

   \[
   \text{Click on [OK].}
   \]
4. The specified previously created GOT data is opened, so that the first base screen can be edited. (The graphics software automatically converts the data to GOT data.)

- Doesn’t the parts file have to be opened?

Parts data in the parts file is automatically read by the graphics software, so there is no need to specify the name of the parts file.

However, please be aware that if no parts data was saved with the previously created GOT data opened using the graphics software when the data was saved with the SW-AGOTP (if the parts file was changed to another drive or the directory of the parts file was changed), the parts data will not be read.

If the parts file was changed to another drive or the directory of the parts file was changed, follow the procedure below, using the SW-AGOTP.

1. Read out the previously created GOT data opened with the graphics software.
2. Read out the parts file.
3. Save the data.
4. Specify the saved conventional parts data using this procedure.
Chapter 4

What to Do First
4. What to Do First

4.1 Setting the GOT Type

What do I need to set?

- Set the screen size (GOT type) for the project data you are about to create.

**POINT**

This setting is used to determine the screen size, so, for example, even if EL data is used as STN data, the operation will be carried out normally even though the two types of data are displayed in different colors.

1. Select [GOT Type] on the Common menu.
2. The "GOT Type" dialog box is displayed.

![GOT Type Dialog Box]

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;GOT Type&quot;</td>
<td>Using the radio button, select the GOT type for the project data you are about to create.</td>
</tr>
</tbody>
</table>
4.2 Specifying the PC Type

What is this function used?
- This function is used when you want to specify the type of PC for the project data you are about to create.

1. Select [PC Type] on the Common menu.
2. The “PC-Type” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>“PC Type”</td>
<td>Select the type of CPU to be monitored.</td>
</tr>
</tbody>
</table>

- What happens if I change the PC type while I’m still creating data?
Be aware that if the PC type is changed while creating data or working on a saved project data, the device will be changed.

Check with the individual sprite function to see if any device has been changed.

If there is no device which corresponds to the updated PC type, the device set earlier will be deleted, so the monitor device has to be specified once again. “???” will be displayed in the “Display Device.”
4.3 Setting Screen Switching Devices

What do I need to set?

- Set the device used to switch the base screen displayed on the GOT.
- Set the device used to switch the window screen displayed on the base screen.

2. The “Switching Screen Device” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Device to switch base”</td>
<td>Click on [Dev.]. This displays the “Device Set” dialog box, where you can specify the NW number, the station number, the device name, and the device number.</td>
</tr>
<tr>
<td>“Device to switch window”</td>
<td></td>
</tr>
</tbody>
</table>

See Section 10.1, Setting Devices for Monitoring.

POINT

- To avoid using the PC CPU device to switch the screen, the GOT has two screen switching devices of its own, GD0 and GD1 (GOT data registers).
If you are not using the PC CPU device, set GD0 and GD1 as the screen switching devices. If you use these, however, please be aware that screens cannot be switched from the PC CPU.
If you do not want to use the PC CPU device to switch the screen, use GD0 to 1023 (GOT data registers).
- When an OMRON-made PC is connected, BIN and BCD data can be used as device types.
• Why do screen switching devices need to be set?

The GOT is designed to display the screen that corresponds to the value stored in the specified device, so a device needs to be specified.

Since the value of the base screen switching device is 10, the base screen with a screen number of 10 will be displayed.

Screens are switched by changing the value of the PC CPU screen switching device.

• Using touch switches to change screens

See Section 15.5, Setting the Touch Key (Base Switching) Functions
See Section 15.6, Setting the Touch Key (Window Switching) Functions
• Does a value have to be stored for the base screen switching device when the power to the GOT is turned on?

- When the value for the base screen switching device is 0, the GOT forcibly displays the No. 1 base screen. Therefore, no value has to be stored in the sequence program for base screen switching when the power is turned on.

- Even if the value for the base screen switching device is 0, the No. 1 base screen will be displayed.

- When the power to the GOT is turned on, if the value for the base screen switching device is a value from 1 to 1024 but there is no screen number which corresponds to the set value, nothing will be displayed. Make sure the set value corresponds to an actual screen number.

- Numbers downloaded:
  Screen No. 1
  Screen No. 3

- If an attempt is made to change from the currently displayed screen to a screen number which has not been downloaded, or if the number specified for the base screen switching device is 1025 or higher, the screen switching command will be ignored, and the current screen will continue to be displayed.
4.4 Setting the Operation Environment for the Graphics Software

What do I need to set?

- Set the temporary area where the screen data is to be stored temporarily, using the "Work area" parameter.
- Specify whether the specified project data is to be opened the next time that the graphics software is run, or whether new data is to be created when the program is booted, using the "Project of edit" parameter.
- Select [Store] on the File menu or Screen menu, and specify whether or not a message dialog box is to be displayed when project data or screen data is saved, using the "Overwrite message" parameter.

POINT

When the graphics software is run the next time, it will boot under the operation environment parameters set here.

2. The "File Option" dialog box is displayed.
<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Work area&quot;</td>
<td>Click on [Browse]. The &quot;Browse&quot; dialog box is displayed, so the drive and directory containing the temporary area can be specified.</td>
</tr>
<tr>
<td>&quot;Project of edit&quot;</td>
<td>Using the radio buttons, select the status for the next time that the graphics software is booted. &quot;Select every time&quot;..... The system will be ready for new data to be created the next time the software is booted. If &quot;Fixed&quot; is selected, click on [Browse]. The specified project data will be opened the next time that the software is booted. This displays the &quot;Browse&quot; dialog box, where the drive and directory containing the project data can be specified.</td>
</tr>
<tr>
<td>&quot;Overwrite message&quot;</td>
<td>To turn off the &quot;Overwrite message&quot; confirmation dialog box so it is not displayed, select the check box and delete the &quot;X&quot; mark in it.</td>
</tr>
</tbody>
</table>

```
Data is overwritten and new data saved.
```

![Diagram](https://via.placeholder.com/150)
4.5 Registering a Password for the Project Data

What do I need to set?

- Register a password for the project data.

POINT

When a password is registered, the following items become effective:

- Data cannot be uploaded inadvertently
- The utility screen cannot be displayed inadvertently.


2. The "Password" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Password&quot;</td>
<td>Click on [Register]. This displays the &quot;Input Password&quot; dialog box, where the password can be input. Enter a password consists of alphanumeric 0 to 9. If you forget your password, you will not be able to upload data or change the password, so make sure you remember the registered password.</td>
</tr>
</tbody>
</table>

- Changing or deleting the registered password once
  - Changing the registered password
    Clicking on [Register] in the "Password" dialog box displays the "Verify Password" dialog box. Input the registered password and then the new password. Passwords can only be changed if the input password matches the one already registered.
  - Deleting the registered password
    Clicking on [Delete] in the "Password" dialog box displays the "Verify Password" dialog box. Input the registered password and then delete it. Passwords can only be deleted if the input password matches the one already registered.
• Operations of the utility screen when registering a password

When password-protected project data is stored in GOT, the following screen appears on the
GOT display when switching to the utility screen.
Enter the registered password.
After entering the password, touch on "Exit." The utility screen will be displayed.

• Note for using data from SW2NIW-A8GOTP

When using data from SW2NIW-A8GOTP and the registered password includes non-single-
byte characters, change to alphanumeric.
4.6 Registering a Title and ID Number for the Project Data

What do I need to set?

- Assign a title for the project data you are about to create.
- Register an ID number for the project data.

POINT
If no title or ID number is necessary, this step can be skipped.

1. On the Common menu, select [Title] and then [Project].
2. The "Project Title" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Project title&quot;</td>
<td>Enter a title for the project data in the text box. Titles can consist of up to 32 characters.</td>
</tr>
<tr>
<td>&quot;Project ID&quot;</td>
<td>Using the spin box, specify an ID number for the project. The number is input in half-width characters. (1 to 4294967295)</td>
</tr>
<tr>
<td>&quot;Detailed explanation&quot;</td>
<td>If necessary, an explanation of the project data can be input in the text box. The explanation can consist of up to 512 characters.</td>
</tr>
<tr>
<td>&quot;Author&quot;</td>
<td>If necessary, input the name of the person creating the data.</td>
</tr>
</tbody>
</table>

- Why does a project ID number have to be registered?

This is to make sure that the downloaded project data is kept separate from other project data. If any of the data from another project is downloaded along with the data for the pertinent project, the ID numbers are verified to make sure the data from the two projects is not mixed together.
Chapter 5

Drawing Canvas Graphics and Preparing to Enter Sprite Settings
5. Drawing Canvas Graphics and Preparing to Enter Sprite Settings

5.1 Displaying a Grid on the Screen Window

- Why does this need to be done?
  - This makes it easier to draw canvas figures and enter settings for sprites.

1. On the Project menu, select [Option] and then [View].
2. The "View Option" dialog box is displayed.

### Item to Set | Description of Item
--- | ---
"Grid" | Using the radio button, select whether or not a grid is to be displayed on the screen window. Select a grid size and grid color if the grid is displayed. 
  - "Front" Displays a grid on the foremost screen. 
  - "Back" Displays a grid on the screen at the back. 
  - "None" No grid is displayed. 
  - "Color" Select a grid color from the list box.

"Item" | See Section 5.2, Deleting the Tool Bar and Status Bar from the Application Window.

"Cursor move" | See Section 5.3, Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set.

"Zoom" | See Section 5.4, Enlarging/Reducing the Screen Window.

"Display paint" | See Section 6.6.9, Painting Areas within a Line and Polygons.
5.2 Deleting the Tool Bar and Status Bar from the Application Window

- Why does this need to be done?
  - This is to broaden the work area of the screen window when the tool bars and status bar are not being used.

1. On the Project menu, select [Option] and then [View].
2. The “View Option” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Item”</td>
<td>Select the check box for Tool Bar 1 or Tool Bar 2, whichever is to be deleted, and delete the “X” mark. Deleting Tool Bar 1 and Tool Bar 2 extends the display range of the screen window.</td>
</tr>
<tr>
<td>“Grid”</td>
<td>See Section 5.1, Displaying a Grid on the Screen Window.</td>
</tr>
<tr>
<td>“Cursor move”</td>
<td>See Section 5.3, Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set.</td>
</tr>
<tr>
<td>“Zoom”</td>
<td>See Section 5.4, Enlarging/Reducing the Screen Window.</td>
</tr>
<tr>
<td>“Display paint”</td>
<td>See Section 6.6.9, Painting Areas within a Line and Polygons.</td>
</tr>
</tbody>
</table>
5.3 Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set

- Why does this need to be done?
  - This makes it easier to position the figures which are drawn and/or moved, and sprites which are set and/or moved.

1. On the Project menu, select [Option] and then [View].
2. The "View Option" dialog box is displayed.

Settings for automatic positioning can also be entered using the list box for the "Cursor move" command on Tool Bar 2.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Cursor move&quot;</td>
<td>Using the list box, select the dot unit in which automatic positioning is to be carried out.</td>
</tr>
<tr>
<td>&quot;Grid&quot;</td>
<td>See Section 5.1, Displaying a Grid on the Screen Window.</td>
</tr>
<tr>
<td>&quot;Item&quot;</td>
<td>See Section 5.2, Deleting the Tool Bar and Status Bar from the Application Window.</td>
</tr>
<tr>
<td>&quot;Zoom&quot;</td>
<td>See Section 5.4, Enlarging/Reducing the Screen Window.</td>
</tr>
<tr>
<td>&quot;Display paint&quot;</td>
<td>See Section 6.8.9, Painting Areas within a Line and Polygons.</td>
</tr>
</tbody>
</table>
• What happens when a figure is drawn or moved?

(Example) If a rectangle is drawn using 16 dots, the following results:

The current cursor position is \( (X = 10, Y = 12) \). To set this as the starting point, press the left button of the mouse. This positions the starting point at the coordinates closest to the position 16 times the current cursor position \( (X = 16, Y = 16) \).

When the cursor is moved to determined the ending point, the cursor moves only to the position nearest that which is 16 times the coordinates. The cursor cannot move to any position which is not a multiple of 16 times the coordinates.

Entering an on the keyboard at this point moves 16 dots.

**POINT**

If "Cursor move" is set to 1 dot, each time the arrow key on the keyboard is entered, the cursor moves one dot. This makes it easier to position the cursor on finely detailed graphics.

The same process as that shown above is used to determine the position at which a sprite is displayed and to move a figure; the cursor moves in the dot unit specified by the "Cursor move" parameter, and moves by the specified dot unit each time an arrow key on the keyboard is entered.
5.4 Enlarging / Reducing the Screen Window

- What's the purpose of this function?
  - To make it easier to draw graphics on the screen window.

1. Using the scroll bars, display the section of the screen window to be enlarged.
2. Select [Option] and then [View] on the Project menu.
3. The "View Option" dialog box is displayed.

Enlarging the screen window can also be entered using the list box on Tool Bar 2.

### View Option

<table>
<thead>
<tr>
<th>Item</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Zoom&quot;</td>
<td>Using the radio button, select the magnification to be used for enlargement or reduction.</td>
</tr>
<tr>
<td>&quot;Grid&quot;</td>
<td>See Section 5.1, Displaying a Grid on the Screen Window.</td>
</tr>
<tr>
<td>&quot;Item&quot;</td>
<td>See Section 5.2, Deleting the Tool Bar and Status Bar from the Application Window.</td>
</tr>
<tr>
<td>&quot;Cursor move&quot;</td>
<td>See Section 5.3, Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set.</td>
</tr>
<tr>
<td>&quot;Display paint&quot;</td>
<td>See Section 6.6.9, Painting Areas within a Line and Polygons.</td>
</tr>
</tbody>
</table>
Chapter 6

Drawing Canvas Graphics
6. Drawing Canvas Graphics

6.1 Figures and Text Characters That Can Be Drawn

<table>
<thead>
<tr>
<th>Figure</th>
<th>Example</th>
<th>Selectable Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Straight line</td>
<td><img src="example1.png" alt="Example" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Continuous line</td>
<td><img src="example2.png" alt="Example" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="example3.png" alt="Example" /></td>
<td>Line type, line width, display color, painting pattern, pattern color</td>
</tr>
<tr>
<td>Polygon</td>
<td><img src="example4.png" alt="Example" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Circle (oval)</td>
<td><img src="example5.png" alt="Example" /></td>
<td>Line type, line width, display color, painting pattern, pattern color</td>
</tr>
<tr>
<td>Circular arc (elliptical arc)</td>
<td><img src="example6.png" alt="Example" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Painted closed area</td>
<td><img src="example7.png" alt="Example" /></td>
<td>Painting pattern, pattern color</td>
</tr>
<tr>
<td>Painted polygon</td>
<td><img src="example8.png" alt="Example" /></td>
<td>Painting pattern, pattern color</td>
</tr>
<tr>
<td>Graphics data in bitmap file format</td>
<td><img src="example9.png" alt="Example" /></td>
<td>Display color, text enlargement</td>
</tr>
</tbody>
</table>

Text

A BC ABC ABC ABC

Display color, outline color, direction in which text is displayed

Text ornamentation, outline color, direction in which text is displayed

Outline font (Outline fonts can only be used if the characters are in double or larger size both vertically and horizontally.)
## Types of attributes that can be selected

The types of attributes that can be selected are shown below.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line type</td>
<td>Solid line ———, Broken line ———, Dotted line ————, Alternate dots and dashes ————, Alternate double dots and dashes ————.</td>
</tr>
<tr>
<td>Line width</td>
<td>1dot ———, 2dots ———, 3dots ———, 4dots ———.</td>
</tr>
<tr>
<td>Selectable display colors</td>
<td>White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple</td>
</tr>
<tr>
<td>How attribute is displayed on GOT</td>
<td>With the A870GOT-EL: All display colors other than black are displayed in the same color (orange).</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-TFT: Selected display colors are displayed.</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-L: All display colors other than black are displayed in the same color (black).</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td>Painting pattern</td>
<td>![Pattern Image]</td>
</tr>
<tr>
<td>Selectable pattern colors</td>
<td>White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple</td>
</tr>
<tr>
<td>How attribute is displayed on GOT</td>
<td>With the A870GOT-EL: All display colors other than black are displayed in the same color (orange).</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-TFT: Selected display colors are displayed.</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-L: All display colors other than black are displayed in the same color (black).</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
</tbody>
</table>

- Graphics in bitmap file format

The only graphics in the BMP file format which can be displayed on the GOT as parts graphics are 16-color bitmap graphics.

If the GOT is an EL model, the only graphic data which can be displayed is BMP file format graphic data which has been converted to two-tone (monochrome) data.
• How much are characters enlarged at the various magnifications?

- Full-width characters (16 dots (vertical) x 16 dots (horizontal))

<table>
<thead>
<tr>
<th>Vertical magnification</th>
<th>0.5 times</th>
<th>1 time</th>
<th>2 times</th>
<th>4 times</th>
<th>8 times</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5 times</td>
<td>Vertical: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 time</td>
<td>Vertical: 16 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 16 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 times</td>
<td>Vertical: 32 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 times</td>
<td>Vertical: 64 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 times</td>
<td>Vertical: 128 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Half-width characters (16 dots (vertical) x 8 dots (horizontal))

<table>
<thead>
<tr>
<th>Vertical magnification</th>
<th>0.5 times</th>
<th>1 time</th>
<th>2 times</th>
<th>4 times</th>
<th>8 times</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5 times</td>
<td>Vertical: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 4 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 time</td>
<td>Vertical: 16 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 times</td>
<td>Vertical: 32 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 times</td>
<td>Vertical: 64 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 times</td>
<td>Vertical: 128 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 6.2 Memory Required for Figures and Text Characters

The amount of memory required to draw figures and characters is shown below. Figures require the amount of memory stated below, regardless of the type of attributes and size.

<table>
<thead>
<tr>
<th>Figure</th>
<th>Amount of memory (bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Straight line</td>
<td>36</td>
</tr>
<tr>
<td>Continuous line</td>
<td>$32 + 4 \times n$ n = no. of vertices</td>
</tr>
<tr>
<td>Rectangle</td>
<td>28</td>
</tr>
<tr>
<td>Polygon</td>
<td>$32 + 4 \times n$ n = no. of vertices</td>
</tr>
<tr>
<td></td>
<td>(starting point and ending point are also each counted as 1 vertex)</td>
</tr>
<tr>
<td>Circle (oval)</td>
<td>28</td>
</tr>
<tr>
<td>Circular arc (elliptical arc)</td>
<td>40</td>
</tr>
<tr>
<td>Painted polygon</td>
<td>28</td>
</tr>
<tr>
<td>Painted closed area</td>
<td></td>
</tr>
<tr>
<td>Graphic data in bitmap file format</td>
<td>This should be checked for the application used to create the graphic data in the bitmap file format.</td>
</tr>
<tr>
<td>Characters</td>
<td>$36 + 2 \times n$ n = no. of characters</td>
</tr>
<tr>
<td></td>
<td>(memory amount is that stated at left, regardless of whether characters are full- or half-width)</td>
</tr>
<tr>
<td>Outline font</td>
<td>1 character: 128 bytes</td>
</tr>
</tbody>
</table>
6.3 Overlapping Graphics

When you draw canvas graphics on base screens and window screens, there may be times when two figures overlap each other, or when characters and a figure overlap.

When drawing with the graphics software and displaying overlapping figures on the GOT, there are no particular restrictions which apply.

Any graphics which can be drawn with the graphics software and displayed on the computer can also be displayed on the GOT, without requiring any modification.

The order in which figures are overlapped can be changed.

See Section 7.4.4, Changing the Order of Overlapped Graphics or Characters.
6.4 Setting Attributes for Graphics

At this step, let's determine the attributes for the graphic we are about to draw. The figure can be drawn once the attributes have been decided.

There are two ways to specify attributes:

- Selecting them from Tool Bar 2
- Selecting them from the "Change Attribute" dialog box

1 Selecting attributes from Tool Bar 2

The attributes of the figure to be drawn are selected by opening the appropriate list box.

<table>
<thead>
<tr>
<th>Line type</th>
<th>Line width</th>
<th>Line display color</th>
<th>Pattern color</th>
<th>Painting pattern</th>
<th>Cursor move</th>
<th>16</th>
<th>100%</th>
</tr>
</thead>
</table>

The attributes selected in the various list boxes are displayed on Tool Bar 2. After drawing the figure, the attributes can be changed by using the corresponding list boxes on Tool Bar 2.

**POINT**

If an area enclosed by a line is painted, when inputting text in that area, attributes can be decided after the icon or command has been selected.
Selecting attributes from the "Change Attribute" dialog box

1. Move the cursor to a position in the screen window where there is no figure or sprite, and double-click the mouse button to select [Attribute] on the Edit menu.

2. The "Change Attribute" dialog box is displayed.

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Item to set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>&quot;Style&quot;</td>
<td>Select the line style for the figure from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Width&quot;</td>
<td>Select the line width for the figure from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which lines of the figure are to be displayed.</td>
</tr>
<tr>
<td>Pattern</td>
<td>&quot;Type&quot;</td>
<td>Select the painting pattern to be used for painted figures from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which the painting pattern is to be displayed.</td>
</tr>
<tr>
<td>Text</td>
<td>&quot;Horizontal&quot;</td>
<td>Select the horizontal magnification of the text from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Vertical&quot;</td>
<td>Select the vertical magnification of the text from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which text is to be displayed.</td>
</tr>
</tbody>
</table>
6.5 Items to Know before Starting to Draw

(1) The same figure, with the same attributes, can be drawn more than once in succession.

(2) Once the starting point of the figure has been decided, **ESC** can be used to interrupt the process.

(3) Lines with a width of 2 to 4 dots are positioned as shown below, in relation to the starting point position.
(4) If another figure is being drawn after drawing a straight-line figure, the same attributes will continue to be effective even if another icon or command is selected.

(5) If the figure is being drawn from the keyboard, use the following keys for input.

<table>
<thead>
<tr>
<th>Straight lines, rectangles, and circular arcs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine starting point</td>
</tr>
<tr>
<td>Move cursor</td>
</tr>
<tr>
<td>Determine ending point</td>
</tr>
<tr>
<td>Interrupt after starting point has been determined</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Continuous lines and polygons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine starting point</td>
</tr>
<tr>
<td>Move cursor</td>
</tr>
<tr>
<td>Determine edge</td>
</tr>
<tr>
<td>Determine ending point</td>
</tr>
<tr>
<td>Interrupt after starting point has been determined</td>
</tr>
<tr>
<td>Delete previously determined edge</td>
</tr>
</tbody>
</table>

(6) When drawing circles and circular arcs, the circle or circular arc will be drawn with a line width of 1 dot even if a line width of 2 or more dots has been selected.

(7) If a figure is drawn using a line style other than a solid line (broken, dotted, two dots with a dash) and the line width is 2 or more dots, there may be times when the figure cannot be displayed properly by the graphics software. (This problem occurs when the screen window has been enlarged.) The figure will be displayed with the line attributes selected with the GOT, however.
6.6 Drawing Figures and Text Characters

There are two ways to draw figures: by selecting an icon on Tool Bar 1, or by selecting a command on the Draw menu.

6.6.1 Drawing Straight Lines

<table>
<thead>
<tr>
<th>Tool Bar 1</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
<tr>
<td></td>
<td>On Draw menu:</td>
</tr>
<tr>
<td></td>
<td>Draw Figure → Line</td>
</tr>
</tbody>
</table>

1. Decide the attributes of the straight line.

2. Move the cursor to the starting point of the line.

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse.

4. At the ending point, release the left button of the mouse.
6.6.2 Drawing Continuous Lines

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:
[Draw Figure] → [Line Freeform]

1. Decide the attributes of the continuous line.
2. Move the cursor to the starting point of the line.
3. Press the left button of the mouse on the starting point, and move the cursor to the first edge position by dragging it with the mouse.

4. At the first edge position, release the left button of the mouse.

5. Move the cursor to the next edge position, and click there.

6. Repeat the above step until all of the edges have been added, and then double-click at the ending point.
6.6.3 Drawing Rectangles

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command

On Draw menu:

[Draw Figure] → [Rectangle]

1. Decide the attributes of the rectangle.

2. Move the cursor to the starting point of the rectangle.

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse. To draw a square, hold down [SHIFT] while dragging the mouse.

4. At the ending point, release the left button of the mouse.
6.6.4 Drawing Polygons

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command

On Draw menu:
[Draw Figure] → [Polygon]

1. Decide the attributes of the polygon.
2. Move the cursor to the starting point of the polygon.
3. Press the left button of the mouse on the starting point, and move the cursor to the first edge position by dragging it with the mouse.

4. At the first edge position, release the left button of the mouse.

5. Move the cursor to the next edge position, and click there.

6. Repeat the above step until all of the edges have been added, and then double-click at the ending point.
6.6.5 Drawing Circles

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:
[Draw Figure] ➔ [Circle]

1. Decide the attributes of the circle.

2. Move the cursor to the starting point of the circle.

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse.

4. At the ending point, release the left button of the mouse.
6.6.6 Drawing Ovals and Painted Ovals

There are no icons or commands for drawing an ellipse or oval. Use the method below for this figure.

1. Decide the attributes of the oval.

2. Follow the steps in Section 6.6.5 above to draw a circle.

3. Switch the cursor to the graphic editing cursor.

[Image]

See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.

4. Move the cursor to a handle which is not positioned on the four sides around the circle.

[Image]

5. Press the left button of the mouse at the handle position, and drag the mouse until the circle changes to the desired oval shape.

[Image]

6. Release the left button of the mouse.

[Image]
6.6.7 Drawing Circular Arcs

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command

On Draw menu:
[Draw Figure] → [Arc]

1. Decide the attributes of the circular arc.

2. Move the cursor to the starting point of the arc.

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse.

4. At the ending point, release the left button of the mouse.
6.6.8 Drawing Oval Arcs

There are no icons or commands for drawing an oval arc. Use the method below for this figure.

1. Decide the attributes of the oval arc.
2. Follow the steps in Section 6.6.7 above to draw a circular arc.

3. Switch the cursor to the graphic editing cursor.
   
   ![See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.]

4. Move the cursor to a handle which is not positioned on the four sides around the figure.

5. Press the left button of the mouse at the handle position, and drag the mouse until the figure changes to the desired oval arc.

6. Release the left button of the mouse.
6.6.9 Painting Areas within a Line and Polygons

Before painting a figure, keep the following points in mind.

- The borders of the area to be painted should be solid lines.

- The lines bordering the painted area should be the same color.

- If there is even a slight gap in the painted area, the paint will leak to other areas. Be sure the painted area is solidly closed.
1. The “Change Attribute” dialog box is displayed. Decide the paint attributes.

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Item to set</th>
<th>Description of setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>“Color”</td>
<td>Select the color in which the border lines around the area to be painted are to be displayed.</td>
</tr>
<tr>
<td>Pattern</td>
<td>“Style”</td>
<td>Select the pattern to be used for painting from the list box.</td>
</tr>
<tr>
<td></td>
<td>“Color”</td>
<td>Select the color in which the painting pattern is to be displayed.</td>
</tr>
</tbody>
</table>

2. Move the cursor to the area to be painted.
3. Click on the area to be painted.

A paint mark is displayed at the clicked position. This is displayed only in the graphics software, and not on the GOT. To edit the painting, select this mark. (This serves the same function as the handles on a figure.)

- Deleting the display of paint from the screen window in the software graphics

With the graphics software, the display of paint can be deleted from the screen window. (The paint remains displayed on the GOT.) To do this, select [View] under [Option] on the Project menu, and in the "View Option" dialog box, select the check box next to "Display paint", and delete the "X" mark.

Painted square →

- Paint is displayed

- Paint is displayed

The paint disappears, leaving only the paint mark. The painted areas of squares and other figures are not deleted.
6.6.10 Entering Text

— Tool Bar 1 —
Selected icon

— Menu Bar —
Selected command
On Draw menu:
Draw Figure → Text

1. The "Text" dialog box is displayed.

2. Enter the text in the text input text box. Up to 80 characters can be input using half-width characters.
   (Example) Line Monitor

3. Click on Change attribute.

4. The "Change Attribute" dialog box is displayed.

[Diagram of Change Attribute dialog box]
### Tab name | Item to set | Description of setting
--- | --- | ---
**"Style"** | Using the list box, select the display format for the text. Regular .... Text is displayed in the standard style. Bold ......... Text is displayed in the bold type. Solid........ Text is displayed in outline style. |  
**"Solid"** | If "Text ornamentation" was set to "Solid", select the outline color from the list box. |  
**"Text"** | Select the color in which text is to be displayed, from the list box. |  
**"Horizontal"** | Select the horizontal magnification of the text from the list box. |  
**"Vertical"** | Select the vertical magnification of the text from the list box. Using the radio button, select the direction (horizontal or vertical) in which character strings are to be displayed. [Horizontal] [Vertical] |  
**"Direction"** |  
**"Outline font"** | When outline fonts are used, mark in the check box (only when the character size is set to double or larger both vertically and horizontally). |  

5. Click on [OK] .

6. The "Text" dialog box is displayed once again. Click on [OK] .

7. A text frame indicating the size of the displayed text is displayed at the upper left of the screen window.

8. Move the cursor to the position at which the text is to be displayed.

9. Click at that position.
• Precautions when displaying text in the vertical direction

Please be aware that characters such as "-", "-", and "/)" will be displayed as shown below if the vertical orientation is used.

(Example)

<table>
<thead>
<tr>
<th>Horizontal direction</th>
<th>Vertical direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>A7GT-BUS</td>
<td>A7GT</td>
</tr>
<tr>
<td>10 – 20</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>20</td>
</tr>
</tbody>
</table>

• Text that can be displayed on the GOT

- The following types of text can be displayed on the GOT. All styles of text that can be displayed in the screen window of the graphics software can be displayed on the GOT.

Please be aware that until the input text is actually entered, however, even though the characters have been input, there may be characters which cannot be displayed with the graphics software or whose size changes. This is not a problem once the text has actually been entered.

- For instructions on inputting Japanese text, please refer to the instruction manual that comes with the Japanese FEP being used.

- The GOT can display languages from all over the world, using the Unicode system. Languages that can be displayed include Japanese, Korean, Chinese (Mandarin), English, German, French, and many others.

If text is being entered in different languages (Korean, Chinese, etc.) using the graphic settings software, the graphic settings software should be installed on a DOS/V computer running Windows 3.1 or Windows 95, which are designed to accommodate characters for various languages.

- Outline fonts can be used only in Japanese and English languages. They cannot be used for characters other than Japanese or English.
6.7 Pasting Graphics Data in Other Formats (BMP File Format)

Image data that has been read using a scanner, and graphics data in the BMP file format that was created using another application, can be pasted to the screen window and displayed on the GOT.

The following points should be noted before pasting graphics data in the BMP file format to the screen window.

- Graphics data in the BMP file format that can be pasted to the screen window is limited to 16-color bitmap format data. Please be aware that no other types of graphics data can be pasted to the screen window.

- Graphics data in the BMP file format that can be pasted to the screen window can be enlarged or reduced, so use another application to adjust the size, color, and other attributes of the text before pasting it to the screen window.

  - See Section 7.3.6, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction.

  - See Section 7.3.7, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Corner Axis.

  - See Section 7.3.8, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Center Axis.

  - See Section 7.3.9, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle without Changing the Horizontal or Vertical Proportion.
1. The "Read Other Form" dialog box is displayed.

2. Click on [OK].
3. The specified graphic in BMP file format is displayed at the upper left of the screen window.

4. Move the cursor to the position where the graphic is to be placed.

5. Click at that position.
Chapter 7

Editing Canvas Graphics after Drawing Them
7. Editing Canvas Graphics after Drawing Them

7.1 Changing the Cursor to the Graphic Editing Cursor

To edit figures and text, first the cursor has to be changed to the graphic editing cursor, and then the figure or text to be edited is selected.

1. On the Edit menu, select [Object of Selection] and then [Figure].

<table>
<thead>
<tr>
<th>Edit (E)</th>
<th>Figure (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo (U)</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Cut (C)</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy (C)</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste (P)</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Edit Text (X)</td>
<td></td>
</tr>
<tr>
<td>Edit Vertex (V)</td>
<td></td>
</tr>
<tr>
<td>Object of Selection (S)</td>
<td>Sprite (S)</td>
</tr>
<tr>
<td></td>
<td>Figure and Sprite (A)</td>
</tr>
</tbody>
</table>

- [Object of Selection] and then [Sprite] are selected to edit a sprite.

See Section 19.1, Changing the Cursor to the Sprite Editing Cursor.

- [Object of Selection] and then [Figure and Sprite] are selected when a figure and a sprite are to be edited at the same time.

See Section 7.8, Editing Graphics and Sprites Simultaneously.

2. The cursor changes to the graphic editing cursor. Select the figure or text to be edited.

- What happens when [ ] is selected on Tool Bar 1?

Selecting [ ] on Tool Bar 1 returns the cursor to the status it was in the last time that [Object of Selection] was selected on the Edit menu (the graphic editing cursor, sprite editing cursor, or graphic + sprite editing cursor).

(Examples)
- If [Object of Selection] and then [Figure and Sprite] were selected previously, selecting [ ] changes the cursor to the graphic + sprite editing cursor.
- If [Object of Selection] and then [Figure] were selected previously, selecting [ ] changes the cursor to the graphic editing cursor.
7.2 Selecting the Graphic or Text to Edit

When editing figures or text, handles are first attached to the figure or text to be edited, and then changes are made to the attributes, position, size, or other elements.

After the figure has been drawn, handles are attached to the figure or text.

![Shapes and Line Monitor](image)

7.2.1 Selecting a Single Graphic or Character

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Move the cursor onto a line of the figure or text to be edited, or within the figure.

   **POINT**
   To edit painting, move the cursor onto one of the lines forming the paint mark (+).

   ![Painting](image)

   3. Click at that point.

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Using [↑↓←→], move the cursor onto a line of the figure or text to be edited, or within the figure.
7.2.2 Selecting a Single Graphic or Character from Overlapped Graphics

1. Using the mouse

1. Change the cursor to the graphic editing cursor.
2. Move the cursor onto the overlapping figure or text.

3. Holding down `CTRL` on the keyboard, click at that point.

4. Repeat step 3) above and attach handles to the figure or text to be edited.

2. Using the keyboard

1. Change the cursor to the graphic editing cursor.
2. Using `↑↓←→`, move the cursor onto the overlapping figure or text.
3. Holding down `CTRL`, press `Enter` twice.
4. Repeat step 3) above and attach handles to the figure or text to be edited.
7.2.3 Selecting Multiple Graphics or Characters from a Group in a Screen Window

This function is used when a number of figures are to be included within a square. There may be times when selecting a number of overlapping figures does not display handles. To avoid this, the figures to be edited should be separated out from the others ahead of time.

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Move the cursor to the position which will serve as the starting point.

   ![Diagram 1]

   3. Press the left button of the mouse at the starting point, and drag the mouse to draw a square that includes all of the figures to be selected.

   ![Diagram 2]

   4. Release the left button of the mouse.

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Using the arrow keys, move the cursor to the starting point.
   3. Press the mouse at the starting point, and then move the cursor to draw a square that includes all of the figures to be selected.

   ![Diagram 3]

   4. Press the mouse.
• What happens if the square includes a sprite?
  
  If the cursor has been changed to the graphic editing cursor, handles will not be attached to a sprite even if it is included in the square.

  ![Diagram](image1)

• This function can be used to select all of the graphics on the screen window.
  
  - Drawing a square that extends from the upper left corner of the screen window to the lower right corner will display handles on all of the graphics on the screen.

  ![Diagram](image2)

  - If no sprites have been specified in the screen window, the **Select All** command on the Edit menu can be used to display handles on all of the figures and text.
  
  - The **Select All** command on the Edit window can be used to display handles on all of the graphics and sprites in the screen window.
7.2.4 Selecting Disparate Multiple Graphics or Characters in a Screen Window

1. **Using the mouse**
   1. Change the cursor to the graphic editing cursor.
   2. Move the cursor onto a line of the figure or text to be selected first.

![Diagram 1](image)

3. Click at that position.

![Diagram 2](image)

4. Move the cursor onto a line of the figure or text to be selected next, and hold down **SHIFT** on the keyboard while clicking at that position.

   Repeat this procedure to display handles on all of the figures and text to be edited.

**POINT**
To edit painting, move the cursor onto one of the lines forming the paint mark (+).

![Diagram 3](image)

2. **Using the keyboard**
   1. Change the cursor to the graphic editing cursor.
   2. Using **↑ ↓ ← →**, move the cursor onto the first figure or text to be edited.
   3. Press **Enter**.
   4. Using **↑ ↓ ← →**, move the cursor onto a line of the figure or text to be selected next, and press **Enter** while holding down **SHIFT**.

   Repeat this procedure to display handles on all of the figures and text to be edited.
7.2.5 Deleting One or More Selected Graphics

1 Using the mouse

1. Move the cursor to a position on the screen window where there is no setting frame for a figure or sprite.

2. Click at that position.

2 Using the keyboard

1. Using \[ \downarrow \uparrow \leftarrow \rightarrow \], move the cursor to a position on the screen window where there is no setting frame for a figure or sprite.

2. Press \[ \text{Enter} \] twice.
7.2.6 Deleting One of Several Selected Graphics

1 Using the mouse

1. Holding down [SHIFT] on the keyboard, move the cursor onto a line of the figure or text to be deleted, or within a figure to be deleted.

If figures are overlapping each other, move the cursor onto a line of the figure or text to be deleted.

2. Holding down [SHIFT] on the keyboard, click at that position.

2 Using the keyboard

1. Holding down [SHIFT] on the keyboard, use [↑ ↓ → ←] to move the cursor onto a line of the figure or text to be deleted, or within a figure to be deleted.

If figures are overlapping each other, move the cursor onto a line of the figure or text to be deleted.

7.3 Correcting Graphics or Characters

7.3.1 Changing the Attributes of a Graphic

There are two ways to change the attributes of a graphic:

- Change the attribute from Tool Bar 2.
- Change the attribute from the "Change Attribute" dialog box.

1. Changing the attribute from Tool Bar 2
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose attribute is to be changed.
      (If the same attribute is to be changed on several figures at the same time, select all of the figures on which the change is to be made.)
   3. Open the list box for changing attributes on the tool bar, and change the attribute.

2. Changing the attribute from the "Change Attribute" dialog box
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose attribute is to be changed.
      (If the same attribute is to be changed on several figures at the same time, select all of the figures on which the change is to be made.)
   3. Move the cursor onto a line of the figure or text, or within the figure (if several figures have been selected, move it onto a line of any selected figure or text, or within any selected figure), and double-click at that position.
   4. This displays the [Attribute] dialog box, where the attribute can be changed.

See Section 6.4, Setting Attributes for Graphics.
7.3.2 Changing the Attributes of a Character

1. Change the cursor to the graphic editing cursor.

2. Select the character string whose attribute is to be changed. (If the same attribute is to be changed on several character strings at the same time, select all of the character strings on which the change is to be made.)

3. Move the cursor onto the character string whose attribute is to be changed (if several strings have been selected, move it onto any selected string), and double-click at that position.

   This can also be done by selecting [Edit Text] on the Edit menu.

4. This displays the "Set Text/Graphic" dialog box, where the attribute can be changed.

   See Section 6.6.10, Entering Text.

7.3.3 Changing Graphic and Character Attributes Simultaneously

1. Change the cursor to the graphic editing cursor.

2. Select the figure and character string whose attribute is to be changed.

   ![Line Monitor]

3. Move the cursor onto either the figure or the character string, or within the figure, and double-click at that position.

4. This displays the "Change Attribute" dialog box, where the attribute can be changed for the figure and character string.

   See Section 6.4, Setting Attributes for Graphics.
   See Section 6.6.10, Entering Text.
7.3.4 Changing the Size of a Straight Line or Circular Arc after Drawing It

1. Using the mouse

1. Change the cursor to the graphic editing cursor.

2. Select the straight line or arc whose size is to be changed.

3. Move the cursor to a handle on the straight line or arc.

4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the graphic editing cursor.

2. Select the straight line or arc whose size is to be changed.

3. Using the arrow keys, move the cursor to a handle on the straight line or arc.

4. The cursor changes to the size changing cursor. Press Enter, and then use the arrow keys to move the cursor to the position at which the size is to be changed.

5. At the position where the size is to be changed, press Enter.
7.3.5 Changing the Length of a Specified Segment of a Continuous Line or Polygon

1. Using the mouse

1. Change the cursor to the graphic editing cursor.

2. Select the continuous line or polygon whose border line length is to be changed.


   The handles are displayed as vertex handles.

4. Move the cursor to the position of a handle where the length of the line is to be changed.

5. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

6. At the position where the size is to be changed, release the left button of the mouse.

To cancel the vertex editing function, select [Edit Vertex] on the Edit menu once again.
2. Using the keyboard

1. Change the cursor to the graphic editing cursor.

2. Select the continuous line or polygon whose border line length is to be changed.


4. Using [↑ ↓ ← →], move the cursor to a handle on a line whose length is to be changed.

5. The cursor changes to the size changing cursor. Press [Esc], and then use [↑ ↓ ← →] to move the cursor to the position at which the line length is to be changed.

6. At the position where the length is to be changed, press [Enter].
7.3.6 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction

1. Using the mouse

   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.

   

   3. If changing the size in the vertical direction, move the cursor to a vertical handle, and if changing it in the horizontal direction, move the cursor to a horizontal handle.

   

   4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

   

   5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard

   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.
   3. Using ▲ ▼ ◀ ▶, move the cursor to a vertical handle if the size is to be changed in the vertical direction, and to a horizontal handle if the size is to be changed in the horizontal direction.
   4. The cursor changes to the size changing cursor. Press [Enter], and then use ▲ ▼ ◀ ▶ to move the cursor to the position at which the size is to be changed.
   5. At the position where the size is to be changed, press [Enter].
7.3.7 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Corner Axis

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.
   3. Move the cursor to a handle at the corner of the figure.
   4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.
   5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.
   3. Using [↑↓←→], move the cursor to a handle at the corner of the figure.
   4. The cursor changes to the size changing cursor. Press [Enter], and then use [↑↓←→] to move the cursor to the position at which the size is to be changed.
   5. At the position where the size is to be changed, press [Enter].
7.3.8 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Center Axis

1 Using the mouse
1. Change the cursor to the graphic editing cursor.
2. Select the figure whose size is to be changed.

3. Move the cursor to a handle at the corner of the figure.

4. The cursor changes to the size changing cursor. Holding down [CTRL] on the keyboard, press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

5. At the position where the size is to be changed, release the left button of the mouse.

2 Using the keyboard
1. Change the cursor to the graphic editing cursor.
2. Select the figure whose size is to be changed.
3. Using [↑↓←→], move the cursor to a handle at the corner of the figure.
4. The cursor changes to the size changing cursor. Holding down [CTRL] on the keyboard, press [Enter], and then use [↑↓←→] to move the cursor to the position at which the size is to be changed.
5. At the position where the size is to be changed, press [Enter].
7.3.9 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle without Changing the Horizontal to Vertical Proportion

1. Using the mouse

1. Change the cursor to the graphic editing cursor.
2. Select the figure whose size is to be changed.

3. Move the cursor to a handle at the corner of the figure.

4. The cursor changes to the size changing cursor. Holding down \[CONTROL\] and \[SHIFT\] on the keyboard, press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the graphic editing cursor.
2. Select the figure whose size is to be changed.
3. Using \[\uparrow\downarrow\leftarrow\rightarrow\], move the cursor to a handle at the corner of the figure.
4. The cursor changes to the size changing cursor. Holding down \[CONTROL\] and \[SHIFT\] on the keyboard, press \[Enter\], and then, still holding down \[CONTROL\] and \[SHIFT\], use \[\uparrow\downarrow\leftarrow\rightarrow\] to move the cursor to the position at which the size is to be changed.
5. At the position where the size is to be changed, press \[Enter\].
7.3.10 Deleting Graphics and Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figure or text to be deleted. (If several figures are to be deleted at the same time, select all of the figures to be deleted.)


TIPS
The editing procedure described on this page can also be carried out on sprites at the same time.
7.3.11 Cutting Graphics and Characters and Storing Them on the Clipboard

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be cut. (If several figures are to be cut at the same time, select all of the figures to be cut.)

3. Select the scissors icon \( \square \) on Tool Bar 1, or the [Cut] command on the Edit menu.

The cut figure is stored on the Clipboard and can be pasted back on the screen window later on, if desired.

See Section 7.4.3, Pasting Graphics and Characters Stored on the Clipboard.
7.3.12 Flipping, Reversing, and Rotating Graphics 90°

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be rotated.

3. Select [Rotate/Flip] on the Edit menu, and then select [Flip Vertical], [Flip Horizontal], or [Rotate Left].

7.3.13 Rotating Text

1. Select the character string to be rotated.

2. Select [Rotate/Flip] and then [Rotate Left] on the Edit menu.

3. To turn the character string upside down, select [Rotate/Flip] and then [Rotate Left] on the Edit menu once again.
7.4 Editing Graphics and Characters

7.4.1 Moving Graphics and Characters

Using the mouse

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be moved. (If several figures are to be moved at the same time, select all of the figures to be moved.)

3. Move the cursor within the figure to be moved (if several figures are to be moved, move the cursor within any of them).

4. The cursor changes to the movement cursor. Press the left button of the mouse and drag the mouse to the position to which the figure is to be moved.

5. At the position where the figure is to be moved, release the left button of the mouse.

TIPS

The editing procedure described on this page can also be carried out on sprites at the same time.
2 Using the keyboard

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be moved. (If several figures are to be moved, select all of them.)

3. Using [↑ ↓ ← →], move the cursor within the figure to be moved (if several figures are to be moved, move the cursor within any of them).

4. The cursor changes to the movement cursor. Press [Enter] and then use [↑ ↓ ← →] to move the cursor to the position to which the figure is to be moved.

5. At the position where the figure is to be moved, press [Enter].

7.4.2 Copying Graphics and Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be copied. (If several figures are to be copied at the same time, select all of them.)

   ![Production Quantity Monitor]

   ![Copy icon]

3. Select the ☑ icon on Tool Bar 1, or select [Copy] on the Edit menu.

4. The selected figure is stored on the Clipboard.

   ![Clipboard]

   ![Clipboard]

   ![Production Quantity Monitor]

   ![Copy icon]

**TIPS**

The editing procedure described on this page can also be carried out on sprites at the same time.
7.4.3 Pasting Graphics and Characters Stored on the Clipboard

1. Select the Paste icon on Tool Bar 1, or select Paste on the Edit menu.

2. The cursor changes to the movement cursor and the image of the figure stored on the Clipboard is displayed. Move the cursor to the position at which the figure is to be pasted.

3. Click at that position.

7.4.4 Changing the Order of Overlapped Graphics or Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figure whose order is to be changed.

3. Select Stacking Order on the Edit menu, and then select Bring to Front or Send to Back.

Bring to Front

Send to Back
7.4.5 Copying and Pasting Figures and Texts as a Group

This editing operation is used to copy and paste figures and text together. Using this function, several figures can be selected and copied at one time.

1. Change the cursor to the figure editing cursor.
2. Select the figure to be copied. (If several figures are to be copied at the same time, select all of the target figures.)

3. Select [Copy and Paste] on the Edit menu. This displays the dialog box shown below.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
</table>
| "Number"       | This specifies the results of copying and pasting the figure or figures in numeric terms. For example, if "2" is specified, one figure is copied, and two figures are pasted on the screen.  
\[ X \text{ direction} \ldots \ldots \text{Specifies the actual number of lines to be copied in the X direction (to the right of the copy source).} \]  
\[ Y \text{ direction} \ldots \ldots \text{Specifies the actual number of lines to be copied in the Y direction (downwards of the copy source).} \]  
[Example] When "3" is specified for the X direction and "2" for the Y direction

\[
\begin{array}{c}
\text{\textbullet\textbullet\textbullet} \\
\end{array} \quad \Rightarrow \quad \begin{array}{c}
\text{\textbullet\textbullet\textbullet} \\
\end{array}
\]
<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Interval (dot)&quot;</td>
<td>If a setting of 2 or more has been entered for either the X or Y direction, this is used to specify the interval from the copy source position, in units of dots. X direction ......... Specifies the interval (number of dots) in the X direction (to the right of the copy source). Y direction ......... Specifies the interval (number of dots) in the Y direction (downwards of the copy source).</td>
</tr>
</tbody>
</table>

**Example**

When "0 dots" is specified for the X direction

- **For one figure**

  ![Diagram](diagram1.png)

- **For several figures**

  ![Diagram](diagram2.png)

When "5 dots" is specified for the X direction

- **For one figure**

  ![Diagram](diagram3.png)

- **For several figures**

  ![Diagram](diagram4.png)

When "0 dots" is specified for the Y direction

- **For one figure**

  ![Diagram](diagram5.png)

- **For several figures**

  ![Diagram](diagram6.png)

When "5 dots" is specified for the Y direction

- **For one figure**

  ![Diagram](diagram7.png)

- **For several figures**

  ![Diagram](diagram8.png)

If no sprites have been selected, "Address Increment" cannot be selected.

4. Click on **OK**.

**TIPS**

The operation described on this page can be done by selecting a sprite or by selecting a figure + sprite.
7.4.6 Undoing the Previous Operation

If a figure or text has been deleted as described in Section 7.3.10, this returns it to the display (this function does not apply to sprites).

To return a figure or text to the original status, select [Undo] on the Edit menu immediately after correcting or editing the figure or text, or editing multiple graphics.

7.5 Editing Several Graphics

7.5.1 Grouping Several Graphics and Characters

- What happens when graphics and text are grouped?

Grouping several graphics and/or characters in one group means that several figures can be treated as a single figure.

There will probably be times when you combine different figures such as a square, a circle, and straight lines, for example, to make a figure. Grouping these various shapes as one figure makes editing much easier.

1. Change the cursor to the graphic editing cursor.

2. Select the figures to be grouped.

3. Select [ ] on Tool Bar 1, or select the [Group] command and then the [Group] command on the Edit menu.

**TIPS**

The editing procedure described on this page can also be carried out on sprites at the same time.
7.5.2 Ungrouping Graphics and Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figures whose group is to be cancelled. (If several groups are to be cancelled at one time, select all of the groups to be cancelled.)

3. Select \( \text{Box} \) on Tool Bar 1, or select the \( \text{Group} \) command and then the \( \text{Ungroup} \) command on the Edit menu.

**TIPS**

The editing procedure described on this page can also be carried out on sprites at the same time.
7.5.3 Centering Several Graphics

1. Change the cursor to the graphic editing cursor.
2. Select the figures to be centered.

3. Select [Align] and then [Center] on the Edit menu.

TIPS
The editing procedure described on this page can also be carried out on sprites at the same time.

7.5.4 Aligning Several Graphics along the Top or Bottom

1. Change the cursor to the graphic editing cursor.
2. Select the figures to be aligned at the top or bottom.


Aligned at top

Aligned at bottom

The uppermost figure is used as a reference to align the others.

The lowermost figure is used as a reference to align the others.
7.5.5 Aligning Several Graphics along the Left or Right

1. Change the cursor to the graphic editing cursor.

2. Select the figures to be aligned at the left or right.

3. Select [Align] and then [Left] or [Right] on the Edit menu.

   | **Aligned at left** | **Aligned at right** |
   --- | --- |
   ![Diagram](image) | ![Diagram](image) |

   - The figure farthest to the left is used as a reference to align the others.
   - The figure farthest to the right is used as a reference to align the others.

**TIPS**

The editing procedure described on this page can also be carried out on sprites at the same time.
7.5.6 **Aligning Several Graphics along the Left or Top at Even Intervals**

1. Change the cursor to the graphic editing cursor.

2. Select the figures to be aligned at the left or top, at even intervals.

3. Select [Align] and then [Left evenly] or [Top evenly] on the Edit menu.

   - **Aligned at left, at even intervals**
   - **Aligned at top, at even intervals**

The figures are spaced at even intervals between the top left coordinates of the uppermost figure and the top left coordinates of the lowermost figure. The figures are spaced at even intervals along the top, between the top left coordinates of the figure farthest to the left and the top left coordinates of the figure farthest to the right.

**TIPS**

The procedure described on this page can also be carried out on sprites at the same time, by selecting the sprite, and then selecting “Figure + Sprite”.
7.6 Editing Graphics and Sprites Simultaneously

Sprites set on the screen window and graphics drawn on the same window can be edited at the same time. To do this, change the cursor to the "Figure + Sprite" cursor, and select the figure and sprite to be edited. Then do the editing.

See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.

Sprites to be edited are selected in the same way as figures to be edited.

- What kinds of editing can be done simultaneously?

Editing operations that can be carried out on sprites and figures simultaneously are listed below. Please be aware that there are a few editing operations which cannot be carried out on both sprites and figures at the same time.

- Figures and sprites can be deleted simultaneously.
- Figures and sprites can be cut simultaneously and pasted to the Clipboard. (Sprites can also be stored on the Clipboard.)
- Figures and sprites can be moved simultaneously.
- Figures and sprites can be copied simultaneously.
- Figures and sprites stored on the Clipboard can be pasted simultaneously.
- Figures and sprites can be grouped simultaneously.
- Groups of figures and sprites can be cancelled simultaneously.
- Figures and sprites can be aligned simultaneously.
- Figures and sprites can be deleted simultaneously at even intervals.

- Editing operations which cannot be carried out simultaneously

- The sizes of figures and sprites cannot be changed simultaneously.
- Figures and sprites cannot be flipped, mirror reversed, or rotated 90° simultaneously.
- Overlapped figures and sprites cannot have the order changed simultaneously.
Chapter 8

Before Entering Sprite Settings
8. Before Entering Sprite Settings

8.1 Types of Sprite Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric display function</td>
<td>This function displays data stored in word devices as numeric data.</td>
</tr>
<tr>
<td>(Section 11.1)</td>
<td>• Monitor device values undergo data processing, and the processed values can be displayed as numeric values.</td>
</tr>
<tr>
<td></td>
<td>• When the monitor device value has reached a certain value, the display color and attributes can be changed.</td>
</tr>
<tr>
<td>ASCII display function</td>
<td>This function enables data stored in conjunction with a word device to be handled as a character code (ASCII code or shift JIS code) and character strings displayed as such.</td>
</tr>
<tr>
<td>(Section 11.2)</td>
<td></td>
</tr>
<tr>
<td>Clock display function</td>
<td>This function displays the data for the internal clock of the PC CPU.</td>
</tr>
<tr>
<td>(Section 11.3)</td>
<td>• The display format can be specified as either time or date.</td>
</tr>
<tr>
<td>Data list display function</td>
<td>This function allows the statuses of a number of word devices to be collected at a specified timing and displayed in numeric format.</td>
</tr>
<tr>
<td>(Section 11.4)</td>
<td>• The statuses of target word devices can be displayed in a specified order of preference.</td>
</tr>
<tr>
<td>Comment display function</td>
<td>This function enables comments to be displayed as bit devices are turned on or off.</td>
</tr>
<tr>
<td>Bit (Section 12.2)</td>
<td>• Comments can be displayed in multiple lines if necessary, in order to fit into the display range.</td>
</tr>
<tr>
<td></td>
<td>• Comments can be displayed only when a bit device is on, or only when it is off.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Word (Section 12.3)</td>
<td>This function enables comments to be displayed as word devices are turned on or off.</td>
</tr>
<tr>
<td></td>
<td>• Comments can be displayed in multiple lines if necessary, in order to fit into the display range.</td>
</tr>
<tr>
<td></td>
<td>• Monitor device values undergo data processing, and the processed values can be displayed as comments.</td>
</tr>
<tr>
<td>Alarm list display function</td>
<td>If an error occurs in the PC CPU, the data link/network, or the GOT, this function displays an error alarm.</td>
</tr>
<tr>
<td>System alarms (Section 12.4)</td>
<td></td>
</tr>
<tr>
<td>User alarms (Section 12.5)</td>
<td>This function attaches a comment to multiple bit devices and displays bit devices which are ON in the order according to the priority.</td>
</tr>
<tr>
<td></td>
<td>• Comment can be displayed folded to the next line (only when single display number is selected).</td>
</tr>
<tr>
<td></td>
<td>• Displays the priority in the order of occurrence/the oldest forwards/the most recent backwards.</td>
</tr>
<tr>
<td></td>
<td>• Displays multiple or single comment(s) in the order of priority</td>
</tr>
<tr>
<td></td>
<td>• Displays the details of a device that became ON.</td>
</tr>
<tr>
<td></td>
<td>• Stores the number of bit devices that are currently ON into a word device.</td>
</tr>
<tr>
<td></td>
<td>• Also, possible to memorize the order of occurrence when switching the alarm list to another screen.</td>
</tr>
<tr>
<td>Function</td>
<td>Contents</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Part display function | **Bit** (Section 13.2) This function enables parts to be displayed with respect to whether the corresponding bit devices are on or off.  
- Figures in BMP format files can be displayed as parts.  
- Parts for only those bit devices which are on or off can be displayed. |
| Part move display function (Section 13.4) | This function enables the display positions for the parts display (bit) and parts display (word) functions to be changed (Move/Trajectory Move) based on the value of a 2-point word device. |
| Lamp display | **Bit** (Section 13.5) This turns lamps on and off in conjunction with bit devices being turned on and off. |
|                  | **Word** (Section 13.6) This function enables the color in which a lamp lights to be changed based on the word device value.  
- Monitor device values undergo data processing, and the color of the lamp can be changed based on the processed values.  
- Lamp colors can be changed to any of eight colors. |
| Panel meter display function (Section 13.7) | This function displays meters as a proportion of the upper and lower limit values of a word device.  
- Monitor device values undergo data processing, and the panel meter can be displayed based on the processed values.  
- When the monitor device value has reached a certain value, the color in which the meter indicator is displayed can be changed. |
| Trend graph display function (Section 14.1) | This function allows the data stored in a word device to be collected at a specified timing and displayed as a trend graph. After the data is displayed to the specified range, the display scrolls.  
- Up to eight graphs (data for eight devices) can be displayed.  
- Monitor device values undergo data processing, and a trend graph can be displayed based on the processed values.  
- Data can continue to be collected continuously even if the screen is switched from the trend graph display screen to another screen. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line graph display function</td>
<td>This function allows the data for multiple word devices to be collected as a group and displayed as a line graph.</td>
</tr>
<tr>
<td>(Section 14.2)</td>
<td>• Data for up to eight devices can be displayed on the graph.</td>
</tr>
<tr>
<td></td>
<td>• Monitor device values undergo data processing, and a line graph can be displayed based on the processed values.</td>
</tr>
<tr>
<td>Bar graph display function</td>
<td>This function displays the data stored in multiple word devices as a bar graph.</td>
</tr>
<tr>
<td>(Section 14.3)</td>
<td>• A standard value can be set, and bar graphs displayed above and below the standard value.</td>
</tr>
<tr>
<td></td>
<td>• Data for up to eight devices can be displayed on one bar graph.</td>
</tr>
<tr>
<td></td>
<td>• Monitor device values undergo data processing, and a bar graph can be displayed based on the processed values.</td>
</tr>
<tr>
<td>Level display function</td>
<td>This function allows a level display showing the proportion of a word device in relation to upper and lower limit values.</td>
</tr>
<tr>
<td>(Section 14.4)</td>
<td>• Level displays can be produced to the top, bottom, right, and left.</td>
</tr>
<tr>
<td></td>
<td>• Monitor device values undergo data processing, and a level display can be produced based on the processed values.</td>
</tr>
<tr>
<td></td>
<td>• When the monitor device value has reached a certain value, the color and pattern of the level display can be changed.</td>
</tr>
<tr>
<td>Touch key</td>
<td>This function turns on a specified bit device when a touch key is touched.</td>
</tr>
<tr>
<td>Bit (Section 15.3)</td>
<td>This function turns off a specified bit device when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function reverses the current status of a specified bit device (ON ↔ OFF) when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function turns on a specified bit device for as long as the key is held down.</td>
</tr>
<tr>
<td>Word (Section 15.4)</td>
<td>This function writes a specified value to a word device when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function writes a specified word device value to a word device when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function writes a specified word device value and a fixed value to a word device when a touch key is touched.</td>
</tr>
<tr>
<td>Base switching (Section 15.5)</td>
<td>This function switches to the previously displayed base screen when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function switches to a specified base screen when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function switches to a specified base screen when a specified bit device is turned on or off by touching a touch key.</td>
</tr>
<tr>
<td></td>
<td>This function switches the base screen based on the current value of a specified word device, by touching a touch key.</td>
</tr>
<tr>
<td>Function</td>
<td>Contents</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Touch key                                    | This function switches to a specified window screen when a touch key is touched.  
| Window switching                             | This function switches to a specified window screen when a specified bit device is turned on or off by touching a touch key.         |
|                                             | This function switches the window screen based on the current value of a specified word device, by touching a touch key.            |
| Expansion                                    | This function switches to the screen for an expanded function by touching a touch key.                                                  |
| Key code setting simultaneous pressing inhibited | This creates a key to be used for numeric or ASCII input.  
|                                             | This function inhibits pressing of two touch keys at the same time.                                                                     |
| Numeric input function                       | This function writes a desired numeric value to the specified word device.                                                             |
| (Section 16.1)                               | • Touching the input area displays the input cursor.                                                                                   |
|                                             | • The numeric input keys display the GOT key window on the screen. (Any keys can be assigned as input keys.)                           |
|                                             | • Input values undergo data processing, and the processed values can be written to a writing device.                                  |
| ASCII input function                         | This function writes any desired key code to the specified word device.                                                               |
| (Section 16.3)                               | • Touching the input area displays the input cursor.                                                                                   |
|                                             | • Any keys can be assigned as input keys. (The key window can also be used for input.)                                               |
| Alarm history function                       | This function correlates comments to sequential bit devices specified and displays the time when the device was turned ON and the comment.|
| (Chapter 22)                                 | • Displays details of a device which became ON.                                                                                       |
|                                             | • Displays the time and date when a comment indicating turning ON or changing from ON to OFF (restoration) of a device is confirmed.|
|                                             | • The display contents can be retained even when the GOT power is turned off.                                                          |
| Operation panel function                     | • By connecting the operation panel to GOT, change of device and switching of a screen can be performed.                               |
| (Chapter 23)                                 | • Can be used as keys for numeric and ASCII character input.                                                                           |
| Hard copy function                           | This function prints out the currently displayed monitor screen when the bit device is on, or when a touch key is entered.         |
| (Section 24.1)                               | System information function                                                                                                            |
|                                             | This function confirms the operation status of GOT with the PC CPU.                                                                  |
| Status monitoring function                   | This function writes data to the PC CPU when the specified conditions are met (the specified bit device is turned on or off).       |
| (Section 24.3)                               | Test function                                                                                                                         |
|                                             | This function displays the test window and changes the device values while monitor screen is being displayed.                           |
| Display speed acceleration function           | This function accelerates the display speed when setting the sequential bit devices with the sprite function.                      |
### 8.2 Memory Required for Sprites and Maximum Settings

The table below shows the required amount of memory for each of the sprites, and the maximum number of settings that can be entered in one base screen and one window screen. The indicated memory capacity and max. no. of settings are the capacity when all of the setting items for sprites are set to the default values. If settings are being entered for data expression, display methods, and other procedures, the amount of memory required will differ from that shown below (more memory is required).

<table>
<thead>
<tr>
<th>Sprite name</th>
<th>Memory capacity (bytes)</th>
<th>Max. no. of settings (points)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric display function</td>
<td>80</td>
<td>200</td>
</tr>
<tr>
<td>Data list display function</td>
<td>400</td>
<td>1 (window screen not possible)</td>
</tr>
<tr>
<td>ASCII display function</td>
<td>60</td>
<td>100 (15) *1</td>
</tr>
<tr>
<td>Clock display function</td>
<td>40</td>
<td>560</td>
</tr>
<tr>
<td>Comment display function</td>
<td>80</td>
<td>200</td>
</tr>
<tr>
<td>Alarm list (system alarms) display function</td>
<td>36</td>
<td>1</td>
</tr>
<tr>
<td>Alarm list (user alarms) display function</td>
<td>64</td>
<td>10 (2) *1</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Values in parentheses are converted to multiples of 4.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parts display function</td>
<td>72</td>
<td>200</td>
</tr>
<tr>
<td>Parts movement display function</td>
<td>108</td>
<td>100</td>
</tr>
<tr>
<td>Parts graphics</td>
<td>Memory capacity for figures drawn as canvas graphics</td>
<td></td>
</tr>
<tr>
<td>Lamp display function</td>
<td>324</td>
<td>315</td>
</tr>
<tr>
<td>Panel meter display function</td>
<td>188</td>
<td>315</td>
</tr>
<tr>
<td>Trend graph display function</td>
<td>76</td>
<td>10</td>
</tr>
<tr>
<td>Line graph display function</td>
<td>184</td>
<td>10 (1) *1</td>
</tr>
<tr>
<td>Bar graph display function</td>
<td>84</td>
<td>200 (40) *1</td>
</tr>
<tr>
<td>Level display function</td>
<td>88</td>
<td>200</td>
</tr>
<tr>
<td>Touch switch functions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit</td>
<td>284</td>
<td>Base screens: 256 (10) *1</td>
</tr>
<tr>
<td>Word</td>
<td>296</td>
<td>Window screens: 64 (10) *1</td>
</tr>
<tr>
<td>Screen switching</td>
<td>288</td>
<td></td>
</tr>
<tr>
<td>Expansion</td>
<td>268</td>
<td></td>
</tr>
<tr>
<td>Numeric input function</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>ASCII input function</td>
<td>84</td>
<td>200</td>
</tr>
<tr>
<td>Window setting</td>
<td>40</td>
<td>100 (15) *1</td>
</tr>
<tr>
<td>Alarm history</td>
<td>140 + (2 + Number of characters in the title) x Number of display items + Number of devices x 2U</td>
<td>1</td>
</tr>
<tr>
<td>Common</td>
<td>Screen title data</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 + 2 / no. of characters</td>
<td>(unit: 1 screen)</td>
</tr>
<tr>
<td></td>
<td>Hard copy</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Operation panel</td>
<td>112 + 4 x Number of operation settings</td>
</tr>
<tr>
<td></td>
<td>Status monitor</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Other than above</td>
<td>128</td>
</tr>
</tbody>
</table>

The data for the various sprite name items listed above are downloaded to the GOT.

*1. Numeric values in parentheses indicate the maximum number than can be set when the maximum is entered for the item being set.
8. Before Entering Sprite Settings

<table>
<thead>
<tr>
<th>Type of sprite</th>
<th>Item set</th>
<th>Default value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII display/ASCII input</td>
<td>No. of digits displayed</td>
<td>6 digits</td>
<td>40 digits</td>
</tr>
<tr>
<td>Alarm list display (user alarms)</td>
<td>No. of monitor device points</td>
<td>1 point</td>
<td>255 points</td>
</tr>
<tr>
<td>Line graph display</td>
<td>No. of graphs/no. of points</td>
<td>1 graph/10 points</td>
<td>8 graphs/100 points</td>
</tr>
<tr>
<td>Bar graph display</td>
<td>No. of graphs</td>
<td>1 graph</td>
<td>8 graphs</td>
</tr>
<tr>
<td>Touch switch function</td>
<td>No. of action setting points</td>
<td>0 point</td>
<td>83 points</td>
</tr>
</tbody>
</table>

- Memory capacity outline fonts are set
  
  Memory capacity for outline fonts is 128 bytes per character regardless of the character size. For instance, when six digits are set for display in the numerical display function and outline fonts are used, the required memory capacity will be $128 \times 6 = 768$ bytes.

- Maximum number of settings when the periodic trigger is set as the display condition
  
  The maximum setting number when the periodic trigger is set is 100 points.

8.3 Overlapping Canvas Graphics and Sprites

On base screens and window screens, there may be times when canvas graphics and sprites overlap. There are no special restrictions in displaying overlapped canvas graphics and sprites on the GOT. When these are being displayed on the GOT, sprites are always displayed on top of canvas graphics, regardless of whether the graphics were drawn first or the sprite settings were entered first. The graphics software can be used to check how the display will appear on the GOT.

See Section 20.2, Viewing an Image of the Created Screen Data.

![Sprite in numeric display function]

Please be aware that if the canvas graphic and the sprite are displayed in the same color, the sprite will not be visible on the screen.

8.4 Entering Settings for Overlapped Sprites

With the graphics software, sprite settings can be overlapped. However, overlapped sprite settings cannot be displayed on the GOT. (When displayed on the GOT, the overlapped sections will not be displayed correctly.)

Make sure the settings for the sprite display conditions and other parameters are entered in such a way that sprites are not displayed in an overlapping configuration.

See Section 10.4, Setting Display Conditions.
### 8.5 Types of Attributes That Can be Set with Sprites

The types of attributes that can be selected are shown below.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
</tr>
</thead>
</table>
| Character size                | Vertical 0.5 time (alarm list (system alarm) display only) /1 time/2 times/4 times/8 times  
                                  Horizontal 0.5 time (alarm list (system alarm) display only) /1 time/2 times/4 times/8 times |
| Fonts                         | Standard, outline fonts (only for numerical display, data list display, comment display, alarm list display, lamp display, panel indicator display, touch switch function, numerical data input function and alarm history function) |
| Line type                     | Solid line ——, Broken line ——, Dotted line ————, Alternate dots and dashes ————, Alternate double dots and dashes ———— |
| Line width                    | 1dot ——, 2dots ———, 3dots ————, 4dots ———— |
| Selectable display colors     | White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple |
| How attribute is displayed on GOT | With the A870GOT-EL:  
                                  All display colors other than black are displayed in the same color (orange).  
                                  With the A870GOT-STN:  
                                  All dark colors are displayed as the original color.  
                                  With the A870GOT-TFT:  
                                  Selected display colors are displayed.  
                                  With the A85□GOT-L:  
                                  All display colors other than black are displayed in the same color (black).  
                                  With the A85□GOT-STN:  
                                  All dark colors are displayed as the original color. |
| Painting pattern (bar graph displays and level displays) | ![Painting pattern](image) |
| Selectable pattern colors (bar graph displays and level displays) | White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple |
| How attribute is displayed on GOT (bar graph displays and level displays) | With the A870GOT-EL:  
                                  All display colors other than black and gray are displayed in the same color (orange)  
                                  (gray is displayed as black).  
                                  With the A870GOT-STN:  
                                  All dark colors are displayed as the original color (gray is displayed as black).  
                                  With the A870GOT-TFT:  
                                  Data is displayed in the selected color.  
                                  With the A85□GOT-L:  
                                  All display colors other than black are displayed in the same color (black).  
                                  With the A85□GOT-STN:  
                                  All dark colors are displayed as the original color. |
| Blinking                      | Blinking interval: 500 ms (multiple settings per screen possible) |
Chapter 9

Devices That Can be Set with Sprites and Their Access Ranges
9. Devices That Can be Set with Sprites and Their Access Ranges

The devices which can be set using sprites, and the access ranges, are the same for the A870GOT and the A85□GOT.

9.1 Names of Devices That Can be Monitored

The devices that can be monitored using the GOT are listed below. There are some devices and device ranges that cannot be monitored with the GOT, depending on how the GOT is connected. For more detailed information on restricted items, please refer to the user's manual for the A870GOT/A850GOT.

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input (X)</td>
<td>X0 to X1FFF</td>
</tr>
<tr>
<td>Output (Y)</td>
<td>Y0 to Y1FFF</td>
</tr>
<tr>
<td>Internal relay (M)</td>
<td>M0 to M8191</td>
</tr>
<tr>
<td>Annunciator (F)</td>
<td>F0 to F2047</td>
</tr>
<tr>
<td>Link relay (B)</td>
<td>B0 to B1FFF</td>
</tr>
<tr>
<td>Special internal relay (M)</td>
<td>M9000 to M9255</td>
</tr>
<tr>
<td>Latch relay (L)</td>
<td>L0 to L32767</td>
</tr>
<tr>
<td>Timer</td>
<td>Contact point (TT) TT0 to TT2047</td>
</tr>
<tr>
<td></td>
<td>Coil (TC) TC0 to TC2047</td>
</tr>
<tr>
<td>Counter</td>
<td>Contact point (CT) CT0 to CT1023</td>
</tr>
<tr>
<td></td>
<td>Coil (CC) CC0 to CC1023</td>
</tr>
<tr>
<td>Word device bit</td>
<td>Specified bit of word device noted above (except for index register and buffer memories)</td>
</tr>
<tr>
<td>GOT bit register (GB)</td>
<td>GB64 to 1023</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0 to D8191</td>
</tr>
<tr>
<td>Special data register (D)</td>
<td>D9000 to D9255</td>
</tr>
<tr>
<td>Link register (W)</td>
<td>W0 to W1FFF</td>
</tr>
<tr>
<td>Timer (current value) (T)</td>
<td>T0 to T2047</td>
</tr>
<tr>
<td>Counter (current value) (C)</td>
<td>C0 to C1023</td>
</tr>
<tr>
<td>File register (R)</td>
<td>R0 to R8191</td>
</tr>
<tr>
<td>Expanded file register (ER) Device</td>
<td>Block 1 to 255</td>
</tr>
<tr>
<td>Index register *2 (Z)</td>
<td>Z0 to Z6 (Z0 = Z)</td>
</tr>
<tr>
<td></td>
<td>V0 to V6 (V0 = V)</td>
</tr>
<tr>
<td>Accumulator (A)</td>
<td>A0 to A1</td>
</tr>
<tr>
<td>Buffer memory (special function module) (BM)</td>
<td>BM0 to BMn (*1)</td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD04 to GD1023</td>
</tr>
</tbody>
</table>

*1. This can be specified only for the special function module of a station connected to the A870GOT. It should be specified as a value within the address range of the buffer memory existing in the applicable special function module.

*2. With the computer link connection, writing to index registers cannot be performed.
### With a MELSEC-QnACPU

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input (X)</td>
<td>X0 to X1FFF</td>
</tr>
<tr>
<td>Output (Y)</td>
<td>Y0 to Y1FFF</td>
</tr>
<tr>
<td>Internal relay (M)</td>
<td>M0 to M32767</td>
</tr>
<tr>
<td>Latch relay (L)</td>
<td>L0 to L8191</td>
</tr>
<tr>
<td>Annunciator (F)</td>
<td>F0 to F32767</td>
</tr>
<tr>
<td>Link relay (E)</td>
<td>D0 to D1FFF</td>
</tr>
<tr>
<td>Timer</td>
<td>Contact point (TT)</td>
</tr>
<tr>
<td></td>
<td>TC0 to TC32767</td>
</tr>
<tr>
<td>Counter</td>
<td>Contact point (CT)</td>
</tr>
<tr>
<td></td>
<td>CC0 to CC32767</td>
</tr>
<tr>
<td>Special relay (SM)</td>
<td>SM0 to SM2047</td>
</tr>
<tr>
<td>Word device bit</td>
<td>Specified bit of word device noted above (except for index register and buffer memories)</td>
</tr>
<tr>
<td>GOT bit register (GB)</td>
<td>GB64 to GB1023</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0 to D32767</td>
</tr>
<tr>
<td>Special register (D)</td>
<td>SD0 to SD2047</td>
</tr>
<tr>
<td>Link register (W)</td>
<td>W0 to W1FF</td>
</tr>
<tr>
<td>Timer (current value) (T)</td>
<td>T0 to T32767</td>
</tr>
<tr>
<td>Counter (current value) (C)</td>
<td>C0 to C32767</td>
</tr>
<tr>
<td>File register (R)</td>
<td>R0 to R32767 (*1)</td>
</tr>
<tr>
<td>Expanded file register (ER)</td>
<td>0 to 31</td>
</tr>
<tr>
<td>Expanded file register (ZR)</td>
<td>R0 to R32767</td>
</tr>
<tr>
<td>Index register (Z)</td>
<td>Z0 to Z15</td>
</tr>
<tr>
<td>Buffer memory (special function module) (BM)</td>
<td>BM0 to BMn (*3)</td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD64 to GD1023</td>
</tr>
</tbody>
</table>

*1. This applies to the file registers of blocks switched using the RSET instruction.

*2. This applies to the file registers of blocks switched using the QFRSET instruction.

*3. This can be specified only for the special function module of a station connected to the A870GOT. It should be specified as a value within the address range of the buffer memory existing in the applicable special function module.

### For the CC-Link connection (Remote device station)

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote input (RX)</td>
<td>X0 to X7FF</td>
</tr>
<tr>
<td>Remote output (RY)</td>
<td>Y0 to Y7FF</td>
</tr>
<tr>
<td>Remote register write area bit specification (RWW)</td>
<td>Ww0 to WwFF</td>
</tr>
<tr>
<td>Remote register read area bit specification (RWr)</td>
<td>Wr0 to WrFF</td>
</tr>
<tr>
<td>GOT bit register (GB)</td>
<td>GB64 to GB1023</td>
</tr>
<tr>
<td>GOT data register bit specification (GD)</td>
<td>GD64 to GD1023</td>
</tr>
<tr>
<td>Remote register write area (RWW)</td>
<td>Ww0 to WwFF</td>
</tr>
<tr>
<td>Remote register read area (RWr)</td>
<td>Wr0 to WrFF</td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD64 to GD1023</td>
</tr>
</tbody>
</table>
## 4 For the MELSEC-FXCPU

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
<th>Device no.</th>
<th>format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input relay (X)</td>
<td>X0000 to X0377</td>
<td></td>
<td>Octal</td>
</tr>
<tr>
<td>Output relay (Y)</td>
<td>Y0000 to Y0377</td>
<td></td>
<td>Octal</td>
</tr>
<tr>
<td>Auxiliary relay (M)</td>
<td>M0000 to M1535</td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>State (S)</td>
<td>S0000 to S0999</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special auxiliary relay (M)</td>
<td>M8000 to M8255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timer contact point (T)</td>
<td>T0000 to T255</td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Counter contact point (C)</td>
<td>C000 to C255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word device bit (*1)</td>
<td>—</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GOT bit register (GB)</td>
<td>GB64 to GB1023</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timer (current value) (T)</td>
<td>T000 to T255</td>
<td></td>
<td>Decimal</td>
</tr>
<tr>
<td>Counter (current value) (C)</td>
<td>C000 to C255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0000 to D0999</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAM file register (C)</td>
<td>D6000 to D7999</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special data register (D)</td>
<td>D8000 to D8255</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD64 to GD1023</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1. If running the touch key function in which a word device bit is specified as the monitor device, do not write the word device in the sequence program.

## 5 For the OMRON PLC

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O relay</td>
<td>..0000 to 51115</td>
</tr>
<tr>
<td>Internal auxiliary relay</td>
<td>LR0000 to LR6315</td>
</tr>
<tr>
<td>Data link relay (LR)</td>
<td>AR0000 to AR2715</td>
</tr>
<tr>
<td>Auxiliary memory relay (AR)</td>
<td>H0000 to H9995</td>
</tr>
<tr>
<td>Timer (contact point) (TIM)</td>
<td>TIM000 to TIM511</td>
</tr>
<tr>
<td>Counter (contact point) (CNT)</td>
<td>CNT000 to CNT511</td>
</tr>
<tr>
<td>Data memory (DM) (*2)</td>
<td>DM0000 to DM9999</td>
</tr>
<tr>
<td>Timer (current value) (TIM)</td>
<td>TIM000 to TIM511</td>
</tr>
<tr>
<td>Counter (current value) (CNT)</td>
<td>CNT000 to CNT511</td>
</tr>
<tr>
<td>GOT bit register</td>
<td>GB64 to GB1023</td>
</tr>
<tr>
<td>I/O relay</td>
<td>..0000 to 511</td>
</tr>
<tr>
<td>Data link relay (LR)</td>
<td>LR0000 to LR0063</td>
</tr>
<tr>
<td>Auxiliary memory relay (AR)</td>
<td>AR0000 to AR0027</td>
</tr>
<tr>
<td>Storage relay (HR)</td>
<td>HR0000 to HR0099</td>
</tr>
<tr>
<td>Data memory (DM)</td>
<td>DM0000 to DM9999</td>
</tr>
<tr>
<td>Timer (current value) (TIM)</td>
<td>TIM000 to TIM511</td>
</tr>
<tr>
<td>Counter (current value) (CNT)</td>
<td>CNT000 to CNT511</td>
</tr>
<tr>
<td>GOT data register</td>
<td>GD64 to GD1023</td>
</tr>
</tbody>
</table>

*1. It cannot be written if the CV1000 is used.

*2. When the touch switch function that has set the bit for a word device as the monitor device is being executed, do not write to the word device from sequence programs.
### For the Yasukawa Electric-made PC

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
<th>Device no. format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit devices</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coil</td>
<td>.01 to 63424</td>
<td></td>
</tr>
<tr>
<td>Input relay</td>
<td>11 to 163424</td>
<td></td>
</tr>
<tr>
<td>Link coil</td>
<td>D1 to 2048</td>
<td></td>
</tr>
<tr>
<td>Link coil</td>
<td>D10001 to D12048</td>
<td>BCD *4</td>
</tr>
<tr>
<td>Link coil</td>
<td>D20001 to D22048</td>
<td></td>
</tr>
<tr>
<td>GOT bit register</td>
<td>GB64 to GB1023</td>
<td></td>
</tr>
<tr>
<td>Word devices</td>
<td></td>
<td>16 bit.</td>
</tr>
<tr>
<td>Input register</td>
<td>Z1 to Z31840 *1</td>
<td>Select unsigned</td>
</tr>
<tr>
<td>Storage register</td>
<td>W1 to W28291 *2</td>
<td></td>
</tr>
<tr>
<td>Link register</td>
<td>R1 to R2048</td>
<td></td>
</tr>
<tr>
<td>Link register</td>
<td>D10001 to D12048</td>
<td></td>
</tr>
<tr>
<td>Link register</td>
<td>D20001 to D22048</td>
<td></td>
</tr>
<tr>
<td>Constant register</td>
<td>K1 to K4096 *3</td>
<td></td>
</tr>
<tr>
<td>GOT data register</td>
<td>GD64 to GD1023</td>
<td></td>
</tr>
</tbody>
</table>

*1. Change input register 30001 to 30512 to Z1 to Z512 for setting. (Setting is default example)
*2. Change retention register 40001 to 49999 to W1 to W9999 for setting. (Setting is default example)
*3. Change constant register 31001 to 35096 to K1 to K4096 for setting. (Setting is default example)
*4. Only the BCD code can be monitored with GL120 and GL130.

### For the Allen-Bradley-made PC

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
<th>Device no. format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit devices</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit (B)</td>
<td>B0030000 to B003255F</td>
<td></td>
</tr>
<tr>
<td>Timer (timing bit) (TT)</td>
<td>TT0040000 to TT0042550</td>
<td></td>
</tr>
<tr>
<td>Timer (timing bit) (TN)</td>
<td>TN0040000 to TN0042550</td>
<td></td>
</tr>
<tr>
<td>Counter (upcounter) (CU)</td>
<td>CU0050000 to CU0052550</td>
<td></td>
</tr>
<tr>
<td>Counter (downcounter) (CD)</td>
<td>CD0050000 to CD0052550</td>
<td></td>
</tr>
<tr>
<td>Counter (complete bit) (CN)</td>
<td>CD0100000 to CD0102550</td>
<td></td>
</tr>
<tr>
<td>GOT internal bit register (GB)</td>
<td>GB64 to GB1023</td>
<td></td>
</tr>
<tr>
<td>Word device bit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bit (B)</td>
<td>B003000 to B003255</td>
<td></td>
</tr>
<tr>
<td>Timer (set value) (TP)</td>
<td>TP0040000 to TP004255</td>
<td>*1</td>
</tr>
<tr>
<td>Timer (current value) (TA)</td>
<td>TA004000 to TA255255</td>
<td>*1</td>
</tr>
<tr>
<td>Counter (set value) (CP)</td>
<td>CP004000 to CP255255</td>
<td>*1</td>
</tr>
<tr>
<td>Counter (current value) (CA)</td>
<td>CA005000 to CA255255</td>
<td>*1</td>
</tr>
<tr>
<td>Integer (N)</td>
<td>N007000 to N007255</td>
<td></td>
</tr>
<tr>
<td>GOT internal data register (GD)</td>
<td>GD64 to GD1023</td>
<td></td>
</tr>
</tbody>
</table>

*1. Device write cannot be executed to 32-bit data.
Since devices of Allen-Bradley-made PC consist of files and elements, specify the device number using the graphics software as shown below:

1. Bit device

   Graphic software setting method: B
   003 064 F
   Bit No. (Hexadecimal)
   Element
   File No.

2. Word device

   Graphic software setting method: N007 015
   Element
   File No.
### For the microcomputer connection

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Got bit register (GB)</td>
<td>GB64 to GB1023 *1</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0 to D2047</td>
</tr>
<tr>
<td>Word device bit</td>
<td></td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0 to D2047</td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD64 to GD1023 *1</td>
</tr>
</tbody>
</table>

*1. Write and read operations from the host cannot be performed to devices GB and GD.
9.2 Monitoring Special Function Modules

With special function modules, monitoring is possible only with the stations noted below.

1. With bus connections, CPU direct connections, and calculator link connections
   Special function modules on the base of the connected station

2. With MELSECNET (II) connections and MELSECNET/B connections
   Special function modules on the base of the master station

3. With MELSECNET/10 connections
   Special function modules on the base of the control station

4. With CC-Link connections (intelligent device stations)
   Special function modules on the base of the master/local station
9.3 Access Ranges for Data Link Systems that can be Monitored when Using the MELSEC-ACPU and QnACPU

1. With bus connections, CPU direct connections, and calculator link connections

(a) When the connected station is the master station
   - Local stations can be monitored.
     If the PC CPU of the local station is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.

(b) When the connected station is a local station
   - The master station can be monitored.
     If the PC CPU of the master station is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
   - Other local stations cannot be monitored.

(c) If the connected station is a tri-layer master station
   - Dual-layer master stations and tri-layer local stations can be monitored.
     If the PC CPU of the station being monitored is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
   - Dual-layer local stations cannot be monitored.

2. With MELSECNET (II) connections and MELSECNET/B connections

- The GOT acts as a local station, and only the master station can be monitored. If the PC CPU of the master station is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
- Local stations cannot be monitored.
  When settings are entered for the monitor device, the settings for the NW number and station number should be entered as shown below.
  When monitoring the B and W devices assigned with the link parameter:
    Set NW number to 0 and local station to host station
  When monitoring any device other than the B and W devices assigned with the link parameter:
    Set NW number to 0 and station number to other station (station number: 0)

POINT
To monitor B and W, which are assigned by the link parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.
3. When monitoring devices of other stations

When monitoring devices of other stations on the data link system, the display speed slows considerably. Monitoring should be limited to the link relay (R) and link register (W) assigned with the link parameter.

4. Setting the monitor device

The following illustration shows an example of how the NW number and station numbers are set when setting a monitor device.

```
M
L1
L2
L3

GOT

1) When monitoring a connected station (host station) and the B and W devices assigned with the link parameter

Set NW number to 0 and local station to host station

POINT

To monitor B and W, which are assigned by the link parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.

2) When monitoring devices of another station

Set NW number to 0 and local station to (see table below).
```

<table>
<thead>
<tr>
<th>Station connected to GOT</th>
<th>Station being accessed</th>
<th>M</th>
<th>L1</th>
<th>L2</th>
<th>L3</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>M</td>
<td>Host station</td>
<td>Other station 1</td>
<td>Other station 2</td>
<td>Other station 3</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L1</td>
<td>Other station 0</td>
<td>Host station</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>L2 m</td>
<td>Other station 0</td>
<td>—</td>
<td>—</td>
<td>Host station</td>
<td>—</td>
<td>Other station 1</td>
<td>Other station 2</td>
<td>—</td>
</tr>
<tr>
<td>L3</td>
<td>Other station 0</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Host station</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Q1</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Other station 0</td>
<td>—</td>
<td>Host station</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Q2</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Other station 0</td>
<td>—</td>
<td>—</td>
<td>Host station</td>
<td>—</td>
</tr>
<tr>
<td>Q3 (GOT)</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Other station 0</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>
9. Access Ranges for Network Systems that can be Monitored when Using the MELSEC-ACPU and QnA CPU

For a bus connection (when the A7GT-BUS Version B, the A7GT-BUS2 Version A or each later version is being used)

1) When the connected station is a QnACPU or AnUCPU

- The control station and all ordinary stations on the network can be monitored.
- The control station and all ordinary stations on another network can be monitored. (When monitoring another network, always set the routine parameters.)
- If the connected station is an intermediate station and is mixed with a data link system, the master station and local stations can be monitored.
- If the connected station is an intermediate station, the data link parameters for the "Unit No. Effective When Accessing Other Stations" (other than the B and W devices assigned with the network parameter) do not need to be set in the PC CPU of the connected station. (If set, the settings will be ignored.)
- When the devices of another station (other than the B and W devices assigned with the network parameter) are being monitored, there may be times when monitoring cannot be done, depending on the PC CPU of the station being monitored.

See (7), (Example 1) to (Example 4).

2) When the connected station is an AnA, or AnNCPU

- The control station on the network can be monitored.

If the PC CPU of the control station is a QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the network parameter.

- Ordinary stations on the network cannot be monitored.
- Other networks cannot be monitored.

For a bus connection (when the A7GT-BUS Version A is being used)

When using the A8S1□GOT, the A7GT-BUS Version A cannot be used.

When using the A870GOT and the connected station is a QnACPU, the A7GT-BUS Version A cannot be used.

1) When the connected station is an AnUCPU

- The control station and all ordinary stations on the network can be monitored. When the devices of another station (other than the B and W devices assigned with the network parameter) are being monitored, however, monitoring cannot be done if the PC CPU of the station being monitored is a QnACPU.

- If the connected station is an intermediate station, the unit number to which the network number being monitored is connected should be set using the data link parameter called "Unit No. Effective When Accessing Other Stations".
2) When the connected station is an AnA or AnNCPU
   - The control station on the network can be monitored.
   - If the PC CPU of the control station is a QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the network parameter.
   - Ordinary stations on the network cannot be monitored.
   - Other networks cannot be monitored.

3) For CPU direct connections or calculator link connections
   1) When the connected station is a QnACPU
      - The access range described in (1) 1 applies.
   2) When the connected station is an AnUCPU
      - The access range described in (2) 1 applies.
   3) When the connected station is an AnA or AnNCPU
      - The access range described in (2) 2 applies.

4) For MELSECNET/10 connections
   - The GOT acts as an ordinary station, and the control station and all ordinary stations on the network can be monitored.
   - If the PC CPU being monitored is the QnACPU, however, monitoring can be done within the AnA device range. (As a restriction, the access range of timer (T) and counter (C) for monitoring is limited from 0 to 255. The file registers (R, ER, ZR) cannot be monitored.)
   - Other networks cannot be monitored.
   - When monitoring devices of other stations (other than the B and W devices assigned with the network parameter), there may be times when monitoring cannot be done, depending on the PC CPU of the station being monitored.

See (Example 6).

5) Monitoring devices of other stations on the network
   When monitoring devices of other stations on the network system, the display speed slows considerably. Monitoring should be limited to the link relay (B) and link register (W) assigned with the link parameter.

6) Monitoring devices of other networks
   - When monitoring another network, always set the routine parameters in the PC CPU.
   - Monitoring another network causes the display speed to drop considerably.
Monitoring access ranges for other stations, and monitor device settings

(Example 1) For bus connections (A7GT-BUS Version B, A7GT-BUS 2 Version A or all subsequent versions)

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>QnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>O Host station</td>
<td>X</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>O</td>
<td>Host station</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td>AnU (1-4)</td>
<td>O</td>
<td>Host station</td>
</tr>
<tr>
<td>(2-2)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>QnA (2-1)</td>
<td>O</td>
<td>Host station</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>O</td>
<td>X</td>
</tr>
</tbody>
</table>

O : Can be accessed
X : Can’t be accessed
• Setting NW numbers and station numbers when setting monitor devices

(1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

POINT

To monitor B and W, which are assigned by the network parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.

(2) When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>AnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>0, host station</td>
<td>1, other station (3)</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>1, other station (1)</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>0, other station (6)</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnU (1-4)</td>
<td>1, other station (1)</td>
<td>0, host station</td>
</tr>
<tr>
<td>(2-2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>QnA (2-1)</td>
<td>1, other station (1)</td>
<td>1, other station (2)</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>1, other station (1)</td>
<td></td>
</tr>
</tbody>
</table>

How to read the table: $\uparrow$, other station (2) $\downarrow$, NW no. setting, Station no. setting
(Example 2) For bus connections (A7GT-BUS Version B, A7GT-BUS 2 Version A or all subsequent versions)

![Diagram](image)

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>AnA (1-3)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>O Host station</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>X</td>
<td>O Host station</td>
<td>X</td>
</tr>
<tr>
<td>QnA (1-3)</td>
<td>O</td>
<td>X</td>
<td>O Host station</td>
</tr>
<tr>
<td>QnA (2-2) (M)</td>
<td>O</td>
<td>X</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

- O: Can be accessed
- △: Can be accessed within AnA range
  (for T/C, the range is 0 to 256, for R/ER/ZR, monitoring is possible)
- X: Can't be accessed

9 - 14
• Setting NW numbers and station numbers when setting monitor devices

  (1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

  Set the NW number to 0 and the station number to the host station.

  **POINT**

  To monitor B and W, which are assigned by the network parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.

(2) When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station being accessed to GOT</th>
<th>Network No. 1</th>
<th></th>
<th>Network No. 2</th>
<th></th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>QnA (1-3)</td>
<td>AnU (2-1)</td>
<td>QnA (2-2)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>0, host station</td>
<td>1, other station (2)</td>
<td>2, other station (2)</td>
<td>2, other station (2)</td>
<td>2, other station (2)</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>-</td>
<td>0, host station</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>QnA (1-3)</td>
<td>1, other station (2)</td>
<td>-</td>
<td>0, host station</td>
<td>2, other station (3)</td>
<td>2, other station (3)</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>0, host station</td>
<td>-</td>
</tr>
<tr>
<td>QnA (2-2)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

*1 When monitoring a data link system, set the NW No. to 0.

How to read the table:  

\[ \begin{array}{c}
\text{NW no. setting} \\
\text{Station no. setting}
\end{array} \]

\[
\begin{array}{c@{\quad}c}
2 & \text{other station (2)}
\end{array}
\]
(Example 3) For bus connections (when using a QnACPU with A7GT-BUS Version B, A7GT-BUS 2 Version A or each later version, or when using an AnUAnA or AnNCPU with A7GT-BUS Version A)

*1. The data link parameter called "Unit No. Effective When Accessing Other Station" should be set to the unit number connected to Network No. 1.

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station connected to GOT</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>QnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>O Host station</td>
<td>X</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>O</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnU (1-2)</td>
<td>O Host station</td>
<td>X</td>
</tr>
<tr>
<td>QnA (2-1)</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

O : Can be accessed
X : Can't be accessed
• Setting NW numbers and station numbers when setting monitor devices

(1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

**POINT**

To monitor B and W, which are assigned by the network parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.

(2) When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station connected to GOT</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>CnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>0, host station</td>
<td>-</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>0, other station [3]</td>
<td>-</td>
</tr>
<tr>
<td>AnU (1-4)</td>
<td>0, other station [1]</td>
<td>-</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

How to read the table: 2 \( \uparrow \), other station (2) \( \uparrow \)
NW no. setting  Station no. setting
(Example 4) For bus connections (when using a QnACPU with A7GT-BUS Version B, A7GT-BUS2 Version A or each later version, or when using an AnUAnA or AnNCPU with A7GT-BUS Version A)

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station connected to GOT</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>AnA (1-3)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnU (1-2)</td>
<td>X</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>(1-3) QnA (2-2) (M)</td>
<td>O</td>
<td>X</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

O: Can be accessed  
△: Can be accessed within AnA range  
(for T/C, the range is 0 to 255, for R/ER/ZR, monitoring is impossible)  
X: Can't be accessed
• Setting NW numbers and station numbers when setting monitor devices

(1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

**POINT**

To monitor B and W, which are assigned by the network parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.

(2) When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station connected to GOT</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>QnA (1-3)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>0, host station</td>
<td>1, other station</td>
<td>1, other station</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>-</td>
<td>0, host station</td>
<td>-</td>
</tr>
<tr>
<td>QnA (2-2) (M) (1-9)</td>
<td>1, other station</td>
<td>-</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>-</td>
<td>-</td>
<td>0, host station</td>
</tr>
<tr>
<td>Gabcot (2-3)</td>
<td>-</td>
<td>-</td>
<td>0, other station</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>-</td>
<td>-</td>
<td>2, other station</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

*1 When monitoring a data link system, set the NW No. to 0.

How to read the table:

2, other station (2)

NW no. setting  Station no. setting

9 - 19
(Example 5) For CPU direct connection and calculator link connection

- The monitoring access range for devices of other stations (other than B and W) and other networks is the same as that listed in Example 3 and Example 4.

- Setting the NW number and station number for monitor devices

  The settings for the NW number and station number for monitor devices are the same as those listed in Example 3 and Example 4.

(Example 4) For MELSENET/10 connections

- Monitoring access ranges for devices of other stations (other than B and W)

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>QnA (1-1)</th>
<th>QnA (1-2)</th>
<th>GOT (1-3)</th>
<th>AnU (1-4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOT (1-3)</td>
<td>△</td>
<td>△</td>
<td>-</td>
<td>O</td>
</tr>
</tbody>
</table>

  - O: Can be accessed
  - △: Can be accessed within AnA range (for T/C, the range is 0 to 255, for R/ER/ZR, monitoring is impossible)
  - X: Can't be accessed

- Setting NW numbers and station numbers when setting monitor devices

  (1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

  Set the NW number to 0 and the station number to the host station.

**POINT**

To monitor B and W, which are assigned by the network parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.

(2) When monitoring another station (other than B and W)

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>QnA (1-1)</th>
<th>QnA (1-2)</th>
<th>GOT (1-3)</th>
<th>AnU (1-4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOT (1-3)</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

  0, other station (1) 0, other station (2) - 0, other station (4)

  How to read the table: ▲, ▲, other station (2)

  NW no. setting Station no. setting
9.5 Access Ranges for CC-Link Systems that can be Monitored when Using the MELSEC-ACPU and QnA CPU

1. With bus connection, CPU direct connection or computer link connection

Only the connected stations can be monitored.

2. With CC-Link connection (remote device stations)

(a) Access range

The RX, RY, RWw and RWr, to which the GOT is assigned at the master station using the CC-Link parameters, and the GOT internal device can be monitored. The other RX, RY, RWw and RWr assigned to the master station cannot be monitored.

(b) NW number and station number settings

Be sure to set NW number to "0" and the station number to "local station."

(c) Device name and device number settings

Set the device names as listed below.

For the device numbers of RX, RY, RWw and RWr, set the addresses assigned by the station number setting.

<table>
<thead>
<tr>
<th>Device to monitor</th>
<th>Device name to be set by the drawing software</th>
<th>Setting device range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote input</td>
<td>RX</td>
<td>X0 to X7FF</td>
</tr>
<tr>
<td>Remote output</td>
<td>RY</td>
<td>Y0 to Y7FF</td>
</tr>
<tr>
<td>Remote register (write area)</td>
<td>RWw</td>
<td>Ww0 to WwFF</td>
</tr>
<tr>
<td>Remote register (read area)</td>
<td>RWr</td>
<td>Wr0 to WrFF</td>
</tr>
<tr>
<td>GOT internal bit device</td>
<td>GB</td>
<td>GB0 to GB1023</td>
</tr>
<tr>
<td>GOT internal word device</td>
<td>GD</td>
<td>GD0 to GD1023</td>
</tr>
</tbody>
</table>

3. With CC-Link connection (intelligent device stations)

(a) Access range

The master station and local station can be monitored.

Also, all RX, RY, RWw and RWr that are assigned to the master station using the CC-Link parameters can be monitored.

(b) NW number and station number settings

**POINT**

To monitor the RX, RY, RWw and RWr that are assigned by the CC-Link parameters, set them in the local station even if they are assigned to other stations. Otherwise, it may cause the display speed to decrease.
① When monitoring the RX, RY, RWw and RWr that are assigned to the master station using the CC-Link parameters

Set NW number to "0" and the PC station number to "local station."

② When monitoring the PC CPU device of other stations

Set NW number to "0" and the PC station number to "other station (station number: n)."

(n : other station numbers that are suggested monitoring (Q : master station, 1 to 64 : local station))

(c) Device name and device number settings

① When monitoring the RX, RY, RWw and RWr that are assigned to the master station using the CC-Link parameters

Set the device names as listed below.

<table>
<thead>
<tr>
<th>Device to monitor</th>
<th>Device name to be set by the drawing software</th>
<th>Setting device range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote input</td>
<td>RX</td>
<td>X</td>
</tr>
<tr>
<td>Remote output</td>
<td>RY</td>
<td>Y</td>
</tr>
<tr>
<td>Remote register (write area)</td>
<td>RWw</td>
<td>Ww</td>
</tr>
<tr>
<td>Remote register (read area)</td>
<td>RWr</td>
<td>Wr</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X0 to X7FF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Y0 to Y7FF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ww0 to WwFF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wr0 to WrFF</td>
</tr>
</tbody>
</table>

For the device numbers of RX, RY, RWw and RWr, set the addresses assigned by the station number setting.

② When monitoring the PC CPU device of other stations

Section 9.1, "Device names that can be monitored"

9.6 Monitor Access Range during Connection with MELSEC-FXCPU and PCs of Other Manufacturers

The monitor access range is limited to the connection destination CPU. It cannot monitor other stations.
Chapter 10

Common Operations Used in Setting Sprites
10. Common Operations Used in Setting Sprites

10.1 Setting Devices for Monitoring

This section describes the device settings used for monitor device and common screen data. Clicking on the “Device” parameter in any of the dialog boxes displays the Device dialog box.

When the PC type is set to MELSEC-ACPU or QnACPU

![Device dialog box for MELSEC-ACPU or QnACPU](image)

When the PC type is set to MELSEC-FXCPU, PCs of other manufacturers (OMRON, Yasukawa), microcomputer connection

![Device dialog box for MELSEC-FXCPU](image)

When the PC type is set to AB PC

![Device dialog box for AB PC](image)

Set the bit number in this spin box when setting a bit device.
"type" Select the data type for the device being specified, using the list box. The options available for selection in the list box vary depending on the sprite being set.

"Device" Select the name of the device being monitored from the list box. The device names available for selection vary depending on the sprite being set.

"Device No." • Set the number of the device being monitored, using the spin box.
• If "BM" (buffer memory) is selected as the device name, specify the address of the buffer memory being monitored, using the spin box.

"Bit position" When a specified bit of a word device is being monitored, specify the bit number being monitored with the spin box.

"Block" When "ER" (expansion file register) is selected as the device name, specify the block number with the spin box.

"Unit top I/O" If "BM" (buffer memory) is selected as the device name, specify the top I/O number, using the spin box.
If the first I/O number specified has not actually been installed, please be aware that the sprite function will be displayed with incorrect data.

"NW No." See Section 9.3, Access Ranges for Data Link Systems That Can be Monitored When Using the MELSEC-ACPU and QnACPU.

"Station No." See Section 9.4, Access Ranges for Network Systems That Can be Monitored When Using the MELSEC-ACPU and QnACPU.
• If monitoring is being carried out on the PC CPU connected to the system, regardless of the connected system, the NW number should be set to 0 and the station number to the host station for the B and W devices assigned with the link parameter or network parameter.

10.1.1 Ranges for Device Names and Device Numbers to be Set
The graphics software program does not check to see if the specified device name and device number are usable by the PC CPU that has been connected or is being monitored.

Please refer to the user's manual for the PC CPU that has been connected or is being monitored, and specify a device name and device number that can be used by the PC CPU.
10.2 Setting Data Expressions (Other Than Numeric Input Function)

10.2.1 Items to Know before Setting Data Expressions

(1) What are data expressions?

With this function, the values set for the various monitor devices by the sprites are read out from the PC CPU based on the display conditions, and those values undergo data calculation using specified equations. Monitoring of sprites is then carried out based on the processed values.

(2) Types of sprites for which data expressions can be set

- Numeric display function
- Parts display (word) function
- Lamp display (word) function
- Trend graph display function
- Level display function
- Comment display (word) function
- Parts movement display function
- Panel meter display function
- Bar graph display function

* Operations based on equations cannot be carried out with graph displays.

10.2.2 Types of Expression Procedures That Can be Set

The following three types of expression procedures can be specified:

- Mask expression
- Shift expression
- Expression based on equations

Expression sequence

Monitor device value → Mask expression → Shift expression → Expression based on equation → Displayed on GOT

indicates that no data expression has been specified.
(1) What is a mask expression?

In this operation, a logical AND, logical OR, or an exclusive OR (XOR) is carried out on the mask value which specifies the monitor device value.

- Logical AND expression

  This returns a value of "1" only if both bit numbers are "1", and otherwise returns a value of "0".

  (Example)

  Monitor device value: \[ \begin{array}{cccccccc}
  1 & 0 & 1 & 0 & 1 & 0 & 1 & 0 \\
  \end{array} \]  

  Specified mask value (set as hexadecimal value): \[ \begin{array}{cccc}
  0 & 0 & 0 & 1 \\
  \end{array} \]  

  Expression result: \[ \begin{array}{cccc}
  0 & 0 & 0 & 0 \\
  \end{array} \]  

- Logical OR expression

  This returns a value of "0" if either bit number is "0", and otherwise returns a value of "0".

  (Example)

  Monitor device value: \[ \begin{array}{cccccccc}
  1 & 1 & 0 & 0 & 1 & 1 & 1 & 1 \\
  \end{array} \]  

  Specified mask value (set as hexadecimal value): \[ \begin{array}{cccc}
  0 & 0 & 0 & 1 \\
  \end{array} \]  

  Expression result: \[ \begin{array}{cccc}
  0 & 1 & 1 & 1 \\
  \end{array} \]  

- Exclusive OR expression (XOR)

  This returns a value of "0" if both values are the same, and otherwise returns a value of "1".

  (Example)

  Monitor device value: \[ \begin{array}{cccccccc}
  1 & 0 & 1 & 0 & 1 & 0 & 1 & 0 \\
  \end{array} \]  

  Specified mask value (set as hexadecimal value): \[ \begin{array}{cccc}
  0 & 0 & 0 & 1 \\
  \end{array} \]  

  Expression result: \[ \begin{array}{cccc}
  0 & 1 & 0 & 1 \\
  \end{array} \]  

(2) What is a shift expression?

This expression shifts the monitor device value in the specified direction (left or right) by the specified number of bits.

(Example 1)

Monitor device value: \[ \begin{array}{cccccccc}
  1 & 1 & 1 & 0 & 0 & 0 & 0 & 0 \\
  \end{array} \]  

Expression result: \[ \begin{array}{cccc}
  0 & 0 & 0 & 1 \\
  \end{array} \]  

Shifted 4 bits to the right

(Example 2)

Monitor device value: \[ \begin{array}{cccccccc}
  0 & 0 & 0 & 1 & 0 & 1 & 1 & 1 \\
  \end{array} \]  

Expression result: \[ \begin{array}{cccc}
  1 & 1 & 0 & 1 \\
  \end{array} \]  

Shifted 4 bits to the left
(3) What are expressions based on equations?

With this function, a monitor device value is added, subtracted, multiplied or divided using a specified equation, and the resulting value is used to display the sprite function.

There are eight types of formats which can be used with equations.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Types of calculation possible</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A \cdot B</td>
<td>When adding</td>
<td>100%3 = 1 (100 / 3 = 33, with a remainder of 1)</td>
</tr>
<tr>
<td>A \cdot (B \cdot C)</td>
<td>When multiplying</td>
<td>50 % 8 = 2 (50 / 8 = 6, with a remainder of 2)</td>
</tr>
<tr>
<td>(A \cdot B) \cdot C</td>
<td>When calculating a percentage</td>
<td></td>
</tr>
<tr>
<td>A \cdot ((B \cdot C) \cdot D)</td>
<td>When subtracting</td>
<td></td>
</tr>
<tr>
<td>A \cdot (B \cdot (C \cdot D))</td>
<td>When dividing</td>
<td></td>
</tr>
<tr>
<td>((A \cdot B) \cdot (C \cdot D)) \cdot E</td>
<td>What is a percentage expression? The left side is divided by the right side, and the remainder is returned as the result.</td>
<td></td>
</tr>
</tbody>
</table>

Items that can be specified for A to E:

Numeric value ........ Numeric values of up to 32 digits including minus signs and decimal points may be specified (in decimal format).

$$ .................. $$ This is specified if the value of the monitor device is specified from among A to E.

This should always be set for at least one position from among A to E. The $$ character may not be set at two locations.

Device ................ This is specified if the current value of the specified device is specified from among A to E.

The only devices which can be specified are those connected to the GOT. If a MELSECONET connection is being used, only the W assigned using the link parameter or network parameter may be used.

The data type for devices which can be specified will be the data type for the monitor device.

Up to two types of devices may be specified from among A to E.
10.2.3 Setting Data Expressions (Other Than Numeric Input Function)

**Data Expression Procedure**

```
+-----------------+-----------------+-----------------+-----------------+
| Basic           | Display Format  | Data Expression | Trigger         |
+-----------------+-----------------+-----------------+-----------------+
| Mask            | Shift           | Mask            |                  |
| ○ None          | ○ None          | ○ AND           | ○ Left Right    |
| ○ AND           | ○ Left Right    | OR              |                  |
| Pattern:        | No. of shift:   | (HEX)           |                 |
|                 | Edit            |                 |                 |
|                 | OK              |                 |                 |
|                 | Cancel          |                 |                 |
|                 | Previous        |                 |                 |
|                 | Next            |                 |                 |
```

"Mask"  
When a mask expression is carried out, the type of mask expression is selected using the radio button.
None .......... Select this when no mask expression is to be carried out.
AND .......... Select this for a logical AND.
OR .......... Select this for a logical OR.
XOR .......... Select this for an exclusive OR.

"Pattern"  
Specify the mask value to be expressed using the spin box. This setting is entered as a hexadecimal value.

"Shift"  
When a shift expression is carried out, select the shift direction using the radio buttons.
None .......... Select this when no shift expression is to be carried out.
Left .......... Select this to shift to the left.
Right .......... Select this to shift to the right.

"No. of shift"  
Specify the number of shifts, using the spin box.
"Expression" If the operation is to be carried out based on an equation, click on "Edit", and specify the equation in the "Input Expression" dialog box.

"Expression style" Select the format of the expression from the list box.

"Expression"

"+" After specifying the expression style, click on the box for each item and specify numeric values for "Numerical term" and "Variable term", and the monitor device ($$) for the "Device" parameter.

"+" Select the operands for the left and right sides from the list box.

- Select for subtraction.
- Select for multiplication.
- Select for division.
- Select for a percentage expression.

"Numerical term" When setting the numeric values for the various items, click on the display position of the numeric value and then on [Enter]. Clicking on [Enter] inputs the numeric value. Numeric values are input as decimal values, and up to 32 digits can be input. To clear a numeric value, click on [C].

"Variable term" To specify the "Device" parameter for each item, click on $$ . (This can only be set at one location.)

To set the current value of a device set for one of the various items, click on [Device] to display the "Set Device" dialog box. Specify the word device in this dialog box. (Up to two devices may be specified.)

The only devices which can be specified are those connected to the GOT.

See Section 10.1, Setting Devices for Monitoring.

If a MELSENET connection is being used, only the W assigned using the link parameter or network parameter may be used.

The data type for devices which can be specified will be the data type for the monitor device.

10 - 7
10.3 Setting Data Expressions (Numeric Input Function)

10.3.1 Types of Expression Procedures That Can be Set with the Numeric Input Function

- Mask expressions
- Shift expressions
- Writing word expressions (expression based on equation)

Expression sequence

- Monitor word expressions (expression based on equation)

(1) What is a mask expression?
This carries out a logical AND, a logical OR, or an exclusive OR (XOR) on an input value and the specified mask value. After the result is written to the destination device, a mask operation is carried out on the written value and the mask value, and the result is displayed as a numeric value.

See Section 10.2.2, Types of Expression Procedure That Can be Set (1).

(2) What is a shift expression?
This carries out a shift of the input value in the specified direction (right/left) by the specified number of bits. After the result is written to the destination device, the written value is shifted in the specified direction by the specified number of bits, and the result is displayed as a numeric value.

See Section 10.2.2, Types of Expression Procedure That Can be Set (2).

(3) What is a writing word expression?
The format of the equation is specified, and an equation is created that includes the input value ($W$). The processed value is then written to the destination device.

See Section 10.2.2, Types of Expression Procedure That Can be Set (3).

POINT
Avoid specifying an equation that causes the expression result to exceed the allowable range for the specified data type (16-bit or 32-bit).

(4) What is a monitor word expression?
The format of the equation is specified, and an equation is created that includes the written value ($W$). The processed value is then written to the destination device.

See Section 10.2.2, Types of Expression Procedure That Can be Set (3).
(5) What is the reverse shift operation?

This is a shift operation in opposite direction from the write shift operation.

For instance, if a shift operation shifts two bits to the right, reverse shift operation shifts two bits to the left.

(6) Restrictions on data operations with the numeric input function

When a numeric value containing a decimal point is converted to an integer through a write word operation (when real numbers are being set) and is stored in the PC CPU, there may be times when the value stored in the PC CPU is different from the actual value, based on the input value.

<Example>

No. of decimal places: 2
Write word equation: $W \times 100$

Input value: 9.95

Write word operation: $W \times 100$

Internal GOT processing:
9.9499999 ---
(Handled as a real number with a floating decimal point)
\[
\downarrow
\]
9.9499999 --- \times 100 = 994.9999...
(6 decimal places are discarded)
\[
\downarrow
\]
Value written to PC CPU: 994

- With the GOT, when real-number data with a floating decimal point is converted to an integer by means of a write word operation, the digits to the right of the decimal point will be discarded when the value is stored in the CPU, as in the above example.

- Specify a write word operation like the following:
$(W + 0.001) \times 100$
If the input value is a negative value (carried to two decimal places):
$(W - 0.001) \times 100$

When carried to three decimal places:
$(W + 0.0001) \times 1000$

- When both positive and negative values are entered, the write word operation varies, as shown above. The numeric input function should be specified independently for positive value input and negative value input. (This is because there is only one type of write word operation equation for one numeric input function.)

POINT

When the SW3NIW-A8SYS version B or later is used, there is no need to restrict. And, previous data (with restriction) can be used as it is.
10.3.2 Setting Data Expressions (Numeric Input Function)

**Data Expression Procedure**

**Numerical Input**

<table>
<thead>
<tr>
<th>Mask</th>
<th>Display Format</th>
<th>Data Expression</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ø/None</td>
<td>Ø/AND</td>
<td>Ø/Pattern: (HEX)</td>
<td>Shift Ø/None</td>
</tr>
</tbody>
</table>

**Mask**
When a mask expression is carried out, the type of mask expression is selected using the radio button.

None .......... Select this when no mask expression is to be carried out.

AND .......... Select this for a logical AND.

**Pattern**
Specify the mask value to be expressed using the spin box. This setting is entered as a hexadecimal value.

**Shift**
When a shift expression is carried out, select the shift direction using the radio buttons.

None .......... Select this when no shift expression is to be carried out.

Left .......... Select this to shift to the left.

Right .......... Select this to shift to the right.

**No. of shift**
Specify the number of shifts, using the spin box.

**Monitor word expression**
If the operation is to be carried out based on an equation created using the value after being written to the writing destination, click on [Edit], and specify the equation in the “Input Expression” dialog box.

**Write word expression**
If the operation is to be carried out based on an equation created using the input value, click on [Edit], and specify the equation in the “Input Expression” dialog box.
"Expression style" Select the format of the expression from the list box.

Expression

\[ ? + ( ? + ? ) \]

Expression style:

Numerical term

\[ \begin{array}{cccc}
\text{7} & \text{8} & \text{9} & \text{C} \\
\text{4} & \text{5} & \text{6} & \text{ } \\
\text{1} & \text{2} & \text{3} & \text{Enter} \\
\text{0} & \text{.} & \text{ } & \text{ } \\
\end{array} \]

Variable term

\[ \begin{array}{cccc}
\text{$$} & \text{$$} & \text{$$} \\
\text{Device} & \text{Help} & \text{ } & \text{ } \\
\end{array} \]

"Expression"

"\[ \]" After specifying the expression style, click on the box for each item and specify numeric values for "Numerical term" and "Variable term", and the monitor device ($$) for the "Device" parameter.

"\[ + \]" Select the operands for the left and right sides from the list box.

\[ \text{+} \] Select for addition.

\[ \text{-} \] Select for subtraction.

\[ \text{\times} \] Select for multiplication.

\[ \text{/} \] Select for division.

\[ \% \] Select for a percentage expression.

"Numerical term" When setting the numeric values for the various items, click on the display position of the numeric value and then on \text{[Enter]}. Clicking on \text{[Enter]} inputs the numeric value. Numeric values are input as decimal values, and up to 32 digits can be input. To clear a numeric value, click on \text{[C]}.

"Variable term" When specifying the "Monitor word expression" parameter, to specify the "Device" parameter for each item, click on \text{[$$]}. (This can only be set at one location.)

When specifying the "Write word expression" parameter, to specify the "Device" parameter for each item, click on \text{[$W$]}. (This can only be set at one location.)

When setting "Monitor Word Expression" and "Write Word Expression", to set the current value of a device set for one of the various items, click on \text{[Device]} to display the "Set Device" dialog box. Specify the word device in this dialog box. (Up to two devices may be specified.)

\[ \text{See Section 10.1, Setting Devices for Monitoring.} \]

The only devices which can be specified are those connected to the GOT. If a MELSENET connection is being used, only the W assigned using the link parameter or network parameter may be used.

The data type for devices which can be specified will be the data type for the monitor device.
10.4 Setting Display Conditions

This section explains how to enter the settings for the display conditions specified for the various sprites.

10.4.1 Items to Know before Setting Display Conditions

1) Types of display conditions that can be set
   - Ordinary
   - While ON/while OFF
   - Rising/falling
   - Sampling

2) Ordinary displays that can be set
   With this method, monitor device data is read out from the PC CPU once during the scan time of the sequence program (END processing) or once per link scan time, and the data is displayed.

3) Displays that can be set while on or off
   With this method, monitor device data can be read out from the PC CPU once during the scan time of the sequence program (END processing) or once per link scan time, while the specified bit device is ON/OFF, and the data displayed. The sprite display can be deleted or saved if the condition is never satisfied.

4) Displays set during rise or fall
   With this method, monitor device data can be read out from the PC CPU once during the scan time of the sequence program (END processing) or once per link scan time, when the specified bit device is detected to have gone ON (rise time) or OFF (fall time), and the data displayed.
   Monitor device data can be read and displayed even if conditions in effect only the first time that the screen is switched have not been fulfilled.

5) Displays set based on sampling
   Monitor device data is read out from PC CPU and displayed at specified intervals (unit: seconds). (Maximum of 100 points per screen.)
10.4.2 Setting Up Displays When Setting Several Sprites on One Screen

With the GOT, there is a limit to the number of sprites that can be read from the PC CPU during one scan time of the sequencer program (END processing) or one link scan time. The number of sprites that can be read depends on the GOT connection configuration and the device being monitored.

<table>
<thead>
<tr>
<th>Connection configuration</th>
<th>Device being monitored</th>
<th>Max. no. readable at one time *1</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bus connection</td>
<td>Monitoring of B and W assigned with host station/link parameter or network parameter</td>
<td>40 points</td>
</tr>
<tr>
<td>• CPU direct connection (other than ACPU)</td>
<td>Monitoring of devices other than B and W for other station</td>
<td></td>
</tr>
<tr>
<td>• Calculator link connection (other than AJ71QC24)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• CPU direct connection (QnACPU)</td>
<td>Monitoring of B and W assigned with host station/link parameter or network parameter</td>
<td>96 points</td>
</tr>
<tr>
<td>• Calculator link connection (AJ71QC24)</td>
<td>Monitoring of devices other than B and W for other station</td>
<td></td>
</tr>
<tr>
<td>• MELSECGNET/II connection</td>
<td>Monitoring of B and W assigned with link parameter</td>
<td>Total no. of points set for 1 screen</td>
</tr>
<tr>
<td>• MELSECGNET/B connection</td>
<td>Monitoring of other station</td>
<td>40 points</td>
</tr>
<tr>
<td>• MELSECGNET/10 connection</td>
<td>Monitoring of B and W assigned with network parameter</td>
<td>Total no. of points set for 1 screen</td>
</tr>
<tr>
<td>• PC of other manufacturer</td>
<td>Monitoring of other station</td>
<td>40 points</td>
</tr>
<tr>
<td>• MELSEC-FX series connection</td>
<td>Monitoring of host station</td>
<td>16 points</td>
</tr>
<tr>
<td>• Microcomputer connection</td>
<td>Monitoring of host station</td>
<td>64 points</td>
</tr>
</tbody>
</table>

*1. Calculating the number of sprite points

- The value obtained by adding the total number of points indicated below is the total number of sprites that can be set for one screen.

<table>
<thead>
<tr>
<th>Display condition</th>
<th>Ordinary</th>
<th>Sampling</th>
<th>Calculated as 0 points</th>
</tr>
</thead>
<tbody>
<tr>
<td>• While on/off</td>
<td></td>
<td></td>
<td>Calculated as 1 point</td>
</tr>
<tr>
<td>• At rise/fall</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Device monitored</th>
<th>Bit device</th>
<th>Calculated as 1 point (1 point)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Word device (Data type: 16-bit)</td>
<td>Calculated as 2 points (2 points)</td>
<td></td>
</tr>
<tr>
<td>• Word device (Data type: 32-bit)</td>
<td>Calculated as 4 points (2 points)</td>
<td></td>
</tr>
</tbody>
</table>

If the sprites specified for one screen exceed the maximum number of points that can be read based on the above table, the display conditions (ON/OFF status of the bit device) for all of the sprites and the device being monitored cannot be read in one scan time (END processing) or one link scan time. The amount of time required for all of the sprites to be displayed will be longer.

In order to make sure all of the display conditions (ON/OFF status of the bit device) for all of the sprites and the device being monitored can be read, set the GOT in the actual monitoring mode, and check whether the ON/OFF time of the bit device for the display conditions and the device being monitored has to be maintained for more than a given number of milliseconds. Then adjust the sequence program accordingly.

Even if the number of sprites specified on one screen is less than the maximum number that can be read at one time, and the scan time (END processing/link scan time of the sequence program is 100 ms or less, the GOT is still unable to finish reading the display conditions (ON/OFF status of the bit device) and the data of the device being monitored, in less than 100 ms. Always adjust the sequence program is adjusted so that the on/off time of the bit device and the data of the device being monitored are maintained for 100 ms or longer. (This is true when connected to a path where the original maximum communication speed is 100ms. Be aware that more processing time may be necessary if using a different connection format.)
10.4.3 Setting Display Conditions

Display Conditions Procedure

We will use an example of a dialog box from the numeric display function.

"Trigger type" Using the radio buttons, select the display conditions under which the sprite is to be displayed. If "Sampling" is selected, select the sampling time with the spin box. Settings can be entered in units of 1 second, starting from a minimum of 1 second.

"Trigger device" If "ON", "OFF", "Rise", or "Fall" is selected for the "Trigger type" parameter, click on [Dev.], and specify the bit device in the "Device Setting" dialog box.

See Section 10.1, Setting Devices for Monitoring.

"Initial display" If "Rise" or "Fall" is selected for the "Trigger type" parameter, place an "X" in the check box if the data for the device being monitored is to be read and displayed even if only the first condition when the screen is switched has not been satisfied.

"Hold display" If "ON" or "OFF" is selected for the "Trigger type" parameter, place an "X" in the check box if the sprite display is to be retained after the condition is no longer satisfied.

If there is no "X" in the check box, the sprite display will disappear as soon as the condition is no longer satisfied.
10.5 Setting Display Ranges (Comparative Equations)

This section explains how display methods are switched based on the values of the device being monitored for each of the sprites, and on the values of the data expression results, and how to specify comparative equations to change the display color and attributes.

This function can also be used to specify the input range for numeric input functions.

When entering settings for the display method, the "Edit Display Format" dialog box is displayed.

For items other than "Display range", the items to be set are described under the respective sprite.

"Display range"

* Left * Clicking on "Left", "Middle", or "Right" displays the "Input Expression" dialog box, where values can be specified for the pertinent items.

* Middle *

* Right *

* < * Select the operands used for left and center items, using the list box.

  < ........ The value of the left item is smaller than that of the center item.

  <= ........ The value of the left item is the same as that of the center item, or smaller.

  == ........ The value of the left item is the same as that of the center item.

  != ........ The value of the left item is different from that of the center item.

* No * Select the operands used for center and right items, using the list box.

  No ........ Select this if the equation does not contain three elements.

  < ........ The value of the center item is smaller than that of the right item.

  <= ........ The value of the center item is the same as that of the right item, or smaller.
Setting the "Input Expression" Dialog Box

"Numerical term"  To enter numeric values for the left, center, and right items, click on the position where the numeric value is displayed, and then click on [Enter].
Clicking on [Enter] enters the numeric value. Numeric values are input as decimal values, and up to 32 digits can be entered.
To clear a numeric value, click on [C].

"Variable term"  Click on this to enter the values listed below for the left, center, and right items.
$V$ ....... "Monitor device value"/Select this when specifying the value resulting from the data expression when a data expression is specified.
$SW$ ....... Select this to specify an input value.
(SW can be selected only if the numeric input function has been specified.)
Chapter 11

Setting Data Display Functions
11. Setting Data Display Functions

11.1 Setting the Numeric Value Display Function

When does this function do?

This function displays data stored in the word device as a numeric value.

Example of Settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Display size&quot;</td>
<td>Vertical: 2 x ; Horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>16 bits/with sign 0-FF-D100</td>
</tr>
<tr>
<td>&quot;Display style&quot;</td>
<td>Decimal, with sign</td>
</tr>
<tr>
<td>&quot;Digits&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Left alignment/Right alignment&quot;</td>
<td>Aligned right</td>
</tr>
<tr>
<td>&quot;Zero suppress&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Display method&quot;</td>
<td></td>
</tr>
<tr>
<td>Ordinary</td>
<td></td>
</tr>
<tr>
<td>&quot;Display color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Flink&quot;</td>
<td>None</td>
</tr>
<tr>
<td>&quot;Reverse display&quot;</td>
<td>None</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Procedure Outline

Basic Settings
- Display size setting
- Monitor device setting
- Display style setting
- Display color setting

Change display color when monitor device reaches a certain value?

Display Method
- Setting of comparative equation to change display method

Set data expression?

Data Expression
- Setting of calculation equation for data expression

Trigger
- Setting of display conditions

When settings have been completed, click on "OK" on any tab.

Setting of display position

End

See 1
See 5
See 2
See 3
See 4
Description of Settings

1. Setting the (Basic) settings

![Basic Settings Screen]

**Display size**  Select the size in which numeric values are to be displayed, using the list box. Characters displayed at the x 1 size in both directions are displayed at 16 x 18 dots.

**Monitor device**  Click on [Dev.] and then use the “Device Settings” dialog box to specify the word device to be monitored.

**Device type**  Select the data type for the word device to be monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td></td>
<td>Select this to display data as a 32-bit real number.</td>
</tr>
</tbody>
</table>

**"NW No."**  See Section 10.1, Setting Devices for Monitoring.

**"Station No."**

**"Device Name"**

**"Device No."**

**"Display style"**  Select the style in which monitor device values or data expression results are to be displayed, using the list box.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>Select this to display monitor device values or data expression results as decimal values.</td>
<td>Select this to display monitor device values or data expression results as real numbers with floating decimal points.</td>
<td>Select this to display monitor device values or data expression results as binary values.</td>
</tr>
</tbody>
</table>
"Digits" Specify the number of digits used to express the numeric value, using the spin box. The number of digits that can be displayed using the "Display style" parameter is as shown below.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 13 digits (including minus sign)</td>
<td>1 to 32 digits (including negative sign, decimal point, and decimal fractions)</td>
<td>1 to 32 digits</td>
<td>1 to 8 digits</td>
</tr>
</tbody>
</table>

"Decimal point" When real numbers are selected using the "Display style" parameter, use the spin box to specify how many digits to the right of the decimal point are to be displayed.

(Example) No. of digits displayed: 5, No. of digits to right of decimal point: 3, Contents of monitor device: 324.5321 (real number with floating decimal point)

"Left alignment" Using the radio buttons, select whether the display is to be aligned to the left or right in relation to "Right alignment" the display position.

(Example) No. of digits displayed: 6, contents of monitor device: 150

When "Right alignment" is selected above, place an "X" in the check box if zeros are to be displayed in front of the numeric value.

"Zero suppress" (Example) No. of digits displayed: 6, contents of monitor device: 150
"Normal" Click on [Edit] and specify the display color in the "Edit Display Format" dialog box.

"Attribute" If a comparative equation is being specified using [Display Format], these settings for the display color and attribute are effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

"Color" Select the color in which numeric values are to be displayed, using the list box.

"Blink" If a blinking display is to be used, select "Yes" using the list box.

"Reverse" If a reversed display is to be used, place an "X" in the check box.

"Outline font" Place an "X" in the check box when displaying values in outline fonts (applicable only when display size is set to double or larger both vertically and horizontally).

2 Setting the [Data Expression]

See Section 10.2, Setting Data Expressions (Other Than Numeric Input Function).

3 Setting the [Trigger]

See Section 10.4, Setting Display Conditions.

4 Setting the display position

(1) When the settings for the various tabs have been entered, click on [OK] in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified numeric values.

(3) Move the cursor to the display position, and click at that position.
5  Setting the Display Format

This is specified if the display color and attributes are to be changed when the value of the monitor device or the value resulting from the data expression reaches a certain value.

Click on [Edit] to display the “Edit Display Format” dialog box, and specify the display color, attribute, and comparison equation. Up to seven types of comparison equations can be specified.

To delete a comparison equation that has been specified, click on [Delete]. To change the order of the specified comparison equations, click on [Up] or [Down].

“Attribute” Specify the display color and attribute to be used once the monitor device value or the value resulting from the data expression corresponds to the comparison equation specified by the “Display Range” parameter.

“Color” Select the display color, using the list box.

“Reverse” If a reversed display is to be used, place an “X” in the check box.

“Blink” If a blinking display is to be used, select “Yes” using the list box.

“Display range” Specify the comparison equation or equations.

See Section 10.5, Setting Display Ranges (Comparative Equations).
(Examples)

Case 1: Monitor device value is -100 or less ($$ \leq -100$$): Blinking display in yellow
Case 2: Monitor device value is 100 to 500 (100 $$\leq $$ $$ \leq 500$$): Displayed in blue
Case 3: Monitor device value is 1000 or higher (1000 $$\leq $$ $$$$): Reversed blinking display in red
Normal: When the monitor device value does not correspond to any of the above: Display color specified with the "Normal" parameter

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$$\leq -100$$</td>
<td>Yellow</td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>100 $$\leq$$ $$ \leq 600$$</td>
<td>Blue</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>1000 $$\leq$$ $$ $$</td>
<td>Red</td>
<td>Reversed</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Normal | White | Normal | No |

The "Normal" parameter is specified using the [Basic] tab.

Outline of Operation Procedure

In the "Edit Display Format" dialog box, specify the display color, attributes, and comparison equations.

The values for "Left", "Middle", and "Right" are specified using the "Input Expression" dialog box.

Specify the for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
11.2 Setting the ASCII Display Function

When does this function do?

With this function, stored data following the word device is viewed as character codes (ASCII codes or shift JIS codes), and is displayed as a character string.

Example of Settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x, horizontal: 2 times</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0 - FF - D0</td>
</tr>
<tr>
<td>&quot;Digits&quot;</td>
<td>9</td>
</tr>
<tr>
<td>&quot;Display format&quot;</td>
<td>&quot;Color&quot;</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Reverse&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Procedure Outline

Basic
- Display size setting
- Monitor device setting
- Display style setting
- Display format setting

See 1

Trigger
- Setting of display conditions

See 2

When settings have been completed, click on "OK" on any tab.

Setting of display position

See 3

End
1 Setting the **Basic** settings

**Display size**  Select the size in which character strings are to be displayed, using the list box.
(Example)  Vertical: 2 x  Horizontal: 2 x

- 8 dots
- 16 dots
- 32 dots

Half-width character  Full-width character

**Monitor device**  Click on **Dev.** and then use the "Device Settings" dialog box to specify the initial word device in which the character code to be displayed is stored.

See Section 10.1, Setting Devices for Monitoring.

**Display style**

**No. of digits displayed**  Select the number of characters to be displayed, using the spin box.
(Example)  No. of digits displayed: 4  (Example)  No. of digits displayed: 6

D1  D2  D3  D4
(21)  (43)  (BC)  (DC)
D4  D2  D3  D1
(87)  (BC)  (43)  (21)

"1234 A8" is displayed on the GOT, comprising 4 digits.

"1234 A8" is displayed on the GOT, comprising 6 digits.

**Display format**

**Color**  Select the color in which character strings are to be displayed, using the list box.

**Blink**  If a blinking display is to be used, select "Yes" using the list box.

**Reverse**  If a reversed display is to be used, place an "X" in the check box.
2 Setting the **Trigger**

See Section 10.4, Setting Display Conditions.

3 Setting the display position

1. When the settings for the various tabs have been entered, click on **OK** in any tab.

2. A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified ASCII display.

3. Move the cursor to the display position, and click at that position.

---

**Special Cases**

- What happens if the character code being displayed contains a space (20H)?

  The space (20H) will be displayed as a blank.

The space (20H) is treated as one digit and displayed.
11.3 Setting the Clock Display Function

**When does this function do?**

This function displays the internal clock data in the PC CPU.

When the power supply is turned on, the GOT reads the PC CPU clock data and verifies the PC CPU clock data once every hour.

**POINT**

If there is no clock data in the PC CPU which is connected to the GOT, the clock display function cannot be used.

--- Example of Settings ---

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Contents of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Item&quot;</td>
<td>Time</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
</tbody>
</table>

--- Example of Settings ---

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Contents of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Item&quot;</td>
<td>Date</td>
</tr>
<tr>
<td>&quot;Date&quot;</td>
<td>Year/month/day</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
</tbody>
</table>
11. Setting Data Display Functions

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command

On Draw menu:
Data Display → Clock

--- Procedure Outline ---

Clock display settings
- Setting of item to be displayed
- Setting of date
- Setting of display size
- Setting of display color

When settings have been completed, click on "OK".

Setting of display position

--- Description of Settings ---

1 Setting the "Clock display settings" dialog box

--- Diagram ---

[Diagram showing the clock display settings dialog box with options for position, size, item, and date format]
"Item" Using the radio buttons, select whether the date or time is to be displayed. The format in which the date and time are displayed is fixed and cannot be changed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Contents of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>The display format is determined by the &quot;Date format&quot; parameter. The number of digits displayed is fixed at 8. The year is displayed in the four-digit style of the Western calendar. (Example) Date format: Year/month/day</td>
<td>The number of digits displayed is fixed at 5. The time is displayed using the 24-hour system. (Example)</td>
</tr>
</tbody>
</table>

"Date format" If "Date" is selected for the "Item" parameter, use the radio buttons to select the format in which the date is displayed.

"Size" Using the list box, select the size in which the characters of the date/time are displayed. Characters displayed at the x1 size consist of 16 x 18 dots.

"Color" Select the color in which the date/time is to be displayed, using the list box.

2 Setting the display position
(1) When the settings have been entered, click on **OK**.
(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified clock display.

(3) Move the cursor to the display position, and click at that position.
### Special Cases

- If there is a clock function in the PC CPU to which the GOT is connected, this function can be run. However, the clock display function is not available during CC-Link connections.

- Which PC CPU is used to read clock data when the power to the GOT is turned on?
  The clock data of the PC CPU stated below is read, depending on how the GOT is connected.
  - For a bus connection, CPU direct connection, and calculator link connection
    .......... the PC CPU connected to the GOT
  - For a MELSENET connection
    .......... the PC CPU of the master station/control station

- Precautions when using the clock display function
  Be aware that the clock setting function of the utility screen is not available if M9028 is ON.

- CPUs that do not support the clock display function
  1. MELSEC-A series
     AOJ2HCPU, A2CCPU, A2CJCPU
  2. MELSEC-FX series, PC CPUs of other manufacturers

<table>
<thead>
<tr>
<th>Device name</th>
<th>Clock function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MELSEC-FX series</td>
<td></td>
</tr>
<tr>
<td>FX0 series, FX2N series</td>
<td>Unusable</td>
</tr>
<tr>
<td>FX0s series, FX1 series</td>
<td>Usable</td>
</tr>
<tr>
<td>FX2 series, FX2c series</td>
<td>Usable when using the real time clock cassette</td>
</tr>
<tr>
<td>C200H-CPU11</td>
<td>Usable</td>
</tr>
<tr>
<td>C200H-CPU31</td>
<td></td>
</tr>
<tr>
<td>C200H-CPU21</td>
<td></td>
</tr>
<tr>
<td>C200H-CPU22</td>
<td></td>
</tr>
<tr>
<td>C200H-CPU23</td>
<td>Usable when using the memory cassette with clock function</td>
</tr>
<tr>
<td>C200H-CPU01</td>
<td></td>
</tr>
<tr>
<td>C200H-CPU02</td>
<td></td>
</tr>
<tr>
<td>C200H-CPU03</td>
<td>Unusable</td>
</tr>
<tr>
<td>C200HS series</td>
<td>Usable</td>
</tr>
<tr>
<td>C200Hα series</td>
<td></td>
</tr>
<tr>
<td>C200HE-CPU11</td>
<td>Unusable</td>
</tr>
<tr>
<td>Other than above PC</td>
<td>Usable</td>
</tr>
<tr>
<td>CQM1 series</td>
<td>Usable when using the memory cassette with clock function</td>
</tr>
<tr>
<td>C1000H, C2000H series</td>
<td>Unusable</td>
</tr>
<tr>
<td>CV1000</td>
<td>Unusable</td>
</tr>
<tr>
<td>Yasukawa PC</td>
<td></td>
</tr>
<tr>
<td>GL60S, GL60H, GL70H, GL120, GL130</td>
<td>Unusable</td>
</tr>
<tr>
<td>Microcomputer connection</td>
<td>Unusable</td>
</tr>
<tr>
<td>AB PC</td>
<td></td>
</tr>
<tr>
<td>SLC 5/03, SLC 5/04</td>
<td>Usable</td>
</tr>
</tbody>
</table>
11.4 Specifying the Data List Display Function

The data list display function cannot be specified on window screens. Only one data list display can be specified on one screen window. If a data list display has been specified for a screen window, the "Scroll" parameter for the alarm list (user alarms) function cannot be specified for that window.

What does this function do?

This function gathers data on the statuses of a number of word devices at a specified timing, and displays the results as numeric data, in the form of a table. The priority order of items in the table can be changed based on the statuses of the applicable word devices.

GOT display

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. of defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>(D10)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D11)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D12)</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>(D20)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D21)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D22)</td>
</tr>
<tr>
<td>3</td>
<td>Machine 3</td>
<td>(D30)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D31)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D32)</td>
</tr>
<tr>
<td>4</td>
<td>Machine 4</td>
<td>(D40)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D41)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(D42)</td>
</tr>
</tbody>
</table>

The order of the display is switched at the specified timing.

Data List Display Format

- Lines and numbers do not need to be drawn in data list displays. These are displayed automatically, based on the columns and rows displayed.

<table>
<thead>
<tr>
<th>No</th>
<th>*1</th>
<th>*1</th>
<th>*1</th>
<th>*1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
<tr>
<td>2</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
<tr>
<td>3</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
<tr>
<td>4</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
</tbody>
</table>

* Device names in parentheses in the table are not actually displayed.

Example: To specify D100

D100 D101 D102

*1. Specify names for the items in each row.
*2. Specify column numbers that correspond to the numbers in each row.
*3. Specify the devices to be displayed in numeric format in each row. Only one device name needs to be specified; the rest are specified automatically in consecutive order, based on the number of rows.
### Example of settings

#### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>Vertical: 1 x Horizontal: 1 x</td>
</tr>
<tr>
<td><strong>List style</strong></td>
<td></td>
</tr>
<tr>
<td>&quot;Rows&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Disp. rows&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Columns&quot;</td>
<td>4</td>
</tr>
<tr>
<td><strong>Sort</strong></td>
<td>Ascending order</td>
</tr>
<tr>
<td>&quot;Sort&quot;</td>
<td>3</td>
</tr>
<tr>
<td>&quot;Sort/Attr. column&quot;</td>
<td></td>
</tr>
<tr>
<td><strong>Interval</strong></td>
<td>Vertical: 3 Horizontal: 3</td>
</tr>
<tr>
<td><strong>Cyclo</strong></td>
<td>10 seconds</td>
</tr>
</tbody>
</table>

#### List

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device</strong></td>
<td>Random</td>
</tr>
<tr>
<td><strong>Comment</strong></td>
<td>Cont.</td>
</tr>
<tr>
<td>**Row 1&quot;</td>
<td>&quot;Comment no.&quot; 100</td>
</tr>
<tr>
<td></td>
<td>&quot;Device no.&quot; D10, D11, D12</td>
</tr>
<tr>
<td>**Row 2&quot;</td>
<td>&quot;Comment no.&quot; 101</td>
</tr>
<tr>
<td></td>
<td>&quot;Device no.&quot; D20, D21, D22</td>
</tr>
<tr>
<td>**Row 3&quot;</td>
<td>&quot;Comment no.&quot; 102</td>
</tr>
<tr>
<td></td>
<td>&quot;Device no.&quot; D30, D31, D32</td>
</tr>
<tr>
<td>**Row 4&quot;</td>
<td>&quot;Comment no.&quot; 103</td>
</tr>
<tr>
<td></td>
<td>&quot;Device no.&quot; D40, D41, D42</td>
</tr>
<tr>
<td>**Col. 1&quot;</td>
<td>&quot;Digits&quot; 12 characters</td>
</tr>
<tr>
<td></td>
<td>&quot;Title&quot; Display of processing results</td>
</tr>
<tr>
<td>**Col. 2&quot;</td>
<td>&quot;Device type&quot; 16 bit/signed</td>
</tr>
<tr>
<td></td>
<td>&quot;Style&quot; Signed decimal; Digits: 3; Right alignment</td>
</tr>
<tr>
<td></td>
<td>&quot;Title&quot; Planned no.</td>
</tr>
<tr>
<td>**Col. 3&quot;</td>
<td>&quot;Device type&quot; 16 bit/signed</td>
</tr>
<tr>
<td></td>
<td>&quot;Style&quot; Signed decimal; Digits: 3; Right alignment</td>
</tr>
<tr>
<td></td>
<td>&quot;Title&quot; No. produced</td>
</tr>
<tr>
<td>**Col. 4&quot;</td>
<td>&quot;Device type&quot; 16 bit/signed</td>
</tr>
<tr>
<td></td>
<td>&quot;Style&quot; Signed decimal; Digits: 3; Right alignment</td>
</tr>
<tr>
<td></td>
<td>&quot;Title&quot; No. of defects</td>
</tr>
</tbody>
</table>

#### Display Format

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default</strong></td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td><strong>Reverse</strong></td>
<td>NO</td>
</tr>
</tbody>
</table>

Entering comments in the *Comment Chart* dialog box

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Text Color</th>
<th>Normal/Reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Machine 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Machine 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>Machine 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>Machine 4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The display color and attributes become effective when the display method is specified.
Outline of Procedure

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:

On Draw menu:

Data Display → DataList

Basic
- Setting of display size
- Setting of list format
- Setting of sorting order
- Setting of display spacing
- Setting of display timing
- Setting of default display attribute

List
- Setting of line comment and monitor device
- Setting of row title, monitor device data type, and number of rows to display

Is data expression to be specified?

NO

YES

Expression
- Setting of equation for data expression

Change display color when monitor device reaches certain value?

NO

YES

Display Format
- Setting of comparative equation used to change display method

After entering settings, click on "OK" on any tab

Setting of display position

End

See 1

See 2

See 2

See 4

See 3
Description of Settings

1. Setting the Basic settings

**Size**
Using the list box, select the title to be displayed and the text size for numeric values. If "Vertical: 1, Horizontal: 1" is selected, the size of one character will be 16 x 8 dots.

**List style**

**Rows**
Using the spin box, specify the total number of lines to be monitored. Up to 128 lines can be specified.

**Disp. rows**
Using the spin box, specify the actual number of lines to be displayed.

**Columns**
Using the spin box, specify the number of rows to be displayed. Up to 6 rows can be specified.

**Title**
Using the list box, select a display color for the title (characters).

**Frame**
Using the list box, select a frame color of the table for the data list display.

**Outline font**
Place an "X" in the check box to display numeric values with outline fonts. (Applicable only when the display size is set to double or larger size both vertically and horizontally)

**Sort**
Using the radio button, select the method by which the display is to be sorted.

Ascending...... Sorting is carried out beginning with the device that has the smallest value among the rows specified by the "Sort/attribute row" parameter.

Descending ...... Sorting is carried out beginning with the device that has the largest value among the rows specified by the "Sort/attribute row" parameter.

Numeric order ...... Items are displayed in order of the specified line numbers.
"Sort/Attr. column"

Using the spin box, specify the rows to be targeted when the display is sorted.

(Example) Total lines: 5 lines, No. of lines displayed: 3 lines,
No. of rows: 3 rows, Sort/ascending row: 2 rows

The results are displayed in the order of the line numbers specified with the List parameter.

When "Sort" is specified in ascending order

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. produced</th>
<th>No. defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Machine 4</td>
<td>300</td>
<td>10</td>
</tr>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>500</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>600</td>
<td>50</td>
</tr>
<tr>
<td>3</td>
<td>Machine 3</td>
<td>700</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>Machine 5</td>
<td>800</td>
<td>1</td>
</tr>
</tbody>
</table>

Since the number of lines to be displayed is 3, these are not displayed on the GOT.

Row 1  Row 2  Row 3

Sorting is carried out in order starting with the smallest value in the cells, in line units.

When "Sort" is specified in descending order

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. produced</th>
<th>No. defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Machine 5</td>
<td>800</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>Machine 3</td>
<td>700</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>600</td>
<td>50</td>
</tr>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>500</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>Machine 4</td>
<td>400</td>
<td>10</td>
</tr>
</tbody>
</table>

Since the number of lines to be displayed is 3, these are not displayed on the GOT.

Row 1  Row 2  Row 3

Sorting is carried out in order starting with the largest value in the cells, in line units.

When "Sort" is specified in numeric order

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. produced</th>
<th>No. defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>500</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>600</td>
<td>50</td>
</tr>
<tr>
<td>3</td>
<td>Machine 3</td>
<td>700</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Machine 4</td>
<td>400</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>Machine 5</td>
<td>800</td>
<td>1</td>
</tr>
</tbody>
</table>

Since the number of lines to be displayed is 3, these are not displayed on the GOT.

Displaying the 4th and 5th Lines on the GOT

"Scroll Up" (00F2H) and "Scroll Down" (00F3H) touch keys should be specified on the screen window.

"Interval"

Using the spin box, specify the amount of spacing to be provided between the title, comments, and numeric values displayed in the chart.
Up to 32 dots can be specified in each direction (vertical and horizontal).

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. produced</th>
<th>No. defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>100</td>
<td>001</td>
</tr>
</tbody>
</table>

Vertical display spacing
Horizontal display spacing

"Cycle"

Using the spin box, specify the timing at which the monitor devices in the PC CPU are checked and the display is sorted.
A value between 1 second and 80 seconds can be specified, in 1-second units.
“Default” Click on [Edit] to display the “Edit Display Method” dialog box, and specify the attributes and display color. Comments will also be displayed in the color and with the attributes specified here. (Attributes specified when the comment is created will be ignored.)

“Attribute” If a comparative equation has been specified with the “Display method” parameter, this setting will revert to the display color and attributes effective when the monitor device value or data expression result does not correspond to the comparative equation.

“Color” Using the list box, specify the color in which numeric values are to be displayed.

“Reverse” Place an “X” in the check box if the data is to be shown in a reversed display.

2 Setting the List settings

(1) Line settings

“Device” Using the radio button, select how devices to be displayed using numeric values are to be specified. Cont. ........ Devices are specified automatically, in successive order, starting from the device set with the [Row 1] parameter and continuing for the number of devices to be displayed using numeric values.

Random ..... The desired number of devices can be set, in line units.

“Comment” Using the radio button, select how comment numbers to be displayed are to be specified. Cont. ........ Comment numbers are specified automatically, in successive order, starting from the comment number set with the [Row 1] parameter and continuing for the number of lines.

Random ..... The desired comment numbers can be set, in line units.

“Row 1” Clicking on [Row 1] displays the “Edit Line” dialog box.

Specify the comment number to be displayed on the selected line, and the device of the numeric value display.

See Section 10.1, Setting Devices for Monitoring.
- If "Continuous" has been specified for "Device" or "Comment", settings will be made automatically, starting with the device and comment number displayed in numeric format as specified by the (Row 1) parameter.

(Example) Device: D10, Comment No.: 1, No. of Rows: 4, No. of Columns: 5

<table>
<thead>
<tr>
<th>Row</th>
<th>Col. 1</th>
<th>Col. 2</th>
<th>Col. 3</th>
<th>Col. 4</th>
<th>Col. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Devices are set continuously starting from D10, for the number of devices to be displayed in numeric format.

Comment No. 1 is displayed first, and the remaining comment numbers are set continuously.

- If "Random" is selected for "Device" or "Comment", the user can specify as many devices and comment numbers as desired, to be displayed in numeric format, in line units.

(Example) Device: D10, Comment No.: 1, No. of Rows: 4, No. of Columns: 5

<table>
<thead>
<tr>
<th>Row</th>
<th>Col. 1</th>
<th>Col. 2</th>
<th>Col. 3</th>
<th>Col. 4</th>
<th>Col. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Devices are set continuously for the number of rows specified to be displayed in numeric format, starting with the specified device. Device settings cannot be entered in row units.

*Row 2 to Row n*

If "Random" is selected for "Device" or "Comment", click on (Row n) (n being whatever number of lines is to be displayed), to display the "Edit Line" dialog box. Here, specify the devices and comment numbers.

* The display format (type of device, number of lines to be displayed, and other information) for numeric displays is set using the row setting.

The specified devices and comment numbers are displayed under the [List] tab display.

Please be aware that, because only six lines of data can be displayed at one time, there may be times when it is not possible to display all of the characters on the screen, depending on the specified devices and device numbers.
(2) Setting columns

* **Col. 1** *

Clicking on **Col. 1** displays the "Edit Columns" dialog box.

![Edit Columns dialog box]

"Title"

Enter the item name for Col. 1.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item name specified for Columns 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

"Digits"

Use the spin box to specify the number of characters to be displayed in Column 1, taking into consideration any comments and titles to be displayed.

After entering the setting, click on **OK** under "Title" or "Digits". The specified title is displayed on the screen display.

![Datalist]

Because only six half-width characters can be displayed, please be aware that there may be times when the full title cannot be displayed, depending on the length of the title that has been set.

* **Col. 2 to Col. n** *

Clicking on **Col. 2** to **Col. n** displays the "Edit Columns" dialog box.
Setting the **Display Style** settings

- **Title**
  Enter the item name for the column.

- **Device type**
  Using the list box, select the data type for the word device to be used to monitor the column.

<table>
<thead>
<tr>
<th>16 bit/signed</th>
<th>16 bit/unsigned</th>
<th>32 bit/real</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 bit/signed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

- **Style**
  Using the list box, select the style in which the column monitor device values or data expression results are to be displayed.

<table>
<thead>
<tr>
<th>Signed decimal</th>
<th>Real</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signed decimal</td>
<td>Real</td>
<td>Binary</td>
<td>Hexadecimal</td>
</tr>
<tr>
<td>Unsigned decimal</td>
<td>Select this to display monitor device values or data expression results as decimal values.</td>
<td>Select this to display monitor device values or data expression results as real numbers with floating decimal points.</td>
<td>Select this to display monitor device values or data expression results as decimal values.</td>
</tr>
</tbody>
</table>

- **Digits**
  Specify the number of digits used to express the numeric value of the column, using the spin box. The number of digits that can be displayed using the "Display style" parameter is as shown below.

<table>
<thead>
<tr>
<th>Signed decimal</th>
<th>Real</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 13 digits (including minus sign)</td>
<td>1 to 32 digits (including decimal points and digits to right of decimal point)</td>
<td>1 to 32 digits</td>
<td>1 to 8 digits</td>
</tr>
</tbody>
</table>

- **Decimal point**
  When real numbers are selected using the "Display style" parameter, use the spin box to specify how many digits to the right of the decimal point are to be displayed.

- **Left alignment**
  - **Right alignment**
    Using the radio buttons, select whether the display is to be aligned to the left or right in relation to the display position.
    If "Right alignment" is selected above, place an "X" in the check box if zeros are to be displayed in front of the numeric value.
Setting **Expression** settings

These settings should be entered if data expressions are to be used in relation to the monitor device for a column.

```
"Mask"
"Shift"
"Expression"
```

See Section 10.2, Setting Data Expressions (Other Than Numeric Input Function).

### Setting the display position

1. When the settings for the various tabs have been entered, click on **OK** in any tab.
2. A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified data list display.

3. Move the cursor to the display position, and click at that position.

### Setting the **Display Format** settings

These settings should be entered if the display color and attributes for the numeric display of the line are to be changed when the monitor device value or the data expression results for the row specified by the "Sort/Attr. column" under **1** reach a certain value.

See Section 11.1, Setting the Numeric Value Display Function **5**
Chapter 12

Setting the Message Display Function
12. Setting the Message Display Function

12.1 Registering Comments to Display with the Comment Display Function

This section explains the procedure for registering comments to be displayed on the GOT using the comment display function and alarm list function (user alarms).

12.1.1 Registering Comments

- **When is this function used?**
  - This function is used when you want to register comments to be displayed using the comment display, Alarm History, Report function and alarm list function (user alarms).

- Useful information before registering comments
  - Up to 32,767 types of comments can be registered.
  - One comment can consist of 1 to 512 characters, regardless of whether half-width or full-width characters are used.
  - Comments consisting of several lines can be created.
  - To enter a line return, press Enter at the end of the comment line.
  - A line return takes up two characters.

```
Line 1 is currently in operation. Enter.
```

- To enter an empty line, with nothing on it, press Enter at that line. This takes up two characters.

```
Line 1 is currently in operation. Enter.
```

- The Enter command accounts for one character.

```
Line 1 is currently in operation. Enter.
```

The overall message consists of 13 characters: 12 for the message “Line 1 is currently in operation”, and one for the Enter command.

- If a comment is created which consists of several lines, it will be displayed on the GOT as follows.

```
Currently in operation
Y70 is ON
```

Display range
- The character display size is specified using the dialog box where sprite settings are entered.

- The characters for various languages can be registered as comments and displayed using the comment display function and the alarm list display (user alarms) function. When such comments are input, however, the character input system corresponding to that language (excluding Japanese and English) is required.

- With the comment display (bit) function, comments to be displayed when the sprite settings are entered can be specified and displayed, without having to register comments corresponding to the on/off status.

- With the comment display (word) function, when comments corresponding to the value of the word device are displayed (indirect command), a comment should be registered for the corresponding comment number.

(Example) If the value of D100 is "0", the comment "Line 1 is not currently in operation" will be displayed.

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current production quantity is 1</td>
</tr>
</tbody>
</table>

The comment is registered as Comment No. 1.

(Example) If the value of D100 is "100", the comment "Current production quantity is 100" will be displayed.

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Current production quantity is 100</td>
</tr>
</tbody>
</table>

The comment is registered as Comment No. 100.
1. Select Comment on the Draw Settings menu.

2. The "Comment List" dialog box is displayed. Click on the comment column for the comment number about to be registered. Then click on Edit.

   If the comment number to be registered is not displayed, use the "Comment No." spin box to specify the comment number to be registered, and then click on Jump.

3. The "Edit Comment" dialog box is displayed. Enter the comment in the "Comment" text box. Using the "Color" list box under the "Attribute" parameter, select the color in which the comment is to be displayed.

   If the comment is to be displayed in a reverse display, place an "X" in the check box next to "Reverse".

   If the comment is to be displayed in a blinking display, select "Yes" for "Blink".

   Place an "X" in the "Outline Font" check box to display comments with outline fonts.

   Click on OK.

4. The "Comment List" dialog box is displayed. To correct the comment which has been registered, click on the comment column for the number of the comment to be corrected, and use the same procedure as that for registering comments to make the correction.

   When all of the comments have been registered, click on OK.

12 - 3
12.1.2 Deleting Registered Comments

- When is this function used?
  - This function is used when you want to delete a comment that has been registered.

   (If the “Comment List” dialog box is already open, this step can be skipped.)

2. The “Comment List” dialog box is displayed. Click on [Delete].

3. The “Delete Comment” dialog box is displayed.
   Using the spin box, specify the number of the comment to be deleted.
   If consecutive comments following the one specified by the “Delete No.” parameter are also to be deleted, specify the number of lines to be deleted using the “No. of delete” spin box.
   Then click on [OK].

4. The comments for the specified comment number or numbers are deleted. After the comment or comments have been deleted, click on [OK].
12.1.3 Copying a Registered Comment to Another Comment Number

When is this function used?

- This function is used when you want to take a comment that has been registered and copy it to another comment number.

   (If the “Comment List” dialog box is already open, this step can be skipped.)

2. The “Comment List” dialog box is displayed. Click on [Copy].

3. The “Copy Comments” dialog box is displayed. Using the “Source No.” spin box, specify the number of the comment to be copied.

   If consecutive comments following the one specified by the “Source No.” parameter are also to be copied, specify the number of lines to be copied using the “No. of copy” spin box.

   Then click on [OK].

4. The comments for the specified comment number or numbers are copied. After the comment or comments have been copied, click on [OK].
12.1.4 Using Data in Text File Format as Comment Data

Text file data created using commercial text editor programs (files with the .TXT extension) can be used as comment data.

Also, registered comment data can be written to a specified file as text file data, enabling it to be edited using a text editor.

- Useful information before creating comment data with a text editor
  - Before inputting a comment, always enter / /, / /, the comment number, and Enter.

    
    
    - One comment can consist of 1 to 512 characters, regardless of whether half-width or full-width characters are used. Comments consisting of several lines can be created. To enter a line return, press Enter at the end of the comment line.

    To enter an empty line, with nothing on it, press Enter at that line. This takes up two characters.

    
    
    - The Enter command is treated as a character.

    - All of the data entered up to the next / /, / /, comment number, and Enter sequence is handled as one comment.
12. Setting the Message Display Function


2. The "Comment List" dialog box is displayed. Click on [File].

3. The "Text File" dialog box is displayed. Using the "Write/Read" radio buttons, specify whether comment data is to be read or written.

Then click on [Browse] after the "File name" parameter.

4. The "Browse" dialog box is displayed. If comment data is being read, specify the name of the file containing the data in text file format which is to be read. If comment data is to be written, specify the file name (.TXT) to which the data is to be written.

Then click on [OK].

5. The "Text File" dialog box is displayed. Click on [OK].

The comment data is read or written as specified. When comment data is being written, only data which is in the text file format can be written. The display color and attributes cannot be written to the file along with the data.
6. The "Comment List" dialog box is displayed. When the reading or writing of the comment data has been completed, click on [OK].
12.2 Setting the Comment Display (Bit) Function

- What does this function do?
  - This function is used to display comments corresponding to the ON/OFF status of the bit device.

Example of settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Preview Comment No.&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; Horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>Bit device: 0 - FF - X0000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;ON&quot;</td>
<td>&quot;Display comment&quot; Direct</td>
</tr>
<tr>
<td>&quot;Attribute&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td>&quot;Reverse&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Comment&quot;</td>
<td>X0 is ON</td>
</tr>
<tr>
<td>&quot;OFF&quot;</td>
<td>&quot;Display comment&quot; Direct</td>
</tr>
<tr>
<td>&quot;Attribute&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td>&quot;Reverse&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Comment&quot;</td>
<td>X0 is OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

12 - 9
Outline of Procedure

**Basic**
- Setting of preview comment number
- Setting of display size
- Setting of monitor device

**Display Format**
- Setting of display comment
- Setting of display color and attributes
- Registration of comments

**Trigger**
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position (display range)

See 1

See 2

See 3

See 4

End
Description of settings

1. Setting the (Basic) settings

*Preview comment* This setting is used to display the comment of the specified number as an image. Specify the comment number to be displayed in the spin box.

See Section 20.2, Viewing an Image of the Created Screen Data.

*Display size* Select the size in which the comment is to be displayed, using the list box. (Example) Vertical: 2x  Horizontal: 2x

- 8 dots
- 16 dots
- 32 dots

Half-width character

- 16 dots
- 16 dots
- 32 dots

Full-width character

*Monitor device* Click on [Dev.] and then use the "Device Settings" dialog box to specify the bit device to be monitored.

*Dev.* If the comment is to be displayed when a bit device is turned ON/OFF, select the bit device using the spin box. If the comment is to be displayed when the bit number of a word device is turned ON/OFF, select the word bit using the spin box.

*NW No.*

*Station No.*

*Device Name*

*Device No.*

See Section 10.1, Setting Devices to for Monitoring.
2 Setting the Display Format

"Comment (ON)" Using the radio buttons, select whether a registered comment is to be displayed, or the comment "Comment (OFF)" about to be entered in the "Comment" box is to be displayed.

No. ........... This is used to display a comment that has already been registered. When "No." is selected, use the spin box to specify the number of the comment to be displayed. Clicking on [Browse] under "Comment indication" displays the "Comment List" dialog box, where the number of the comment to be displayed can be confirmed.

Direct ........... Select this to display the comment entered in the "Comment" box. Clicking on [Copy from ON] enables the contents specified with the ON comment to be copied. To select this directly, enter a comment in the Comment column.

See Section 12.1, Registering Comments to Display with the Comment Display Function.

"Outline font" When displaying comments entered directly in outline fonts, place an "X" in the check box. (Applicable only when the display size is set to double or larger size both vertically and horizontally.)

"Attribute" When a number has been selected using the above setting, place an "X" in the check box if you do not want to display the comment in the color and with the attributes entered when the comment was entered.

"Change attribute" If an "X" is placed in the box, enter the desired settings for the color and attributes under "Color", "Blink", and "Reverse".

"Color" Using the list box, select the color in which the comment is to be displayed.

"Blink" If a blinking display is to be used, select "Yes" in the list box.

"Rev." If a reversed display is to be used, select "Yes" in the list box.
3. Setting the display conditions
   See Section 10.4, Setting Display Conditions.

4. Setting the display position (display range)
   (1) When the settings for the various tabs have been entered, click on [OK] in any tab.
   (2) A dotted-line box is displayed at the upper left of the screen window.

   (3) Move the cursor to the position where the first letter of the comment is to be displayed (the upper left of the first letter), and click at that position. The image specified by the "OFF comment" will be displayed in the dotted-line box.

   (4) Move the cursor to a handle on the sprite setting frame, and press the left button of the mouse. Holding down the button, drag the mouse to the position marking the comment display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.

   (5) When the display range has been determined, release the left button of the mouse.
**Special Cases**

- How do I display a comment only when the bit device is ON or OFF?

  Use the **Display Format** tab to specify the conditions under which the comment is to be displayed (when ON or OFF).

  (Example) To display the comment only when the bit device is ON:
  
  Comment to be displayed: X0 is currently ON.

  ![Diagram showing display of comment when X0 is ON]

  Nothing is displayed when the bit device is OFF.

- What happens if the comment is longer than the specified display range?

  If the comment is longer than the display range in the horizontal direction, it will be displayed in a wrap-around display.

  Comment to be displayed: Line 1 is currently in operation

  ![Diagram showing wrap-around display]

  If the comment is longer than the display range in the vertical direction, only the part of the comment which fits in the display range is shown.

  Comment to be displayed: Line is currently stopped

  Press START button

  X1 is ON

  ![Diagram showing wrap-around display in vertical direction]

  The sentence "X1 is ON" will not be displayed.
12.3 Setting the Comment Display (Word) Function

- What does this function do?
  - This function is used to display comments corresponding to the value of the word device.

Example of Settings

Comment registered in “Comment List” dialog box

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Display color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current production quantity is 1.</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td>Current production quantity is 10.</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>100</td>
<td>Today’s production has been completed.</td>
<td>White</td>
<td>Reversed</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Preview comment no.”</td>
<td>Specify either 1, 5, or 100</td>
</tr>
<tr>
<td>“Size”</td>
<td>Vertical: 2 x; horizontal: 2 x</td>
</tr>
<tr>
<td>“Monitor device”</td>
<td>Word device: 0-FF-D100</td>
</tr>
<tr>
<td>Normal &quot;display format&quot;</td>
<td>Indirect</td>
</tr>
</tbody>
</table>

Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Trigger type”</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

**Basic**
- Setting of preview comment number
- Setting of display size
- Setting of monitor device
- Setting of display format

**Display Format**
- Setting of comparative equation used to switch display format

**Data Expression**
- Setting of equation for data expression

**Trigger**
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position (display range)

End

**Menu Bar**
Selected command
On Draw menu:
Message Display → Comment
**Description of settings**

1. Setting the **Basic** settings

   ![Configuration Screen]

   *Position*
   - X1: 0 Y1: 0 - X2: 15 Y2: 15
   - Preview comment
   - Size: V: 1 H: 1
   - Monitor device (Hex): 0-FF
   - Default: No.
   - Edit: Dev.
   - Help:

   "Preview comment no." Using the spin box, specify the number of the comment to be displayed when an image is displayed.

   ![See Section 20.2, Viewing an Image of the Created Screen Data.]

   "Size" Select the size in which the comment is to be displayed, using the list box.
   - (Example) Vertical: 2 x Horizontal: 2 x
   - 6 dots → 16 dots
   - 16 dots → 32 dots
   - Half-width character
   - 16 dots → 32 dots
   - Full-width character

   "Monitor device" Click on [Dev.] and then use the "Device Settings" dialog box to specify the bit device to be monitored.

   The "Device type" parameter for word devices is fixed at 16-bit with a sign.

   ![See Section 10.1, Setting Devices for Monitoring.]

   "Default" Click on [EDIT] and select "Indirect" using the radio button in the Edit Display Format dialog box.

   Using the radio button, select "Indirect". When "Indirect" is specified, nothing is displayed if the value of the word device is 0 or less. If a comparative equation is specified under [Display Format], the comment display format specified when the monitor device value or data expression result does not correspond to the comparative equation will be used.

   ![Image](currently_1_is_stored.png) → ![Image](monitor_device_value_0.png)

   When monitor device value is "1"
   When monitor device value is "0"
2 Setting “Data Expression”
   See Section 10.2, Setting Data Expressions (Other than Numeric Input Function).

3 Setting “Trigger”
   See Section 10.4, Setting Display Conditions.

4 Setting the display position (display range)
   (1) When the settings for the various tabs have been entered, click on OK in any tab.
   (2) A dotted-line box is displayed at the upper left of the screen window.

   ![Dotted-line box at upper left of screen window]

   (3) Move the cursor to the position where the first letter of the comment is to be displayed (the upper left of the first letter), and click at that position.

   ![Cursor at correct position]

   (4) The cursor changes to the size changing cursor. Press the left button of the mouse, and, holding down the button, drag the mouse to the position marking the comment display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.

   ![Cursor moved to correct display range]

   (5) When the display range has been determined, release the left button of the mouse.
5 Setting the Display Format

This is specified if the comment display format is to be switched when the monitor device value or the value resulting from the data expression reaches a certain value.

(1) Comments can be displayed in the following display formats, based on the comparative equation specified by “Display Range” and the monitor device value or the value resulting from the data expression.

No. ................ If the monitor device value or the value resulting from the data expression fits the comparative equation, the comment corresponding to the specified comment number is displayed.

Indirect ............. If the monitor device value or the value resulting from the data expression fits the comparative equation, the comment corresponding to the value is displayed.

No Processing ..... If the monitor device value or the value resulting from the data expression fits the comparative equation, the currently displayed comment continues to be displayed.

(2) The comparative equation for the display range is specified as follows.

<table>
<thead>
<tr>
<th>Type of comparative equation</th>
<th>Left</th>
<th>Operand</th>
<th>Middle</th>
<th>Operand</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>n1</td>
<td>&lt;=</td>
<td>$V</td>
<td>&lt;=</td>
<td>m1</td>
</tr>
<tr>
<td>Above</td>
<td>n2</td>
<td>&lt;=</td>
<td>$V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>$V</td>
<td>&lt;=</td>
<td>$3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify numeric values for n1, m1, n2, and $3.

"$V" indicates the monitor device value or the value resulting from the data expression.
Click on "Edit" and specify the display format and comparative equation in the "Edit Display Format" dialog box. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

"Comment indication" Using the radio buttons, select the display format in which the comment is to be displayed when the monitor device value or the value resulting from the data expression fits the comparative equation specified with the "Display Range" parameter.

No. .................... This is used to display the comment corresponding to the specified comment number. Clicking on [Browse] under "Comment indication" displays the "Comment List" dialog box, where the number of the comment to be displayed can be confirmed.

Indirect .................. Select this to display the comment for the comment number corresponding to the value.

No Processing ........... The currently displayed comment continues to be displayed.

"Change attribute" When a number has been selected with the "Comment indication" parameter, or "Indirect" has been selected, place an "X" in the check box if the comment is not to be displayed in the color and with the attributes specified when the comment was registered. Use the "Attribute" parameter to specify the display color and attributes of the comment.

"Attribute"

"Color" Using the list box, select the color in which the comment is to be displayed.

"Blink" If a blinking display is to be used, select "Yes" in the list box.

"Reverse" If a reversed display is to be used, place an "X" in the check box.

"Display range" Specify a comparative equation.

See Section 10.5, Setting Display Ranges (Comparative Equations).
(Example)

Case 1: No comment is displayed if the monitor device value is 0 or less ($V \leq 0$).
(Comment no.: Specify 0.)

Case 2: If the value of the monitor device is between 1 and 100 ($1 \leq V \leq 100$), the comment for the comment number corresponding to the monitor device value is displayed.

Case 3: If the value of the monitor device is between 101 and 199 ($101 \leq V \leq 199$), the currently displayed comment continues to be displayed.

Defit: If the monitor device value does not fit any of the above cases (the monitor device is 200 or above), the comment for comment number 101 is displayed.
Comment being registered

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Display color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current production quantity is 1.</td>
<td>White</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Current production quantity is 2.</td>
<td>White</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Production quantity has exceeded 100.</td>
<td>White</td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td>101</td>
<td>Today's production has been completed.</td>
<td>White</td>
<td>Reversed</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Case | Display range | Displayed comment  
--- | ------------- | ------------------- 
1   | $V<=0$       | No. 0               
2   | 1<=$V<=$100  | Indirect            
3   | 101<=$V<=$199 | No processing       

Normal | ☐ No. 101 | ☐ Indirect | ☐ No processing

---

Operation Procedure Outline

Specify the display format to be used if the value does not fit any of the specified comparative equations.

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box. The values for Left, Middle, and Right are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
12.4 Setting the Alarm List Display (System Alarms) Function

What does this function do?
- If an error occurs in the GOT, the PC CPU, or the data link or network, this function displays an error message.
- Use this function to detect communication errors.

Example of settings

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Object&quot;</td>
<td>System alarm</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 1 x; horizontal: 1 x</td>
</tr>
</tbody>
</table>

Useful Information before Setting the Alarm List (System Alarms) Function
- If the Y axis of the display range is set to 3 lines (which is different from the "Size" setting), separate error messages can be displayed if an error occurs in the PC CPU, the data link or network, or the GOT.

<table>
<thead>
<tr>
<th>Display range is set to 3 lines</th>
<th>Error message displayed if error occurs in PC CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Error message displayed if error occurs in data link/network</td>
</tr>
<tr>
<td></td>
<td>Error message displayed if error occurs in GOT</td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Selection of display contents for system alarm
- Setting of display size

See 1

After entering settings, click on "OK"

Setting of display position (display range)

See 2

End

The display condition for the alarm list display (system alarms) function is fixed at “___” (3 seconds). "Trigger" does not need to be specified.

Description of settings

1 Setting the (Basic) settings

[Image of setting screen]

12 - 24
"Object" Select the system alarm, using the radio button. The format in which system alarms are displayed is fixed.

<table>
<thead>
<tr>
<th>4 characters</th>
<th>48 characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error code</td>
<td>Warning message</td>
</tr>
<tr>
<td>Sequencer CPU error</td>
<td></td>
</tr>
<tr>
<td>Data link/network error</td>
<td></td>
</tr>
<tr>
<td>GOT error</td>
<td></td>
</tr>
</tbody>
</table>

If an error occurs in the GOT, the time at which the error occurred is also displayed. 8 characters

"Size" Select the size in which characters are to be displayed, using the list box.

<table>
<thead>
<tr>
<th>4 characters (32 dots)</th>
<th>48 characters (384 dots)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error code</td>
<td>Warning message</td>
</tr>
</tbody>
</table>

48 dots

Time of occurrence
8 characters (64 dots)

480 dots

2 Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on "OK" in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window.

(3) Move the cursor to the position where the first letter of the warning message (error code) is to be displayed (the upper left of the first letter), and click at that position.

(4) The cursor changes to the size changing cursor. Press the left button of the mouse, and, holding down the button, drag the mouse to the position marking the display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.
(5) When the display range has been determined, release the left button of the mouse.

---

**Special Cases**

- Causes of error messages and reference manuals

Errors occur in the following cases:

(1) The GOT detects an error pertaining to error code No. 300 or higher.

(2) An error code is stored in D9008 of the ACPU.

(3) An error code is stored in SD0 of the QnACPU.

(4) A special relay (M9200) for the data link has gone on.
   (The effective special relays are different for master stations and local stations.)

(5) A special relay (SB0000) for the network has gone on.

(6) Error codes and reference manuals

<table>
<thead>
<tr>
<th>Location where error occurs</th>
<th>Error code</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACPU</td>
<td>0 to 199 (value of D9008)</td>
<td>User's manual for the ACPU connected to the GOT</td>
</tr>
<tr>
<td>MNET/B, MNET (I)</td>
<td>200 to 299</td>
<td>Data link system reference manual for the MNET (I) or MNET/B (see explanation of special relays for links) *1</td>
</tr>
<tr>
<td>GOT</td>
<td>300 to 499</td>
<td>GOT User's Manual</td>
</tr>
<tr>
<td>MNET/10</td>
<td>500 to 799</td>
<td>Network system reference manual for the MNET/10 (see explanation of special relays for links) *2</td>
</tr>
<tr>
<td>QCPU</td>
<td>1000 to (value of SD)</td>
<td>User's manual for the QnACPU connected to the GOT</td>
</tr>
</tbody>
</table>

*1. See the section explaining the special link relay for (error code) + 9000 and handle the error accordingly. For example, if the error for error code (210) occurs, 210 + 9000 = 9210, so handle the error as described under M9210.

*2. See the section explaining the special link relay for (error code) - 500 and handle the error accordingly. For example, if the error for error code (510) occurs, 510 - 500 = 10, so handle the error as described under SB000A.
   (Special link relays are hexadecimal values, so decimal values should be converted to hexadecimal values.)
12.5 Setting the Alarm List Display (User Alarms) Function

What does this function do?

- This function is used to set up a correspondence between comments and several bit devices, and display the comments for bit devices which are on, in sequential order.

![Diagram of alarm list display function]

Above screen is displayed again

Screen switches to another screen

Order of occurrence is stored in memory
### Example of settings

Comments registered using the "Comment List" dialog box

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Display color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>X1 Check processed product</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>11</td>
<td>X2 Conveyor error</td>
<td>White</td>
<td>Reversed</td>
<td>No</td>
</tr>
<tr>
<td>12</td>
<td>X3 Inspect conveyor</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type&quot;</td>
<td>User</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>V: 2 x; H: 2 x</td>
</tr>
<tr>
<td>&quot;Comment No.&quot;</td>
<td>10</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>No. of points: 3/Bit device: 0-FF-X1</td>
</tr>
<tr>
<td>&quot;Storing device&quot;</td>
<td></td>
</tr>
</tbody>
</table>

#### Format

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number&quot;</td>
<td>Plural</td>
</tr>
<tr>
<td>&quot;Sort&quot;</td>
<td>Address</td>
</tr>
<tr>
<td>&quot;Option&quot;</td>
<td>&quot;Store memory&quot;</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Scroll on&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Display date&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Detailed display&quot;</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Action

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Sampling (3)</td>
</tr>
</tbody>
</table>
Outline of Procedure

- **Basic**
  - Setting of display contents
  - Setting of character size
  - Setting of number of head comment
  - Setting of monitor device
  - Setting of device where error occurrence is stored
  
  See [1]

- **Format**
  - Setting of number to be displayed
  - Setting of display order
  - Setting of options
  
  See [2]

- **Action**
  - Setting of detailed display number
  
  See [3]

- **Trigger**
  - Setting of display conditions
  
  See [4]

After entering settings, click on "OK" on any tab

Setting of display position (display range)

End

See [5]
Description of settings

1 Setting the **Basic** settings

```
<table>
<thead>
<tr>
<th>Type</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>O System</td>
<td>X1: 0 Y1: 0</td>
</tr>
<tr>
<td>User</td>
<td>X2: 32 Y2: 16</td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>Size</th>
<th>Comment No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>V: 1</td>
<td>1</td>
</tr>
<tr>
<td>H: 1</td>
<td></td>
</tr>
</tbody>
</table>
```

Monitor device($$)

Pls.: 1 0-FF

Storing device

0-FF

**"Type"**  Select the system alarm, using the radio button.

**"Size"**  Select the size in which the comment is to be displayed, using the list box.

(Example) Vertical: 2 x  Horizontal: 2 x

```
8 dots  16 dots  16 dots  32 dots
16 dots ➞  32 dots ➞  16 dots ➞  32 dots
Half-width character  Full-width character
```

**"Comment No."** Using the spin box, specify the number of the comment corresponding to the first bit device. With the alarm list display, blinking displays are not used even if "Yes" has been specified for "Blink" for the comment pertaining to that number.

See Section 20.2, Viewing an Image of the Created Screen Data.
*Monitor device* Using the spin box, specify the number of bit devices (up to 255 may be specified). Then click on "pts" and specify the bit device. If "1" is set as the number of devices, the "Set Device" dialog box will be displayed at this point. Specify the bit device.

If a value of 2 or more has been entered, the "Set Multiple Devices" dialog box will be displayed.

<table>
<thead>
<tr>
<th>Device</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0-FF</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0-FF</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0-FF</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0-FF</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0-FF</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0-FF</td>
<td></td>
</tr>
</tbody>
</table>

**Device type:** Bit

*Type* Using the list box, specify the data type (the specified bit of the bit or word device).

*Continuous* Using the radio button, select how the monitor device to be specified at this point is to be set.

*Random* Continuous ........ Starting with the specified device, devices will be specified continuously, up to the number of points specified.

Random ........... This enables the desired points to be specified individually.

Click on Edit to display the "Set Device" dialog box, and specify the word device to be monitored. If "Random" is selected, click on the column for the specified number, and then click on Edit.

See Section 10.1, Setting Devices for Monitoring.
"Storing device" Click on [Dev.], and in the "Device Setting" dialog box, specify the word device which identifies the number of bit devices that are currently on. The number of occurrences can be confirmed by displaying the specified device using the numeric display function.

![Numeric display of specified word device.]

2 Setting the (Format) settings

Using the radio buttons, specify whether several comments are to be displayed when on, in priority order, within the specified display range, or whether one comment is to be displayed.

Plural ...... Several comments are displayed in priority order.
Single...... Only one comment is displayed, in priority order.
"Sort"  Using the radio buttons, select whether comments which are ON are to be displayed in the order in which they went ON, or whether comments are to be displayed in the order of the bit devices which are ON, starting with the lowest number.
(Example)

<table>
<thead>
<tr>
<th>&quot;On&quot; order</th>
<th>Corresponding comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1: ON</td>
<td>2</td>
</tr>
<tr>
<td>X2: ON</td>
<td>3</td>
</tr>
<tr>
<td>X3: ON</td>
<td>1</td>
</tr>
</tbody>
</table>

If "Plural" is selected for "Number":

<table>
<thead>
<tr>
<th>Address</th>
<th>Oldest</th>
<th>Latest</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Display range" /></td>
<td><img src="image" alt="Display range" /></td>
<td><img src="image" alt="Display range" /></td>
</tr>
</tbody>
</table>

If "Single" is selected for "Number":

<table>
<thead>
<tr>
<th>Address</th>
<th>Oldest</th>
<th>Latest</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Display range" /></td>
<td><img src="image" alt="Display range" /></td>
<td><img src="image" alt="Display range" /></td>
</tr>
</tbody>
</table>
"option" If the screen is switched from the alarm list display screen to another screen and then back again, "Store memory" placing an "X" in the check box records the order of occurrences up until the previous display in the memory, and displays them.

(Example) When the display screen shows the oldest

When an "X" is placed in the "Store memory" check box

- When an "X" is placed in the "Store Memory" check box, up to 16 alarm list (user alarm) functions per project (total monitor device points: 512 points max.).
- If an "X" is placed in the "Store memory" check box, the setting for the display condition should be set to "Cycle".
- If the GOT has been reset, the power has been turned off, or the GOT has been connected to a computer and communications carried out, the data saved in the memory will be deleted.
When setting the scroll up (00F2+) and down (00F3+) switches on the screen window in order to switch the comment display, place an “X” in the check box.

* Be aware that if the above switch is set up, only one alarm list (user alarm) function can be set up on the screen.
* Be aware that if the above touch keys are set up the alarm history display function cannot be set on the same screen.
* Be aware that if the above touch keys are set up the data list display cannot be set up on the same screen.

(Example) Corresponding comment

| X1: ON | X1: Check Line 1 |
| X2: ON | X2: Check conveyor |
| X3: ON | X3: Please inspect |

Number: Plural; Sort: Number order

- Following switches are available as switches for alarm list (user alarm) other than the scroll up/down keys. Set them on the screen window as required.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>① Display/Erase Cursor key</td>
<td>Displays/erases the cursor for the alarm list display.</td>
</tr>
<tr>
<td>② Move Up/Down key</td>
<td>If the cursor for the alarm list display is not displayed, performs page up and down of the alarm content. If the cursor is being displayed, moves the cursor upward/downward.</td>
</tr>
<tr>
<td>③ Detailed Display key</td>
<td>Displays the detailed display screen of the selected alarm content.</td>
</tr>
</tbody>
</table>
1) Display/Erase Cursor keys for the alarm list display function
   - Key codes to set
     | Type               | Key code |
     |--------------------|----------|
     | Display Cursor key | FFB0H    |
     | Erase Cursor key   | FFB1H    |
   - Operation example

2) Move Up/Down key
   - Key codes to set
     | Type                         | Key code |
     |--------------------------------|----------|
     | Move Cursor Upward key        | FFB2H    |
     | Move Cursor Downward key      | FFB3H    |
   - Operation example (when the cursor is displayed)
Operation example (when the cursor is not displayed)

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>11:00:00</td>
</tr>
</tbody>
</table>

Move Downward

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:00:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
</tr>
</tbody>
</table>

Move Upward

Scrolls the alarm contents up and down.

- Take note that these switches function in reverse of the scroll up/down functions.

3) Detailed Display key

See next page.

"Display date" To display this when the specified bit device is on, place an "X" in the check box. The date/time display appears at the left of the Comment column. The date is shown at the left, followed by the time (this format is fixed and cannot be changed). Up to 20 characters can be displayed.

(Example)

96/07/07 09:30:40, Check Line 1

20 characters

If "Size" is set to Vertical: 1, Horizontal: 1, the size of a single character will be 16 x 8 dots (160 dots for 20 characters). Years are displayed two digits A.D., and times are displayed using the 24-hour format.

Be aware that monitoring of the date and time display may not be possible depending on the connection type of the GOT.

See Section 11.3, Setting the Clock Display Function.
"Detailed display" Using a radio button, select whether or not to display the detailed display screen of the bit device when "Number" is set to plural.

The detailed display screen is displayed using the detailed display key. The screen can also be displayed by touching on the alarm list display entry.

(Refer to 9 Action.)

Not display ............... Select when not displaying the detailed display.

Comment window ...... Select to display the screen window dedicated to the alarm list in order to display the comment corresponding to the specified comment number after the detailed display switch is turned on.

Window screen .......... Select to display the screen corresponding to the specified window screen number after the detailed display switch is turned on.

Base screen ............. Select to display the screen corresponding to the specified base screen number after the detailed display switch is turned on.

<table>
<thead>
<tr>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/07/07 09:30:00 X3 Inspect conveyor</td>
</tr>
<tr>
<td>97/07/07 10:30:00 X8 Check processed product</td>
</tr>
<tr>
<td>97/07/06 11:00:00 X5 Conveyor error</td>
</tr>
</tbody>
</table>

Key code: Set FF88h

- Comment display method when the comment window is selected

When the comment window is selected, comments will be displayed as follows.

- Character size of the comment is fixed to 1x vertical and 1x horizontal.
- Comments are displayed without highlight or blinking regardless of the setting at the time of registering the comments.
- The screen window dedicated for the alarm list cannot be displayed while the ten-key window for numeric input is being displayed. The ten-key display must be erased prior to carrying out the operation.
3 Setting the Action

This setting is made only when detailed display is performed.

"One touch" Using the radio button, select whether or not to display the detailed display screen with one-touch operation when executing detailed display.

Valid: Select if displaying the detailed display screen by touching on a display entry. (Specify the position of alarm list display by multiples of 16 dots.)

Invalid: Select if displaying the detailed display screen using the detailed display touch key. The key code for the detailed display is FFB84.

Even when the one-touch operation has been set to valid, the detailed display screen will be displayed if the detailed display key is entered.
12. Setting the Message Display Function

<table>
<thead>
<tr>
<th>Message</th>
<th>Time</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/07/07 09:30:00</td>
<td>X3</td>
<td></td>
<td>Inspect conveyor</td>
</tr>
<tr>
<td>97/07/07 10:30:00</td>
<td>X8</td>
<td></td>
<td>Check processed product</td>
</tr>
<tr>
<td>97/07/08 11:00:00</td>
<td>X5</td>
<td></td>
<td>Conveyor error</td>
</tr>
</tbody>
</table>

Detailed display is displayed.

Key code: Set FFB8h
"Display No." Using the radio button, select how to set up the comment number/window screen number/base screen number for the detailed display to be specified.

Cont. ......... Select when setting with continuous numbers starting with the comment number/window screen number/base screen number to be specified.

Random..... Select when setting one point at a time.

"Disp. No." Enter to the "Disp. No." field the comment number/window screen number/base screen number which correspond to the monitor device specified.

(Example 1) When the setting is carried out as follows:

Monitor device: M0; Number of points: 5 points; Destination of detailed display: Window screen; Detailed Display No.: Cont.; Disp. No.:5

<table>
<thead>
<tr>
<th>No.</th>
<th>Disp. No.</th>
<th>Display content</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>When the comment display entry corresponding to M0 is pressed or input by key, the screen of the window screen 5 will be displayed.</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>When the comment display entry corresponding to M1 is pressed or input by key, the screen of the window screen 6 will be displayed.</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>When the comment display entry corresponding to M2 is pressed or input by key, the screen of the window screen 7 will be displayed.</td>
</tr>
<tr>
<td>4</td>
<td>8</td>
<td>When the comment display entry corresponding to M3 is pressed or input by key, the screen of the window screen 8 will be displayed.</td>
</tr>
<tr>
<td>5</td>
<td>9</td>
<td>When the comment display entry corresponding to M4 is pressed or input by key, the screen of the window screen 9 will be displayed.</td>
</tr>
</tbody>
</table>

(Example 2) When the setting is carried out as follows:

Monitor device: M10; Number of points: 4 points; Destination of detailed display: Comment window; Detailed Display No.: Cont.; Disp. No.:1

<table>
<thead>
<tr>
<th>No.</th>
<th>Disp. No.</th>
<th>Display content</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>When the comment display entry corresponding to M10 is pressed or input by key, the screen dedicated to the alarm list will be displayed, then the comment for the comment number 1 registered in the dedicated screen will be displayed.</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>When the comment display entry corresponding to M11 is pressed or input by key, the screen dedicated to the alarm list will be displayed, then the comment for the comment number 2 registered in the dedicated screen will be displayed.</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>When the comment display entry corresponding to M12 is pressed or input by key, the screen dedicated to the alarm list will be displayed, then the comment for the comment number 3 registered in the dedicated screen will be displayed.</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>When the comment display entry corresponding to M13 is pressed or input by key, the screen dedicated to the alarm list will be displayed, then the comment for the comment number 4 registered in the dedicated screen will be displayed.</td>
</tr>
</tbody>
</table>
4 Setting the Trigger

See Section 10.4, Setting Display Conditions.

5 Setting the display position (display range)

1. When the settings for the various tabs have been entered, click on OK in any tab.

2. A dotted-line box is displayed at the upper left of the screen window.

3. Move the cursor to the position where the first letter of the comment is to be displayed (the upper left of the first letter), and click at that position.

4. The cursor changes to the size changing cursor. Press the left button of the mouse, and, holding down the button, drag the mouse to the position marking the comment display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.

5. When the display range has been determined, release the left button of the mouse.

- When multiple displays have been selected, please be aware that comments cannot be wrapped at the ends of lines if the comment is longer than the display range. The display range should be taken into consideration when specifying comments.
- If the one-touch operation has been set to valid with the Action setting, set the display position of the alarm list to a multiple of 16 dots.
Chapter 13

Setting Moving Screen Display Functions
13. Setting Moving Screen Display Functions

13.1 Registering Parts (Graphics) Displayed in the Parts Display and Parts Movement Display

This section explains how to register parts (graphics) displayed on the GOT in the parts display and parts movement display functions.

13.1.1 Useful Information When Utilizing and Registering Parts

- Of the 32,767 part numbers, up to 15,000 types of parts can be registered.
- Graphic data in the BMP format can be registered as a part.
- The memory capacity for registered parts is the same as that when the graphic is drawn.

- Parts graphics should be drawn using a line width of 1 dot. If graphics are drawn using a line width of 2 or more dots, there may be times when the graphics are not displayed on the GOT using the specified line width.
  If graphics with a line width of 2 or more dots are to be displayed as parts, they should be registered by combining graphics drawn with a line width of 1 dot.

- To display parts for part numbers corresponding to the values of word devices (indirectly specified parts) with the parts display and parts movement display functions, register the part for the part number corresponding to the value.

(Example) Displaying [ ] when the value of D100 is "1"

(Example) Displaying the solid black part when the value of D100 is "100"
13.1.2 Registering Parts

When is this function used?
- This function is used when you want to register parts to be displayed in the parts display and parts movement display functions.

1. Draw the figure to be registered, and add handles.


3. The “Parts” dialog box is displayed. Click at the position where the part number to be registered is displayed. Then click on [Write].

   If the part number to be registered is not displayed, use the “Part No.” spin box to specify the part number to be registered, and click on [Jump].

4. The “Name” dialog box is displayed. Enter the name of the part in the text box.

   Click on [OK]. The part is registered for the specified part number.

5. The display returns to the screen window, where registered graphics can be deleted. To change a part that has been registered, register the part following the change once again, for the part number that has been changed.
13.1.3 Reading Out Registered Parts

- When is this function used?
  
  - This function is used when you want to read out a registered part in the screen window and check it.

   The “Parts” dialog box is displayed.

2. Click at the position where the part number to be read is displayed. You can also click on [Image], and when the “Select Image” dialog box is displayed, click on the position at which the part number being read out is to be displayed.
   Click on [Read].
   Clicking on “Select” in the “Select Image” dialog box returns the display to the “Parts” dialog box.

3. The image of the part is displayed at the upper left of the screen window.

4. Move the cursor and click at the position where the image is to be placed.
13.1.4 Deleting Registered Parts

When is this function used?

- This function is used when you want to delete a part that has been registered.


2. The "Parts" dialog box is displayed. Click at the position where the part number to be deleted is displayed. Then click on [Delete].

   To check what type of part is being deleted, click on [Image].
   This displays the "Select Image" dialog box, where the part can be confirmed.

   Clicking on [Select] in the "Select Image" dialog box returns the display to the "Parts" dialog box.

3. The specified part is deleted.

   After the part has been deleted, click on [Close].
13.1.5 Changing a Part Name Assigned When a Part was Registered

When is this function used?

- This function is used to change the name which has been assigned to a part.


2. The "Parts" dialog box is displayed. Click at the position where the part number to be changed is displayed. Then click on [Rename].

3. The "Name" dialog box is displayed. Enter the new part name in the text box, and click on [OK].

4. The "Parts" dialog box is displayed, showing the changed name.

When the name change has been completed, click on [Close].
### 13.2 Setting the Parts Display (Bit) Function

**What does this function do?**
- This function is used to display a part in accordance with the ON/OFF status of a bit device.

---

**Example of settings**

Part registration

<table>
<thead>
<tr>
<th>Part No. 1</th>
<th>Part No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Part 1" /></td>
<td><img src="image2.png" alt="Part 2" /></td>
</tr>
</tbody>
</table>

**Basic**

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Preview part&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Center</td>
</tr>
<tr>
<td>&quot;Display mode&quot;</td>
<td>Replace</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-X0</td>
</tr>
</tbody>
</table>
### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ON&quot; &quot;No.&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;OFF&quot; &quot;No.&quot;</td>
<td>2</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
</tbody>
</table>

### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

---

#### Tool Bar 1

- Selected icon: ![SP] → [Part Disp]

#### Menu Bar

- Selected command: On Draw menu:
  - [Animation Display] → [Part Display]

---

### Outline of Procedure

1. **Basic**
   - Setting of preview comment number
   - Setting of positioning
   - Setting of display mode
   - Setting of monitor device
   - See 1

2. **Display Format**
   - Setting of number of part to be displayed
   - Setting of attribute (blinking)
   - See 2

3. **Trigger**
   - Setting of display conditions
   - See 3

4. After entering settings, click on "OK" on any tab
   - Setting of display position (display range)
   - See 4

---

13 - 7
Description of settings

1 Setting the (Basic) settings

“Preview part no.” This setting is used to display the part of the specified number as an image. Specify the part number to be displayed in the spin box.

See Section 20.2, Viewing an Image of the Created Screen Data.

“Positioning” Using the radio buttons, specify how the part is to be displayed in relation to the specified display position.

(Example) Positioning: Left - Top

The part is displayed with its top left corner at the specified display position.

Specified display position

Specified display position

Specified display position
(Example) Positioning: Center
The part is displayed with its center at the specified display position.

"Display mode" Using the radio buttons, select how the part is to be displayed if there is a canvas graphic at the display position, and how it is to be displayed based on the on/off status of the bit device.
Replace ...... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead.
When parts are changed, the currently displayed part is deleted, and a new one is displayed in its place.

Overwrite .......... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead.
When parts are changed, the new part is superimposed on top of the one currently displayed.
XOR............. If there is a canvas graphic at the display position, the canvas graphic and the part are superimposed in an XOR reversed display.

When parts are changed, the currently displayed part is deleted, and the new part is displayed in its place.

- XOR color combinations when using single colors

<table>
<thead>
<tr>
<th>black</th>
<th>blue</th>
<th>red</th>
<th>purple</th>
<th>green</th>
<th>bulle-green</th>
<th>yellow</th>
<th>white</th>
<th>dark blue</th>
<th>dark red</th>
<th>dark purple</th>
<th>dark green</th>
<th>dark blue</th>
<th>dark yellow</th>
<th>beige</th>
</tr>
</thead>
<tbody>
<tr>
<td>black</td>
<td>blue</td>
<td>red</td>
<td>purple</td>
<td>green</td>
<td>bulle-green</td>
<td>yellow</td>
<td>white</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>blue</td>
<td>black</td>
<td>purple</td>
<td>red</td>
<td>green</td>
<td>bulle-green</td>
<td>yellow</td>
<td>white</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>red</td>
<td>purple</td>
<td>black</td>
<td>blue</td>
<td>green</td>
<td>bulle-green</td>
<td>yellow</td>
<td>white</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>blue</td>
<td>green</td>
<td>dark red</td>
<td>dark blue</td>
<td>black</td>
<td>beige</td>
<td>dark yellow</td>
<td>dark green</td>
<td></td>
</tr>
<tr>
<td>green</td>
<td>blue-green</td>
<td>yellow</td>
<td>white</td>
<td>black</td>
<td>blue</td>
<td>red</td>
<td>purple</td>
<td>dark blue</td>
<td>green</td>
<td>dark yellow</td>
<td>beige</td>
<td>black</td>
<td>dark yellow</td>
<td>dark green</td>
</tr>
<tr>
<td>blue-green</td>
<td>green</td>
<td>white</td>
<td>yellow</td>
<td>blue</td>
<td>black</td>
<td>purple</td>
<td>red</td>
<td>dark green</td>
<td>beige</td>
<td>dark blue</td>
<td>black</td>
<td>purple</td>
<td>dark purple</td>
<td>dark red</td>
</tr>
<tr>
<td>yellow</td>
<td>white</td>
<td>green</td>
<td>blue</td>
<td>green</td>
<td>red</td>
<td>purple</td>
<td>black</td>
<td>blue</td>
<td>beige</td>
<td>dark yellow</td>
<td>dark green</td>
<td>dark blue</td>
<td>red</td>
<td>dark purple</td>
</tr>
<tr>
<td>white</td>
<td>yellow</td>
<td>blue-green</td>
<td>green</td>
<td>purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>dark yellow</td>
<td>dark blue</td>
<td>dark green</td>
<td>dark purple</td>
<td>black</td>
<td>blue</td>
<td>yellow</td>
</tr>
<tr>
<td>dark blue</td>
<td>black</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>dark purple</td>
<td>black</td>
<td>blue</td>
<td>purple</td>
<td>red</td>
<td>blue-green</td>
<td>green</td>
<td>white</td>
</tr>
<tr>
<td>dark purple</td>
<td>dark red</td>
<td>dark purple</td>
<td>black</td>
<td>dark blue</td>
<td>dark yellow</td>
<td>beige</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>purple</td>
<td>black</td>
<td>blue</td>
<td>yellow</td>
<td>white</td>
<td>green</td>
</tr>
<tr>
<td>dark green</td>
<td>dark blue</td>
<td>dark purple</td>
<td>black</td>
<td>dark blue</td>
<td>dark yellow</td>
<td>beige</td>
<td>black</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>purple</td>
<td>black</td>
<td>blue</td>
<td>yellow</td>
<td>white</td>
</tr>
<tr>
<td>dark blue</td>
<td>dark purple</td>
<td>black</td>
<td>dark yellow</td>
<td>blue</td>
<td>dark blue</td>
<td>black</td>
<td>dark yellow</td>
<td>green</td>
<td>white</td>
<td>yellow</td>
<td>blue</td>
<td>black</td>
<td>purple</td>
<td>red</td>
</tr>
<tr>
<td>dark yellow</td>
<td>beige</td>
<td>dark blue-green</td>
<td>dark red</td>
<td>dark red</td>
<td>dark purple</td>
<td>black</td>
<td>dark blue</td>
<td>black</td>
<td>green</td>
<td>white</td>
<td>yellow</td>
<td>blue</td>
<td>black</td>
<td>purple</td>
</tr>
<tr>
<td>beige</td>
<td>dark yellow</td>
<td>green</td>
<td>purple</td>
<td>red</td>
<td>dark blue</td>
<td>black</td>
<td>dark blue</td>
<td>black</td>
<td>yellow</td>
<td>blue-green</td>
<td>green</td>
<td>purple</td>
<td>red</td>
<td>blue</td>
</tr>
</tbody>
</table>
"Monitor device" Click on [Dev.], and specify the bit device to be monitored in the "Device Setting" dialog box.

"Dev." When parts are being displayed in accordance with the on/off status of the bit device, select the bit device with the list box, and when parts are being displayed in accordance with the on/off status of the word device bit number, select the bit of the word with the list box.

"NW No."
"Station No." 
"Device name"
"Device number"

See Section 10.1, Setting Devices for Monitoring.

2 Setting the Display Format

Using the spin box, select the part number to be displayed.

Using the list box, select "Yes" to specify a blinking display.

If [Browse] is clicked, the "Select on Image" dialog box will be displayed, in which the registered parts can be confirmed.

See Section 13.1, Registering Parts (Graphics) Displayed in the Parts Display and Parts Movement Display.
3 Setting the display conditions

See Section 10.4, Setting Display Conditions.

4 Setting the display position

(1) When the settings for the various tabs have been entered, click on OK in any tab.

(2) The dotted-line box will be displayed to the top left corner of the screen window.

(3) Move the cursor to the position at which the part is to be displayed, and click at that position.

The image of the part specified as the "OFF" part will be displayed in the dotted-line box.

Specify a display position which enables all of the part specified with the "Preview part" parameter and one other part to be displayed.

If "Left - Top" is specified for the "Positioning" parameter, the coordinates of this position (the center of the sprite setting frame) will be set.

If "Center" is specified for the "Positioning" parameter, the coordinates of this position will be set.
Special Cases

- How do I display a part only when the bit device is ON/OFF?

Use the [Display Format] tab to specify the conditions under which the part specification No. 0 is to be displayed (when ON/OFF).

(Example) To display the part only when the bit device is ON:

Comment to be displayed: X0 is currently ON.

<table>
<thead>
<tr>
<th></th>
<th>Part specification</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>No. 1</td>
<td>No</td>
</tr>
<tr>
<td>OFF</td>
<td>No. 0</td>
<td>No</td>
</tr>
</tbody>
</table>

Nothing is displayed when the bit device is off. Canvas graphic text

When the bit device is on, the specified part is displayed.
Part (When "XOR" is set for display mode)
13.3 Setting the Parts Display (Word) Function

What does this function do?

- This function is used to display a part in accordance with the on/off status of a word device.

---

Example of settings

Part registration

<table>
<thead>
<tr>
<th>Part No. 1</th>
<th>Part No. 10</th>
<th>Part No. 100</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Preview part&quot;</td>
<td>100</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Center</td>
</tr>
<tr>
<td>&quot;Display mode&quot;</td>
<td>Replace</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td>&quot;Normal&quot;</td>
<td>&quot;Part&quot;</td>
</tr>
<tr>
<td></td>
<td>Indirect</td>
</tr>
<tr>
<td></td>
<td>&quot;Attribute&quot; Blink</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Setting of preview comment number
- Setting of positioning
- Setting of display mode
- Setting of monitor device
- Setting of parts display format

NO

Change display color when monitor device reaches a certain value?

Display Format
- Setting of comparative equation to be used to switch parts display format

YES

Is data expression to be specified?

NO

Data Expression
- Setting of equation for data expression

YES

Trigger
- Setting of display conditions

See 1

See 5

See 2

See 3

After entering settings, click on "OK" on any tab

Setting of display position

See 4

End
**Description of settings**

1. **Setting the (Basic) settings**

![Screenshot of the Part Display window](image)

"Preview part" Using the spin box, specify the number of the part to be displayed when an image is displayed.

See Section 20.2, Viewing an Image of the Created Screen Data. When setting the display position, the part for the part number specified by the "Preview part" parameter can be displayed as an image while positioning is being carried out.

"Positioning" Using the radio buttons, specify how the part is to be displayed in relation to the specified display position.

(Example) Positioning: Left - Top

The part is displayed with its top left corner at the specified display position.
(Example) Positioning: Center
The part is displayed with its center at the specified display position.

"Display mode" Using the radio buttons, select how the part is to be displayed if there is a canvas graphic at the display position, and how it is to be displayed based on changes in the value of the word device. Replace ...... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead.

When parts are changed, the currently displayed part is deleted, and a new one is displayed in its place.

Overwrite .... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead.

When parts are changed, the new part is superimposed on top of the one currently displayed.
XOR............. If there is a canvas graphic at the display position, the canvas graphic and the part are superimposed in an XOR reversed display.

See Section 13.2, Setting the Parts Display (Bit) Function.

"Monitor device" Click on [Dev], and specify the word device to be monitored in the "Device Setting" dialog box. See Section 10.1, Setting Devices for Monitoring.

"Default" Click on [Edit], and specify the parts display format in the "Edit Display Format" dialog box.

"Display format" Using the radio button, select "Indirect".

If a comparative equation is being specified using [Display Format], this setting is effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

"Attribute" "Blink" If the part is to be shown in a blinking display, select "Yes" in the list box.
2 Setting the [Data Expression]
   See Section 10.2, Setting Data Expressions (Other than Numeric Input Function).

3 Setting the [Trigger]
   See Section 10.4, Setting Display Conditions.

4 Setting the display position
(1) When the settings for the various tabs have been entered, click on [OK] in any tab.
(2) The image of the part specified with the "Preview part" parameter is displayed at the upper left of the screen window.

(3) Move the cursor to the position at which the part is to be displayed, and click at that position.
   Specify a display position which enables all of the parts other than those specified with the "Preview part" parameter to be displayed.

If "Center" is specified for the "Positioning" parameter, the coordinates of this position (the center of the sprite setting frame) will be set.
If "Left - Top" is specified for the "Positioning" parameter, the coordinates of this position will be set.
5 Setting the **Display Format**

This is specified if the part display format is to be switched when the monitor device value or the value resulting from the data expression reaches a certain value.

(1) Parts can be displayed in the following display formats, based on the comparative equation specified by “Display Range” and the monitor device value or the value resulting from the data expression.

- **No.** ................. If the monitor device value or the value resulting from the data expression fits the comparative equation, the part corresponding to the specified part number is displayed.
- **Indirect.** ............. If the monitor device value or the value resulting from the data expression fits the comparative equation, the part corresponding to the value is displayed.
- **No Processing.** ...... If the monitor device value or the value resulting from the data expression fits the comparative equation, the currently displayed part continues to be displayed.

(2) The comparative equation for the display range is specified as follows.

<table>
<thead>
<tr>
<th>Type of comparative equation</th>
<th>Left</th>
<th>Operand</th>
<th>Middle</th>
<th>Operand</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>n1</td>
<td>&lt;=</td>
<td>$V</td>
<td>&lt;=</td>
<td>m1</td>
</tr>
<tr>
<td>Above</td>
<td>n2</td>
<td>&lt;=</td>
<td>$V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>$V</td>
<td>&lt;=</td>
<td>23</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify numeric values for n1, m1, n2, and 23.

“$V” indicates the monitor device value or the value resulting from the data expression.
Click on [Edit] and specify the parts display format and comparative equation in the "Edit Display Format" dialog box. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

**Parts indication**

Using the radio buttons, select the display format in which the part is to be displayed when the monitor device value or the value resulting from the data expression fits the comparative equation specified with the "Display Range" parameter.

No. .................. This is used to display the part corresponding to the specified part number.

Specify the number of the part to be displayed, using the spin box.

If [Browse] is clicked when specifying No., the "Select on Image" dialog box, in which the registered parts can be confirmed, will be displayed.

See Section 13.1, Registering Parts (Graphics) Displayed in the Parts Display and Parts Movement Display.

Indirect .................. Select this to display the part for the part number corresponding to the value.

No Processing ...... The currently displayed part continues to be displayed.

**Attribute**

**Blink**

If the part is to be shown in a blinking display, select "Yes" in the list box.

**Display range**

Specify a comparative equation.

See Section 10.5, Setting Display Ranges (Comparative Equations).
(Example)

Case 1: No part is displayed if the monitor device value is 0 or less ($V \leq 0$).

(Part no.: Specify 0.)

Case 2: If the value of the monitor device $i$ between 1 and 100 ($1 < V < 100$), the part for the part number corresponding to the monitor device value is displayed.

Case 3: If the value of the monitor device is between 101 and 199 ($101 \leq V \leq 199$), the currently displayed part continues to be displayed.

Default: If the monitor device value doesn't fit any of the above cases (the monitor device is 200 or above), the part for part number 101 is displayed.
Part being registered

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Parts indication</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$V&lt;=0</td>
<td>No. 0</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>1&lt;=$V&lt;=100</td>
<td>Indirect</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>101&lt;=$V&lt;=199</td>
<td>No processing</td>
<td>No</td>
</tr>
</tbody>
</table>

Default: Parts indication: Part No.101
          Blinking: Yes

When monitor device value does not fit the above cases.

The "Default" value is set under the [Basic] tab settings.

---

**Operation Procedure Outline**

**Display Format**

Edit → OK

**Edit Display Format**

Left / Middle / Right → OK

**Input Expression**

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box.

The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
13.4 Setting the Parts Movement Display Function

- What does this function do?
  - This function is used to change the display position of the parts display function described in Sections 13.2 and 13.3, based on the values of two word devices.
  - It can also be used to change (movement display) a specified (fixed) part based on the values of two word devices.

---

**Examples of settings**

Registration of part

Part No. 10

---

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Position device&quot;</td>
<td>D100, D101</td>
</tr>
<tr>
<td>&quot;Parts switching&quot;</td>
<td>Fixed</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Center</td>
</tr>
<tr>
<td>&quot;Display mode&quot;</td>
<td>Shift</td>
</tr>
<tr>
<td>&quot;Default&quot;</td>
<td>&quot;Parts indication&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Attribute&quot;</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Setting of position device
- Setting of parts switching format

Select "Word" for "Parts switching"

- Setting of positioning
- Setting of display mode
- Setting of monitor device
- Setting of parts display format

Should parts display format be switched when monitor device value reaches a certain value?

Display Format
- Set comparative equation to be used for parts display format

YES

Is data expression to be set?

Data Expression
- Set equation for data expression

NO

Trigger
- Set display conditions

When settings have been completed, click on "OK" on any tab

End

Select "Bit" for "Parts switching"

- Setting of positioning
- Setting of display mode
- Setting of monitor device

Basic

Display Format
- Set number of part to be displayed
- Set attribute (blink)

YES

Select "Fixed" for "Parts switching"

- Setting of positioning
- Setting of display mode

Basic

Trigger
- Set display conditions

When settings have been completed, click on "OK" on any tab

End
Description of settings

1 Setting the Basic settings

"Position device" Click on Dev., and in the "Device Settings" dialog box, specify the word device to be used to change the position at which the part is displayed.

See Section 10.1, Setting Devices for Monitoring.

(Example) If the specified device is D100:
Device which determines the X coordinate ....... D100
Device which determines the Y coordinate ....... D101
The specified device +1 serves as the device which determines the Y coordinate.

"Parts switching" Using the radio buttons, select the parts display where the parts movement display is to be carried out.

Word .... Select this if the movement display is to be carried out with the parts display (word) function described in Section 13.2.
Bit ......... Select this if the movement display is to be carried out with the parts display (bit) function described in Section 13.3.
Fixed ...... Select this if the movement display is to be carried out using only one type of part.
"Positioning" Use the radio buttons to select how the part is to be displayed in relation to the coordinate position corresponding to the values of the word device specified with the "Position device" parameter.

(Example) Positioning: Top - Left

X coordinate: (Word device value 280)
Y coordinate: (Word device value 260)

The part is displayed so that its upper left is at the coordinate position corresponding to the values of the position device.

Positioning: Center

X coordinate: (Word device value 280)
Y coordinate: (Word device value 260)

The part is displayed so that its center is at the coordinate position corresponding to the values of the position device.

Using the radio button, select whether the trace pattern is to be retained each time the part figure is moved, or whether the previously displayed figure is to be deleted each time the part figure is moved.
"Monitor device" If the movement is being carried out with the parts display (word) function, specify the word device. If it is being carried out with the parts display (bit) function, specify the bit device.

See Section 10.1, Setting Devices for Monitoring.

"Normal"

Under "Change Display Format", click on [EDIT] to specify "Word" or "Fixed", and then, in the Edit Display Format dialog box, specify the method by which parts are to be displayed.

"Part display format" If "Fixed" is selected under "Change Display Format", use the radio button to select the number, and specify the number of the part to be displayed, using the spin box.

If "Word" is selected under "Change Display Format", the operation is the same as specifying the parts display (word) function.

See Section 13.3, Setting the Parts Display (Word) Function.

"Attribute"

"Blink" If the part is to be shown in a blinking display, select "Yes" in the list box.

Setting [Display Format], [Data Expression], and [Trigger]

If "Word" has been selected with the "Parts switching" parameter, the setting procedure is the same as that for the parts display (word) function. If "Bit" has been selected, the setting procedure is the same as that for the parts display (bit) function.

See Section 13.2, Setting the Parts Display (Bit) Function.

See Section 13.3, Setting the Parts Display (Word) Function.

Setting the display position

- The device for the display position is specified using the "Position device" parameter, so there is no setting for the display position, as there is with other sprites.

- No sprite setting box is displayed in the screen window after the parts movement display has been specified. If data is to be edited, use the "Edit Sprite" dialog box to make the changes.

- Please be aware that the parts movement display will not be displayed even if an image display is used.
Special Cases

• What happens if a value is stored for the position device which cannot be displayed on the GOT?

If none of the values stored in the position device can be used to display parts, the previous parts display will continue to be displayed.

(Example)  A870GOT

- X coordinate: (Word device value 40)
  Y coordinate: (Word device value 40)

- X coordinate: (Word device value 1000)
  Y coordinate: (Word device value 500)

- X coordinate: (Word device value 240)
  Y coordinate: (Word device value 200)

- X coordinate: (Word device value 10)
  Y coordinate: (Word device value 50)

Previous parts display is continued

- X coordinate: (Word device value 560)
  Y coordinate: (Word device value 50)

Previous parts display is continued

No parts can be displayed

- What happens if a display overlaps with other sprites?

Move part display
Numeric display

Numeric display is hidden.

The part display is hidden by the update timing of the numeric display.
13.5 Setting the Lamp Display (Bit) Function

What does this function do?
- This function turns lamps on and off, based on whether the bit device is ON/OFF.

Example of settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-Y70</td>
</tr>
<tr>
<td></td>
<td>&quot;Shape&quot;</td>
<td>&quot;Type&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lamp 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;ON&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td></td>
<td>&quot;Text&quot; White</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Set text&quot; Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Text&quot; Lamp 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Horizontal alignment&quot;</td>
<td>5 dots</td>
</tr>
<tr>
<td></td>
<td>&quot;Vertical alignment&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;OFF&quot;</td>
<td>&quot;Color&quot; Black</td>
</tr>
<tr>
<td></td>
<td>&quot;Text&quot; White</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Set text&quot; Top</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Text&quot; Lamp 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Horizontal alignment&quot;</td>
<td>5 dots</td>
</tr>
<tr>
<td></td>
<td>&quot;Offset&quot;</td>
<td></td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Setting of monitor device
- Setting of lamp graphic

Display Format
- Setting of color in which lighted lamp graphic is to be displayed
- Setting of attributes for lamp graphic
- Setting of text display color
- Setting of text display position
- Input of text to be displayed

Setting of display position

See 1

See 2

See 3

End

The display conditions for the lamp display function are fixed at the default values. When specifying data, there are no settings to be entered under Trigger.
Description of settings

1 Setting the Basic settings

"Monitor device" Click on Dev., and specify the bit device to be monitored in the "Device Setting" dialog box.

"Dev." When the lamp is being turned on and off in accordance with the ON/OFF status of the bit device, select the bit device with the list box, and when the lamp is being turned on and off in accordance with the ON/OFF status of the word device bit number, select the word with the list box.

"NW No." "Station No." "Device name" "Device number"

See Section 10.1, Setting Devices for Monitoring.

"Shape" Click on Select to display the "Shape Select" dialog box.

Click on the lamp figure to be displayed.
"ON" "OFF"

"Lamp" Select the color in which the lamp is to be displayed, using the list box.

"Text" If text is to be displayed on the lamp, select the color in which the text is to be displayed, using the list box.

"Blink" If a blinking display is to be used for the lamp graphic and text, select "Yes" in the list box.

"Text" If text is to be displayed on the lamp, select the position at which the text is to be displayed.

<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
<th>Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td></td>
<td>Text</td>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

After the display position for the text has been selected, specify the positioning for the text. Click on [Edit], and when the "Text" dialog box is displayed, specify the text to be displayed and the positioning.

With lamp graphics, text can be displayed at the left, right, top, bottom, or center of the lamp. To delete the specified contents, click on [Delete].

Clicking on [Copy from ON] enables the specified contents to be copied when on.

"H, V" Select the size for lamp text characters from the list box.

"Outline font" Place an "X" in the check box to display the lamp text in outline fonts. (Available only when the character size is set to double or larger size both vertically and horizontally.)
"Text"  Input the text to be displayed. If text is to be displayed in several lines, input \n after each line.

"Horizontal alignment"  Select the horizontal positioning of the text, using the command button.

"Vertical alignment"  Select the vertical positioning of the text, using the command button.

"Offset"  Using the spin box, specify the number of dots by which the lamp graphic and the text are to be separated. A maximum of 100 dots can be specified.

(Example 1) Text setting: Top / Horizontal alignment: ▶️ / Offset: 5 dots

(Example 2) Text setting: Right / Vertical alignment: ▓ / Offset: 5 dots

(Example 3) Text setting: Center / Horizontal alignment: ▶️ / Vertical alignment: ▓

*** indicates the input text.
3 Setting the display position

(1) When the settings for the various tabs have been entered, click on "OK" in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, indicating the size of the lamp graphic.

(3) Move the cursor to the position where the lamp is to be displayed, and click at that position.

(4) Specify the lamp display size. (Possible to change the size in dot units.)

To change the size by altering the vertical and horizontal proportions, change while holding down the Shift key.

Do not change the size of a lamp graphic to a 32-dot square or smaller. The lamp graphic will not be displayed correctly.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Coner Axis).
13.6 Setting the Lamp Display (Word) Function

What does this function do?

- This function changes the color in which the lamp lights, based on the value of the word device.

Example of settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td></td>
<td>&quot;Shape&quot;</td>
<td>&quot;Size&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Default&quot;</td>
<td>&quot;Lamp color&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Text color&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Blink&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Text&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Text&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Horizontal alignment&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Offset&quot;</td>
</tr>
</tbody>
</table>
### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Case 1&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>$V=0</td>
</tr>
<tr>
<td>&quot;Lamp color&quot;</td>
<td>Black</td>
</tr>
<tr>
<td>&quot;Text color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Bottom</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Not lighted</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>▶️</td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
<tr>
<td>&quot;Case 2&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>1≤$V≤100</td>
</tr>
<tr>
<td>&quot;Lamp color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Text color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Top</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Lighted</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>▶️</td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
</tbody>
</table>

---

### Outline of Procedure

**Basic**

- Setting of monitor device
- Setting of lamp graphic
- Setting of default lamp graphic display format

**Display Format**

- Setting of display range (comparative equation)
- Setting of color in which lighted lamp graphic is to be displayed
- Setting of attributes for lamp graphic
- Setting of text display color
- Setting of text display position
- Input of text to be displayed

SEE [1]

SEE [2]

(continued on next page)
The display conditions for the lamp display function are fixed at the default values. When specifying data, there are no settings to be entered under Trigger.

**Description of settings**

1. **Setting the Basic settings**

![Diagram showing the Basic settings interface]

- **Position**
  - X: 0
  - Y: 0

- **Monitor device (##)**
  - O-FF

- **Shape**
  - Select

- **Default Lamp: Text: Blink:**

---

See [3]

See [4]

---

13 - 38
"Monitor device" Click on [Dev.], and specify the word device to be monitored in the "Device Setting" dialog box.

"Dev." Select the word device with the list box.

"NW No."  "Station No." "Device name" "Device number"  

See Section 10.1, Setting Devices for Monitoring.

"Shape"  
Click on [Select] to display the "Select Figure" dialog box.
Click on the lamp figure to be displayed.

See Section 13.5, Setting the Lamp Display (Bit) Function.

"Default"  
The "Default" setting is the same setting as that for the lamp graphic display format used when the monitor device value or the value resulting from the data expression does not fit the comparative equation specified in the [Display Format] tab settings.
Click on [Edit], and in the "Edit Display Format" dialog box, specify the format in which the lamp graphic is to be displayed when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

![Edit Display Format diagram]
"Attribute"

"Lamp" Select the color in which the lighted lamp is to be displayed, using the list box.

"Text" If text is to be displayed on the lamp, select the color in which the text is to be displayed, using the list box.

"Text" If text is to be displayed on the lamp, select the position at which the text is to be displayed.

<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
<th>Center</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Text</td>
<td>Text</td>
<td></td>
<td>Text</td>
</tr>
</tbody>
</table>

After the display position for the text has been selected, specify the positioning for the text. Click on [Edit], and when the "Text" dialog box is displayed, specify the text to be displayed and the positioning.

With lamp graphics, text can be displayed at the left, right, top, bottom, or center of the lamp. To delete the specified contents, click on [Delete].

"Text" Input the text to be displayed. If text is to be displayed in several lines, input \n after each line. The size at which text is displayed is fixed at 1 x in both the vertical and horizontal directions.

"Horizontal alignment" "Vertical alignment" "Offset"

See Section 13.5, Setting the Lamp Display (Bit) Function.

"H, V" Select the size for lamp text characters from the list box.

"Outline font" Place an "X" in the check box to display the lamp text in outline fonts. (Available only when the character size is set to double or larger size both vertically and horizontally.)
2 Setting the display Format

This is used to switch the lamp graphic display when the monitor device value or the value resulting from the data expression reaches a certain value.

Click on **Edit**. When the “Edit Display Format” dialog box is displayed, specify the display color, the attributes, and the comparative equation. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on **Delete**. To change the order of the comparative equations, click on **Up** or **Down**.

“Attribute” Specify the display color and the attributes to be used for the lamp graphic display if the monitor device value or the value resulting from the data expression fits the comparative equation. For instructions on the procedure, please refer to the previous page.
"Display range" Specify a comparative equation.

See Section 10.5, Setting the Display Range (Comparative Equation).

**Operation Procedure Outline**

- **Display Format**
  - **Edit**
  - **OK**
  - **Edit Display Format**
    - **Left**
    - **Middle**
    - **Right**
    - **OK**
    - **Input Expression**
      - Specify the comment display format and comparative equation in the "Edit Display Format" dialog box. The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.
      - Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.

3 Setting **Data Expression**

See Section 10.2, Setting Data Expressions (Other Than Numeric Input Function).

4 Setting the display position

See Section 13.5, Setting the Lamp Display (Bit) Function.
13.7 Setting the Panel Meter Display Function

- What does this function do?
  - This function produces a meter display showing the proportion between the upper and lower limit values for the word device value.

---

**Example of settings**

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>16-bit, with sign 0-FF-D100</td>
</tr>
<tr>
<td>&quot;Meter style&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Type&quot;</td>
<td>Top 1/2</td>
</tr>
<tr>
<td>&quot;Org.&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Direction&quot;</td>
<td>Clockwise</td>
</tr>
<tr>
<td>&quot;Frame&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Scale&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Scale points&quot;</td>
<td>7</td>
</tr>
<tr>
<td>&quot;Edit text&quot;</td>
<td>Bottom</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Meter 1</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
<tr>
<td>&quot;Default&quot;</td>
<td>&quot;Meter color&quot;</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
</tbody>
</table>

**Display Format**

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Range&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Min.&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;Max.&quot;</td>
<td>300</td>
</tr>
</tbody>
</table>

---

13 - 43
The display conditions for the panel meter display function are fixed at the default values. When specifying data, there are no settings to be entered under Trigger.
**Description of settings**

1. **Setting the (Basic) settings**

   ![Parameter settings](image)

   - **Position:**
     - X: 0 ▲  Y: 0 ▼
     - Monitor device($$)
       - 0-FF
   - **Meter style**
     - Type: Top 1/4 ✗
     - Org.: O° ✗
     - Direction: Clockwise ✗
     - Scale points: 3 ▼
   - **Default Color:**

   "Monitor device" Click on [Dev.], and specify the word device to be monitored in the "Device Setting" dialog box.

   "Dev." Select the data type with the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>32-bit with no sign</td>
<td></td>
</tr>
<tr>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

   "NW No."
   "Station No."
   "Device Name"
   "Device No."

See Section 10.1, Setting Devices for Monitoring.
"Type" Select the type of meter to be displayed, using the list box.

<table>
<thead>
<tr>
<th>Top 1/4</th>
<th>Bottom 1/4</th>
<th>Left 1/4</th>
<th>Right 1/4</th>
<th>Top right 1/4</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td><img src="image2.png" alt="Diagram" /></td>
<td><img src="image3.png" alt="Diagram" /></td>
<td><img src="image4.png" alt="Diagram" /></td>
<td><img src="image5.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Top left 1/4</th>
<th>Bottom left 1/4</th>
<th>Bottom right 1/4</th>
<th>Top 1/2</th>
<th>Bottom 1/2</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image6.png" alt="Diagram" /></td>
<td><img src="image7.png" alt="Diagram" /></td>
<td><img src="image8.png" alt="Diagram" /></td>
<td><img src="image9.png" alt="Diagram" /></td>
<td><img src="image10.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

The various squares and boxes indicate the specified frame. To display text, specify the position at which the text is to be displayed in relation to this specified frame.

If the "Type" parameter specified in the screen window for the panel meter display function has been changed (corrected), the display size must also be changed. Be sure to change the size to match the new type.

"Org." Specify the origin if "Circle" has been selected for the meter type. If the monitor device value or the value resulting from the data expression is outside of the minimum/maximum values specified on the (Display Format) tab, use the list box to select the position at which the indicator of the meter is to be located.

<table>
<thead>
<tr>
<th>Left 1/2</th>
<th>Right 1/2</th>
<th>Circle</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image11.png" alt="Diagram" /></td>
<td><img src="image12.png" alt="Diagram" /></td>
<td><img src="image13.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

"Direction" Specify whether, as the monitor device value or the value resulting from the data expression increases, the meter indicator is to rotate in the clockwise direction, or in the counterclockwise direction.

If "Clockwise" is specified, the circle shown on the illustration under "Type" will serve as the origin. If "Counterclockwise" is specified, the triangle shown on the illustration under "Type" will serve as the origin.
"Frame" Place an "X" in the check box if a frame is to be displayed around the panel meter. The width of the line used to draw the frame is 1 dot, and the display color is white. These are fixed and cannot be changed.

"Scale" Place an "X" in the check box if a scale is to be displayed on the panel meter. The display color is white and cannot be changed.

"Scale points" Specify this if a scale is being displayed. Use the spin box to specify how many points will be displayed on the scale. The number of scale points can be between 2 and 11.

(Example)

Type: Top 1/2
Frame: Yes
Scale: Yes
Scale points: 3

Type: Top 1/2
Frame: No
Scale: Yes
Scale points: 3

Type: Top 1/2
Frame: No
Scale: No
Scale points: —

If no frame or scale is displayed, only the indicator will be displayed on the meter.

If text is to be displayed on the panel meter, click on [Edit Text]. The "Text" dialog box is displayed.
"Text" Select the position at which the text is to be displayed.

<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
<th>Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td></td>
<td>Text</td>
<td></td>
<td>Text</td>
</tr>
</tbody>
</table>

"Color" Select the color in which the text is to be displayed, using the list box.

"H, V" Select the size for panel text characters from the list box.

"Outline font" Place an "X" in the check box to display the panel text in outline fonts. (Available only when the character size is set to double or larger size both vertically and horizontally.)

After the display position for the text has been selected, specify the positioning for the text. Click on Edit, and when the "Text" dialog box is displayed, specify the text to be displayed and the positioning.

With panel meters, text can be displayed at the left, right, top, bottom, or center of the lamp. To delete the specified contents, click on Delete.

"Text" Input the text to be displayed. If text is to be displayed in several lines, input \n after each line.
**Horizontal alignment**
Select the horizontal positioning of the text, using the command button.

**Vertical alignment**
Select the vertical positioning of the text, using the command button.

**Offset**
Using the spin box, specify the number of dots by which the panel meter frame and the text are to be separated. A maximum of 100 dots can be specified.

(Example 1) Text setting: Top / Horizontal alignment: \[ \] / Offset: 5 dots

\[ \*
\]
5 dots
5 dots
Panel meter frame

(Example 2) Text setting: Right / Vertical alignment: \[ \] / Offset: 5 dots

\[ * \]
Panel meter frame

*** indicates the input text.

**Default**
Click on [Edit], and when the “Edit Display Format” dialog box is displayed, specify the color of the panel meter indicator.

![Edit Display Format](image)

**Attribute**
**Color**
Select the display color for the meter indicator, using the list box.

The width of meter indicator is fixed at 3 dots.
The line width of the meter indicator may be either 1 dot or 2 dots, depending on whether the indicator is slanted, and by how much.

If a comparative equation is being specified using [Display Format], this setting is effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.
2 Setting the **Display Format** (data display range)

![Panel meter setup interface]

"Range" If a data expression has been specified, this serves as the setting for the minimum and maximum values for the result of the data expression.

"Lower/Upper" Specify the minimum and maximum values for the panel meter display.

[See Section 14.4, Setting the Level Display Function.]

The range which can be specified varies depending on the "Data Type" parameter under the "Monitor Device" parameter.

3 Setting the **Data Expression**

[See Section 10.2, Setting Data Expressions (Other Than Numeric Input Function).]

4 Setting the display position (display size)

If "Yes" has been specified for "Scale", the display position must always be specified at a point 2 dots away from the end of the screen window.

(1) When the settings for the various tabs have been entered, click on **OK** in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window.
(3) Move the cursor to the position where the panel meter is to be displayed, and click at that position.

(4) Change the size in which the panel meter is displayed to the display size.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

See Section 19.3.4, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis).

See Section 19.3.5, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction without Changing the Proportion.

5 Setting the Display Format (comparative equation)

Specify this if the color in which the panel meter is displayed is to be changed when the monitor device value or the value resulting from the data expression reaches a certain value.
Click on [Edit] and specify the meter indicator color and comparative equation in the "Edit Display Format" dialog box. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

```
Attribute
Color:
```

```
Display range
<
Left < ≤ Middle No ≥ Right
```

"Attribute" Specify the color in which the meter indicator is to be displayed when the monitor device value or the value resulting from the data expression fits the comparative equation specified by the "Display range" parameter.

"Meter color" Select the display color for the meter indicator, using the list box.

"Display range" Specify a comparative equation.

See Section 10.5, Setting Display Ranges (Comparative Equations).

(Example) Type: 16-bit, with sign
Min.: 0
Max.: 300
Case 1: When monitor device value is 200 or higher: Indicator is displayed in red.
Case 2: When monitor device value is 50 or lower: Indicator is displayed in blue.
Default: If monitor device value does not correspond to the above cases: Indicator is displayed in white.

<table>
<thead>
<tr>
<th>Blue</th>
<th>White</th>
<th>Red</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 50</td>
<td>51 to 199</td>
<td>200 to 300</td>
</tr>
<tr>
<td>Case</td>
<td>Display range</td>
<td>Displayed comment</td>
</tr>
<tr>
<td>------</td>
<td>---------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>1</td>
<td>200&lt;=$V$</td>
<td>Red</td>
</tr>
<tr>
<td>2</td>
<td>$V&lt;=$50</td>
<td>Blue</td>
</tr>
<tr>
<td>Default</td>
<td></td>
<td>White</td>
</tr>
</tbody>
</table>

The default value is specified under the Basic settings.

---

**Outline of Procedure**

```
Display Format

Edit

Edit Display Format

Left   Middle   Right

Input Expression

OK
```

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box. The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
Chapter 14

Setting Graph Display Functions
14. Setting Graph Display Functions

14.1 Setting the Trend Graph Display Function

What does this function do?

- This function collects data stored in the word device at a specified timing, and displays it as a trend graph. When the data has been displayed to the end of the display range, it scrolls the display.

---

When using the Save function
Switch to another screen (data acquisition can also be carried out after the screen is switched)
The trend graph screen is displayed once again.

When not using the Save function
Switch to another screen (data acquisition ends after the screen is switched)
The trend graph screen is displayed once again.

Data continues to be acquired, and the screen shows the ongoing accumulation of data.

Data acquisition begins after the trend graph screen is displayed, and the results are displayed.
### Example of settings

#### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Display style&quot;</td>
<td>To right</td>
</tr>
<tr>
<td>&quot;No. of lines&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;No. of pts.&quot;</td>
<td>5</td>
</tr>
<tr>
<td>&quot;Sampling&quot;</td>
<td>2000ms</td>
</tr>
<tr>
<td>&quot;Memory store&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Memory clear trigger&quot;</td>
<td></td>
</tr>
</tbody>
</table>

#### Monitor Device

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;No.1&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>Solid line</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>1 dot</td>
</tr>
<tr>
<td>&quot;Device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td>&quot;Device type&quot;</td>
<td>16-blt, with sign</td>
</tr>
<tr>
<td>&quot;Continuous/Random&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Lower&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;Upper&quot;</td>
<td>400</td>
</tr>
</tbody>
</table>

The values for the graph display frame, the scale, and the number of scale points should be entered after the sprite settings have been entered.
Outline of Procedure

- **Basic**
  - Setting of display style
  - Setting of display timing
  - Setting of whether or not data is to be saved

- **Monitor Device**
  - Setting of device type
  - Setting of upper/lower limit values
  - Setting of graph line attributes
  - Setting of monitor device

- Is data expression to be specified?
  - **NO**
  - **YES**
    - Setting of data expression

After entering settings, click on "OK" on any tab

Setting of display position (display range)

End

See 1
See 2
See 3
See 4
"Display style"  
Displaying the list box, select the direction in which the graph is to be displayed.

<table>
<thead>
<tr>
<th>To right</th>
<th>To left</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device</td>
<td>Monitor device</td>
</tr>
<tr>
<td>Display timing</td>
<td>Display timing</td>
</tr>
</tbody>
</table>

"No. of lines"  
Specify the number of lines (the number of monitor device points) to be displayed on the graph, using the spin box. A maximum of eight lines (eight points) can be specified.

"No. of pts."  
Specify the number of points to be displayed on one graph for each sampling. Up to 100 points can be specified.

The spacing between points is determined automatically by the specified number of points and the display range in the X axis direction.

(Example) No. of points: 5
"Sampling" Using the spin box, specify the timing at which monitor device values are read from the PC CPU and graphs are displayed. The minimum timing that can be specified is 100 ms, and the timing can be specified in units of 100 ms.

However, if specify the setting to continue the data acquisition when the screen is switched from the trend graph screen to another screen, the timing can be specified from minimum 2 seconds (2000 ms) in units of 100 ms.

The following precautions should be observed regarding the sampling:
- If the monitor device values cannot be read from the PC CPU at the specified timing, or the graphs cannot be displayed at the specified timing, depending on the configuration of the GOT connections and the number of sprites set for the screen on which the trend graph is displayed.
- If the monitor device values cannot be read from the PC CPU at the specified timing, or the graphs cannot be displayed at the specified timing because multiple sprite settings have been entered for the screen on which the trend graph has been specified, trend graphs like those described below can be displayed on the GOT.

The GOT will always display graphs at the specified timing, regardless of whether or not the monitor device values can be read from the PC CPU at the specified timing.

If monitor device values cannot be read at the right timing, graphs will be displayed using the previously displayed values. (The same values will be displayed at several points.)

- If trend graphs cannot be displayed at the specified timing because multiple sprite settings have been entered on the screen.

As long as displays can still be produced, the GOT detects how many samplings have been displayed up to that point, and always processes the necessary number of points to display a graph. Graphs will be displayed by drawing a line from the previous point to the current point, so that the correct values will not be displayed for the interim points.

"Memory store" Using the radio button, specify whether data acquisition is to continue when the screen is switched from the trend graph screen to another screen, or whether data acquisition is to end.

YES ...... Data continues to be acquired after the screen has been switched. The acquired data is stored in the internal memory of the GOT.

Normally, the most recent setting for the number of points is stored in the memory.

- Up to two trend graph display functions using the "Save" function can be specified for one project.
- Data stored in the internal memory of the GOT will be lost if the GOT is reset, the power supply is turned off, or the GOT is connected to a computer and communications are carried out.
NO........Data acquisition ends when the screen is switched.

"Memory clear" This can be selected only if "Save" has been specified.
"Trigger" If the data stored in the internal memory of the GOT is to be deleted when a bit device is turned on or off, use the list box to select this option.
After the selection has been made using the list box, click on [Device] to display the "Set Device" dialog box, and specify the bit device.

See Section 10.1, Setting Devices for Monitoring.

- On/Off times for specified bit devices
  The on and off times for the bit device should always be specified in such a way that the time is longer than the timing specified with the "Sampling" parameter.
2. Setting the Monitor Device

Device type: 16-bit signed, Continuous, Random

Display range:
Lower: -32768  Upper: 32767

Select the type of data for the word device being monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
</tr>
</tbody>
</table>

Clicking on Edit displays the “Set Range” dialog box.
"Display range"

Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values.

Fixed ..... Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device ..... Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the "Set Device" dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768 to 32767</td>
<td>0 to 65535</td>
<td>-2147483648 to 2147483647</td>
<td>0 to 4294967295 to 99999999999.00</td>
<td></td>
</tr>
</tbody>
</table>

If "Device" is selected, the "Type" parameter in the "Set Device" dialog box is fixed as the data type specified for the "Type" parameter on the previous page.

"Continuous"/

"Random"

Select this if a value of 2 or more has been entered for "No. of lines".

Using the radio button, specify the monitor device and the attributes for the graph lines.

Continuous ..... Starting with the specified device, devices are specified continuously and automatically, for the number of lines of the graph. The same line attributes will be used for all of the graphs.

Random ........ Any desired device and attribute can be specified for each point.

Click on [Edit] and when the "Attribute" dialog box is displayed, specify the attributes for the graph lines.

If "Random" is selected, click on the number to be specified, and specify the monitor device and graph line attributes for each individual point.

"Attribute"

"Color"

Select the color in which the graph lines are to be displayed, using the list box.

"Style"

Select the style of the graph lines, using the list box.

"Width"

Select the width of the graph lines, using the list box.

"Device"

Click on [Dev] and when the "Device" dialog box is displayed, specify the word device to be monitored.

See Section 10.1, Setting Devices for Monitoring.
Setting the **Data Expression**

See Section 10.2, Setting Data Expressions (Other than Numeric Input Function).

**Setting the display position (display range)**

1. When the settings for the various tabs have been entered, click on "OK" in any tab.
2. A square consisting of dotted lines is displayed at the upper left of the screen window.

3. Move the cursor to the position where the graph is to be displayed, and click at that position.

4. Move the cursor to a handle on the sprite setting frame, and determine the range within which the graph is to be displayed.

See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

If "Style" has been set to anything other than a solid line, the display range of the X axis should be set so that the spacing between points is at least 16 dots.
14.2 Setting the Line Graph Display Function

**What does this function do?**

- This function collects data stored in several word devices in batch and displays them in the a line graph.

---

**Example of settings**

<table>
<thead>
<tr>
<th>Basic</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td>To right</td>
</tr>
<tr>
<td>&quot;Display style&quot;</td>
<td>&quot;Direction&quot;</td>
</tr>
<tr>
<td>&quot;No. of lines&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;No. of pts.&quot;</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Monitor Device</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;No.1&quot;</td>
<td>&quot;Color&quot;</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>Solid line</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>1 dot</td>
</tr>
<tr>
<td>&quot;Continuous/Random&quot;</td>
<td>Continuous</td>
</tr>
<tr>
<td>&quot;Device&quot;</td>
<td>0-FF-D100-D104</td>
</tr>
<tr>
<td>&quot;Device type&quot;</td>
<td>16-bit, with sign</td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>&quot;Lower&quot;</td>
</tr>
<tr>
<td>&quot;Upper&quot;</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td>Default</td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td></td>
</tr>
</tbody>
</table>

The values for the graph display frame, the scale, and the number of scale points should be entered after the sprite settings have been entered.
### Outline of Procedure

**Basic**
- Setting of display style

**Monitor Device**
- Setting of device type
- Setting of upper/lower limit values
- Setting of graph line attributes
- Setting of monitor device

Is data expression to be specified?

**Data Expression**
- Setting of data expression

**Trigger**
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position (display range)

End

See 1

See 2

See 3

See 4

See 5
"Display style"

"Direction" Using the list box, select the direction in which the graph is to be displayed.

<table>
<thead>
<tr>
<th>To right</th>
<th>To left</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device</td>
<td>Monitor device</td>
</tr>
<tr>
<td>Display timing</td>
<td>Display timing</td>
</tr>
</tbody>
</table>

"Lines" Specify the number of lines (the number of monitor device points) to be displayed on the graph, using the spin box. A maximum of eight lines (eight points) can be specified.

"Points" Specify the number of monitor devices to be displayed on the graph, using the spin box. Up to 100 points can be specified.

The spacing between points is determined automatically by the specified number of points and the display range in the X axis direction.

A monitor device setting for the number of points x the number of graphs is necessary.

Example) No. of points: 5
2 Setting the Monitor Device

"Device type" Select the type of data for the word device being monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit real number.</td>
</tr>
<tr>
<td>32-bit with no sign</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit real number.</td>
</tr>
</tbody>
</table>

Clicking on Edit displays the "Set Range" dialog box.
"Display range"

"Lower"/
"Upper"

Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values.

Fixed ..... Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device ..... Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the “Set Device” dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768 to 32767</td>
<td>0 to 65535</td>
<td>-2147483648 to 2147483647</td>
<td>0 to 4294967295 to 999999999999.0</td>
<td></td>
</tr>
</tbody>
</table>

If “Device” is selected, the “Type” parameter in the “Set Device” dialog box is fixed as the data type specified for the “Type” parameter on the previous page.

Click on the number to be specified, and then on [Edit]. The “Attribute” dialog box will be displayed.

"Attribute"

"Color"

Select the color in which the graph lines are to be displayed, using the list box.

"Style"

Select the style of the graph lines, using the list box.

"Width"

Select the width of the graph lines, using the list box.

"Continuous"/
"Random"

Using the radio button, select how the monitor devices to be used for the graph are to be specified.

Continuous ..... Starting with the specified device, devices are specified continuously and automatically.

Random ......... Any desired device can be specified for the number of points used for the graph.
"2 Device/point" Place an "X" in the check box when a point will be monitored with two devices. In this case, the maximum number of points is fifty.

Click on [Edit], and when the "Device" dialog box is displayed, specify the word device to be monitored.
If "Random" is selected, click on the number to be specified, and then click on [Edit].

See Section 10.1, Setting Devices for Monitoring.
3 Setting the [Data Expression]
   See Section 10.2, Setting Data Expressions (Other than Numeric Input Function).

4 Setting the [Trigger]
   See Section 10.4, Setting Display Conditions.

5 Setting the display position (display range)
   (1) When the settings for the various tabs have been entered, click on [OK] in any tab.
   (2) A square consisting of dotted lines is displayed at the upper left of the screen window.

   ![Dotted Square]

   (3) Move the cursor to the position where the graph is to be displayed, and click at that position.

   ![Graph Position]

   (4) Move the cursor to a handle on the sprite setting frame, and determine the range within which
       the graph is to be displayed.

   ![Sprite Setting Frame]

   See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.
   See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

   If "Style" has been set to anything other than a solid line, the display range of the X axis should
   be set so that the spacing between points is at least 16 dots.
   If a spacing of less than 16 dots is specified, dotted lines will be displayed as solid lines.
14.3 Setting the Bar Graph Display Function

What does this function do?
- This function collects data stored in several word devices and displays it as a bar graph.

Example of settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Display style&quot;</td>
<td>&quot;No. of bars&quot; 4</td>
</tr>
<tr>
<td></td>
<td>&quot;Vertical/horizontal&quot; Vertical</td>
</tr>
<tr>
<td></td>
<td>&quot;Offset&quot; 20</td>
</tr>
<tr>
<td></td>
<td>&quot;Width&quot; 20</td>
</tr>
<tr>
<td></td>
<td>&quot;Space&quot; 40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Monitor Device</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Device type&quot;</td>
<td>16-bit, with sign</td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>&quot;Base&quot; 0</td>
</tr>
<tr>
<td></td>
<td>&quot;Lower&quot; -400</td>
</tr>
<tr>
<td></td>
<td>&quot;Upper&quot; 400</td>
</tr>
<tr>
<td>&quot;Continuous&quot;/*&quot;Random&quot;</td>
<td>Continuous</td>
</tr>
<tr>
<td>&quot;No.1&quot;/*No.3&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td>&quot;No.2&quot;/*No.4&quot;</td>
<td>&quot;Pattern&quot; Fill paint</td>
</tr>
<tr>
<td>&quot;Device&quot;</td>
<td>0-FF-D100 to D103</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item to Set</td>
<td></td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

The values for the graph display frame, the scale, and the number of scale points should be entered after the sprite settings have been entered.
Outline of Procedure

**Basic**
- Setting of display style

**Monitor Device**
- Setting of device type
- Setting of base and upper/lower limit values
- Setting of graph line attributes
- Setting of monitor device

Is data expression to be specified?

**Data Expression**
- Setting of data expression

**Trigger**
- Setting of display conditions

After entering settings, click on "On" on any tab

Setting of display position (display range)

End

---

See 1
See 2
See 3
See 4
See 5
**Description of settings**

1. Setting the **Basic** settings

![Graph Display Settings](image)

"Display style"

"Bars" Using the spin box, select the number of bars (the number of monitor device points) to be displayed. A maximum of eight lines (eight points) can be specified.

"Vertical/horizontal" Using the radio buttons, select the direction in which the graph is to be displayed.

<table>
<thead>
<tr>
<th>Vertical direction</th>
<th>Horizontal direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device values</td>
<td>Sequence of specified devices</td>
</tr>
<tr>
<td>Sequence of specified devices</td>
<td>Monitor device values</td>
</tr>
</tbody>
</table>

"Offset" Using the spin box, specify the number of dots comprising the distance from the origin point to the bar graph display position. A maximum of 100 dots can be specified.

![Offset Diagram](image)
**"Width"** Specify the width of the bar graph to be displayed, using the spin box. A maximum of 500 dots can be specified.

**"Space"** Specify the spacing between bars (including the bar width), using the spin box. A maximum of 500 dots can be specified.

---

**2 Setting the Monitor Device**

![Graph Display Function Settings](image_url)
"Device type" Select the type of data for the word device being monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>32-bit with no sign</td>
<td>Select this to display data as a 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
</tr>
</tbody>
</table>

Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.

Select this to display data as a 32-bit word device with a floating decimal point.

Clicking on [Edit] displays the "Set Range" dialog box.

Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values.

Fixed ...... Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device .... Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the "Set Device" dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768 to 32767</td>
<td>0 to 65535</td>
<td>-2147483648 to 2147483647</td>
<td>0 to 4294967295</td>
<td>-999999999999.0 to 999999999999.00</td>
</tr>
</tbody>
</table>

If "Device" is selected, the "Type" parameter in the "Set Device" dialog box is fixed as the data type specified for the "Type" parameter on the previous page.
Specify the value which will serve as the origin point of the bar graph, using the spin box. The base value should be between the upper and lower limit values.

- **Base**: Lower limit: 0  Upper limit: 300  Base: 100
  - Monitor device value: 300 (1)  Monitor device value: 0 (2)  Monitor device value: 200 (3)

Select a value of 2 or more for “No. of bars”.

Using the radio buttons, select how to monitor devices used to draw the graph are to be specified, and how the bar graph attributes are to be specified.

Continuous ...... Starting with the specified device, devices are specified continuously and automatically, for the number of bars on the graph. The same attributes will be used for all of the graphs.

Random .......... Any desired device and attributes can be specified for each individual point.

Click on “Edit”, and when the “Attribute” dialog box is displayed, specify the monitor device and the graph attributes.

- **Attribute**
- **Color**: Select the color in which the graph lines are to be displayed, using the list box.
- **Pattern**: Select the painting pattern for the graph, using the list box.
- **Device**: Click on [Dev.], and when the “Device” dialog box is displayed, specify the word device to be monitored.

See Section 10.1, Setting Devices for Monitoring.

See Section 10.2, Setting Data Expressions (Other than Numeric Input Function).

See Section 10.4, Setting Display Conditions.
Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on "OK" in any tab.

(2) A square consisting of dotted lines is displayed at the upper left of the screen window.

    A line frame is displayed at the minimum size for the contents specified by the "Display style" parameter.

(3) Move the cursor to the position where the graph is to be displayed, and click at that position.

(4) Move the cursor to a handle on the sprite setting frame, and determine the range within which the graph is to be displayed.

    The display range cannot be smaller than the size displayed by the dotted-line box.

    See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

    See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).
14.4 Setting the Level Display Function

- What does this function do?
  - This function displays a level display showing the value of the word device in relation to the upper and lower limit values.

---

Example of settings

Drawing the figure to be used for the level graph

(X = 200, Y = 25)  
(X = 500, Y = 360)

---

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Display style&quot;</td>
<td>Up</td>
</tr>
<tr>
<td>&quot;Direction&quot;</td>
<td>Up</td>
</tr>
<tr>
<td>&quot;Boundary&quot;</td>
<td>Up</td>
</tr>
<tr>
<td>&quot;Internal pos.&quot;</td>
<td>X: 350 Y: 200</td>
</tr>
<tr>
<td>&quot;Monitor Device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td>&quot;Default&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Pattern&quot;</td>
<td>Fill paint</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Range&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Min.&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;Max.&quot;</td>
<td>400</td>
</tr>
</tbody>
</table>
### Display Conditions

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

#### Tool Bar 1

Selected icon

![SP Level](image)

#### Menu Bar

Selected command

On Draw menu:

Graph → Level

### Outline of Procedure

- Drawing of figure to use for level display
  - See [1]

  **Basic**
  - Setting of display style
  - Setting of internal position
  - Setting of monitor device
  - Setting of level display attributes
  - See [2]

  **Display Format**
  - Setting of minimum/maximum values for level display
  - Change attribute if monitor device reaches a given value?
    - NO
    - Display Format
      - Setting of comparative equation used to change attributes of level display
      - See [3]
    - YES
  - See [7]

  **Data Expression**
  - Is data expression to be specified?
    - NO
    - See [4]
    - YES

(continued on next page)
1. Drawing the figure to be used for the level display

A level display can be drawn if the graphic is a closed figure.

- Always use solid lines to draw the graphic used for the level display.
- The level display cannot be produced correctly if the figure is open even slightly. Make sure it is completely closed.

2. Setting the **Basic** settings

<table>
<thead>
<tr>
<th>Position</th>
<th>Display Format</th>
<th>Data Expression($)</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1: 0 Y1: 0 - X2: 32 Y2: 16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display style</td>
<td>Direction:</td>
<td>Boundary:</td>
<td>Internal pos.</td>
</tr>
<tr>
<td>Monitor device($)</td>
<td>0-FF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>Color: Pattern:</td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>

See 5
See 6
“Display style”

“Direction” Using the list box, select the direction in which the level is to be displayed each time the value of the monitor device increases.

<table>
<thead>
<tr>
<th>Up</th>
<th>Down</th>
<th>Right</th>
<th>Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>➡️</td>
<td>🔽</td>
<td>➡️</td>
<td>⬅️</td>
</tr>
</tbody>
</table>

“Boundary” Select the color in which the lines of the figure used for the level display are to be displayed.

“Internal pos.” When the display position (display range) is set, the position inside the figure used for the level display will automatically be specified as the internal position, so no setting needs to be entered here.
If the position inside the figure is already known, the internal position should be specified using the spin box.
The internal position may be specified at any position, as long as it is within the figure being used for the level display.

“Monitor Device” Click on [Dev.], and when the “Device” dialog box is displayed, specify the word device to be monitored.

“Device type” Select the type of data, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
</table>
| 32-bit with sign | Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs. | Select this to display data as a 32-bit real numbers.
| 32-bit with no sign | Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs. | Select this to display data as a 32-bit word device with a floating decimal point.

“NW No.”
“Station No.”
“Device name”
“Device number”

See Section 10.1, Setting Devices for Monitoring.
"Default" Click on Edit, and specify the painting color and the pattern for the level display, using the list boxes in the "Edit Display Format" dialog box.

If a comparative equation is being specified using Display Format, these settings for the painting color and pattern are effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

### Setting the Display Format (display range)

```
<table>
<thead>
<tr>
<th>Case</th>
<th>Display Range</th>
<th>Color</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Default**

```
Range
Lower: -32768 Upper: 32767
```

"Display range" Clicking on Edit displays the "Set Range" dialog box.

### Set Range

**Basic**

- Fixed
- Device: OFF

**Lower**

- Fixed: -32768

**Upper**

- Fixed: 32767
"Display range" "Min."/"Max." Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values. Fixed......Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device......Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the "Set Device" dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768 to 32767</td>
<td>0 to 65535</td>
<td>-2147483648 to 2147483647</td>
<td>0 to 4294967295 to 4294967295</td>
<td>-999999999999.0 to 999999999999.0</td>
</tr>
</tbody>
</table>

If "Device" is selected, the "Type" parameter in the "Set Device" dialog box is fixed as the data type specified for the "Type" parameter on the previous page.

4 Setting the [Data Expression]

See Section 10.2, Setting Data Expressions (Other than Numeric Input Function).

5 Setting the [Trigger]

See Section 10.4, Setting Display Conditions.

6 Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on "OK" in any tab.

(2) A square consisting of dotted lines is displayed at the upper left of the screen window. A cross-shaped marker which indicates the internal position is displayed inside the dotted-line square.

(3) Move the cursor to the position where the level is to be displayed, and click at that position.

(4) Move the cursor to a handle on the sprite setting frame, and change the sprite setting frame to a size in which the entire figure used for the level display can be enclosed.

See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).
• After setting the display position (display range), the following procedure should be carried out if the + marker used for the internal position is not positioned within the figure used for the level display.

(1) Move the cursor to the handle at the upper left corner of the sprite setting frame, and double-click at that position.

(2) Handles will appear on the + marker for the internal position. Move the + marker inside the figure used for the level display.

7 Setting the Display Format (Comparative Equation)

Specify this if the attributes of the level display are to be changed when the monitor device value or the value resulting from the data expression reaches a certain value.

Click on [Edit], and when the "Edit Display Format" dialog box is displayed, specify the painting color, the pattern, and the comparative equation. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].
"Attribute" Specify the painting color and pattern to be used when the monitor device value or the value resulting from the data expression fits the comparative expression specified with the "Display range" parameter.

"Color" Select the painting color, using the list box.

"Pattern" Select the painting pattern, using the list box.

"Display range" Specify a comparative equation.

See Section 10.5, Setting Display Ranges (Comparative Equations).

(Example) Type: 16-bit, with sign
Min.: 0
Max.: 300
Case 1: When monitor device value is 200 or higher: Level displayed in red, with fill painting.
Case 2: When monitor device value is 50 or lower: Level displayed in blue, with fill painting.
Default: If monitor device value does not correspond to the above cases: Displayed in white, with fill painting.

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Displayed comment</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$V \leq 200$</td>
<td>Red</td>
<td>Fill</td>
</tr>
<tr>
<td>2</td>
<td>$V \leq 50$</td>
<td>Blue</td>
<td>Fill</td>
</tr>
<tr>
<td>Default</td>
<td></td>
<td>White</td>
<td>Fill</td>
</tr>
</tbody>
</table>

The default value is specified under the Basic settings.

---

**Operation Procedure Outline**

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box. The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
Chapter 15

Setting the Touch Key Functions
15. Setting the Touch Key Functions

15.1 Items to Know before Setting the Touch Key Functions

Before setting the touch key functions, there are a few useful items of information we will look at.

(1) Up to 256 touch keys can be specified on base screens. With the A870GOT, a maximum of 209 touch keys can be specified on window screens, and with the A85GOT, up to 77 touch keys can be specified on window screens.

(2) The minimum size for one touch key is 16 x 16 dots.

(3) When setting the display positions for touch keys, there are two sizes which can be specified: the size of the touch key graphic, and the effective size of the key when it is actually touched and operated (the touch key size). Touch key graphics can be specified in units of 1 dot, while the effective area can be specified in units of 16 dots.

- ■: Effective area of touch key when actually touched (size can be changed in units of 16 dots horizontally/vertically)

- □: Key graphic size (size can be changed in units of 1 dot horizontally/vertically)

- ○: Minimum unit for touch key (effective area)

Nothing happens if the shaded area □ is touched.

(4) Several functions can be assigned to one touch key.

<table>
<thead>
<tr>
<th>Execution sequence when multiple functions are assigned:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word SET: 20</td>
</tr>
<tr>
<td>Bit SET: 20</td>
</tr>
<tr>
<td>Bit RST: 20</td>
</tr>
<tr>
<td>Bit ALT: 20</td>
</tr>
<tr>
<td>Bit momentary: 1</td>
</tr>
<tr>
<td>Base screen switching: 1</td>
</tr>
<tr>
<td>Window screen switching: 1</td>
</tr>
</tbody>
</table>

| Total: 83 |

If expanded functions screen switching has been specified, please be aware that the above functions cannot be set.
(5) Several functions can be assigned to one touch key, but please be aware that there are some functions which may not run properly, depending on the combination of functions specified.

<table>
<thead>
<tr>
<th>Key Type</th>
<th>High</th>
<th>Operation priority order when multiple functions are set</th>
<th>Low</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Expanded function</td>
<td>Key code setting</td>
</tr>
<tr>
<td>Expanded function</td>
<td>O</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Key code setting</td>
<td>X</td>
<td></td>
<td>O</td>
</tr>
<tr>
<td>Key code setting (numeric/ASCII input Enter key)</td>
<td>X</td>
<td></td>
<td>O</td>
</tr>
</tbody>
</table>

(6) While one touch key is being pressed, it is possible to specify that the other touch keys are invalid (simultaneous pressing inhibited).

If simultaneous pressing is to be inhibited, the key code FFFE should be set for the touch keys.

See Section 15.8, Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys.

(7) When the touch key functions are specified, the user can specify the type of key graphic to be displayed, so there is no need to draw graphics for touch keys.

There are two ways to specify key graphics, as shown below. Key graphics can be switched between off and on in response to a change in the status of the device when touched.

1. Setting from the basic figures provided by the graphic settings software
2. Setting from a panel kit

(If the user is using any desired figure, the figure must first be registered in the panel kit.)

(8) Be aware that when three touch keys are pressed simultaneously, the third touch key will not operate.

First touch key

Second touch key

Third touch key

Valid

Valid

The third key is not valid.
15.2 Common Settings for Touch Key Functions

This section explains setting operations which are common to all of the functions described starting in Section 15.3.

15.2.1 Setting Key Graphics

Key graphics are set using the (Basic) settings tab.

"Display trigger" Using the radio buttons, select the conditions under which the OFF and ON graphics about to be set are to be switched.

Key .......... The figure is switched from OFF to ON when touched.
Device .......... The figure is switched from OFF to ON when the specified bit device goes ON or when the value of the specified word device reaches the value specified by the "fixed" parameter.
To select a device, click on Dev. and use the "Device Setting" dialog box to specify the bit device or word device.

See Section 10.1, Setting Devices for Monitoring.

"Fixed" When a word device has been specified using the above setting, use the spin box to specify the value of the word device at which the key is to be turned on.

"Shape" Select the type of graphic to be displayed, using the list box.
User .......... The basic graphic supplied by the graphics software is displayed.
Computer .......... A graphic registered in the panel kit is displayed.
None .......... Select this if no graphic is to be displayed.
• If a free figure is selected
  Clicking on [ON] or [OFF] displays the “Panel Kit” dialog box. Select the figure to be displayed.
  Please be aware that panel kit figures with sprites cannot be used.
  See Section 18.3, Reading a Registered Panel Kit.

• If a basic figure is selected
  Click on either [ON] or [OFF].
  The “Select Figure” dialog box is displayed.
  (When [OFF] is selected)

  ![](image)

  Click on the switch figure to be displayed.
  Clicking on [-> ON] displays the switch figure when on, and clicking on [-> OFF] displays the switch figure when off.
  If a basic figure has been selected, select the switch figure using either [ON] or [OFF].
  Please be aware that when a figure is on, a figure like SWITCH1 cannot be selected, and when off, a figure like SWITCH3 cannot be selected.

“Edit”
Specify the characters, display position, and color for the switch figure.
Then click on [Edit].
This displays the “Set Attribute” dialog box.
"ON"/"OFF"

"Key"
Using the list box, select the color in which the switch figure is to be displayed.

"Text"
If characters are to be displayed on the switch figure, select the direction in which the text is to be displayed.

Characters can be displayed at the left, right, top, bottom, or center of the figure.

"Key color"
Using the list box, select the color in which characters are to be displayed.

"H, V"
Select the size for touch switch text characters from the list box.

"Outline font"
Place an "X" in the check box to display the touch switch text in outline fonts. (Available only when the character size is set to double or larger size both vertically and horizontally.)

After the display direction of the text has been specified, click on [Edit] to display the "Set Text" dialog box. Specify the characters and alignment of the text to be displayed.

To delete any contents that have been specified, click on [Delete].
Clicking on [Copy from ON] enables characters and display positions specified when the switch is on to be copied.

"Text"
Input the text to be displayed. If text is to be displayed in several lines, input \n after each line.
"Horizontal alignment" Select the horizontal positioning of the text, using the command button.

"Vertical alignment" Select the vertical positioning of the text, using the command button.

"Offset" Using the spin box, specify the number of dots by which the key graphic and the text are to be separated. A maximum of 100 dots can be specified.

(Example 1) Text setting: Top / Horizontal alignment:  / Offset: 5 dots

(Example 2) Text setting: Right / Vertical alignment:  / Offset: 5 dots

*** indicates the input text.

**Special Cases**

- Using specified touch key functions as hidden keys

    Key graphics can be used as hidden keys if no settings are entered for them.
### 15.2.2 Setting the Run Timing for Specified Movements

The timing at which specified movements are executed can be specified on the Trigger tab.

<table>
<thead>
<tr>
<th>Trigger type</th>
<th>ON</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td></td>
<td>Ordinary</td>
</tr>
</tbody>
</table>

#### Trigger device

<table>
<thead>
<tr>
<th>Range</th>
<th>Dev.</th>
<th>Previous</th>
<th>Next</th>
</tr>
</thead>
</table>

Key code: FFFF

**"Trigger type"** Using the radio buttons, select whether the specified action is to be executed immediately when the key is touched, or if it is to be executed only when a specified bit device is ON/OFF. Ordinary... The action is executed when the key is touched.

**ON**... The action is executed only when the bit device specified with the "Trigger device" parameter is ON.

- Specified bit is OFF
  - Specified action is not executed
- Specified bit is ON
  - Specified action is executed

**POINT**

When a touch key function is executed, this is the interlock device which either enables or inhibits that action to be executed.

**OFF**... The action is executed only when the bit device specified with the "Trigger device" parameter is OFF.

- Specified bit is ON
  - Specified action is not executed
- Specified bit is OFF
  - Specified action is executed
“Range”  This can be run only if the word device specified with “Trigger device” corresponds to the comparative equation specified with the “Range” parameter.

Comparative equation
0 < D10 < 100
When D10 is 1000

Comparative equation
0 < D10
When D10 is 50

Specified action is not carried out
Specified action is carried out

“Trigger device”  This is specified after either “ON” or “OFF” has been selected for the “Trigger type” parameter. Click on Dev. and specify the bit device in the “Device Setting” dialog box.

See Section 10.1, Setting Devices for Monitoring.

“Range”  When the range is selected using the “Trigger type” parameter, a comparative equation can be specified.

See Section 10.5, Setting Display Ranges (Comparative Equations) for instructions on entering settings.

“Key code”  This is not specified in the run timing settings.

See Section 15.8, Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys.

“Edit key group”  When the “Touch Key” dialog box is displayed in order to edit touch keys which have already been specified, place an “X” in this check box if the effective area is also to be changed. After the editing has been completed, the sprite setting box is displayed in the area outlined by dotted lines, for effective area settings.

---

Special Cases

- Timing at which the bit device specified with “Trigger device” is checked

This function checks the status of a specified bit device immediately after a key is touched and determines whether or not the action can be executed. For example, with a touch key in the touch key (momentary) function, this checks the status of the bit device immediately after the key has been touched, and determines whether or not the action can be executed. This means that the action will not change even if the status of the bit device changes while the key is being touched.
### 15.2.3 Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics

#### 1 Positioning

1. When the settings for the various tabs have been entered, click on "OK" in any tab.
2. A dotted-line box is displayed at the upper left of the screen window.

The smaller dotted box inside the larger one is for specifying the effective area. The effective area is displayed at a position which is a multiple of 16 dots in both the horizontal and vertical directions.

(3) Move the cursor to the display position, and click at that position.

When the position is determined, the graphic and text in the OFF status are displayed (only when a key graphic has been specified).

#### 2 Adjusting the key graphic size

1. Move the cursor to a handle on the sprite setting frame, and determine the size of the key graphic.

- See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.
- See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).
- See Section 19.3.4, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis).
3 Adjusting the size of the effective area

(1) Move the cursor to the top left corner of the sprite setting frame and double-click at that position.

(2) The box for specifying the effective area is displayed in the sprite setting frame.

(3) Move the cursor to a handle on the sprite setting frame, and use the same procedure as that in step (4) to determine the effective area. When doing this, the cursor moves in units of 16 dots in the horizontal and vertical directions, regardless of the amount of movement used in automatic positioning.

The effective area must be smaller than the display size of the key graphic.

If the key graphic and the effective area are the same size, the key graphic should be specified in units of 16 dots in the horizontal and vertical directions.
15.3 Setting Touch Key (Bit) Functions

What does this function do?

- This function turns on the specified bit device by touching it. (Bit SET)
- This function turns off the specified bit device by touching it. (Bit RST)
- This function reverses the status (ON ↔ OFF) of the specified bit device by touching it. (Bit ALT)
- This function keeps the specified bit device on as long as it is touched. (Bit Momentary)

Touching the specified bit turns it ON

Touching the specified bit turns it OFF

Touching the currently specified bit reverses its status
(ON → OFF)
(OFF → ON)

The specified bit is ON only while touched
Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1
No key graphic specified

Action
- Clicking on "Bit"
- Setting of type of action
  Getting of storing device

See 2

Trigger
- Setting of action conditions

See 3

After entering settings, click on "OK" on any tab

Setting of display position, display size, and effective area

See 4

End
15. Setting the Touch Key Functions

Description of settings

1. Setting the (Basic) settings
   See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings

Click on [Bit].

To correct the specified contents after the action settings have been entered, click on [Edit]. To delete the specified contents, click on [Delete].

The “Key Action (Bit)” dialog box is displayed.
"Action" Using the radio buttons, select the type of function to be carried out for the bit device to which the data is written when the device is touched.

<table>
<thead>
<tr>
<th>Bit SET</th>
<th>Bit RST</th>
<th>Bit ALT</th>
<th>Bit Momentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>![Image]</td>
<td>![Image]</td>
<td>![Image]</td>
</tr>
<tr>
<td>Bit is turned ON when touched</td>
<td>Bit is turned OFF when touched</td>
<td>Bit switches between ON and OFF when touched</td>
<td>Bit is ON while touched</td>
</tr>
</tbody>
</table>

"Storing device" Click on [Device], and in the "Device Setting" dialog box, specify the bit device to which the data is to be written.

See Section 10.1, Setting Devices for Monitoring.

3 Setting the [Trigger] settings

See Section 15.2.2, Setting the Run Timing for Specified Movements.

4 Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.

---

Special Cases

- Making sure the specified action was actually executed

The status of the target device can be confirmed by specifying a key graphic and then specifying the device set with the "Storing device" parameter for the "Display Key" parameter.
• What happens if the power supply is turned OFF while a touch key for which “Bit Momentary” was specified is being touched?

The bit device remains on even if the power supply to the GOT is turned off.

• What happens if a request is issued to switch the base screen while a touch key for which “Bit Momentary” was specified is being touched?

The screen will be switched after the key is released. Switching of base and windows screens is carried out when the key is no longer being touched.

• What happens if a hardware problem occurs with the GOT and monitoring is interrupted while a touch key for which “Bit Momentary” was specified is being touched?

The bit device remains ON, so it should be turned OFF using the procedure outlined below.

(1) Specify a time-out for the pertinent device which is continually on, and when the time-out occurs, initiate a forced RST on the sequencer CPU side.

(2) When using the A870GOT, use the I/O signal from the RUN terminal as an interlock.

• Setting other touch switches invalid while a touch switch for which bit momentary has been specified is being touched

Using the “Action” tab, set the key code FFFEh.

See Section 15.8, Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys.
15.4 Setting Touch Key (Word) Functions

What does this function do?

- This function writes the value of the specified word device by touching it. (Fixed value)
- This function writes the value of the specified word device to a word device by touching it. (Indirect)
- This function writes the value of the specified word device + the fixed value to a word device by touching it. (Fixed value + Indirect)
### Outline of Procedure

**Basic**
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1

No key graphic specified

**Action**
- Clicking on "Word"
- Setting of storing device
- Setting of typo of action

See 2

**Trigger**
- Setting of action conditions

See 3

After entering settings, click on "OK" on any tab

Setting of display position, display size, and effective area

See 4

End
Description of settings

1. Setting the **Basic** settings

   See Section 15.2.1, Setting Key Graphics.

2. Setting the **Action** settings

![Touch Key Settings](image)

Click on **Word**.

To correct the specified contents after the action settings have been entered, click on **Edit**. To delete the specified contents, click on **Delete**.

The "Key Action (Word)" dialog box is displayed.

![Key Action (Word) Settings](image)
"Storing device"  Click on [Dev.] and use the "Device Setting" dialog box to specify the word device to which the data is to be written.

"Type"  Select the type of data to be written, using the list box. The range of values which can be written varies depending on the selected data type.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768 to 32767</td>
<td>0 to 65535</td>
<td>-2147483648 to 2147483647</td>
<td>0 to 4294967295</td>
<td>-999999999999.0 to 999999999999.00</td>
</tr>
</tbody>
</table>

"NW No."  
"Station No."  
"Device name"  
"Device number"

See Section 10.1, Setting Devices for Monitoring.

"Fixed"  
"Device"  Select the check box for the method by which data is to be written to the storing word device when touched.

<table>
<thead>
<tr>
<th>☑ Fixed</th>
<th>☑ Fixed</th>
<th>☑ Fixed</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Device</td>
<td>☐ Device</td>
<td>☐ Device</td>
</tr>
</tbody>
</table>

Storing word device 100→10  
Storing word device 200→100  
Storing word device 50→101

When touched, the specified fixed value is written. Specify the value using the spin box to the right of "Fixed".

Current value of specified word device: 100

When touched, the current value of the specified word device is written. Specify the word device by clicking on [Dev.] to display the "Device Setting" dialog box.

Current value of specified word device + fixed value

When touched, the current value of the specified word device + the fixed value is written.

The range of values which can be specified as fixed values changes depending on the setting entered for "Device".
3 Setting the **Trigger** settings

See Section 15.2.2, Setting the Run Timing for Specified Movements.

4 Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.

---

Special Cases

- Adding or subtracting the current word device value by touching it

If you set the same value for the storing word device and the specified word device, and then specify the value to be added or subtracted (using the "Fixed" parameter), values can be added to and subtracted from the current word device value.

*(Example)* Each time [+] is touched, the value of D100 increases by 1, and each time [-] is touched, the value decreases by 1.

---

The monitor device specifies the numeric display function for D100. The fixed value for the storing device and the specified word device is set to "10".

The fixed value for the storing device and the specified word device is set to "11".

Set for D100

The fixed value for the storing device and the specified word device is set to "-1".

Set for D100

---

16 - 20
15.5 Setting Touch Key (Base Switching) Functions

15.5.1 Switching to the Screen of the Previously Displayed Base Screen Number

What does this function do?

- This function switches to the screen of the previously displayed base screen number when touched.

POINT

- Base screens are switched when the touch key is released.
- Base screens can also be switched through the PC program.

- This function can be used to switch base screens as shown below.

The screen numbers of up to ten previously displayed base screens can be stored in the memory of the GOT, so base screens can be switched all the way back to the first one displayed, in reverse order.

Screen switching using this function

Base screen numbers in displayed order
Outline of Procedure

- **Basic**
  - Setting of display switching
  - Setting of type of graphic
  - Setting of key graphic and text

- **Action**
  - Clicking on "Base"

See 1

No key graphic specified

This is the "Touch Key" dialog box.

See 2

This is the "Touch Key" dialog box.

See 3

This is the "Set action (Base switching)" dialog box.

See 4

This is the "Touch Key" dialog box.

See 5

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

End
Description of settings

1. Setting the (Basic) settings in the “Touch Key” dialog box

   See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings in the “Touch Key” dialog box

   Click on [Base]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].

   The “Set Action (Base switching)” dialog box is displayed.

   ![](image)

   There are three tabs in the “Set Action (Base switching)” dialog box: [Basic], [Action] (for word settings), and [Action] (for bit settings).

3. Setting the (Basic) settings in the “Set Action (Base switching)” dialog box

   “Next screen” Select “Previous monitored”, with the radio button.
4. Setting the Trigger settings in the "Touch Key" dialog box
   See Section 15.2.2, Setting the Run Timing for Specified Movements.

5. Setting the display position, display size, and effective area for key graphics
   See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.

---

**Special Cases**

- Example of switching screens using this function

```
First base screen displayed

1
   /   \
 2   3   4
   |   |   \
5   6   7   8
   |   |   \
9   10  11  12

Case 1: 1 → 2 → 6 → 10 → 6 → 2 → 5 → 9 → 5 → 2 → 1
Case 2: 1 → 3 → 7 → 11 → 7 → 3 → 1
Case 3: 1 → 4 → 8 → 12 → 8 → 4 → 1
```

The values in the boxes indicate the base screen number.

→ indicates a screen switching action not initiated using this function.
← indicates a screen switching action initiated using this function.
15.5.2 Switching to the Screen of the Specified Base Screen Number

What does this function do?

- This function switches to the screen of a specified base screen number by touching the screen.

POINT

- Base screens are switched when the touch key is released.
- Base screens can also be switched through the sequence program.
Outline of Procedure

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:

--- Basic ---
• Setting of display switching
• Setting of type of graphic
• Setting of key graphic and text

See 1
No key graphic specified
This is the
"Touch Key" dialog box.

--- Action ---
• Clicking on "Base"

See 2
This is the
"Touch Key" dialog box.

--- Basic ---
• Selection of "Fixed" with "Next screen", and
  specifying of destination base screen number

See 3
This is the "Set action (Base switching)"
dialog box.

--- Trigger ---
• Setting of action conditions

See 4
This is the "Touch Key"
dialog box.

After entering settings, click on "OK" on any tab
in the "Touch Key" dialog box.

Setting of display position, display size, and
effective area

See 5

End
### Description of settings

1. Setting the (Basic) settings in the “Touch Key” dialog box
   - See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings in the “Touch Key” dialog box
   - Click on [Base]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].
   - The “Set Action (Base switching)” dialog box is displayed.

   ![Set Action (Base switching) dialog box](image)

   There are three tabs in the “Set Action (Base switching)” dialog box: [Basic], [Action] (for word settings), and [Action] (for bit settings).

3. Setting the (Basic) settings (in the “Set Action (Base switching)” dialog box)
   - (1) Next screen
     - Select “Fixed”, with the radio button.
     - Using the spin box to the right of the “Fixed” parameter, specify the screen number of the next base screen to be displayed.

4. Setting the (Trigger) settings in the “Touch Key” dialog box
   - See Section 15.2.2, Setting the Run Timing for Specified Movements.

5. Setting the display position, display size, and effective area for key graphics
   - See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
15.5.3 Switching to the Screen of a Base Screen Number by Turning the Specified Bit Device ON/OFF

What does this function do?

- This function switches to the specified base screen by touching a specified bit device to turn it ON and OFF.

POINT

- Base screens are switched when the touch key is released.
- Base screens can also be switched through the sequence program.
Outline of Procedure

**Basic**
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

**Action**
- Clicking on "Base"

---

**See 1**
No key graphic specified

---

This is the "Touch Key" dialog box.

**See 2**
This is the "Touch Key" dialog box.

---

**See 3**
This is the "Set action (Base switching)" dialog box.

---

**See 4**
This is the "Set action (Base switching)" dialog box.

---

**See 5**
This is the "Touch Key" dialog box.

---

**See 6**

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

---

End
Description of settings

1  Setting the (Basic) settings in the "Touch Key" dialog box
   See Section 15.2.1, Setting Key Graphics.

2  Setting the (Action) settings in the "Touch Key" dialog box
   Click on [Base]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].
   The "Set Action (Base switching)" dialog box is displayed.

![Set Action (Base switching) dialog box]

There are three tabs in the "Set Action (Base switching)" dialog box: [Basic], [Action] (for word settings), and [Action] (for bit settings).

3  Setting the (Basic) settings in the "Set Action (Base switching)" dialog box
   "Next screen"  Select "Device", with the radio button.
   Click on [Dev.], and in the "Device Setting" dialog box, specify the bit device.
   See Section 10.1, Setting the Device to be Monitored.
4 Setting the **Trigger** settings (in the "Set Action (Base switching)" dialog box)

To specify the number of the base screen to which the display is to be switched when the specified bit device is on, click on the "ON" column, and then on **Edit**.

To specify the number of the base screen to which the display is to be switched when the specified bit device is off, click on the "OFF" column, and then on **Edit**.

The "Edit Display Format" dialog box is displayed.

"Switching type" Select the method by which the base screen is to be switched, using the radio buttons.

- **No.** ............ Select this if the screen is to be switched to the specified base screen number when the specified bit device is turned on or off.
- **Hold** ............ Select this if the screen is not to be switched when the specified bit device is turned on or off.
5  Setting the (Trigger) settings in the "Touch Key" dialog box
   See Section 15.2.2, Setting the Run Timing for Specified Movements.

6  Setting the display position, display size, and effective area for key graphics
   See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
15.5.4 Switching to the Screen of a Base Screen Number Using the Current Value of the Specified Word Device

- What does this function do?
  - This function switches the base screen based on the current value of a specified word device, by touching it.

**POINT**
- Base screens are switched when the touch key is released.
- Base screens can also be switched through the sequence program.

When touched, if the value of the specified word device fits a specified comparison equation, the screen of the specified base screen number is displayed.

Base screen switching device
The switched value differs depending on \( 1 \rightarrow \) comparison equation

Up to 8 comparison equations can be specified.
Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1
No key graphic specified
This is the "Touch Key" dialog box.

Action
- Clicking on "Base"

See 2
This is the "Touch Key" dialog box.

Basic
- Selection of "Device" with "Next screen"
- Specifying of word device

See 3
This is the "Set action (Base switching)" dialog box.

Set action
- Setting of comparative equation and number of next base screen to be displayed

See 4
This is the "Set action (Base switching)" dialog box.

Trigger
- Setting of action conditions

See 5
This is the "Touch Key" dialog box.

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

See 6
1. Setting the (Basic) settings in the “Touch Key” dialog box

See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings in the “Touch Key” dialog box

Click on [Base]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].

The “Set Action (Base switching)” dialog box is displayed.

There are three tabs in the “Set Action (Base switching)” dialog box: (Basic), (Action) for word settings, and (Action) for bit settings.

3. Setting the (Basic) settings in the “Set Action (Base switching)” dialog box

“Next screen” Select “Device”, with the radio button.

Click on [Dev.], and in the “Device Setting” dialog box, specify the bit device.

See Section 10.1, Setting Devices for Monitoring.
4 Setting the (Trigger) settings (in the "Set Action (Base switching)" dialog box)

This is specified if the base screen is to be switched when touched, based on the value stored in the specified word device.

(1) Base screens can be switched as described below, based on the value stored in the specified word device and the comparative equation.

- No. ............. If the value of the specified word device fits the comparative equation, the screen is switched to the specified base screen.
- Indirect .......... If the value of the specified word device fits the comparative equation, the screen is switched to the base screen corresponding to the value.
- I hold ........... If the value of the specified word device fits the comparative equation, the screen is not switched even if touched.

(2) The comparative equation for the display range is specified as follows.

<table>
<thead>
<tr>
<th>Type of comparative equation</th>
<th>Left</th>
<th>Operand</th>
<th>Middle</th>
<th>Operand</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>n1</td>
<td>&lt;=</td>
<td>$V</td>
<td>&lt;=</td>
<td>m1</td>
</tr>
<tr>
<td>Above</td>
<td>n2</td>
<td>&lt;=</td>
<td>$V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>$V</td>
<td>&lt;=</td>
<td>2 3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify numeric values for n1, m1, n2, and 2 3.
"$V" indicates the value stored in the specified word device.

Click on [Edit] and specify the method by which the screen is to be switched and the comparative equation in the "Edit Display Format" dialog box. Up to eight types of comparative equations can be specified.
"Switching type" Using the radio buttons, specify the method by which the base screen is to be switched if the value of the specified word device fits the comparative equation specified with the "Display range" parameter.

Hold .............. Select this if the screen is to be switched to the specified base screen number. Use the spin box to specify the number of the next base screen to be displayed.

Indirect ............ Select this if the base screen is to be switched to the screen whose number corresponds to the value of the specified word device.

No. ................. Select this if the screen is not to be switched even if touched.

"Display range" Specify a comparative equation.

See Section 10.5, Setting Display Ranges (Comparative Equations).
(Example)
Case 1: The screen is switched to Base Screen No. 10 if the current value of the specified word device is 0 or less ($V \leq 0$) when touched.

Current value of specified word device $\leq 0$

Case 2: If the current value of the specified word device is between 1 and 20 ($1 \leq V \leq 20$) when touched, the screen is switched to the base screen number corresponding to the value.

- If the current value of the specified word device is 5, the screen is switched to Base Screen No. 5.
- If the current value of the specified word device is 10, the screen is switched to Base Screen No. 10.

$1 \leq \text{Current value of specified word device} \leq 20$

Case 3: If the current value of the specified word device does not fit the above cases when touched (the current value of the specified word device is 21 or higher), the currently displayed base screen continues to be displayed.

$21 \leq \text{Current value of specified word device}$

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$V \leq 0$</td>
<td>No.10</td>
</tr>
<tr>
<td>2</td>
<td>$1 \leq V \leq 20$</td>
<td>Indirect</td>
</tr>
<tr>
<td>Default</td>
<td>$21 \leq V$</td>
<td>Hold</td>
</tr>
</tbody>
</table>
15.5.5 Switching the Base Screen Using a Sequence Program

Base screens can be switched without using the touch key (base switching) function, by creating a sequence program in which the value of the base screen switching device is written to the value of the base screen number to be displayed next.

If "GD" is specified as the device name for the base screen switching device, however, the base screen cannot be switched using the sequence program.

(Example) Base screen switching device: D100

The display switches to base screen No. 10 when M10 goes on.

```
<table>
<thead>
<tr>
<th>Switching instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>M0</td>
</tr>
<tr>
<td>[MOVP K10 D100]</td>
</tr>
</tbody>
</table>
```

If "GD" is specified as the device name for the base screen switching device, the base screen cannot be switched using the sequence program.
15.6 Setting the Touch Key (Window Switching) Functions

15.6.1 Changing to the Screen of the Specified Window Number

What does this function do?

- This function switches to a specified window screen number by touching the screen.

POINT

- Only one window screen can be displayed on a base screen.
- Window screens are displayed and switched when the touch key is released.
- Window screens can also be switched through the sequence program.

- This function can also be used to switch from the currently displayed window screen to a specified window screen.
- Tool Bar 1 -
Selected icon

- Menu Bar -
Selected command
On Draw menu:

Touch key

Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

No key graphic specified

This is the “Touch Key” dialog box.

Action
- Clicking on “Window”

This is the “Touch Key” dialog box.

Basic
- Selection of “Fixed” with “Next screen”, and specifying of number of next screen to be displayed

This is the “Set action (Base switching)” dialog box.

Trigger
- Setting of action conditions

This is the “Touch Key” dialog box.

After entering settings, click on “OK” on any tab in the “Touch Key” dialog box.

Setting of display position, display size, and effective area

End

- Settings for this function are entered using the same procedures as those for switching base screens. (The same approach is used.)

See Section 15.5.2, Changing to the Screen of the Specified Base Screen Number.
15.6.2 Changing to the Screen of a Window Screen Number by Turning the Specified Bit Device ON/OFF

- **What does this function do?**
  - This function switches to the specified window screen by touching a specified bit device to turn it on and off.

**POINT**

- Only one window screen can be displayed on a base screen.
- Window screens are displayed and switched when the touch key is released.
- Window screens can also be switched through the sequence program.

- The window screen can be switched by using this function to specify another window screen.
Outline of Procedure

- **Basic**
  - Setting of display switching
  - Setting of type of graphic
  - Setting of key graphic and text

- **Action**
  - Clicking on "Window"

- **Action settings**
  - Specifying the number of the window screen to be displayed or switched

- **Trigger**
  - Setting of action conditions

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

End

- Settings for this function are entered using the same procedures as those for switching base screens by turning the specified bit device on or off. (The same approach is used.)

See Section 15.5.3, Switching to the Screen of a Base Screen Number by Turning the Specified Bit Device ON/OFF.
15.6.3 Changing to the Screen of a Window Screen Number Using the Current Value of the Specified Word Device

What does this function do?

- This function switches the window screen based on the current value of a specified word device, by touching it.

**POINT**

- Only one window screen can be displayed on a base screen.
- Window screens are displayed and switched when the touch key is released.
- Window screens can also be switched through the sequence program.

When touched, if the value of the specified word device fits a specified comparison equation, the screen of the specified window screen number is displayed.

- This function can be used to switch the window screen by specifying another window screen.
Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

Action
- Clicking on "Window"

Action settings
- Specifying the comparative equation and the number of the window screen to be displayed or switched

Trigger
- Setting of action conditions

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

End

- Settings for this function are entered using the same procedures as those for switching base screens by turning the specified word device on or off. (The same approach is used.)

See Section 15.5.4, Switching to the Screen of a Base Screen Number Using the Current Value of the Specified Word Device.
15.6.4 Changing the Window Screen Using a Sequence Program

Window screens can be switched without using the touch key (base switching) function, by creating a sequence program in which the value of the window screen switching device is written to the value of the window screen number to be displayed next.

If "GD" is specified as the device name for the window screen switching device, however, the window screen cannot be switched using the sequence program.

(Example) Window screen switching device: D100

The display switches to window screen No. 10 when M10 goes ON.

If a window screen is already displayed:

Switching instruction

M10

[ MOV PK10 D100 ]

M10

[ MOV PK10 D100 ]
15.7 Setting the Touch Key (Expansion) Functions

What does this function do?

- This function switches from the screen being monitored to the next screen. The following can be switched to and displayed:
  - Utility screens (utility menu screens)
  - Key windows, key windows 1 (for numeric input function)
  - System monitor (basic screen for system monitor)
  - Test windows
  - Circuit monitor screens (circuit monitor screens/PC readout screens) .... A85□GOT can't be set.
  - Special unit monitors (system configuration) .................A85□GOT can't be set.
  - Start Hard Copy .............................................A85□GOT can't be set.
  - Cancel Hard Copy .............................................A85□GOT can't be set.

--- Tool Bar ---

Selected icon

| SP                  | Touch key |

--- Menu Bar ---

Selected command

On Draw menu:

Touch key

Outline of Procedure

Basic

- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1

No key graphic specified

Action

- Clicking on "Expanded"
- Specifying the screen to be switched

See 2

Trigger

- Setting of action conditions (Set only when key window is selected)

See 3

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

See 4

Setting of display position, display size, and effective area

End
Description of settings

1. Setting the Basic settings in the "Touch Key" dialog box

   See Section 15.2.1, Setting Key Graphics.

2. Setting the Action settings

Click on [Extended].

After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].

The "Action (Expanded Key)" dialog box is displayed.
"Expanded action" Select the screen to be displayed, using the radio buttons.

3 Setting the Trigger settings
   See Section 15.2.2, Setting the Run Timing for Specified Movements.

4 Setting the display position, display size, and effective area for key graphics
   See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
15.8 Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys

This function can be specified on a window screen and touch keys used as the keys for inputting numeric values to base screens and for input in the ASCII input function.

**When is this function used?**

- This function is used when you want to create keys to use with the numeric input function or the ASCII input function, and when simultaneous pressing of touch keys is inhibited.

**Description of settings**

---

**Tool Bar 1**

Selected icon

![Selected icon](image)

**Menu Bar**

Selected command

On Draw menu:

Touch key

---

**Outline of Procedure**

- **Basic**
  - Setting of display switching
  - Setting of type of graphic
  - Setting of key graphic and text

- **Action**
  - Specifying the key code
  - Specifying the action conditions

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

---

See 1

No key graphic specified

See 2

See 3

End
1. Setting the (Basic) settings in the "Touch Key" dialog box

See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings

Using the spin box, specify the key codes for the keys to be used for numeric input or ASCII input. ASCII codes and shift JIS codes may be specified.

When the display format for numeric input is hexadecimal or binary, the entry becomes hexadecimal automatically. When "10" is entered, "16"(10h) is written to the PC CPU.

---

### Numeric Input Functions

- **Numeric values input** ........................................... 002Dh, 002Eh, 0030h to 0046h

  See Appendix 1, Key Code Table.

- **Delete all input numeric values** .................................................. 0008h

  **Delete numeric value being input and reverse sign "—"** ............................ 002Dh

  **Delete last digit of input numeric value and shift all one digit to the right** ............... 0008h

  **Write input numeric value to storing device (execute) / shift cursor** ................ 000Dh

  **Interrupt input and shift cursor** To right ........................................ 0080h

  and shift cursor To left ....................................................... 0081h

  Up ............................................................. 0082h

  Down ............................................................. 0083h

- **Interrupt input and delete cursor** ........................................... 001Bh
15.Setting the Touch Key Functions

- ASCII Input Functions
  - For ASCII input .................................. ASCII codes, Shift JIS Kanji character code (Level 1, Level 2)  
    See Appendix 1, Key Code Table.
  - Delete all characters being input ................................................................. 0008h
  - Write input characters to storing device (execute) /shift cursor ...................... 000Dh
  - Shift cursor
    To right ................................................................. 0080h
    To left ................................................................. 0081h
    Up ................................................................. 0082h
    Down ................................................................. 0083h
  - Delete cursor ......................................................................................... 001Bh

---

4 Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
Chapter 16

Setting Data Input Functions
16. Setting Data Input Functions

16.1 Setting the Numeric Input Function

What does this function do?

- This function allows any desired numeric value to be written to a specified word device.
- Keys for numeric input are displayed on the GOT key window screen (keys for input can be freely created by the user (also possible from the operation panel)).
- If the value is not to be input (the input cursor is not displayed), the value is displayed as a numeric value.

*1...When “Open key window simultaneously” is selected.

Useful Information About the Numeric Input Function

- Touching the area to be input displays the input cursor. (When specifying the display position, the X and Y axes should be specified in values that are multiples of 16 dots.)
- When a window is displayed, if the numeric input function is specified in the displayed window screen, the input cursor is displayed only in the window screen. It will not be displayed in the base screen, even if the numeric input function is on in the base screen.
Outline of Procedure

Basic
- Setting of display size
- Setting of monitor device
- Setting of display format

Display Format
- Setting of input range
- Setting of display color

Is layered conversion to be used for input data?
Is value to be stored in device to be added and displayed?

Expression
- Specify equations for layered conversion and addition

Trigger
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position

Setting of cursor position following writing of numeric value

End
Description of settings

1 Setting the Basic settings

"Display size" Using the list box, select the size in which text is to be input following input of numeric values. The size of one character at a horizontal and vertical size of 1 x is 16 x 18 dots.

"Monitor device" Click on Dev., and specify the word device to which the data is to be written in the "Device Setting" dialog box.

"Dev." Using the list box, select the data type for the input numeric value or the value resulting from the written word calculation. The range of values that can be stored varies depending on the data type setting.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>–32768 to 32767</td>
<td>0 to 65535</td>
<td>–2147483648 to 2147483647</td>
<td>0 to 4294967395</td>
<td>–999999999999.0 to 999999999999.99</td>
</tr>
</tbody>
</table>

If "32-bit real number" is specified, the input value is written to the PC CPU with the precision of a single-precision integer with seven significant digits.

If "32-bit real number" is specified, the input value is written in real number format.

"NW No."  "Station No."  "Device name"  "Device number"

See Section 10.1, Setting Devices for Monitoring.
"Display style" Using the list box, select the numeric format in which the value of the storing device or the value resulting from the monitor word calculation is to be displayed.

Numeric values can be displayed in any format, but are input as decimal/hexadecimal values.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>Select this to display monitor device values as decimal values.</td>
<td>Select this to display monitor device values as real numbers with floating decimal points.</td>
<td>Select this to display monitor device values as binary values.</td>
</tr>
</tbody>
</table>

"Digits" Specify the number of digits used to express the numeric area, using the spin box. The number of digits that can be displayed using the "Display style" parameter is as shown below.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>1 to 13 digits</td>
<td>1 to 32 digits</td>
<td>1 to 32 digits</td>
</tr>
</tbody>
</table>

"Decimal point" When real numbers are selected using the "Display style" parameter, use the spin box to specify how many digits are to be displayed to the right of the decimal point.

"Left alignment" Using the radio buttons, select whether the display is to be aligned to the left or right in relation to "Right alignment" the display position.

(Example) 6 digits, with a monitor device of 150

"Zero suppress" When "Right alignment" is selected for the above parameter, place an "X" in the check box if zeroes are to be displayed in front of the numeric value.

"Outline font" When numeric values are to be displayed in outline fonts, place an "X" in the check box. (Applicable only when the display is set to double or larger size both vertically and horizontally.)

"Input ID" Using the radio button, select whether or not to specify an ID number If "Specify" is selected, set an ID number in the spin box. ID numbers in the range of 1 to 65535 can be specified.
2 Setting the Display Format

Click on "Case" and then Edit to display the "Edit Display Format" dialog box, and specify the numeric input range and the numeric display attributes. The "Edit Display Format" dialog box is displayed.

"Attribute"
"Color" If the value of the storing device is within the range specified by the "Display range" parameter, select the color in which the numeric value is to be displayed, using the list box.

"Reverse" If the value of the storing device is within the range specified by the "Display range" parameter and a reversed display is to be used, place an "X" in the check box.

"Blink" If the value of the storing device is within the range specified by the "Display range" parameter and a blinking display is to be used, select "Yes" using the list box.
"Display range" Specify the range of values that can be input. If a numeric value is input which is not within this range, it will not be written to the storing device. Up to eight types of comparative equations can be specified.
Also, if “All area” button is clicked, the entire range is selected for the input range.

See Section 10.5, Setting Display Ranges (Comparative Equations).

Setting the (Expression)

See Section 10.3, Setting Data Expressions (Numeric Input Function).

Please keep the following in mind when setting the data expression:

- “Monitor word expression” is specified if the value of the storing device is to be added and displayed.
- “Storing word expression” is specified if the input value is to be written to the storing device.
- The equation specified for the “Storing word expression” parameter should enable values to be stored in the data type specified with the “Device type” parameter.
- Input values are written to the device in the sequence shown below, and displayed as numeric values.

![Diagram of data expression sequence]
**“Trigger type”**  Using the radio buttons, select whether the value is to be written to the storing device immediately when [ON] is touched, or if it is to be written only when a specified bit device is on or off. Ordinary...... The numeric value is written to the storing device when the key is touched.

**ON ...............** The numeric value is written to the storing device only when the bit device specified with the “Trigger device” parameter is on.

```
Specified bit is off
     ↓
Input value is not written
```

```
Specified bit is on
     ↓
Input value is written
```

**OFF .............** The numeric value is written to the storing device only when the bit device specified with the “Trigger device” parameter is off.

```
Specified bit is on
     ↓
Input value is not written
```

```
Specified bit is off
     ↓
Input value is written
```

**Range ...........** This can be run only if the word device specified with “Trigger device” corresponds to the comparative equation specified with the “Range” parameter.

```
Comparative equation
0 < D10 < 100
When D10 is 1000
```

```
Comparative equation
0 < D10
When D10 is 50
```

```
Specified action is not carried out
```

```
Specified action is carried out
```

**“Trigger device”** This is specified after either “ON” or “OFF” has been selected for the “Trigger type” parameter. Click on [Dev.] and specify the bit device in the “Device Setting” dialog box.

See Section 10.1, Setting Devices for Monitoring.
"Range" A comparison expression is specified when selecting the range with the "Trigger type". See Section 10.5 Setting Display Ranges (Comparative Equations).

- Display of the input cursor when operation conditions are not met

When ON/OFF of bit device is set as an operation condition for an input area during setting of numeric or ASCII input functions, if the condition is not met, the input cursor will not be displayed even if the input area is pressed.

In addition, with respect to the input area whose condition is not met, the cursor will skip the input area and move to the next input area when it is moved.

<table>
<thead>
<tr>
<th>Operation condition specified</th>
<th>Status of device</th>
<th>When input area is pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a) While ON</td>
<td>ON</td>
<td>Displays the input cursor (Buzzer sounds)</td>
</tr>
<tr>
<td>(b) While OFF</td>
<td>ON</td>
<td>The input cursor is not displayed.</td>
</tr>
<tr>
<td>(c) While ON</td>
<td>ON</td>
<td>Displays the input cursor (Buzzer sounds)</td>
</tr>
</tbody>
</table>

When the cursor is moved, it skips (b) and directly goes from (a) to (c).

The cursor is not displayed in (b).

Setting the display position

(1) When the settings for the various tabs have been entered, click on OK in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the input numeric value function.
(3) Move the cursor to the display position, and click at that position.

**POINT**

To touch the input area and display the input cursor, the X and Y axes of the display position should be specified so that they are multiples of 16 dots.

Also, when the width of the "display size" is x1 and "number of display digits" is 1, the input cursor is not displayed by touching even if the setting is made to a multiple of 16 dots. In this case, either increase the "number of display digits" or set the "display size" width to x2.

6 Setting the input cursor movement direction following writing of a numeric value

Select [Data Input] [Cursor Info] from the Drawing Setting menu in the base screen window or window screen where numeric and ASCII input functions have been specified.

The "Cursor Movement" dialog box is displayed.
"Mode"

Using the radio button, select the display position of the input cursor after writing numeric and ASCII inputs.

As a right arrow key. After writing, moves the cursor to the input area to the right of the coordinate position specified by the "Position to specify area".

As a down arrow key. After writing, moves the cursor to the input area below the coordinate position specified by the "Position to specify area".

Do Not Move. The input cursor will not move after write.

"Position to specify area"

Using the radio button, select the reference coordinate in the current input area for moving the input cursor.

Bottom-right coordinate. Moves using the bottom-right coordinate of the current input area as a reference.

- As a right arrow key
  - As a down arrow key

  Moves in the order ① → ② → ③

  Moves in the order ① → ② → ③

Top-left coordinate. Moves using the top-left coordinate of the current input area as a reference.

- As a right arrow key
  - As a down arrow key

  Moves in the order ① → ② → ③

  Moves in the order ① → ② → ③

POINT

Since the setting of the coordinate to specify the setting mode and the destination of the move is specified for each screen, more than one setting cannot be made per screen.
"Project common"

During screen switches, place an "X" in the check box to select whether or not to display the cursor as well as the window for numerical value input.

<table>
<thead>
<tr>
<th>&quot;Project common&quot;</th>
<th>Operation status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display cursor when switching screen</td>
<td>Open key window at the same time</td>
</tr>
<tr>
<td>![Diagram 1]</td>
<td>![Diagram 2]</td>
</tr>
<tr>
<td>![Diagram 3]</td>
<td>![Diagram 4]</td>
</tr>
<tr>
<td>![Diagram 5]</td>
<td>![Diagram 6]</td>
</tr>
</tbody>
</table>

Also, if "Invalidate Key-Window and Cursor on selection" is checked, the key window and cursor will disappear when the RET key is pressed.

**POINT**

Since the setting of the coordinate to specify the project common setting is specified for each project, more than one setting cannot be made per project.
Special Cases

- What is the target area for the input?
  There is only one area targeted for input, even if several numeric input functions have been specified for one screen.

- Is all monitoring interrupted during numeric input?
  Monitoring of the input area where the input cursor is displayed will be interrupted, but other sprites can be monitored during numeric input.

- What happens if the display positions for the numeric input function aren’t set to a multiple of 16 dots?
  In this case, the input cursor cannot be displayed by touching the input area. The input cursor can be displayed using the following procedure in this case:
  1) Display the key window.
  2) Touch any arrow key.

  The input cursor is displayed.

16.2 Key Window Operations

This section describes how to display and operate the key windows used with the numeric input function.

1. Displaying a key window

   Key windows can be displayed by specifying the touch key (expansion) function, and touching the touch keys.

   **POINT**
   Key windows can also be used in the ASCII input function.

   See Section 15.7, Setting the Touch Key (Expansion) Functions.

   ① Touch the input area to display the input cursor.
   ② Touch a touch key used for the touch keys (expansion) function.
   ③ A key window is displayed.
2 Key window display size

A870GOT ..... The display size for key windows is fixed at 174 (vertical) x 314 (horizontal) dots.
A85□GOT .... The display size for key windows is fixed at 118 (vertical) x 190 (horizontal) dots.

3 Key window type

1 Key window

A870GOT ..... Decimal/hexadecimal input key window.
A85□GOT .... Decimal input key window.

2 Key window 1

The key window will be displayed automatically in accordance with the data type of the numerical value input area. When the display format is the hexadecimal or binary, hexadecimal key window will be displayed.

A870GOT ..... There are 2 types: for decimal input and for hexadecimal input.
A85□GOT .... There are 2 types: for decimal input and for hexadecimal input.

1. The data to be inputted will be displayed.
2. The input range of the data will be displayed.
   (A85□GOT will not be displayed.)
4 Moving the key window display position

① Touch the top of the key window.
The key window enters the movement status and all monitoring is interrupted.

② Touch the position to which the window is to be moved within three seconds.
If the key window is not touched within three seconds, the movement status is cancelled, and monitoring is resumed. If the key window is touched within three seconds, the touch keys will not function even if touched at the specified positions.

③ The position at which the key window is displayed moves.
Applications of the various keys

<table>
<thead>
<tr>
<th>Key</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 9</td>
<td>Touch to input numeric values</td>
</tr>
<tr>
<td>A to F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Touch to input a decimal point</td>
</tr>
<tr>
<td></td>
<td>Touch to input a negative value</td>
</tr>
<tr>
<td></td>
<td>Touch to move the input cursor</td>
</tr>
<tr>
<td></td>
<td>Touch to delete the last digit of the numeric value being input and shift all of the digits one digit to the right</td>
</tr>
<tr>
<td></td>
<td>Touch to write the input numeric value to the storing device (execute)</td>
</tr>
</tbody>
</table>

Movements of the input cursor using \[ \text{↑} \text{↓} \text{←} \text{→} \]

Touching these keys moves the input cursor in the sequence indicated by (1), (2), and (3). (1), (2), and (3) are the display positions specified for the numeric input and ASCII input functions.)
7  Closing a key window

1. Touch the box on the key window.  
2. The key window is closed.

Closing a key window causes the input cursor to disappear.

8  Creating the desired keys for input

With the touch key function, the user can create keys for input by specifying the key code for keys to be used for input when touch keys are pressed.

See Section 15.8, Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys.
16.3 Setting the ASCII Input Function

What does this function do?

- This function writes any desired numeric value to a specified word device.
- The user can create keys to be used for input. (Numeric values can also be input using key windows.)
- If the value is not targeted for input (the input cursor is not displayed), it will be displayed as an ASCII value.

Touch the input area to display the input cursor.

Text input →

Cursor moves to the next input area

Useful Information About the ASCII Input Function

- Touching the area to be input displays the input cursor. (When specifying the display position, the X and Y axes should be specified in values that are multiples of 16 dots.)
- When a window screen is displayed, if the ASCII input function is specified in the displayed window screen, the input cursor is displayed only in the window screen. It will not be displayed in the base screen, even if the ASCII input function is on in the base screen.
Outline of Procedure

Basic
- Setting of display size
- Setting of monitor device
- Setting of display style
- Setting of display format

See 1

Trigger
- Setting of display conditions

See 2

After entering settings, click on "OK" on any tab

See 3

Setting of display position

See 4

Setting of cursor position following writing of ASCII value

End
Description of settings

1. Setting the Basic settings

- **Basic**
  - **Position**
    - X: 0
    - Y: 0
  - **Size**
    - V: 1
    - H: 1
  - **Monitor device($$)**
    - 0-FF
    - Dev.
  - **Display style**
    - Digits: 6
  - **Display format**
    - Color: 
      - Blink: No
        - Reverse

- **Trigger**
  - OK
  - Cancel
  - Previous
  - Next
  - Help

(1) **Display size** Using the list box, select the size in which character strings are to be displayed.

  (Example) Vertical: 2 x  2 x

  ![8 dots](8 dots)
  ![16 dots](16 dots)
  ![32 dots](32 dots)

(2) **Monitor device** Click on [Dev.] and then use the “Device Settings” dialog box to specify the first word device in which the data is to be stored.

  ![See Section 10.1, Setting Devices for Monitoring.](See Section 10.1, Setting Devices for Monitoring.)

(3) **Display style**

  - **Digits** Using the spin box, specify the number of digits in which the text is to be input.

(4) **Display format**

  - **Color** Select the color to be used for ASCII displays, using the list box.
  - **Blink** If a blinking display is to be used for ASCII displays, select “Yes” using the list box.
  - **Reverse** If a reversed display is to be used for ASCII displays, place an “X” in the check box.
2. **Setting Trigger**

"Trigger type" Using the radio buttons, select whether the character code is to be written to the storing device immediately when [Esc] is touched, or if it is to be written only when a specified bit device is on or off.

Ordinary ...... The character code is written to the storing device when the key is touched.
ON ............... The character code is written to the storing device only when the bit device specified with the "Trigger device" parameter is on.

Specified bit is off
↓ Character code for input character is not written
Specified bit is on
↓ Character code for input character is written

OFF ............. The character code is written to the storing device only when the bit device specified with the "Trigger device" parameter is off.

Specified bit is on
↓ Character code for input character is not written
Specified bit is off
↓ Character code for input character is written

"Trigger device" This is specified after either "ON" or "OFF" has been selected for the "Trigger type" parameter. Click on [Dev.] and specify the bit device in the "Device Setting" dialog box.

See Section 10.1, Setting Devices for Monitoring.
3 Setting the display position

(1) When the settings for the various tabs have been entered, click on [OK] in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the ASCII input function.

(3) Move the cursor to the display position, and click at that position.

**POINT**
To touch the input area and display the input cursor, the X and Y axes of the display position should be specified so that they are multiples of 16 dots.

4 Setting the input cursor movement direction following writing of a numeric value

Select [Data Input] [Cursor Info] from the Drawing Setting menu in the base screen window or window screen where numeric and ASCII input functions have been specified.

The "Cursor Movement" dialog box is displayed.
“Setting Mode” Using the radio button, select the display position of the input cursor after writing numeric and ASCII inputs.

As a right arrow key .................. After writing, moves the cursor to the input area to the right of the coordinate position specified by the “Position to specify area”.

As a down arrow key .................. After writing, moves the cursor to the input area below the coordinate position specified by the “Position to specify area”.

Do Not Move ......................... The input cursor will not move after write.

“Position to specify area”

Using the radio button, select the reference coordinate in the current input area for moving the input cursor.

Bottom-right coordinate ............... Moves using the bottom-right coordinate of the current input area as a reference.

- As a right arrow key

```
1 2 3 4
Moves in the order ①→②→③
```

- As a down arrow key

```
① ② ③ ④
Moves in the order ①→②→③
```

Top-left coordinate .................... Moves using the top-left coordinate of the current input area as a reference.

- As a right arrow key

```
① ② ③ ④
Moves in the order ①→②→③
```

- As a down arrow key

```
① ② ③ ④
Moves in the order ①→②→③
```

**POINT**

Since the setting of the coordinate to specify the setting mode and the destination of the move is specified for each screen, more than one setting cannot be made per screen.
"Project common"

During screen switches, place an "X" in the check box to select whether or not to display the cursor as well as the window for numerical value input.

<table>
<thead>
<tr>
<th>Display cursor when switching screen</th>
<th>Open key window at the same time</th>
<th>Operation status</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>□</td>
<td></td>
</tr>
<tr>
<td>□</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

**POINT**

Since the setting of the coordinate to specify the project common setting is specified for each project, more than one setting cannot be made per project.
**Special Cases**

- What is the target area for the input?
  
  There is only one area targeted for input, even if several ASCII input functions have been specified for one screen.

- Is all monitoring interrupted during text input?
  
  Monitoring of the input area where the input cursor is displayed will be interrupted, but other sprites can be monitored during text input.

- What happens if the display positions for the ASCII input function aren't set to a multiple of 16 dots?
  
  In this case, the input cursor cannot be displayed by touching the input area. The input cursor can be displayed using the following procedure in this case:

  1. Display the key window.
  2. Touch any arrow key.

  The input cursor is displayed.

**16.4 Creating Keys to be Input**

The user can create keys to be used for input in the touch key function, by specifying a key code for the touch key to be used for input.

See Section 15.8, Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys.
Chapter 17

Displaying Window Screens
17. Displaying Window Screens

17.1 Window Screen Operations

This section describes how to display and operate window screens.

1 Displaying a key window

Key windows can be displayed by specifying the touch key (window switching) function, and touching the touch keys. The touch key (window switching) function can also be specified to switch from the currently displayed window screen to another window screen.

See Section 15.6, Setting the Touch Key (Window Switching) Functions.

2 Window screen display size

A870GOT

Minimum size .... 99 dots x 83 dots (The range where graphic drawing and sprite function settings are possible on the graphics software is 96 dots x 64 dots.)

Maximum size .... 446 dots x 247 dots (The range where graphic drawing and sprite function settings are possible on the graphics software is 443 dots x 228 dots.)

Possible setting range for horizontal size

.... minimum 96 dots to initial value 316 dots to maximum 446 dots (Setting is possible in one-dot units within the range described above.)

Possible setting range for vertical size

.... minimum 64 dots to initial value 176 dots to maximum 247 dots (Setting is possible in one-dot units within the range described above.)

A85□GOT

The size is fixed to 127 dots, horizontal x 191 dots, vertical.
The range where graphic drawing and sprite settings are possible on the graphics software is 126 dots x 190 dots.
3 Status of base screens in which a window screen is displayed

Monitoring of the base screen can be carried out even if a window screen is displayed on the base screen.

4 When a key window is displayed on the base screen

Window screens can be displayed even if a key window is displayed on the base screen.

5 In the graphics software, a line with a one-dot width at the upper left of the window screen overlaps the window frame. Please be aware that, because of this, if a graphic is drawn which includes this line, that line of the graphic will not be displayed on the GOT.

6 Setting the first position at which a window screen is displayed

The first position at which a window screen is displayed is specified by setting the position at which the window is to be displayed on the base screen window.

See Section 17.3, Setting the Initial Display Position for the Window Screen.

If a window screen is displayed on a base screen without entering the above setting, the window screen will be displayed in the center of the base screen.

7 Moving the window screen display position

1 Touch the top of the window screen.

The window screen enters the movement status and all monitoring is interrupted.

2 Touch the black section of the window screen
② Touch the position to which the window is to be moved within three seconds.

If the window is not touched within three seconds, the movement status is cancelled, and monitoring is resumed. If the window is touched within three seconds, the touch keys will not function even if touched at the specified positions.

③ The position at which the window screen is displayed moves.

8 Closing the window screen

① Touch the [ ] on the window screen. ② The window screen closes.
17.2 Setting the Size of the Window Screen

The procedure to set the size of the window screen will be described below.

Open the window screen for setting the size of the window screen in the application window, then activate. Select [Change Size] from the Screen Menu.

"Screen Size" dialog box will be displayed.

Click on [Edit].

The handles for changing screen size will be displayed in the drawing area of the screen window.

Move the cursor to the position of the handle and set the display size of the window screen.
When the setting is completed, left-click on one of the positions.
To change the screen size again, repeat this operation.
The screen size can be set using the spin box of the "Drawing area size" in the "Screen Size" dialog box also.
17.3 Setting the Initial Display Position for the Window Screen

1. Make the base screen window on which the window screen is to be displayed the active window.


3. The "Window Position" dialog box is displayed.

4. Click on [Edit].

5. A dotted square indicating the window screen appears on the base screen window.

6. Move the cursor to the first position at which the window is to be displayed, and click at that position.
   - To correct a position after it has been specified, enter this setting once again.
17.4 Precautions When Base Screen Touch Keys, and Window Screens are Overlapped

This section explains precautions which should be observed if the touch keys on a base screen overlap a window screen.

1 A870GOT

A 32-dot area around the periphery of the window screen is reserved and cannot be used for base screen touch keys.

- The touch key will not function even if touched.

(Example 2)

- If the section marked ① is touched, the key functions.
- If the section marked ② is touched, the key does not function.
A 16-dot area around the periphery of the window screen is reserved and cannot be used for base screen touch keys.

- The touch key will not function even if touched.

- If the section marked ① is touched, the key functions.
- If the section marked ② is touched, the key does not function.
Chapter 18

Operations Using the Panel Kit
18. Operations Using the Panel Kit

18.1 Items to Know When Using the Panel Kit

1. Panel kit configuration

   - Panel kit
   - Library No. 1
     - 1
     - The panel kit provided with the graphics software is registered.
   - Library No. 2
     - 1
     - Registered by user
     - 2
     - 255
   - Library No. 50
     - 1
     - Registered by user
     - 2
     - 255

**POINT**
To check what kind of graphic is registered, click on [Image] in the "Panelkit" dialog box.

2. Panel kit provided by the graphics software

   Library No. 1 contains graph display boxes and three-dimensional switch graphics (with sprites). These can be easily drawn by reading out the panel kit, pasting the graphics on the screen window, and then editing them.

   *Graphics drawn by the user and sprites set by the user cannot be registered in Library No. 1.*

3. Registering user-drawn graphics and set sprites in a panel kit

   Graphics drawn by the user, as well as text and sprites which have been set, can be registered in panel kits. Several graphics and sprites can also be grouped and registered in the panel kit as a single figure.

   The user can also group all of the graphics and sprites on a screen and registered them in a panel kit. The registered graphics and sprites can then be read out from the panel kit.

4. The number of panel kits that can be registered

   Up to 49 panel kits can be registered in the user library, and up to 50 types of data can be registered in one library.
18.2 Registering Drawn Graphics and Sprite Settings in a Panel Kit

- When is this function used?
  - This function is used when you want to register graphics that you have drawn, or sprites for which you have entered settings, in a panel kit, so that they can be used on other screens and with other project data.

1. Affix handles to the graphic or sprite to be registered.

   If you are registering several graphics and/or sprites in one panel kit, group them first.


3. The “Panelkit” dialog box is displayed. Click on Create under “Standard Library”.

4. The “Number” dialog box is displayed. Using the spin box, enter the number of the library in which the graphics or sprites are to be registered, and then click on OK.

5. The “Name” dialog box is displayed. Enter the library name in the text box, and click on OK.
6. Under "Panelkit name" in the "Panelkit" dialog box, click on the display position for the number being registered. Then click on **Write**.

7. The "Name" dialog box is displayed. Enter the panelkit name in the text box, and click on **OK**.

The specified graphics and/or sprites are registered.

8. The screen returns to the screen window display.
18.3 Reading a Registered Panel Kit

- When is this function used?
  - This function is used when you want to paste graphics or sprites that have been registered in a panel kit on a screen window.
  - It is also used to paste a panel kit provided by the graphics software on a screen window.


2. The “Panelkit” dialog box is displayed. Using the “Library name” list box, select the number of the library to be read.

   Click on the display position for the panel kit to be read out, in the “Panelkit name” list box.

   This can also be done by clicking on [Image] and then clicking on the display position for the panel kit to be read out, in the “Select Image” dialog box.

   With a panel kit with a sprite function, clicking on [-> ON] enables the user to confirm the switch figure when the switch is on, and clicking on [-> OFF] enables the user to confirm the switch figure when the switch is off.

   Click on [Read]. Clicking on [Select] in the “Select Image” dialog box returns the display to the “Panelkit” dialog box.

3. An image of the selected panel kit appears at the upper left of the screen window.

4. Move the cursor to the position where the panel kit is to be pasted, and click at that position.

   - If the panel kit being read contains sprites, the following dialog box is displayed.
     - If the panel kit being read out contains a single sprite, the dialog box for that sprite is displayed, so the sprite can be edited.
     - If the panel kit being read out contains several sprites, the “Edit Sprites” dialog box is displayed, so the sprites can be edited.

See Section 19.4, Selecting Several Sprites and Correcting Sprites from a List.
18.4 Deleting a Registered Panel Kit

When is this function used?

- This function is used when you want to delete a panel kit that has been registered.
- Panel kits in Library No. 1 cannot be deleted.


2. The "Panelkit" dialog box is displayed. Using the "Library name" list box, select the number of the library to be deleted. If all of the panel kits in the library are to be deleted, click on [Delete].

   Click on the display position for the panel kit to be deleted, in the "Panelkit name" list box.

   To check the type of panel kit, click on [Image] and confirm the panel kit in the "Select Image" dialog box.

   Then click on [Delete].

3. The selected panel kit is deleted. When it has been deleted, click on [Close].
18.5 Changing the Registered Library Name or Panel Kit Name

When is this function used?

- This function is used when you want to change the name of the library in a panel kit, or the name of a panel kit itself.
- Library names and panel kit names in Library No. 1 cannot be changed.


2. The "Panelkit" dialog box is displayed. To change the name of a library, select the number of the library in the "Library name" list box, and click on [Rename].

To change the name of a panel kit, select the library name to be changed. Then use the "Panelkit name" list box to click on the display position for the panel kit whose name is to be changed, and click on [Rename].

3. The "Name" dialog box is displayed. Enter the name of the library or panel kit to be changed in the text box, and click on [OK].

4. The "Panelkit" dialog box is displayed, showing the new library or panel kit name.

When the change has been made, click on [Close].
Chapter 19

Editing Set Sprites
19. Editing Set Sprites

19.1 Changing the Cursor to the Sprite Editing Cursor

To edit a sprite, the cursor first has to be changed to the sprite editing cursor, and then the sprite to be edited has to be selected.

1. On the Edit menu, select **Object of Selection** and then **Sprite**.

<table>
<thead>
<tr>
<th>Edit (E)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo (U)</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Cut (X)</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy (C)</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste (P)</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Edit Text (E)</td>
<td></td>
</tr>
<tr>
<td>Edit Vertex (V)</td>
<td></td>
</tr>
</tbody>
</table>

- **Object of Selection** | **Figure (F)**
- **Sprite (S)**
- **Figure and Sprite (A)**

This shows the current cursor status.

- Select **Object of Selection** and then **Figure** to edit a graphic or text.

  ![See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.](image)

- To edit sprites and user-drawn graphics at the same time, select **Object of Selection** and then **Figure and Sprite**.

2. The cursor changes to the sprite editing cursor. Select the sprite to be edited.

- What happens if **X** is selected on Tool Bar 1?

  Selecting **X** on Tool Bar 1 returns the cursor to the status it was in the last time that **Object of Selection** was selected on the Edit menu (the graphic editing cursor, sprite editing cursor, or graphic + sprite editing cursor).

  (Examples)

  - If **Object of Selection** and then **Figure and Sprite** were selected previously, selecting **X** changes the cursor to the graphic + sprite editing cursor.

  - If **Object of Selection** and then **Figure** were selected previously, selecting **X** changes the cursor to the graphic editing cursor.
19.2 Selecting the Sprite to Edit

When editing sprites, handles are first attached to the sprite to be edited. After the sprite setting has been entered (the display position for the sprite has been specified), handles are attached to the sprite.

POINT
The sprite setting frame shows the display range for the specified sprite on the screen window, in order to let the user see the display range and confirm that the sprite has been specified correctly.

The sprite setting frame is displayed in green, with an asterisk (*) displayed at the left or at the upper left of the specified position.

19.2.1 Selecting a Single Sprite

1. Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Move the cursor onto a line of the sprite frame containing the sprite to be edited, or within the frame.

3. Click at that point.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Using [↑↓←→], move the cursor onto a line of the sprite frame containing the sprite to be edited, or within the frame.

19.2.2 Selecting Several Overlapped Sprites in a Screen Window

1. **Using the mouse**
   1. Change the cursor to the sprite editing cursor.
   2. Move the cursor to the position which serves as the starting point.

   ![Diagram 1](image1)

   3. Click the left button of the mouse at the starting point, and then drag the mouse to a position which encloses all of the sprite setting frames to be selected.

   ![Diagram 2](image2)

   4. Release the left button of the mouse.

   ![Diagram 3](image3)

2. **Using the keyboard**
   1. Change the cursor to the sprite editing cursor.
   2. Using the arrow keys, move the cursor to the starting point.
   3. Press and, using the arrow keys, move the cursor to a position which encloses all of the sprite setting frames to be selected.

   ![Diagram 4](image4)

   4. Press .

[Image 1](image1)
[Image 2](image2)
[Image 3](image3)
[Image 4](image4)
• What happens if there is a graphic within the enclosed area?

If the cursor has changed to the sprite editing cursor, handles will not be attached to any graphics within the selected area.

• All of the sprites on the screen window can be selected using this procedure.

  - Drawing a square that extends from the upper left corner of the screen window to the lower right corner will display handles on all of the sprites on the screen.

  - If no graphics have been drawn in the screen window, the [Select All] command on the Edit menu can be used to display handles on all of the sprites.

  - The [Select All] command on the Edit menu can be used to display handles on all of the graphics and sprites in the screen window.

• What if the graphics and sprite are overlapping each other?

When the graphics and sprite are overlapping, move the cursor inside the overlapping graphics and sprite and repeat clicking while pressing down on the [CTRL] on the keyboard. The object being edited switches between the graphics and the sprite.
19.2.3 Selecting Disparate Several Sprites in a Screen Window

1. Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Move the cursor onto a line of the sprite setting frame to be selected first, or within the frame.

3. Click at that position.

4. Move the cursor onto a line of the sprite setting frame containing the sprite to be selected next, and hold down \textit{SHIFT} on the keyboard while clicking at that position.

Repeat this procedure to display handles on all of the sprites to be edited.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Using \textit{[← → ↑ ↓]}, move the cursor onto a line of the sprite setting frame containing the sprite to be selected first, or within the frame.

3. Press \textit{[F8]}.

4. Using \textit{[← → ↑ ↓]}, move the cursor onto a line of the sprite setting frame containing the sprite to be selected next, or within the frame, and press \textit{[F8]} while holding down \textit{SHIFT}. Repeat this procedure to display handles on all of the sprites to be edited.
19.2.4 Deleting One or More Selected Sprites

1. Using the mouse

1. Move the cursor to a position on the screen window where there is no sprite setting frame, and no graphic.

2. Click at that position.

2. Using the keyboard

1. Using [← → ↑ ↓], move the cursor to a position on the screen window where there is no sprite setting frame and no graphic.

19.2.5 Deleting One of Several Selected Sprites

Using the mouse

1. Move the cursor onto a line of the sprite setting frame containing the sprite to be deleted, or within the frame.

If figures are overlapping each other, move the cursor onto a line of the figure or text to be deleted.

2. Holding down \texttt{SHIFT} on the keyboard, click at that position.

Using the keyboard

1. Use $\texttt{\textup{Left/Right/Up/Down}}$ to move the cursor onto a line of the sprite setting frame containing the sprite to be deleted, or within the frame.

2. Holding down \texttt{SHIFT}, press \texttt{Enter} twice.
19.3 Editing a Sprite Using the Same Procedures as Graphic Editing

19.3.1 Correcting the Data of a Set Sprite

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be corrected.

3. Move the cursor onto a line of the sprite setting frame containing the sprite to be corrected, or within the frame, and double-click at that position. This can also be done by selecting [Edit Sprite] on the Edit menu.

4. When the dialog box for the selected sprite is displayed, correct the data.

- What happens if I click on [Previous Setting] or [Next Setting] after correcting the data?

[Previous Setting] or [Next Setting] can be selected if several sprites of the same type as that currently being corrected have been specified on the screen window. Selecting these can be very convenient if you want to continue correcting similar sprites.

Clicking on [Previous Setting] or [Next Setting] initiates the following:

(Example) If the sprite currently being corrected is displayed in Numeric Display 2:

[Previous Setting] : Displays the Numeric Display 1 dialog box

[Next Setting] : Displays the Numeric Display 3 dialog box

(Example) If the sprite currently being corrected is displayed in Numeric Display 1:

[Previous Setting] : Cannot be selected

[Next Setting] : Displays the Numeric Display 2 dialog box

(Example) If the sprite currently being corrected is displayed in Numeric Display 3:

[Previous Setting] : Displays the Numeric Display 2 dialog box

[Next Setting] : Cannot be selected
19.3.2 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction

This editing procedure can be used only with the sprites listed below:

- Comment display
- Alarm list display
- Trend graph display
- Line graph display
- Level display
- Touch key display
- Panel meter display
- Bar graph display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1 Using the mouse

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display range is to be changed.
3. If changing the display range in the vertical direction, move the cursor to a vertical handle, and if changing it in the horizontal direction, move the cursor to a horizontal handle.

![Changing in the vertical direction](image1)

![Changing in the horizontal direction](image2)

4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the display range is to be changed.
5. At the position where the change is to be made, release the left button of the mouse.

2 Using the keyboard

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display range is to be changed.
3. Using [↑↓←→], move the cursor to a vertical handle if the display range is to be changed in the vertical direction, and to a horizontal handle if the display range is to be changed in the horizontal direction.
4. The cursor changes to the size changing cursor. Press [Enter], and then use [↑↓←→] to move the cursor to the position at which the change is to be made.
5. At the position where the change is to be made, press [Enter].
### 19.3.3 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis)

This editing procedure can be used only with the sprites listed below:

- Comment display
- Alarm list display
- Trend graph display
- Line graph display
- Level display
- Touch key display
- Bar graph display
- Lamp display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

#### 1 Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the change is to be made.

5. At the position where the change is to be made, release the left button of the mouse.

#### 2 Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Using the arrow keys, move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Press Enter, and then use the arrow keys to move the cursor to the position at which the change is to be made.

5. At the position where the change is to be made, press Enter.
19.3.4 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis)

This editing procedure can be used only with the sprites listed below.

- Comment display
- Alarm list display
- Trend graph display
- Line graph display
- Level display
- Bar graph display
- Panel meter display
- Touch key display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1 Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Holding down CTRL on the keyboard, press the left button of the mouse and drag the mouse to the position at which the change is to be made.

5. At the position where the change is to be made, release the left button of the mouse.

2 Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Using ← → ↑ ↓, move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Holding down CTRL on the keyboard, press Enter, and then use ← → ↑ ↓ to move the cursor to the position at which the change is to be made.

5. At the position where the change is to be made, press Enter.
19.3.5 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction without Changing the Proportion

This editing procedure can be used only with the sprites listed below.

- Comment display
- Alarm list display
- Trend graph display
- Line graph display
- Level display
- Touch key display
- Panel meter display
- Bar graph display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1. Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Holding down [Ctrl] and [Shift] on the keyboard, press the left button of the mouse and drag the mouse to the position at which the change is to be made.

5. At the position where the change is to be made, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Using [← → ↑ ↓], move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Press [Enter], and, holding down the [Ctrl] and [Shift], use [← → ↑ ↓] to move the cursor to the position at which the change is to be made.

5. At the position where the change is to be made, press [Enter].
19.3.6 Deleting a Set Sprite

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be deleted. (If several sprites are to be deleted at the same time, select all of the sprites to be deleted.)

3. Press **DEL** on the keyboard.

**TIPS**
The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.7 Cutting the Set Sprite and Storing it on the Clipboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be cut. (If several sprites are to be cut at the same time, select all of the sprites to be cut.)

3. Select the scissors \( \text{X} \) on Tool Bar 1, or the \text{Cut} command on the Edit menu.

The cut sprite is stored on the Clipboard and can be pasted back on the screen window later on, if desired.

See Section 19.3.10, Pasting a Sprite Stored on the Clipboard.

**TIPS**

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.8 Changing (Moving) the Display Position of the Set Sprite

Using the mouse

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display position is to be changed. (If the display positions of several sprites are to be changed at the same time, select all of the target sprites.)
3. Move the cursor to a position within the sprite setting frame (if several sprites have been selected, move the cursor within the frame of any selected sprite).

![Diagram]

4. The cursor changes to the movement cursor. Press the left button of the mouse and drag the mouse to the position at which the display position is to be changed.

![Diagram]

5. At the position where the change is to be made, release the left button of the mouse.

Using the keyboard

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display position is to be changed. (If the display positions of several sprites are to be changed at the same time, select all of the target sprites.)
3. Using [←→↑↓], move the cursor to a position within the sprite setting frame (if several sprites have been selected, move the cursor within the frame of any selected sprite).
4. The cursor changes to the movement cursor. Press [Enter], and then use [←→↑↓] to move the cursor to the display position to be changed.
5. At the position where the change is to be made, press [Enter].

TIPS

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.9 Copying a Set Sprite

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be copied. (If several sprites are to be copied at the same time, select all of the sprites to be copied.)

3. Select $\square$ on Tool Bar 1, or select Copy on the Edit menu.

4. The selected sprite is stored on the Clipboard.

TIPS
The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.10 Pasting a Sprite Stored on the Clipboard

1. Select \( \text{ } \) on Tool Bar 1, or select \( \text{ } \text{Paste} \) on the Edit menu.

2. The cursor changes to the movement cursor and the setting frame for the sprite stored on the Clipboard is displayed as a dotted-line square. Move the cursor to the position at which the sprite is to be pasted.

3. Click at that position.
19.3.11 Copying and Pasting Sprites as a Batch

This editing operation enables a group of sprites to be copied and pasted at one time.
Using this function, several sprites can be selected and copied at one time.

1. Change the cursor to the sprite editing cursor.
2. Select the sprite to be copied. (If several sprites are to be copied at the same time, select all of
   the target sprites.)

3. Select [Copy and Paste] on the Edit menu. This displays the dialog box shown below.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number&quot;</td>
<td>This specifies the results of copying and pasting the sprite or sprites in numeric terms. For example, if &quot;2&quot; is specified, one sprite is copied, and two sprites are pasted on the screen.</td>
</tr>
<tr>
<td>X ...............</td>
<td>Specifies the actual number of sprites to be copied in the X direction (to the right of the copy source).</td>
</tr>
<tr>
<td>Y ...............</td>
<td>Specifies the actual number of sprites to be copied in the Y direction (downwards of the copy source).</td>
</tr>
<tr>
<td>[Example]</td>
<td>When &quot;3&quot; is specified for the X direction and &quot;2&quot; for the Y direction</td>
</tr>
</tbody>
</table>

![Diagram showing the result of copying and pasting]
<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
</table>
| "Interval (dot)" | If a setting of 2 or more has been entered for either the X or Y direction, this is used to specify the interval from the copy source position, in units of dots.  
X Specifications the interval (number of dots) in the X direction (to the right of the copy source).  
Y Specifications the interval (number of dots) in the Y direction (downwards of the copy source).  
[Example] When "0 dots" is specified for the X direction  
<For one figure>  
<For several figures>  
When "5 dots" is specified for the X direction  
<For one figure>  
<For several figures>  
When "0 dots" is specified for the Y direction  
<For one figure>  
<For several figures>  
When "5 dots" is specified for the Y direction  
<For one figure>  
<For several figures> |
<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Address increment&quot;</td>
<td>Set the number of increments to the device number of the original copy to within the -10,000 to 10,000 range. Incrementing is applied to the monitor device of the selected sprite. (For touch switches only, incrementing targets the writing device of the bit and word operations.)</td>
</tr>
<tr>
<td></td>
<td>Not........................................... The number is not incremented.</td>
</tr>
<tr>
<td></td>
<td>X priority............................. Numbers are incremented in the X direction (to the right).</td>
</tr>
<tr>
<td></td>
<td>![Diagram](D0 D1 D2 D3 D4 D5)</td>
</tr>
<tr>
<td></td>
<td>Y priority............................. Numbers are incremented in the Y direction (downwards).</td>
</tr>
<tr>
<td></td>
<td>![Diagram](D0 D2 D4 D1 D3 D5)</td>
</tr>
</tbody>
</table>

If "32 bits" has been specified for "Device type", incrementing is done in units of two addresses, and if a word bit has been specified, incrementing is done 1 bit at a time.

4. Click on [OK].

**TIPS**

The procedure described on this page can also be carried out on graphics at the same time.
19.3.12 Grouping Several Sprites in One Group

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be grouped.

3. Select [ ] on Tool Bar 1, or select the [Group] command and then the [Group] command on the Edit menu.

19.3.13 Ungrouping Sprites

1. Change the cursor to the sprite editing cursor.

2. Select the sprites whose group is to be cancelled. (If several groups are to be cancelled at one time, select all of the groups to be cancelled.)

3. Select [ ] on Tool Bar 1, or select the [Group] command and then the [Ungroup] command on the Edit menu.

**TIPS**

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.14 Aligning Several Sprites along the Top or Bottom

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be aligned at the top or bottom.


    | Aligned at top | Aligned at bottom |
    |----------------|-------------------|
    | The uppermost sprite is used as a reference to align the others. | The lowermost sprite is used as a reference to align the others. |

19.3.15 Aligning Several Sprites along the Left or Right

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be aligned at the left or right.

3. Select [Align] and then [Left] or [Right] on the Edit menu.

    | Aligned at left | Aligned at right |
    |----------------|------------------|
    | The sprite farthest to the left is used as a reference to align the others. | The sprite farthest to the right is used as a reference to align the others. |

**TIPS**

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.16 Aligning Several Sprites along the Left or Top at Even Intervals

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be aligned at the left or top, at even intervals.

3. Select [Align] and then [Left evenly] or [Top evenly] on the Edit menu.

   - Aligned at left, at even intervals
   - The sprites are spaced at even intervals between the top left coordinates of the uppermost sprite and the top left coordinates of the lowermost sprite.

   - Aligned at top, at even intervals
   - The sprites are spaced at even intervals along the top, between the top left coordinates of the sprite farthest to the left and the top left coordinates of the sprite farthest to the right.

19.3.17 Displaying Numeric or ASCII Displays in Block Format

The alignment operations described above can be used to show several numeric displays or ASCII displays as a block display.

TIPS

The procedure described on this page can also be carried out on graphics at the same time.
19.4 Selecting Several Sprites and Correcting Sprites from a List

With this editing function, if several sprites are being corrected, only those sprites which have been selected are displayed in list format, allowing editing to be done on a limited number of sprites.

1. Change the cursor to the sprite editing cursor.
2. Select the sprites to be corrected.
4. The "Edit Sprites" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Sprite name</em></td>
<td>The names of the selected sprites and the device being monitored are displayed. Names are displayed in the order in which they are to be specified in the screen window. Click on the position at which the name of the sprite to be corrected is displayed, and then click on [Modify]. The dialog box for the selected sprite is displayed, so that the data can be corrected. After the data has been corrected, the &quot;Edit Sprites&quot; dialog box is displayed, with an asterisk (*) next to the name of the sprite which has been corrected.</td>
</tr>
<tr>
<td><em>Device change to</em></td>
<td>Click on [Dev.] . When the &quot;Device Setting&quot; dialog box is displayed, specify the NW number, station number, device name, and device number to be effective after the change is made. See Section 10.1, Setting Devices for Monitoring. Click on [Change dev.] after setting the changed device.</td>
</tr>
<tr>
<td>Close</td>
<td>Click on this when all of the sprite corrections have been made.</td>
</tr>
</tbody>
</table>
19.5 Correcting, Utilizing, and Deleting Set Sprites from a List

This editing procedure is used to correct, utilize, and delete all of the sprites which have been specified on one screen.

1. Check to make sure handles have been affixed to the sprites, and then select [Edit Sprites] on the Edit menu.

2. The “Edit Sprites” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Sprite name”</td>
<td>The names of the sprites specified on one screen are displayed. Names are displayed in the order in which they are to be specified in the screen window. Click on the position at which the name of the sprite to be corrected, allocated, or deleted is displayed, and then click on [Modify], [Utilize], or [Delete]. If you have clicked on [Modify], [Utilize], the dialog box for the selected sprite is displayed, so that the data can be corrected. After the data has been corrected, the “Edit Sprites” dialog box is displayed, with an asterisk (*) next to the name of the sprite which has been edited.</td>
</tr>
<tr>
<td>Close</td>
<td>Click on this when all of the sprite editing has been completed.</td>
</tr>
</tbody>
</table>
### 19.6 Batch Changes to Monitor Devices Set Using Sprites


2. The "Batch Device Change" dialog box is displayed.

![Replace Devices dialog box](image)

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
</table>
| "Objects"      | Using the radio buttons, select the object of the monitor device to be changed.  
In Edit Screen: Select this if a monitor device in the screen window opened in the current application window is to be changed.  
All Screens: Select this if the monitor devices in all of the created screen windows are to be changed. |
| "Points"       | Using the spin box, set the number of points to be changed.  
Setting the number of points to be changed also changes the device numbers subsequent to the device number of the monitor device to be changed. |
| "Device"       | Select [Device], and specify the NW numbers, station numbers, device names, and device numbers both before and after the change, in the "Set Device" dialog box.  
See Section 10.1, Setting Devices for Monitoring. |

[Replace] button

After setting the devices prior to and after the change, click on this.

**POINT**

The bits of the bit device ↔ word device can also be switched.
Chapter 20

Operations Subsequent to Screen Creation
20. Operations Subsequent to Screen Creation

20.1 Assigning a Title to the Screen Data

What purpose does this function serve?

This function is used to assign titles to base screens and window screens that have been created, to make it easy to recognize the type of screen. Titles and detailed information about the screens can also be printed out.

1. On the Common menu, select [Title] and then [Screen].

2. The "Screen Title" dialog box is displayed. Select whether a base screen or window screen title is to be specified.

   In the "Title list" text box, click at the position where the number of the screen to which a title is to be assigned is displayed.

   Then click on [Edit].

3. Enter the title in the "Title" text box. (Up to 32 full-width characters can be input.)

   If necessary, enter any explanations of the screen in the "Detailed explanation" text box. (Up to 512 full-width characters can be input.)

   Then click on [OK].

4. The "Set Title" dialog box is displayed. To correct a title which has been specified, click on the screen number for the title to be corrected, and then follow the same procedure as when the title is first specified to correct the title. When the title has been specified, click on [Close].
20.2 Viewing an Image of the Created Screen Data

- When is this function used?
  - This function is used when you want to confirm how screen data which you have created will actually look when it is displayed on the GOT.

1. Make the screen window containing the image to be viewed the active window.
2. Select [Preview] and then [Image] on the Screen menu, or select [Q].
3. The contents of the screen window are displayed as an image display.
Operations that can be used after an image is displayed

To enlarge an image display to its maximum size : Select the "Max. Size" button.

To close an image display          : Select [Close] in the control menu box.
To switch to a device display      : Select [Device] on the Display Format menu.
To switch to an image and device display : Select [Image and Device] on the Display Format menu.
To switch to a canvas display      : Select [Canvas] on the Display Format menu.
To switch to a sprite ID display   : Select [Sprite ID] on the Display Format menu.
To print out an image display      : Select [Print] on the File menu.
To output an image display to a file : Select [Save] on the File menu.

The character displays which are set in outline fonts
Take note that the characters set in outline fonts will not be displayed in outline fonts even after image display operations are performed.

Changing the window size for screen preview
When the window size for screen preview is changed, the changed size is saved.
When screen preview is invoked again, the window will open at the saved size.
20.3 Viewing the Monitor Device Specified by a Sprite

When is this function used?

- This function is used when you want to check the device for a monitor device specified with a sprite.

1. Make the screen window containing the device to be viewed the active window.
2. Select [Preview] and then [Device] on the Screen menu.
3. The device name and device number specified for the monitor device are displayed.
• Operations that can be used after the device is displayed
  To enlarge a display to its maximum size: Select the "Max. Size" button.
  To close a device display: Select [Close] in the control menu box.
  To switch to an image display: Select [Image] on the Display Format menu.
  To switch to an image and device display: Select [Image and Device] on the Display Format menu.
  To switch to a sprite ID display: Select [Sprite ID] on the Display Format menu.
  To switch to a canvas display: Select [Canvas] on the Display Format menu.
  To print out a device display: Select [Print] on the File menu.
  To output a device display to a file: Select [Save] on the File menu.

• Displaying overlapping sprites at the same position
  If several sprites have been specified so that they overlap each other at the same position, the monitor device for the last sprite to have been specified will be displayed. To display the monitor devices of all of the overlapping sprites, select "Display Several Devices/IDs" on the Display Format menu.

• If multiple actions have been specified in the touch switch function, this function can be used to display multiple devices for actions which have been specified.

• The character displays which are set in outline fonts
  Take note that the characters set in outline fonts will not be displayed in outline fonts even after image display operations are performed.

• Changing the window size for screen preview
  When the window size for screen preview is changed, the changed size is saved. When screen preview is invoked again, the window will open at the saved size.
20.4 Viewing the Image and Device for the Created Screen Data

When is this function used?
- This function is used when you want to check devices for monitor devices specified by both images and sprites in the screen data.

1. Make the screen window containing the image and device screen data to be viewed the active window.

2. Select [Preview] and then [Image and Device] on the Screen menu.

3. The contents of the screen window are displayed as an image display, and the device name and device number for the monitor device specified by the sprite are displayed.
• Operations that can be used after an image and device display

To enlarge a display to its maximum size: Select the "Max. Size" button.
To close an image and device display: Select [Close] in the control menu box.
To switch to an image display: Select [Image] on the Display Format menu.
To switch to a device display: Select [Device] on the Display Format menu.
To switch to a canvas display: Select [Canvas] on the Display Format menu.
To switch to a sprite ID display: Select [Sprite ID] on the Display Format menu.
To print out an image and device display: Select [Print] on the File menu.
To output an image and device display to a file: Select [Save] on the File menu.

• Displaying overlapping sprites at the same position

If several sprites have been specified so that they overlap each other at the same position, the monitor device for the last sprite to have been specified will be displayed. To display the monitor devices of all of the overlapping sprites, select "Display Several Devices/IDs" on the Display Format menu.

• If multiple actions have been specified in the touch switch function, this function can be used to display multiple devices for actions which have been specified.

• Changing the window size for screen preview

When the window size for screen preview is changed, the changed size is saved.
When screen preview is invoked again, the window will open at the saved size.
20.5 Viewing an Image for a Still Screen (Canvas Screen)

When is this function used?

- This function is used when you want to confirm how the still image (canvas graphic) section of the screen data will actually look when it is displayed on the GOT.

1. Make the screen window containing the screen data for the still image (canvas graphic) to be viewed the active window.

2. Select [Preview] and then [Canvas] on the Screen menu.

3. An image of the still image (canvas graphic) is displayed, with the sprite setting screen deleted.

   The "OFF" graphics for the touch key function and lamp display function are displayed, along with the panel meter graphic for the panel meter function.
• Operations that can be used after a canvas display

To enlarge the display to its maximum size: Select the “Max. Size” button.

To close a canvas display: Select Close in the control menu box.

To switch to an image display: Select Image on the Display Format menu.

To switch to a device display: Select Device on the Display Format menu.

To switch to an image and device display: Select Image and Device on the Display Format menu.

To switch to a sprite ID display: Select Sprite ID on the Display Format menu.

To print out a canvas display: Select Print on the File menu.

To output a canvas display to a file: Select Save on the File menu.

• Changing the window size for screen preview

When the window size for screen preview is changed, the changed size is saved.

When screen preview is invoked again, the window will open at the saved size.
20.6 Viewing Sprite ID Numbers Set Using Sprites

When is this function used?

- This function is used to check sprite ID numbers which were assigned automatically by the graphics software.

- What is a sprite ID number?

  This is an ID number assigned to each sprite specified in a screen window. The graphics software automatically assigns an ID number to sprites for each screen window.

  An ID number of 10000 is assigned to the first sprite specified in a screen window, followed by 10001, 10002, 10003, and so on.

  When a sprite which has been specified is deleted, sprite ID numbers specified after the deleted one will be moved up to fill in the gap.

1. Make the window in which the sprite ID number is to be confirmed the active window.
2. Select [Preview] and then [Sprite ID] on the Screen menu.
3. The sprite ID numbers are displayed.
• Operations that can be used after a sprite ID display

To enlarge the display to its maximum size: Select the "Max. Size" button.

To close a sprite ID display: Select [Close] in the control menu box.
To switch to an image display: Select [Image] on the Display Format menu.
To switch to a device display: Select [Device] on the Display Format menu.
To switch to an image and device display: Select [Image and Device] on the Display Format menu.
To switch to a canvas display: Select [Canvas] on the Display Format menu.
To print out a sprite ID display: Select [Print] on the File menu.
To output a sprite ID display to a file: Select [Save] on the File menu.

• Displaying overlapping sprites at the same position

If several sprites have been specified so that they overlap each other at the same position, the sprite ID No. for the last sprite to have been specified will be displayed. To display the sprite ID No. of all of the overlapping sprites, select "Display Several Devices/IDs" on the Display Format menu.

• Changing the window size for screen preview

When the window size for screen preview is changed, the changed size is saved. When screen preview is invoked again, the window will open at the saved size.
Chapter 21

Editing in Screen Units / Single-Project Units
21. Editing in Screen Units/Single-Project Units

21.1 Copying Other Screen Data to the Project Data being Edited

When is this function used?

- This function is used when you want to copy screen data, parts data, or comment data created as separate project data into the project data currently being edited.

Because parts data and comment data cannot be copied in number units, if there is parts data or comment data among the project data being edited, please be aware that the existing data will be deleted when the other project data is copied to the data currently being edited.

1. On the Project menu, select [Import File] and then [Project].

2. The "Import From Project" dialog box is displayed.
   - Click on [Browse] under "Source".

3. The "Browse" dialog box is displayed.
   - Specify the directory containing the project data to be copied, and then click on [OK].

4. The "Import From Project" dialog box is displayed again. Click on [Select] under the "Object" parameter.
5. The "Select Copy Objects" dialog box is displayed. Using the "Objects" parameter under the (Select objects) tab, place an X in the check box for the data to be copied. If a base screen or window screen is to be copied, specify the screen number to be copied, and the screen number to which it is to be copied.

If a base screen is to be copied, select the (Base) tab, and if a window screen is to be copied, select the (Window) tab.

6. Under "Source Screen", click on the position where the title of the screen to be copied is displayed. More than one screen number can be selected for copying. To cancel a screen number which has been selected, click on the title display position once again.

Using the "Destination head screen no." parameter, specify the screen number to which the screen is to be copied, and then click on (Browse).

7. The "Browse Title" dialog box is displayed.

If the data is being copied to more than one screen number, or more than one screen is being copied, click on the position where the destination screen number is displayed, and then click on (OK).

The "Destination head screen no." spin box can also be used to specify the screen number to which the data is to be copied.

8. When the source screen numbers and destination screen numbers for base screens and window screens have been specified, click on (OK).
9. The "Import From Project" dialog box is displayed.

Click on [Import]. This initiates the copying procedure. If a base screen or window screen is being copied, the title data for that screen number is also copied.

When the data has been copied from the other project, click on [Close].
21.2 Combining Data Created by More than One Person

This section explains how to take several different elements of project data which have been created by more than one person, and combine them as one project data element. It also explains useful information to know before beginning this procedure.

21.2.1 Items to Know Before Creating Data as a Team

- The persons involved in creating the data should discuss the project beforehand, and decide items such as base screen numbers, window screen numbers, part numbers, and comment numbers.

- If there are sections of the data which are common to all of the screens being created individually (such as screen frames and screen title boxes), these can be created ahead of time by one person, and registered in a panel kit.

1. Create the common data items to be used on all of the screens.

2. Register the data which has been created in a panel kit.

See Section 18.2, Registering Drawn Graphics and Sprite Settings in a Panel Kit.

After the data has been registered in a panel kit, store it in the drive containing the graphics software, under the following file name:

\[ \text{a8gotppkit} \text{nn} . \text{A8} \]

\( \text{nn is the library number} \)

3. Using the Windows File Manager and DOS commands, copy the above data to a floppy disk.
4. Copy the data to the required number of floppy disks.

To change the library number, change the (nn) of the destination file name and then copy the data.

5. Those persons receiving the data should then copy it under "a8gotppkit" in the drive in which the graphics software has been installed.

6. Read the common data elements from the panel kit.
21.2.2 Combining Data Created by More than One Person

Open any of the project data to be combined in the application window, and following the procedure described in Section 21.1, copy several project data elements and combine them in one.

Base screens and window screens can be copied in number units, but parts data and comment data cannot. To combine these data elements, follow the procedures described in Sections 21.2.3 and 21.2.4.

21.2.3 Combining Parts Data

Because parts data cannot be copied in number units, the procedure outlined below must be used.

1. Read the individually registered parts into the screen window. (A screen number which is not in actual use should be used as the screen window into which the parts data is read.)

See Section 13.1.2, Reading Parts.
2. Open one of the project data in the application window, and following the procedure described in Section 21.1, combine the data created by Persons A and B. (Make sure the parts data is not copied.)

![Project data after being combined]

- Base screen nos. 1 to 6 + base screen nos. 100 and 101

Monitor Screen 1

3. Register the parts from base screen numbers 100 and 101, and then delete the data of base screen numbers 100 and 101.

See Section 13.1.1, Useful Information When Utilizing and Registering Parts.
21.2.4 Combining Comment Data

Because comment data cannot be copied in number units, the procedure outlined below must be used. However, this procedure requires a commercial text editor. Please be aware that comment data cannot be combined without a text editor.

The only comment data which can be combined using this procedure is the comment itself (the text section). Attributes for the comments must be specified after the comment data has been combined.

1. Write the individually registered comment data to a text file.

   See Section 12.1.4, Using Data in Text File Format as Comment Data.

   ![Diagram showing the process of combining comment data]

2. Using the text editor, combine the text data file created by Persons A and B.
3. Open one of the project data in the application window, and following the procedure described in Section 21.1, combine the data created by Persons A and B. (Make sure the comment data is not copied.)

- Project data after being combined
  - Base screen nos. 1 to 6
  - Monitor Screen 1

4. Read the comment data in text file format combined using the text editor, and then specify the attributes for each comment.

Combined with text editor

```
// 1
Operation started
// 2
Operation in progress
// 3
Operation stopped
// 4
Line 1 error
// 5
Line 2 error
// 6
Line 3 error
```

Setting of attributes for each comment

<table>
<thead>
<tr>
<th>No.</th>
<th>Comment</th>
<th>Color</th>
<th>Normal/Reversed</th>
<th>Balking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Operation started</td>
<td>White</td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Operation in progress</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Operation stopped</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>Line 1 error</td>
<td>Red</td>
<td>Reversed</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>Line 2 error</td>
<td>Red</td>
<td>Reversed</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>Line 3 error</td>
<td>Red</td>
<td>Reversed</td>
<td>No</td>
</tr>
</tbody>
</table>

Combined Comment Data
21.3 Copying the Created Screen Data to Another Screen Number

When is this function used?

- This function is used when you want to copy screen data you have created to another screen number.

2. The "Screen Utilize/Delete" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base</td>
<td>Using the tab, select the type of screen to be copied. Copying cannot be done between base screens and window screens.</td>
</tr>
<tr>
<td>Window</td>
<td></td>
</tr>
<tr>
<td>&quot;Action&quot;</td>
<td>Using the radio buttons, select &quot;Utilize&quot;</td>
</tr>
<tr>
<td>&quot;Source/Delete No.&quot;</td>
<td>Click on the position where the title of the screen number to be copied is displayed. More than one screen number can be selected for copying. To cancel a screen number which has been selected, click on the title display position again.</td>
</tr>
<tr>
<td>&quot;Utilize number&quot;</td>
<td>Using the spin box, specify the number to be utilized. When the number to be utilized has been specified, the function is applied to screens subsequent to that of the destination screen number.</td>
</tr>
<tr>
<td>&quot;Destination No.&quot;</td>
<td>Click on the position where the title of the destination screen number is displayed. When the source and destination screen numbers have been specified, click on [Execute]. This initiates the copying procedure. The title data for the screen numbers is also copied.</td>
</tr>
<tr>
<td>Close</td>
<td>Select this when all of the data has been copied.</td>
</tr>
</tbody>
</table>
21.4 Deleting the Created Screen Data in Screen Number Units

When is this function used?

- This function is used when you want to delete several units of screen data in number units, as a batch.

2. The “Screen Utilize/Delete” dialog box is displayed.

---

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base, Window</td>
<td>Using the tab, select the type of screen to be deleted.</td>
</tr>
<tr>
<td>“Action”</td>
<td>Using the radio buttons, select “Delete”.</td>
</tr>
<tr>
<td>“Source/Delete No.”</td>
<td>Click on the position where the title of the screen number to be deleted is displayed. More than one screen number can be selected for deletion. To cancel a screen number which has been selected, click on the title display position again. When the screen numbers to be deleted have been specified, click on [Execute]. This initiates the deletion procedure. The title data for the screen numbers is also deleted.</td>
</tr>
<tr>
<td>[Close]</td>
<td>Select this when all of the specified data has been deleted.</td>
</tr>
</tbody>
</table>
21.5 Changing the Screen Number of the Created Screen Data

When is this function used?

- This function is used when you want to change the screen number for screen data you have created to another screen number.

1. Make the screen window containing the screen number to be changed the active window.
2. Select [Store As] on the Screen menu.
3. The "Store As" dialog box is displayed.

```
Old No.: 1       New No.: 2
Type: Base       OK

Old screen:
- Undelete   Delete

Title list:
1 Initial screen
2 Demo-menu
3 Operator panel
4 Multi-language
5 High speed monitor
```

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;New No.&quot;</td>
<td>Using the spin box, specify the screen number to which the screen data in the active screen window is to be changed. This can also be done by clicking on the position at which the screen number to be changed using the &quot;Screen title&quot; parameter is displayed.</td>
</tr>
</tbody>
</table>

| "Old No."     | Using the radio buttons, specify whether or not the screen data for the current screen number is to be deleted after the change is made. When the setting for the screen number to be changed has been entered, click on [OK]. The screen data is moved to the specified screen number, and that screen window becomes active. |

| Title list     | Click on this to specify a title. The "Set Title" dialog box is displayed. See Section 20.1, Assigning a Title to the Screen Data. |
Chapter 22

Alarm History Display Functions
22. Alarm History Display Functions

22.1 Summary of Alarm History Display Functions

The alarm history display function performs the following monitoring functions.

- Correlates comments with continuous bit device/word device so that comments (error message, etc.) can be displayed when it turns ON (occurrence of an error, etc.).

- Displays the detailed contents corresponding to a device which turned ON. Thus, the detailed contents and corrective actions of ON status (occurrence of an error) can be displayed. The window dedicated to the alarm history, base screen or window screen can display the detailed contents.

- The date and the time when the comments (error messages), which turns ON, were confirmed, as well as the date and the time when it returned from ON to OFF (restored) can be displayed.

- As the display content can be memorized even when the power to the GOT is turned off, the condition immediately before it was turned off can be displayed when the power is turned back on. A memory card is necessary to use this function. The optional driver must be installed to the GOT in order to save to a memory card.

Display example

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00 10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>Conveyor 6 error</td>
<td>10:30:00 10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>13:10:06</td>
<td>Processed product error</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>16:30:12</td>
<td>Line 1 error</td>
<td></td>
</tr>
</tbody>
</table>

The following operations can be performed with the alarm history function switch. (performed using the touch key, operation panel)

- Display/erase cursor: Displays the alarm history cursor.
- Move upward/ downward: When the cursor is not displayed, it moves to the previous/next page of the alarm content. When the cursor is displayed, the cursor can be moved upward/downward.
- Detailed display: Performs a detailed display of the alarm content selected.
- Confirmation: Displays the date and the time when the alarm content was confirmed by key input.
  (The key for confirmation of all alarm contents can also be set up.)
- Delete display: Deletes alarm content (*Delete all” key can be set up.)
- Reset: Can change monitor device status from ON to OFF/reset value.
- Save memory: Can save the current alarm content to a memory card.
22.2 Things to Know in the Beginning

Things to know in the beginning with respect to the alarm history display function will be described.

1. Maximum number of devices to monitor and the types of monitor devices

The devices that can be monitored are continuous bit devices (bit specification by word) and word devices (recognition and ON status by the range setting of the value). The maximum number of points that can be monitored with one alarm history display function is 1024 points for bit devices, and 128 points for 16-bit and 64 points for 32-bit word devices.

2. About the restrictions and setting positions when using this function and setting positions

- Only one setting of number of device points and device names can be made per project. The alarm history display function can be set up on several screens, even though it will be the same monitor device.

- Take note that the alarm list (user alarm) display function (scrolls the display content upward and downward) and the data list display function cannot be set up to the screen on which the alarm history display function has been set up.

3. Saving the alarm contents when the power to the GOT is OFF.

The contents of the alarm history currently displayed can be saved to a memory card. Since the data can be saved to a memory card when the power to the GOT is turned off, when the GOT is started up again, the conditions immediately before the power turn off can be displayed. (A maximum of 1024 points can be saved).

The optional units shown below and a memory card are necessary to save alarm contents.

A87GOT : Memory card
A85□GOT : A1SD59J-M1F-type memory card interface module
A85GT-C05H-type memory card connector cable, memory card

When a memory card is not used, turning off the power to the GOT will erase all alarm contents.

POINT
The optional driver must without fail be installed to GOT in order to save to a memory card.
The timing to save to a memory card can be specified arbitrarily. (1 to 60 minutes). It is possible to save via touch key input.

Power OFF

Power ON. The conditions immediately before the power off and the current conditions are displayed.

When a memory card is not used.

Power OFF

Power ON. Monitors with the current conditions during power ON status.

4 Re-display when switching the screen
Because the contents of the alarm history display function are saved to the GOT's memory, even when the screen is switched to other screens or is switched back to the alarm history display function screen again, the previously-displayed contents will be displayed without fail.

Switching to other screens

The previously-displayed contents are saved to the memory. When the alarm history function is displayed again, even if previously the display had been changed to a different page by the move upward/downward keys, the display will be carried out in the order specified by the display start line.
Methods to display the detailed contents

The alarm history display function can display the detailed contents when the specified devices turn to ON status (occurrence of an error, etc.). Detailed contents can be displayed by the three kinds of methods shown below.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>Conveyor 5 error</td>
<td>10:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>13:10:06</td>
<td>Processed product error</td>
<td>13:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>16:30:12</td>
<td>Line 1 error</td>
<td></td>
</tr>
</tbody>
</table>

The detailed display screen will be displayed by the key input from the one-touch/touch key/operation panel.

Specified comments will be displayed to the window screen dedicated to the alarm history function.

The screen corresponding to the specified window screen number will be displayed.

The screen of the specified base screen number will be displayed.

- The comment display when selecting comments.

When the comments are being selected, the specified comments will be displayed to screen dedicated to the alarm history in the below manner:

- Comments will be displayed from the top-left part of the window.
- When a comment is longer than the display range of the window screen, it will wrap the text when displaying it.
- To display a comment in the center of the window, register the comment while changing a page.

Control motor is malfunctioning. Check Conveyor 1.

Display of the time of occurrence, confirmation and restoration

The alarm history display function can display the time when a specified device turns ON as well as the time when it was displayed resorted. However, take note that depending on the type of connection, the clock display may not be possible.

See Section 11.3, Setting the Clock Display Function.
22.3 Outline of Procedures

An outline of procedures to set the alarm history display function are shown below.

Select [Alarm History] from the common setting menu

- Number of device points to be monitored
- Monitoring period
- Setting the type of detailed display
- Setting whether or not to save to the memory
- Setting messages corresponding to each device (comment number)
- Setting whether or not to reset the ON status of each monitoring device

Register comments to be displayed.
(Refer to Section 12.1.)

See Section 22.4.
The optional driver must be installed without fail to the GOT to save to the memory card.

Select [Message Display] \[ Alarm History \] from the drawing settings menu.

Basic

- Setting the display size of each item.
- Setting the display format (number of total digits, number of display rows, setting the number display digits for comment, display distance for each item).
- Display items (Setting whether or not to display the time of restoration and confirmation)
- Setting the one-touch operation of the detailed display (valid/invalid setting)

See Section 22.5 1.

Occurrences

- Display format of occurrence contents entries (setting whether or not to display the date and the time)
- Setting the title of the occurrences

See Section 22.5 2.

(To the next page)
Display the restorations?

Do not set

Set

Restorations
- Display format of the restorations (Setting whether or not to display the date and time)
- Setting the title of the restorations

See Section 22.5 3.

Display the checks?

Do not set

Set

Checks
- Display format of the checks (Setting whether or not to display the date and time)
- Setting the title of the restorations

See Section 22.5 4.

Setting the display position

See Section 22.5 5.

Setting the switch for the alarm history display function

See Section 22.6.

End
22.4 Setting Common Settings

What will be set?

- Monitor devices to be monitored by the alarm history display function will monitor, the number of device points, and the type of monitoring period detailed display contents display will be set up.

Select **Alarm History** from the common setting menu

"Alarm History (common setting)" dialog box will be displayed

1 Setting the **Basic** settings

"Form" From the spin box, select a period to check PC CPU for the specified device.

"Watch cycle" Can be set from the minimum of 600ms to the maximum of 80 seconds in units of 100ms.

"Alarm" From the spin box, select the number of device points to monitor.

The number of device points differ by the type of device specified.

<table>
<thead>
<tr>
<th>Device type</th>
<th>Number of device points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit device</td>
<td>1 to 1024 points</td>
</tr>
<tr>
<td>Bit specification by word device</td>
<td></td>
</tr>
<tr>
<td>Word device (16-bit data)</td>
<td>1 to 128 points</td>
</tr>
<tr>
<td>Word device (32-bit data)</td>
<td>1 to 64 points</td>
</tr>
</tbody>
</table>

"Memory store" Use the radio button to select whether or not to store the alarm history contents using a memory card.

"Not store/Store" When "Store" has been selected, select a storage cycle from the spin box. The setting is possible from the minimum of 1 minute to the maximum of 60 minutes in units of 1 minute.

Storing to a memory card can also be carried out by using the switch for the alarm history display function.

See Section 22.6, Setting the Touch Keys for Alarm History Display Function.

"The oldest Alarm is Deleted"

When a check is placed in this box, the older contents of the alarm history are deleted in order from the oldest and replaced with the new alarm contents if the number of alarms saved reaches the maximum point number (128 points for 16 bit data, 64 points for 32 bit data). If this box is not checked and the alarm history reaches the maximum point number (128 points for 16 bit data, 64 points for 32 bit data), the new error contents will not be saved even if the new device is set to ON.
"Detailed display"

Using the radio button, select a method to perform the detailed display after pressing the touch key for detailed display when the specified device turned on.

See Section 22.6, Setting the Touch Keys for Alarm History Display Function.

- Not display ................. Select when the detailed display is not to be carried out.
- Comment windows .... Select to display the window screen dedicated to the alarm history after pressing the touch key for the detailed display in order to display comments corresponding to the specified comment numbers.
- Windows screen ....... Select to display the screen of specified window screen number, after pressing the touch key for the detailed display.
- Base screen ............. Select to display the screen of the specified base screen number after pressing the touch key for the detailed display.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
</tr>
<tr>
<td>97/04/18</td>
<td>12:30:00</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>13:10:06</td>
<td>Processed product error</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>16:30:12</td>
<td>Line 1 error</td>
<td></td>
</tr>
</tbody>
</table>

- The method to display comments when selecting the comments window

When the comments display is selected, the comments will be displayed as follows:

- The character size of the comments is fixed vertically at 1× and horizontally at 1×.
- The comments window will be displayed without normal display or blinking, regardless of the settings made when registering the comments.
- The window screen dedicated to the alarm history cannot be displayed while the ten-key window for numerical value input is being displayed. The ten-key window display must be erased before performing the operations.

The screen corresponding to the specified window screen number is displayed. Display details with canvas characters, etc., on the window screen specified.
2. Setting the Monitor Device

Settings can be made for the number of monitor points set up.

"Device" The monitor devices that can be set up with the alarm history display are continuous devices only. If the monitor device has been set up to a word device and several ranges of occurrences have been set up to the same device, select "Fixed" after setting the monitor device.

"Comment No." Using the radio button, select how to set comment numbers corresponding to the devices which are to be specified hereafter.
Continuous .... Select when comment numbers are set starting with an initial comment number and setting consecutively thereafter.
Random ......... Select when a comment number is set a single point at a time.

"Display No." Using the radio button, select how to set up the comment number/window screen number/base screen number of the detailed displays to be specified hereafter.
Continuous .... Select when the comment number/window screen number/base screen number are set starting with an initial number and setting consecutively thereafter.
Random ......... Select when the number is set a single point at a time.

"Alarm No." When the number to edit is not being displayed, select the number to display from the "Alarm No" spin box and select [Jump].

After above settings are completed, click on the entry column which will be set up hereafter. After selecting [Edit], "Edit Alarm History" dialog box will be displayed.
"Comment No." Using the spin box, specify the comment number corresponding to the device which will be set up herein.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10 09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10 10:30:00</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Specify the comment number for the message which will be displayed in this column.

"Display No." Using the spin box, specify the comment number/window screen number/base screen number, which will be displayed in detail when the device which will be set up hereafter turns ON.

"Device" Click on [Dev] and set the devices to be monitored with the "Device" dialog box.
The data types (by sub-type) that can be set, and the display conditions by data type are as follows:

<table>
<thead>
<tr>
<th>Data type (by sub-types)</th>
<th>Conditions to display alarm contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>Displays the alarm content (display of the time of occurrence and specified comments) when specified the bit devices turns ON.</td>
</tr>
<tr>
<td>Bit of word</td>
<td></td>
</tr>
<tr>
<td>16 bit/with sign</td>
<td>Displays the alarm content (display of the time of occurrence and specified comments) when the value of a specified word device is within the range specified by the &quot;Display Range&quot;.</td>
</tr>
<tr>
<td>16 bit/without sign</td>
<td>After setting up the devices, the &quot;Display Range&quot; is specified with the &quot;Setting and Editing Alarms&quot; dialog box.</td>
</tr>
<tr>
<td>32 bit/with sign</td>
<td></td>
</tr>
<tr>
<td>32 bit/without sign</td>
<td></td>
</tr>
<tr>
<td>32 bit/real number</td>
<td></td>
</tr>
</tbody>
</table>

See Section 10.1, Setting Devices for Monitoring.

"Device reset" Using the radio button, select whether or not to reset the device specified by the alarm contents displayed using the reset switch input.
Reset ............... Select if the status of the device specified of the alarm contents is to be reset (OFF if the specified device is a bit device, the reset value status if the specified device is a word device) after the reset switch input.
Not reset .......... Select if the specified device in the alarm contents is not to be reset. Set the range of the word device value which displays the alarm contents in the case in which monitor device is performed with the word device value.

"Display range" Set the range of the word device value to display the alarm contents in the case in which the monitor device is performed with the word device value.

See Section 10.2, Setting Data Expressions (Other Than Numeric Input Function).

(Example 1) Display the alarm contents when the word device value is from 1 to 99.
Set the "Display Range": 0<$V<100
(Example 2) Display the alarm contents when the word device value is 50.
Set the "Display Range": $V=50
(Example 3) Display the alarm contents when the word device value is 100 or greater.
Set the "Display Range": 100<=$V
When the setting is completed, click on OK in the “Edit Alarm History” dialog box. The contents set up will be displayed in the “Alarm History (common setting)” dialog box.

<table>
<thead>
<tr>
<th>No.</th>
<th>Device</th>
<th>Alarm range</th>
<th>Comm.</th>
<th>Disp.</th>
<th>OK</th>
<th>Cancel</th>
<th>Edit</th>
<th>Copy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0-FF M200</td>
<td>20</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0-FF M201</td>
<td>21</td>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>0-FF M302</td>
<td>22</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0-FF M203</td>
<td>23</td>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0-FF M204</td>
<td>24</td>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0-FF M205</td>
<td>25</td>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Displays the device names which have been set up

Displays the comment numbers which have been set up

Displays the comment number/window screen number/base screen number with which to execute the detailed display

When all the settings are completed, select OK from any one of the tabs.

When the settings of common settings are completed, set the display contents.

- About editing the setting

To change the setting, select the number (column) to be changed and perform the setting again.

To copy a setting to another row, select Copy. “Copy Alarm History” dialog box will be displayed.

*Source No.* Using the spin box, set the number of the source for the copy.

*Destination No.* Using the spin box, set the number of the destination for the copy.

*Number of copy* Using the spin box, set the number of copies to execute.

*Copy item* Place an "X" in the check box if a comment number., reset setting, detailed display number, and display range is subject to copy.

When above settings are completed, select OK to execute copying.
22.5 Setting Display Contents

What will be set?
- Set the format (display formats) for each display column entry of the alarm history display.

--- Tool Bar 1 ---
Selected icon

![Alarm History]

--- Menu Bar ---
Selected command

Command menu: [Message Display] → [Alarm History]

1 Setting the (Basic) settings

![Basic settings window]

"Size"
Select a display character size in the list box.
All characters displayed in the alarm history display (date and time display, comment display) is affected by the selection of the character size made with the "Display Size".

"Display style"
Select the number of rows to be displayed in a single screen in the spin box.
The maximum setting is 27 rows.
Although the maximum number of rows displayed is 27 rows, all of the conditions can be confirmed by scrolling the display contents using move upward/downward keys.

See Section 22.6, Setting the Touch Keys for Alarm History Display Function.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>10:30:00</td>
<td>10:26:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>13:10:06</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>16:30:12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sets the display digits of the alarm contents. (The title row is not included.)

POINT
If [Common] is clicked in the [Setting alarm history display] dialog box, the common settings for the alarm history display function can be performed.
When the common settings are completed, it returns to this dialog box.
"Disp. head" Using the spin box, select from what occurrence the alarm content are displayed when multiple monitor devices are on ON status.
(Example) When the settings are as follows: Sort from the oldest; display from the fourth row.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECK</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10 09:30:00</td>
<td>M6 is ON</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10 10:30:00</td>
<td>M6 is ON</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Display begins with the fourth occurrence of the alarms which have occurred.

By setting up the alarm history display function to multiple screens, and setting different display head to each screen, contents of multiple alarms can be confirmed.

"Comm. digits" Using the spin box, select the number of display digits for comments (messages) displayed when specified devices are turned ON.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10 09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10 10:30:00</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Sets the number of digits for display comments.
Set with one digit for a single-byte and 2 digits for double-byte characters.

"Comm. title" Enter a title for the comment column displayed in the title row to the character input text box. Set the title within the number of digits specified by "Comm. digits".

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10 09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10 10:30:00</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Display position of the title specified

"Title" Select a display color for the comment title from the list box.
"Frame" Select a color for the frame in the alarm history display from the list box.
"Outline font" When the comments are to be displayed with the outline fonts, place an "X" in the check box.
"Sort" Using the radio button, select the display order of the alarms.
From the oldest: Select when displaying the alarms in the order of the oldest alarm.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/11</td>
<td>13:10:06</td>
<td></td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/12</td>
<td>16:30:12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Displays the time of occurrence in the order of the oldest.

From the most recent: Select when displaying the alarms in the order of the most recent alarm.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/12</td>
<td>16:30:12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97/04/11</td>
<td>13:10:06</td>
<td></td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td></td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Displays the time of occurrence in the order of the most recent.

"Disp. style" Place an "X" in the check box in the case of displaying the date/time when specified devices turned off (restored).

"Restorations" Place an "X" in the check box in the case of displaying the date and the time when the display confirmation switch was entered after the alarms are displayed.

"Checks" Display positions of restoration and confirmation.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/12</td>
<td>16:30:12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97/04/11</td>
<td>13:10:06</td>
<td></td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td></td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Display positions of restoration and confirmation.

"Interval" Using the spin box, set the margin between the texts or time from the frame.
Vertical margins can be set to a maximum of 32 dots in one-dot units.
Horizontal margins can be set to a maximum of 64 dots in 8-dot units.
It must be set to a multiple of 8 dots when setting the "One touch" effective.
"One touch" Using the radio button, select whether or not to display the detailed display screen with the one touch operation when performing the detailed display.
Valid: Select to display the detailed display screen by a touch on the display column.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00 Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00 Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>13:10:06 Processed product error</td>
<td></td>
<td>10:28:00</td>
</tr>
</tbody>
</table>

Invalid: Select to display the detailed display screen the touch key for the detailed display. The key code for the detailed display is FFB8H. Even if the one-touch operation has been set to valid, the detailed display screen will be displayed when the detailed display key is entered.

See Section 22.6, Setting the Touch Keys for Alarm History Display Function.
This setting specifies the display contents to be displayed in the following position of below the alarm history display.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10 09:30:00</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10 10:30:00</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/11 13:10:06</td>
<td>Processed product error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>97/04/12 16:30:12</td>
<td>Line 1 error</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Occurrences are displayed here.

"Display style" Using the radio button, select a format to display the date/time of occurrence when specified devices were restored to OFF status from ON status.
Date & time ....... Select to display both date/time.
Date ............... Select to display only date.
Time ............... Select to display only time
String .............. Select to display specified character string.

To select a string, enter the character string to be displayed in the character input text box and set a number of characters for the character string using the spin box.

"Date"
When Date has been selected with the "Display style", use the radio button to select a display format.
The year will be displayed in the last 2 digits.

<table>
<thead>
<tr>
<th>yy/mm/dd/dd</th>
<th>mm/dd/yy</th>
<th>dd/mm/yy</th>
<th>mm/dd</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>04/10/97</td>
<td>10/04/97</td>
<td>04/10</td>
</tr>
</tbody>
</table>
(Dispaly digits: 8 digits) (Display digits: 8 digits) (Display digits: 8 digits) (Display digits: 5 digits)

"Time"
When Time has been selected with the "Display style", use the radio button to select a display format.
The time will be displayed in the 24 hours format.

<table>
<thead>
<tr>
<th>hh : mm : ss</th>
<th>hh : mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>09 : 50 : 48</td>
<td>09 : 50</td>
</tr>
</tbody>
</table>
(Dispaly digits: 8 digits) (Display digits: 5 digits)
This setting specifies the display contents to be displayed in the following position of below the alarm history display.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/11</td>
<td>Processed product error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/12</td>
<td>Line 1 error</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Restoration contents are displayed here.*

"Display Style" Using the radio button, select a format to display the date/time of occurrence when specified devices were restored to OFF status from ON status.

- Date & Time ..... Select to display both date/time.
- Date .............. Select to display only date.
- Time .............. Select to display only time.
- String .............. Select to display specified character string.

To select a string, enter the character string to be displayed in the character input text box and set a number of characters for the character string using the spin box.

"Date"

When Date has been selected with the "Display style", use the radio button to select a display format.

The year will be displayed in the last 2 digits.

<table>
<thead>
<tr>
<th>yy/mm/dd</th>
<th>mm/dd/yy</th>
<th>dd/mm/yy</th>
<th>mm/dd</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>04/10/97</td>
<td>10/04/97</td>
<td>04/10</td>
</tr>
</tbody>
</table>

(Display digits: 8 digits) (Display digits: 8 digits) (Display digits: 8 digits) (Display digits: 5 digits)

"Time"

When Time has been selected with the "Display style", use the radio button to select a display format.

The time will be displayed in the 24 hours format.

<table>
<thead>
<tr>
<th>hh : mm : ss</th>
<th>hh : mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>09 : 50 : 48</td>
<td>09 : 50</td>
</tr>
</tbody>
</table>

(Display digits: 8 digits) (Display digits: 5 digits)
4 Setting Checks

This setting specifies the display contents to be displayed in the following position of below the alarm history display.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>Conveyor error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/11</td>
<td>Processed product</td>
<td>10:28:00</td>
<td></td>
</tr>
<tr>
<td>97/04/12</td>
<td>Line 1 error</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Checks are displayed here.

"Display Style" Using the radio button, select a format to display the date/time of occurrence when specified devices were restored to OFF status from ON status.
Date & Time ..... Select to display both date/time.
Date .............. Select to display only date.
Time .............. Select to display only time
String............. Select to display specified character string.

To select a string, enter the character string to be displayed in the character input text box and enter a number of characters for the character string using the spin box.

"Date"

When Date has been selected with the "Display style", use the radio button to select a display format.
The year will be displayed in the last 2 digits.

<table>
<thead>
<tr>
<th>yy/mm/dd</th>
<th>mm/dd/yy</th>
<th>dd/mm/yy</th>
<th>mm/dd</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>04/10/97</td>
<td>10/04/97</td>
<td>04/10</td>
</tr>
<tr>
<td>(Display digits: 8 digits)</td>
<td>(Display digits: 8 digits)</td>
<td>(Display digits: 8 digits)</td>
<td>(Display digits: 5 digits)</td>
</tr>
</tbody>
</table>

"Time"

When Time has been selected with the "Display style", use the radio button to select a display format.
The time will be displayed in the 24 hours format.

<table>
<thead>
<tr>
<th>hh : mm : ss</th>
<th>hh : mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>09 : 50 : 48</td>
<td>09 : 50</td>
</tr>
<tr>
<td>(Display digits: 8 digits)</td>
<td>(Display digits: 5 digits)</td>
</tr>
</tbody>
</table>
Setting the display position

1. When the setting is completed, click on [OK].

2. A frame with dotted lines showing the specified display area of the alarm history display appear in the upper left of the screen window.

3. Move the cursor to a desired position and click the mouse.

If the one-touch operation has been set to valid in the [Basic], set the display position of the alarm history display to a multiple of 10 dots (if it is performed by the touch key).
22.6 Setting the Touch Keys for Alarm History Display Function

What will be set?

- Switches used in the alarm history display such as to display and move the cursor display for the alarm history function and for detailed displays of alarms, etc., will be set up.

1. Setting of the switches for the alarm history display function

The switches for the alarm history display function are operated by the touch keys or the operation panel.

By setting the key code for the function used for each touch key or key on the operation panel, it assigned as a switch for the alarm history display function.

See Section 15.8, Setting a Key Code to a Touch Key and Prohibiting Simultaneous Pressing of Multiple Touch Keys.

See Section 23.3, Setting Action to the Operation Panel Keys.

Refer to 2 for the key code of each function.

2. Switch types for the alarm history display function and key codes

The available switch types for the alarm history display function are as follows:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Display/Erase Cursor key</td>
</tr>
<tr>
<td>2</td>
<td>Move Upward/Downward keys</td>
</tr>
<tr>
<td>3</td>
<td>Detailed Display key</td>
</tr>
<tr>
<td>4</td>
<td>Confirmation, Confirmation All key</td>
</tr>
<tr>
<td>5</td>
<td>Delete, Delete All key</td>
</tr>
<tr>
<td>6</td>
<td>Reset key</td>
</tr>
<tr>
<td>7</td>
<td>Save Memory key</td>
</tr>
</tbody>
</table>
1. Display/Erase cursor key for alarm history display function
   - Key code setting
     | Type               | Key code |
     |--------------------|----------|
     | Display Cursor key | FFB0H    |
     | Erase Cursor key   | FFB1H    |

   - Operation example

2. Move Upward/Downward keys
   - Key code setting
     | Type                | Key code |
     |---------------------|----------|
     | Move Upward key     | FFB2H    |
     | Move Downward key   | FFB3H    |

   - Operation example (when the cursor is displayed)
Operation example (when the cursor is not displayed)

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 5 error</td>
<td>11:00:00</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/11</td>
<td>Conveyor 30 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/11</td>
<td>Conveyor 405 error</td>
<td>13:00:00</td>
<td></td>
</tr>
<tr>
<td>97/04/11</td>
<td>Conveyor 60 error</td>
<td>14:00:00</td>
<td></td>
</tr>
</tbody>
</table>

Move Upward

Move Downward

Moves to the previous or next page of the alarm contents.

Detailed Display key

This setting is not necessary when the detailed display is specified by one-touch operation using the touch key.

<table>
<thead>
<tr>
<th>Type</th>
<th>Key code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detailed Display key</td>
<td>FFB8h</td>
</tr>
</tbody>
</table>

Operation example

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED</th>
<th>CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>Conveyor 1 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 6 error</td>
<td>10:30:00</td>
<td>10:28:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>Conveyor 5 error</td>
<td>11:00:00</td>
<td></td>
</tr>
</tbody>
</table>

Detailed display will be displayed according to the detailed display setting destination.

When selecting comment window

When selecting window screen

When selecting base screen
2) Confirm, Confirm All keys
   · Key code setting
   
<table>
<thead>
<tr>
<th>Type</th>
<th>Key code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm key</td>
<td>FFB4#</td>
</tr>
<tr>
<td>Confirm All key</td>
<td>FFB5#</td>
</tr>
</tbody>
</table>

   · Operation example

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>Conveyor 1 error</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>Conveyor 6 error</td>
</tr>
<tr>
<td>97/04/10</td>
<td>11:00:00</td>
<td>Conveyor 5 error</td>
</tr>
</tbody>
</table>

   The confirmation date and time of selected alarm (highlighted by the cursor) will be displayed.

3) Delete, Delete All keys
   · Key code setting
   
<table>
<thead>
<tr>
<th>Type</th>
<th>Key code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete key</td>
<td>FFB6#</td>
</tr>
<tr>
<td>Delete All key</td>
<td>FFB7#</td>
</tr>
</tbody>
</table>

   · Operation example

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>Conveyor 1 error</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>Conveyor 6 error</td>
</tr>
<tr>
<td>97/04/10</td>
<td>11:00:00</td>
<td>Conveyor 5 error</td>
</tr>
</tbody>
</table>

   The selected alarm (highlighted by the cursor) will be deleted.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>Conveyor 6 error</td>
</tr>
<tr>
<td>97/04/10</td>
<td>11:00:00</td>
<td>Conveyor 5 error</td>
</tr>
</tbody>
</table>

   Contents of All alarms will be deleted.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   POINT
   The alarms which have been restored will be the subject of Delete and Delete All. the alarms which have not been restored will not be deleted.
6. Reset key
   - Key code setting

<table>
<thead>
<tr>
<th>Type</th>
<th>Key code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset key</td>
<td>FFB9h</td>
</tr>
</tbody>
</table>

- Operation example

   ![Reset diagram]

   Resets the device of the selected alarm to OFF or reset value, and displays the date/time of the restoration (the date and time of the first watchdog cycle timing since the touch key input).

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
<th>RESTORED CHECKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
<td>Conveyor 1 error 12:00:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
<td>Conveyor 6 error</td>
</tr>
<tr>
<td>97/04/10</td>
<td>11:00:00</td>
<td>Conveyor 5 error</td>
</tr>
</tbody>
</table>

7. Memory Card Save key
   - Key code setting

<table>
<thead>
<tr>
<th>Type</th>
<th>Key code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset key</td>
<td>FFB8h</td>
</tr>
</tbody>
</table>

- Operation example

   ![Save Memory diagram]

   All of the current alarm contents will be saved in the memory card.

<table>
<thead>
<tr>
<th>OCCURRED</th>
<th>MESSAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>97/04/10</td>
<td>09:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>10:30:00</td>
</tr>
<tr>
<td>97/04/10</td>
<td>11:00:00</td>
</tr>
</tbody>
</table>
22.7 Formatting Memory Card for the Alarm History Display Function and Confirming Data Information

Use the file function of the GOT’s utility to format the memory card used for the alarm history display and to confirm the contents of the alarm history.
The screens, functions and operations of the file function described below.

1 Selecting the file function screen

Select the file icon on the GOT’s utility screen. The file maintenance screen will be displayed.

2 Screens

<table>
<thead>
<tr>
<th>A850GOT</th>
<th>A870GOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE: MAINTENANCE</td>
<td>FILE: MAINTENANCE</td>
</tr>
<tr>
<td>1 ALARMHIST.DAT 100 97/04/31</td>
<td>1 ALARMHIST.DAT 100 97/04/31</td>
</tr>
<tr>
<td>2 LOSTEMP.DAY 100 97/07/01</td>
<td>2 LOSTEMP.DAY 100 97/07/01</td>
</tr>
<tr>
<td>DELETE</td>
<td>DELETE</td>
</tr>
<tr>
<td>FORMAT</td>
<td>FORMAT</td>
</tr>
<tr>
<td>END</td>
<td>END</td>
</tr>
</tbody>
</table>

3 Functions

- File name, size, year/month/date when the data was stored with the alarm history function can be confirmed. (The file name of the data stored with the alarm history function is fixed to ARARMHIST.DAT.)
- Formats memory cards.
- Can delete data stored with the alarm history function.

4 Operation

1. Operation to format a memory card
   Press [Format].

2. Operation to delete data stored with the alarm history function
   Select data to delete by pressing [▼] and [▲].
   After making a selection, press [Delete].
   To delete all data stored in the memory card, press [All DEL]. (Only with A870GOT)

3. Return to the utility menu screen
   To return to the utility menu, press [End].

POINT

- A memory card cannot be used commonly for both the alarm history function and the screen copy function.
- If a memory card is replaced with another memory card while this screen is being displayed (when multiple memory cards are used for the alarm history function), the data in the latter card will not be displayed. Display this screen from the utility screen once again.
- The optional driver must be installed to the GOT in order to store the alarm history function data to a memory card.
- To save 1024 points of alarm history contents, approximately 25K-byte of memory card capacity is required.
Chapter 23

Setting the Operation Panel Functions
23. Setting the Operation Panel Functions

23.1 Things to Know before Setting the Operation Panel Functions

Things to know before setting the operation panel functions will be described below. Also, the setting procedures of the operation panel other than those described in this chapter are the same as those for the touch switch. Refer to “Chapter 15 Setting Touch Switch Functions” for details.

When doing so, read “touch switch” as “key”.

Please be aware

- An external I/O interface module is necessary to use this function.
- The optional driver must be installed to the GOT to use the operation panel.
- Keys are not dependent on each display screen.
- This is not compatible with the utility screen.
- When a touch input and the operation panel are pressed simultaneously, both will become valid and the one detected earlier will be processed first.
- This cannot be used for the system monitor, circuit monitor nor special module monitor function.

Multiple functions can be assigned to a key.

<table>
<thead>
<tr>
<th>Function</th>
<th>Available Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word SET</td>
<td>20 functions</td>
</tr>
<tr>
<td>Bit SET</td>
<td>20 functions</td>
</tr>
<tr>
<td>Bit RST</td>
<td>20 functions</td>
</tr>
<tr>
<td>Bit ALT</td>
<td>20 functions</td>
</tr>
<tr>
<td>Bit momentary</td>
<td>1 function</td>
</tr>
<tr>
<td>Switch base screen</td>
<td>1 function</td>
</tr>
<tr>
<td>Switch window screen</td>
<td>1 function</td>
</tr>
<tr>
<td>Extended function</td>
<td>Cannot be assigned</td>
</tr>
<tr>
<td>Total</td>
<td>83 functions</td>
</tr>
</tbody>
</table>
Please be aware that although multiple functions can be assigned to a key, a function may not operate due to the combination of the functions.

<table>
<thead>
<tr>
<th>Key type</th>
<th>High</th>
<th>Operation priority order when multiple functions have been assigned</th>
<th>Low</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Alphanumeric</td>
<td>Execution of write alphanumeric</td>
<td>Word SET</td>
</tr>
<tr>
<td>Alphanumeric keys</td>
<td>○</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>CR key</td>
<td>—</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>No key code</td>
<td>—</td>
<td>—</td>
<td>○</td>
</tr>
</tbody>
</table>

* When the bit momentary and the switch screen functions are assigned to the same key, the switch screen will be executed after the bit off output.

* To specify no key code, set FFFFH as the key code value.

It is possible to inhibit the behavior of other keys if pressed while the key specified is on (inhibition of the simultaneous pressing).

To inhibit simultaneous pressing of a specified key, enter the key code FFFEH to that key.

See Section 23.3, Setting Key Code to the Operation Panel Keys.

Operation panels that can be used

For details of the operation panel, refer to the External I/O Interface Module User's Manual.
23.2 Setting Action to the Operation Panel Keys

When to perform the setting?

- When assigning an action (bit SET/RST/ALT/Momentary, Word SET, Switch screen) to the keys on the operation panel.

Select the [Operation panel] from the Common Menu.

Click on the [Operation panel key]. The "Action/key code" dialog box will be displayed.

"Bit dev." Set SET/RST/ALT/Momentary to specified bit device to a key.

See Section 15.3, Setting Touch Key (Bit) Functions.
"Word dev." Assign write function to a word device to a key.

See Section 15.4, Setting Touch Key (Word) Functions.

"Base" Assign switch base function to a key.

See Section 15.5, Setting Touch Key (Base Switching) Functions.

"Window" Assign switch window function to a key.

See Section 15.6, Setting the Touch Key (Window Switching) Functions.

If [Initial] is clicked, the settings of the operation panel will revert to the default.
If [Action] is clicked, the screen display changes to the following:

* Indicates keys whose action is already performed.

Clicking on [Key Code] switches the screen to the one showing the key codes.
To enable the operation setting, set FFFFH as the key code value.

"Setting effectively"
Place an "X" in the check box and click on "OK" to make the setting effective.
23.3 Setting Key Code to the Operation Panel Keys

- When to perform the setting?
  - When assigning a key code to each key of the operation panel.

Click [Operation panel] in the Common menu.

Click [Operation panel key]. The "Action/Key code" will be displayed.
Click on [Trigger/Key code].

"Key code"  Sets a key code to be assigned to a key.
Click on [Initial]. This returns the settings of the operation panel to the defaults. When [Action] is clicked, the screen changes to the following.

* Indicates keys whose action is already performed.

Clicking on [Key Code] switches the screen to the one showing the key codes.

"Setting effectively"

Place an "X" in the check box and click on "OK" to make the setting effective.

- **About the key codes for numeric input and ASCII input**

  **Numeric Input Functions**
  - Numeric values input .................................................. 002D, 002E, 0030 to 0046
  - Delete all input numeric values ...................................... 0008
  - Delete numeric value being input and reverse sign "—" ............ 002D
  - Delete last digit of input numeric value and shift all one digit to the right .................................................. 0008
  - Write input numeric value to storing device (execute) /shift cursor .................................................. 000D
  - Interrupt input
    - To right .................................................. 0080
    - To left .................................................. 0081
    - Up .................................................. 0082
    - Down .................................................. 0083
  - Interrupt input and delete cursor .................................. 001B

  **ASCII Input Functions**
  - For ASCII input .......................................................... ASCII codes, Shift JIS Kanji character code (Level 1, Level 2)
  - Delete all characters being input .................................... 0008
  - Write input characters to storing device (execute) /shift cursor .................................................. 000D
  - Shift cursor
    - To right .................................................. 0080
    - To left .................................................. 0081
    - Up .................................................. 0082
    - Down .................................................. 0083
  - Delete cursor .................................................. 001B
23.4 External I/O Function

- What is the external I/O function?
  The functions execute external input or external output (lamp or relays) using the external I/O module.

- Graphics software setting when the external I/O function is used
  No graphics software settings are necessary when the external I/O function is used.

- Devices to control external input signal
  When there is an external input, GOT internal bit devices GB30 to 37 (equivalent to 8 points) become ON.
  Perform the control from the GOT using the ON signals of GB30 to 37.

- Devices to perform external output
  External output operation is executed by setting the GOT internal bit devices GB10 to 25 (16 points) to ON.
- GOT internal devices used for the external I/O function

GOT internal devices used for the external I/O function are shown below.

<table>
<thead>
<tr>
<th>Device number</th>
<th>GD (Data register)</th>
<th>GB (Bit register)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>For data screen switching device (can be used for other devices)</td>
<td>Unusable</td>
</tr>
<tr>
<td>1</td>
<td>For window screen switching device (can be used for other devices)</td>
<td>For external output by output terminal of A870GOT</td>
</tr>
<tr>
<td>2 to 9</td>
<td>Unusable</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>For external output, Y0 OUT output</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>For external output, Y1 OUT output</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>For external output, Y2 OUT output</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>For external output, Y3 OUT output</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>For external output, Y4 OUT output</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>For external output, Y5 OUT output</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>For external output, Y6 OUT output</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>For external output, Y7 OUT output</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>For external output, Y8 OUT output</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>For external output, Y9 OUT output</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>For external output, YA OUT output</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>For external output, YB OUT output</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>For external output, YC OUT output</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Unusable</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>For external output, YD OUT output</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>For external output, YE OUT output</td>
<td></td>
</tr>
<tr>
<td>26 to 29</td>
<td>Unusable</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>For external input, X0 input</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>For external input, X1 input</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>For external input, X2 input</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>For external input, X3 input</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>For external input, X4 input</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>For external input, X5 input</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>For external input, X6 input</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>For external input, X7 input</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>For external input, fuse blown</td>
<td></td>
</tr>
<tr>
<td>39 to 63</td>
<td>Unusable</td>
<td></td>
</tr>
<tr>
<td>64 to 1023</td>
<td>User area</td>
<td>User area</td>
</tr>
</tbody>
</table>

**POINT**

- If I/O of external I/O function is controlled by a PC CPU, perform it with the system information function.

Refer to Section 24.2 for the system information signal for the external I/O function.

- Refer to the External I/O Interface Module User’s Manual for details of the specifications, performance and functions of the external I/O function.
Chapter 24

Other Sprite Functions
24. Other Sprite Functions

24.1 Setting the Hard Copy Function

If the hard copy function is to be used, always make sure the option driver corresponding to a printer to be used has been installed in the GOT.

Using the hard copy function requires the printer interface module.

**What does this function do?**

This function enables the monitor screen currently displayed on the GOT to be printed out by turning a bit device on or off, or by using the touch key (expanded) function.

If the monitor screen is printed out using a touch key, the hard copy function should be initiated by specifying the touch key (expansion) function.

See Section 15.7, Setting the Touch Key (Expansion) Functions.

1. Select [Hardcopy] on the Common menu.
2. The "Hardcopy" dialog box is displayed.
<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Start trigger”</td>
<td>Click on [Device], and specify the device which is to initiate the hard copy function. <strong>See Section 10.1, Setting Devices for Monitoring.</strong></td>
</tr>
<tr>
<td>“Abort trigger”</td>
<td>Click on [Device] and specify the device which is to terminate the printout. <strong>See Section 10.1, Setting Devices for Monitoring.</strong></td>
</tr>
<tr>
<td>“Print mode”</td>
<td>Using the radio buttons, select whether printing is to be done in color, or black and white.</td>
</tr>
<tr>
<td>“Rev./Norm.”</td>
<td>Using the radio buttons, specify whether or not the black and white areas of the screen are to be reversed when printing is done.</td>
</tr>
<tr>
<td>“Change page”</td>
<td>Using the radio buttons, select whether or not to change (feed) page after printing out.</td>
</tr>
<tr>
<td></td>
<td>If “Change” is selected, specify how many screens to be printed out before executing the change page using the spin box.</td>
</tr>
<tr>
<td></td>
<td>Setting is possible within the range of 1 to 4 pages.</td>
</tr>
<tr>
<td>“Trigger watch cycle”</td>
<td>Specify the timing at which the PC CPU is to be checked for the status of the bit devices used to initiate and stop printing. The value should be specified in 1-second units, with a minimum value of 2 seconds. The bit devices for the start and stop triggers should always be set so that they are on for at least two seconds.</td>
</tr>
</tbody>
</table>

- Internal processing of the GOT after printing starts

The monitor screen currently displayed on the GOT is temporarily stored in the GOT internal memory when the specified bit device goes on, or when the touch key (expanded) function is activated. (The screen is retained in the internal memory of the GOT for up to 5 seconds.)

After the monitor screen has been stored in the internal memory, it is printed out. (The time required to print out the monitor screen depends on the performance of the printer being used.)

![Diagram](image-url)
• Monitor screens when printing is carried out

During printing, we recommend displaying monitor screens that have a small number of sprite functions. If monitor screens that have sprite functions with a large number of changes (such as numeric display functions) are displayed on the GOT, the GOT assigns priority to the sprite functions, which results in more time being required for printing. (Using a bus connection with the GOT especially slows printing.)

The table below shows the printing time for a displayed monitor screen for which a numeric display (25, 50, 75, or 100 points) has been specified. (These are reference values based on a sequence program scanning time of 10 ms.)

(1) For black-and-white printing

<table>
<thead>
<tr>
<th>No. of numeric display set</th>
<th>Type of connection</th>
<th>Bus connection</th>
<th>CPU direct connection</th>
<th>Calculator link connection (C24)</th>
<th>NET (l)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>3:36 minutes</td>
<td>3:22 minutes</td>
<td>2:03 minutes</td>
<td>1:57 minutes</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>5:19 minutes</td>
<td>5:34 minutes</td>
<td>2:33 minutes</td>
<td>2:05 minutes</td>
</tr>
<tr>
<td>50</td>
<td></td>
<td>4:50 minutes</td>
<td>5:34 minutes</td>
<td>5:35 minutes</td>
<td>2:10 minutes</td>
</tr>
<tr>
<td>75</td>
<td></td>
<td>5:41 minutes</td>
<td>5:36 minutes</td>
<td>5:37 minutes</td>
<td>2:14 minutes</td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(2) For color printing

<table>
<thead>
<tr>
<th>No. of numeric display set</th>
<th>Type of connection</th>
<th>Bus connection</th>
<th>CPU direct connection</th>
<th>Calculator link connection (C24)</th>
<th>NET (l)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>10:34 minutes</td>
<td>9:48 minutes</td>
<td>5:54 minutes</td>
<td>5:36 minutes</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>16:38 minutes</td>
<td>16:27 minutes</td>
<td>16:32 minutes</td>
<td>6:23 minutes</td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• What happens if the printer power supply is off when the hard copy function is started?

If the power to the printer is off when the hard copy function is started, the monitor screen cannot be printed out. Make sure the power supply is on before using the function.

• What happens if the hard copy function is begun while printing is in progress, or data is being stored in the internal memory of the GOT?

If the hard copy function is run while a monitor screen is being printed out, or while data is being stored to the internal memory, the monitor screen will not be saved to the internal memory. (The instruction to begin the hard copy function will be ignored.)

• Which printers can be used?

The following printers can be used:

ESC/P24-J84 compatible printers (sold only in Japan)

Hewlett Packard printers (PCL command compatible, no color)

* Can only be used when the drawing software is set to the English mode.

For more detailed information, please refer to the Printer Interface Module User’s Manual.

CANON    BJC-600J (color printer)
          BJC-400J (color printer)

EPSON    VP-600 (dot matrix kanji printer)
          MJ-800C (color printer)
### 24.2 Setting Devices to Check GOT Operation (System Information)

**What do I need to set?**

- Set the device used to check GOT operation with the PC CPU.

1. Select [System Information] on the Common menu.
2. The "System Information" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Read device&quot;</td>
<td>Click on [Dev.]. The &quot;Device&quot; dialog box is displayed. Specify the NW number, station number, device name, and device number. When the external I/O function is used, set the &quot;Number of device points&quot; of &quot;Read device&quot; to 2 points. When set to 1 point, the I/O operations of the system information (output signal area, input information storage area) are not performed. For a read device, 1 word or 2 words will be allocated as the system information (when the external I/O function is used). For a write device, first 15 words will be allocated as the system information. For the read cycle, set the interval for the GOT to read the specified device in seconds, using the spin box. The allowable range is 1 to 5 seconds (default: 3 seconds).</td>
</tr>
<tr>
<td>&quot;Write device&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**POINT**

- For the writing device, 15 words starting from the first device are assigned as system information.
- Settings should be entered in such a way that the system information devices do not overlap the screen switching devices.
- Special registers should not be used as system information devices.
- What kind of information is stored in the specified devices?

  - Reading device .......... The GOT operation status is written to the device.
    The GOT scans the written information for setting read cycle: (1 to 5 seconds)

<table>
<thead>
<tr>
<th>Reading device</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified reading device</td>
<td>+0  System signal 1 area</td>
</tr>
<tr>
<td></td>
<td>+1  External I/O function area</td>
</tr>
</tbody>
</table>

- Writing device .......... This writes the current operating status from the GOT to the device.
  Each time the operation status is changed, the GOT writes the updated information to the device. Information should not be written to the writing device from the PC CPU.

<table>
<thead>
<tr>
<th>Writing device</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified writing device</td>
<td>+ 0  System signal 2 area</td>
</tr>
<tr>
<td></td>
<td>+ 1  GOT error code storage area</td>
</tr>
<tr>
<td></td>
<td>+ 2  Currently-displayed base screen number storage area</td>
</tr>
<tr>
<td></td>
<td>+ 3  Currently-displayed window screen number storage area</td>
</tr>
<tr>
<td></td>
<td>+ 4  Numeric input number storage area</td>
</tr>
<tr>
<td></td>
<td>+ 5  Current cursor position storage area</td>
</tr>
<tr>
<td></td>
<td>+ 6  Previous cursor position storage area</td>
</tr>
<tr>
<td></td>
<td>+ 7  Input key code storage area</td>
</tr>
<tr>
<td></td>
<td>+ 8  Numeric input value before change storage area, 2 words used</td>
</tr>
<tr>
<td></td>
<td>+ 9  Numeric input value after change storage area, 2 words used</td>
</tr>
<tr>
<td></td>
<td>+10  Currently-printing report number storage area</td>
</tr>
<tr>
<td></td>
<td>+11  Input information storage area for external I/O function</td>
</tr>
<tr>
<td></td>
<td>+12  Cursor position numeric input storage area</td>
</tr>
</tbody>
</table>

1 Contents of system signal 1 area

Word device set by read device

- Automatic screen save invalidity signal
- Forced screen save signal
- Entry key read completion
- Numerical input read completion
- Bar-code input invalidity signal
- Bar-code input read completion signal
- Keyed-in data inhibit signal
- GOT error reset signal
• Automatic screen saver invalid signal (Bit 0)

If the screen has currently been turned off by the screen saver function, turning this bit on displays the screen. Turning it off turns off the display.

If the screen saver timing is specified with the screen displayed, turning this bit on renders the specified timing invalid and keeps the screen displayed all the time.

Turning this bit off makes the specified screen saver timing effective.

• Forced screen saver signal (Bit 1)

Turning this bit on causes the display to be forcibly turned off. While this bit is on, the screen will not be displayed even if the GOT screen is touched. Turning this bit off displays the screen.

Please be aware that, even if the bit of the forced screen saver signal is on, if the bit of the automatic screen saver invalid signal is on, the screen display will not be turned off.
• Input key readout completed signal (Bit 3)
  See (10) Contents of the input key code storage area.

• Numeric value input readout complete signal (Bit 4)
  This signal changes the numeric input signal in the system signal 2 area of a write device
  from ON to OFF. For details, refer to the description for the numeric input signal in the
  system signal 2 area.

• Bar-code input invalidity signal (bit 5)
  With the bar-code reader connected to the GOT, entry from the bar-code reader is made
  invalid by switching this bit on.

<table>
<thead>
<tr>
<th>bit 5</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>Bar-code reader input invalid</td>
</tr>
<tr>
<td>OFF</td>
<td>Bar-code reader input valid</td>
</tr>
</tbody>
</table>

• Bar-code input read completion signal (bit 6)
  This signal switch from ON to OFF the bar-code input signal in the system signal 2 area for
  writing devices.
  For more information, refer to the explanation of the bar-code input signal in the system
  signal 2 area.

• Key input prohibited signal (Bit 9)
  While this bit is ON, all of the touch key inputs will be invalid.

• GOT error reset signal (Bit 13)
  See (4) Contents of the GOT error code storage area.

2 Output signal area of the external I/O function

While external I/O function is used, external output can be carried out by setting the following
bit numbers to ON. The signals to carry out external output can be outputted by the devices
GB10 to 25 (16 points). (Refer to Section 23.4.)
Contents of the system signal 2 area

Word device set by write device + 0

- GOT ready signal (Bit 1)
  When the power supply is turned on, this bit is turned on if the GOT is operating normally. If this bit remains off, there may be a problem with the hardware, and the unit should be replaced.

- Memory card battery error detection signal (Bit 2)
  Becomes ON when a memory card battery error is detected. It becomes OFF when the battery is replaced.

- Input key signal (Bit 3)
  See (10) Contents of the input key code storage area.

- Numerical input signal (Bit 4)
  Numerical input signal turns ON when a value entered by a numeric input function with an ID number has been confirmed (the return key is pressed).
  The confirmation timing of numeric input can be confirmed with the PC CPU.
  This signal is not cleared (turned OFF) even when the numeric input has been confirmed.
  To clear it, set the numeric input signal (Bit 4) of the system signal 1 to ON.

<table>
<thead>
<tr>
<th>Numeric value key input</th>
<th>1</th>
<th>2</th>
<th>Confirm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write to numeric value input signal storage area</td>
<td>ID No. is stored</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeric input signal</td>
<td>ON</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>Numeric value input roadout complete signal</td>
<td>ON</td>
<td>OFF</td>
<td></td>
</tr>
</tbody>
</table>
• Bar-code input signal (bit 6)

When data read by the bar-code reader is stored to the specified devices, the bar-code input signal switches on.

This signal can be used to confirm the timing at which the data read by the bar-code reader is stored to the PLC CPU.

To clear (switch off) the bar-code input signal, switch on the bar-code input completion signal (bit 6) in system signals 1.

Data is read by bar-code reader. [1234567890123ET]

Read data is stored to specified devices.

Bar-code input signal

<table>
<thead>
<tr>
<th>ON</th>
<th>OFF</th>
</tr>
</thead>
</table>

Bar-code input completion signal

<table>
<thead>
<tr>
<th>ON</th>
<th>OFF</th>
</tr>
</thead>
</table>

Note that the GOT checks the PLC CPU at intervals of 1 to 5 seconds for the status of the bar-code input completion signal in system signals 1. Therefore, when the data read using this signal is to be controlled by the PLC CPU, the reading intervals of the bar-code reader should be more than 1 to 5 seconds.

When it is desired to make the reading intervals of the bar-code reader within 1 second, make setting to switch off this signal with the PLC CPU.

• Hard copy output signal (Bit 7)

Stays ON while printing out by the hard copy function. It becomes OFF when the printout is completed or interrupted.

• Report output signal (Bit 8)

Stays ON while printing out by the report function. It becomes OFF when the printout is completed or interrupted.

• GOT error detection signal (Bit 13)

See (4) Contents of the GOT error code storage area.

• Numeric input value error detection signal (Bit 14)

It becomes ON when a value input by the numeric input function is outside the set write range (display range).

It becomes OFF when the next operation performs writing normally, or the screen is switched.

• Printer error detection signal (Bit 15)

It becomes ON when an error occurred with a printer (cable disconnection, out of paper, paper jam, etc.).

It becomes OFF when the printer error has been removed.
4 Contents of the GOT error code storage area

If an error occurs in the GOT, the error code is stored here, and the system signal 2, which is the GOT error detection signal (Bit 13), is turned on.

If several error codes are produced at the same time, the last error code to be produced is stored here.

Checking the error code and eliminating the cause of the problem does not clear the GOT error code storage error or the GOT error detection signal.

To clear these, turn on the system signal 1, which is the GOT error reset signal (Bit 13).

5 Storage area for base screen number during display

The number of the screen currently displayed on the GOT is displayed here.

If -1 is stored here : A utility function screen is displayed
If 0 is stored here : Nothing is displayed, or the screen is being switched
If 1 to 1024 is displayed : The base screen with the screen number corresponding to the numeric value stored here is displayed

POINT

When an Omron-made PC is connected, if *16 bits/BCD" is selected as the screen switching device, BDC data is stored in the screen number storage area.

6 Storage area for window screen number during display

If 0 is stored here : Nothing is displayed, or the window screen is being switched
If 1 to 1024 is displayed : The window screen with the screen number corresponding to the numeric value stored here is displayed

POINT

When an Omron-made PC is connected, if *16 bits/BCD" is selected as the screen switching device, BDC data is stored in the screen number storage area.

7 Numeric input number storage area

When a number input by the numeric input function has been confirmed (the return key is pressed), the ID number registered with the numeric input function setting will be stored.

After the ID number has been stored, the numeric input signal of the system signal 2 becomes ON.

8 Contents of the current cursor position storage area

This contains the sprite ID number of the currently displayed cursor for input. When sprites are being set, the graphics software assigns sprite ID numbers automatically. To confirm the sprite ID number, select [Print] on the Project menu, and print out the sprite ID number.

The sprite ID number can be confirmed by selecting "Preview" and then "Sprite ID" on the Screen menu.
9 Contents of the previous cursor position storage area

This contains the sprite ID number of the previously displayed cursor for input. When sprites are being set, the graphics software assigns sprite ID numbers automatically. To confirm the sprite ID number, select on the Project menu, and print out the sprite ID number.

The sprite ID number can be confirmed by selecting "Preview" and then "Sprite ID" on the Screen menu.

10 Contents of the input key code storage area

When the touch switch specified by the key code is input, the key code is stored here, and the system signal 2, which is the key input signal (Bit 3) is turned on.

The timing at which the touch switch is input can be confirmed by checking the system signal 2, which is the key input signal (Bit 3).

The input key code storage area and input key signal are not cleared by concluding the touch switch input. To clear these, turn on the system signal 1 input key readout completed signal (Bit 3).

11 Numeric input value before change storage area

The value entered last time by the numeric input function (32 words) is stored.

12 Numeric input value after change storage area

The value (32 bit) entered by the numeric input function to which an ID number has been set up is stored. The value entered last time by the numeric input function will be stored into the numeric input value before-change storage area.

13 Currently-printing report number storage area

The number of the report data currently being printed out is stored. The number stored is retained after the print out is completed until the next printout begins.

14 Input information storage area for external I/O function

Input information from outside is stored when the external I/O function is used. The corresponding bit number becomes ON by the input from the outside.

The signal can also be inputted from outside by the devices GB30 to GB37 (8 points). (Refer to Section 23.4)

15 Cursor position numeric input information storage area

The ID number of the numeric input function at the current cursor position is stored.

When the cursor is not being displayed, a 0 is stored.
24.3 Setting the Observe Status Function

What does this function do?

This function writes data to the PC CPU when the specified conditions have been met (the specified bit device is turned on or off).

Regardless of the monitor screen currently displayed, the following types of data can be written to the PC CPU when the specified conditions have been met (the specified bit device is turned on or off).

- Bit devices can be turned on only while the conditions are satisfied, and are turned off as soon as the conditions are no longer satisfied (momentary).
- Bit devices can be turned on (Bit SET).
- Bit devices can be turned off (Bit RST).
- The current status of a bit device can be reversed (Bit ALT).
- Values can be written to a word device (Word SET).

Two bit devices can be set as conditions.

Only one of the above can be specified for writing in relation to the specified conditions. A maximum of 40 points (condition + data writing) can be specified.

(Example) A value of 100 is written to D100 when the specified bit device is turned on.

![Diagram showing the Observe Status Function](image)

1. The GOT acknowledges that the specified bit device has been turned on (the status of the specified bit is monitored at the specified timing).

2. The specified PC CPU writing is carried out when the conditions have been met.

2. The "Observe Status" dialog box is displayed.

Clicking on [Add] displays the "Trigger/Action" dialog box.

---

24 - 13
1. Setting the **Trigger** settings

**Condition 1**
Click on **Dev.** to display the “Device” dialog box, and specify the bit device to be set as a condition.

See Section 10.1, Setting Devices for Monitoring.
After specifying the device, use the radio buttons to select whether the specified bit device is to be turned on or off when the conditions are satisfied.

**Condition 2**
If a second bit device is to be set as a condition, specify it here, using the same operation as that for “Condition 1”.

2. Setting the **Action** settings.

**Action**
Using the list box, select the actions to be written to the PC CPU when the specified bit device conditions are satisfied.

- **Bit Momentary** ...... A bit device is turned on only while the conditions are satisfied, and is turned off as soon as the conditions are no longer satisfied.
- **Bit SET** ............... The bit devices is turned on when the conditions are satisfied.
- **Bit RST** ............... The bit device is turned off when the conditions are satisfied.
- **Bit ALT** ............... The current status of the bit device is reversed (OFF ↔ ON) when the conditions are satisfied.
- **Data SET (16-bit)** ... The specified value (16-bit data) is written to a word device when the conditions are satisfied.
- **Data SET (32-bit)** ... The specified value (32-bit data) is written to a word device when the conditions are satisfied.
"Points" Click on [Dev.] to display the "Device" dialog box, and in the "Set Multiple Devices" dialog box, specify the device to which the data is to be written.

See Section 10.1, Setting Devices for Monitoring.

<table>
<thead>
<tr>
<th>action</th>
<th>Bit momentary, Bit SET, Bit RST, Bit ALT</th>
<th>Data SET (16-bit)</th>
<th>Data SET (32-bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. no. of points</td>
<td>40</td>
<td>20</td>
<td>10</td>
</tr>
</tbody>
</table>

"Storing device" Using the spin box, specify the number of devices to be set using the "Writing device" parameter when the conditions are satisfied.

"Fixed" "Indirect"

If "Data SET (16-bit)" or "Data SET (32-bit)" is selected for the "Writing device" parameter, specify the value to be written.

1) When writing the specified value to a word device when the conditions have been met

Place an "X" in the check box by "Fixed", and use the spin box to specify the value to be written.

(Example) Trigger 1: M0 is on, points: 3, Storing devices: D10, D11, D12

Fixed: 1000

2) If the current value of the word device is to be written when the conditions have been satisfied, or the current value of a specified word device + a specified value are to be written (when there is one writing destination specified)

Place an "X" in the check box by "Indirect", and click on [Dev.] to display the "Device" dialog box. Specify the word device in this dialog box.

If the current value of a word device and a specified value are to be written, place an "X" in the check box by "Fixed", and use the spin box to specify the value to be written.

(Example 1) Trigger 1: M0 is on, points: 1, Storing device: D10

Indirect: D100
(Example 2) Trigger 1: M0 is on, points: 1, Storing device: D10
Indirect: D100 Fixed: 100

③ If the current value of the word device is to be written when the conditions have been satisfied, or the current value of a specified word device + a specified value are to be written (when there is more than one writing destination specified)

Place an "X" in the check box by "Indirect", and click on [Dev.] to display the "Device" dialog box. Specify the word device in this dialog box.

If the current value of a word device and a specified value are to be written, place an "X" in the check box by "Fixed", and use the spin box to specify the value to be written.

After the above settings have been entered, use the radio buttons to select whether the data is to be written to the writing destination in a single transmission, or whether similar data items are to be sent to the destination together, in a batch.

FMOV..... The current value of the specified device is written to multiple destination devices when the conditions have been satisfied (batch transmission of similar data).

(Example 1) Trigger 1: M0 is on, points: 3, Storing devices: D10, D20, D30
Indirect: D100

(Example 2) Trigger 1: M0 is on, points: 3, Storing devices: D10, D20, D30
Indirect: D100 Fixed: 100
BMOV .... The current values of the specified devices are written to multiple destination devices when the conditions have been satisfied (batch transmission).

(Example 1) Trigger 1: M0 is on, points: 3, Storing devices: D10, D11, D12
Indirect: D100

(Example 2) Trigger 1: M0 is on, points: 3, Storing devices: D10, D11, D12
Indirect: D100 Fixed: 100

When the conditions and actions have been set, click on OK.
The "Observe Status" dialog box is displayed once again.
If any of the settings are to be changed after the conditions and actions have been specified, click on [Edit]. To delete any setting which has been entered, click on [Delete].

To set multiple conditions and actions, click on [Add] and specify the conditions and actions. (Up to 40 settings can be entered.)

When all of the settings have been entered, specify a value for the “Observe Status” parameter.

“Observe cycle”

This specifies the timing at which the GOT monitors status of bit devices for conditions which have been specified.

Values can be entered in 1-second units, with the smallest setting being 1 second.

If the time interval during which the bit device specified by the condition is on or off cannot be maintained for longer than the timing specified for condition monitoring, the data is not written to the PC CPU.

- Precautions if multiple conditions and actions have been specified

  Always make sure the same NW numbers and station numbers are set for all of the bit devices to which conditions apply.

- Precautions if data is being written to several devices within one point which has been specified

  If "Bit ALT", "Data SET (10-bit)", or "Data SET (32-bit)" has been specified as the writing action, and an error (link error) occurs with the PC CPU of the device to which the data is being written, no data will be written to any of the writing destination devices.
24.4 Setting the Test Function

What is the test function?

The function displays the test window while the monitor screen is being displayed and allows to change device values.

Types of devices that can be changed include:

- ON/OFF of bit devices
- Change timer/counter settings
- Change current value of word devices
- Change current value of buffer memory

- GOT types that support the test function

The GOT type that can use the test function is A870GOT only. A85□GOT cannot use it.

- Connection types supported by the test function

Please be aware that the test function can not be used in connections with PCs of other manufacturers nor microcomputer. (The possible test range is equivalent to the system monitor function.)

- Setting operations to display the test window

To display the test window, perform the setting using the touch switch (extension) function.

See Section 15.7, Setting the Touch Key (Expansion) Functions.

The operation in the test window is equivalent to the test function of the GOT's system monitor function.
24.5 Setting the Display Speed Acceleration Function

What is the display speed acceleration function?

When the CPU of the monitoring destination is a MELSEC-A/QnA series and when continuous bit numbers are set for the monitoring device of the sprite function that is set for the screen, this function is used to increase the display speed with respect to the sprite function.

The display speed can also be accelerated if multiple setups of the same word devices are present on a screen.

Please be aware that the memory capacity of the screen data increases by 1 to 3% when the acceleration is specified.

1. Select [Option] and then [PC Communication] from the Common menu.
2. “Communication acceleration option” dialog box will be displayed.

![PC Communication Option]

A screen that has many settings of consecutive bit devices is effective. Data size increase when this option is selected.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Base</strong></td>
<td>When the screen to set acceleration is a base screen, select [Base]. When it is a window screen, select [Window]. Place a &quot;X&quot; in the check box of the screen No. to set acceleration. To set all of the screens for acceleration, select [All select]. When acceleration is set up and reset all the contents, select [All not select]. When setup of each screen is complete, select [Execute].</td>
</tr>
</tbody>
</table>
# Appendices

## Appendix 1. Key Code Table

<table>
<thead>
<tr>
<th>Key</th>
<th>Key Code (H)</th>
<th>Key</th>
<th>Key Code (H)</th>
<th>Key</th>
<th>Key Code (H)</th>
<th>Key</th>
<th>Key Code (H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP</td>
<td>20</td>
<td>@</td>
<td>40</td>
<td></td>
<td>60</td>
<td>→</td>
<td>80</td>
</tr>
<tr>
<td>!</td>
<td>21</td>
<td>A</td>
<td>41</td>
<td>a</td>
<td>61</td>
<td>↓</td>
<td>81</td>
</tr>
<tr>
<td>&quot;</td>
<td>22</td>
<td>B</td>
<td>42</td>
<td>b</td>
<td>62</td>
<td>↑</td>
<td>82</td>
</tr>
<tr>
<td>#</td>
<td>23</td>
<td>C</td>
<td>43</td>
<td>c</td>
<td>63</td>
<td>↓</td>
<td>83</td>
</tr>
<tr>
<td>$</td>
<td>24</td>
<td>D</td>
<td>44</td>
<td>d</td>
<td>64</td>
<td>(Clear)</td>
<td>88</td>
</tr>
<tr>
<td>%</td>
<td>25</td>
<td>E</td>
<td>45</td>
<td>e</td>
<td>65</td>
<td>(Scroll up)</td>
<td>F2</td>
</tr>
<tr>
<td>&amp;</td>
<td>26</td>
<td>F</td>
<td>46</td>
<td>f</td>
<td>66</td>
<td>(Scroll down)</td>
<td>F3</td>
</tr>
<tr>
<td>,</td>
<td>27</td>
<td>G</td>
<td>47</td>
<td>g</td>
<td>67</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(</td>
<td>28</td>
<td>H</td>
<td>48</td>
<td>h</td>
<td>68</td>
<td></td>
<td></td>
</tr>
<tr>
<td>)</td>
<td>29</td>
<td>I</td>
<td>49</td>
<td>i</td>
<td>69</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td>2A</td>
<td>J</td>
<td>4A</td>
<td>j</td>
<td>6A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>2B</td>
<td>K</td>
<td>4B</td>
<td>k</td>
<td>6B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>,</td>
<td>2C</td>
<td>L</td>
<td>4C</td>
<td>l</td>
<td>6C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>2D</td>
<td>M</td>
<td>4D</td>
<td>m</td>
<td>6D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.</td>
<td>2E</td>
<td>N</td>
<td>4E</td>
<td>n</td>
<td>6E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/</td>
<td>2F</td>
<td>O</td>
<td>4F</td>
<td>o</td>
<td>6F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>30</td>
<td>P</td>
<td>50</td>
<td>p</td>
<td>70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>31</td>
<td>Q</td>
<td>51</td>
<td>q</td>
<td>71</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>32</td>
<td>R</td>
<td>52</td>
<td>r</td>
<td>72</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>33</td>
<td>S</td>
<td>53</td>
<td>s</td>
<td>73</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>34</td>
<td>T</td>
<td>54</td>
<td>t</td>
<td>74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>35</td>
<td>U</td>
<td>55</td>
<td>u</td>
<td>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>36</td>
<td>V</td>
<td>56</td>
<td>v</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>37</td>
<td>W</td>
<td>57</td>
<td>w</td>
<td>77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>38</td>
<td>X</td>
<td>58</td>
<td>x</td>
<td>78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>39</td>
<td>Y</td>
<td>59</td>
<td>y</td>
<td>79</td>
<td></td>
<td></td>
</tr>
<tr>
<td>:</td>
<td>3A</td>
<td>Z</td>
<td>5A</td>
<td>z</td>
<td>7A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>;</td>
<td>3B</td>
<td>[</td>
<td>5B</td>
<td>{</td>
<td>7B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;</td>
<td>3C</td>
<td>Y</td>
<td>5C</td>
<td>l</td>
<td>7C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>3D</td>
<td>]</td>
<td>5D</td>
<td>}</td>
<td>7D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&gt;</td>
<td>3E</td>
<td>^</td>
<td>5E</td>
<td>~</td>
<td>7E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>3F</td>
<td>_</td>
<td>5F</td>
<td>!</td>
<td>7F</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*See Page 15-51 and 52, Key Code for Numeric Input/ASCII Input.*
Appendix 2. Screen Creation Form
Appendix 3. Display Speeds for Sprites

The table below shows the speeds at which the various sprites are displayed.

The actual display speed depends on the number of sprites specified on one screen and the canvas graphics drawn on the screen.

Incidentally, the display speed of continuous devices is the speed when the display-speed acceleration setup has been made.

<table>
<thead>
<tr>
<th>Sprite name</th>
<th>Setting conditions</th>
<th>No. set</th>
<th>Display speed (unit: s)</th>
<th>MELSECNET/10 connection</th>
<th>CC Link connection (Remote device station)</th>
<th>CC Link connection (Intelligent device station)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bus</td>
<td>CPU direct</td>
<td>Calculator link</td>
<td>Cyclic</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>connection</td>
<td>connection</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Serial device Random</td>
<td>Serial device Random</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>device</td>
<td>device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numeric display</td>
<td>No. of digits: 6</td>
<td>16 points</td>
<td>0.20</td>
<td>0.23</td>
<td>0.23</td>
<td>0.24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
<td>0.25</td>
<td>0.28</td>
<td>0.25</td>
<td>1.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 points</td>
<td>0.39</td>
<td>0.39</td>
<td>0.30</td>
<td>0.42</td>
</tr>
<tr>
<td>ASCII display</td>
<td>No. of digits: 6</td>
<td>6 points</td>
<td>0.20</td>
<td>0.20</td>
<td>0.19</td>
<td>0.20</td>
</tr>
<tr>
<td>Comment (8-bit) display</td>
<td>No. of comment characters: 10</td>
<td>32 points</td>
<td>0.10</td>
<td>0.15</td>
<td>0.15</td>
<td>0.40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 points</td>
<td>0.20</td>
<td>0.20</td>
<td>0.25</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>128 points</td>
<td>0.35</td>
<td>0.40</td>
<td>0.30</td>
<td>0.50</td>
</tr>
<tr>
<td>Lamp (8-bit) display</td>
<td>Lamp size: 48 x 48 dots</td>
<td>32 points</td>
<td>0.10</td>
<td>0.15</td>
<td>0.15</td>
<td>0.40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 points</td>
<td>0.20</td>
<td>0.20</td>
<td>0.25</td>
<td>0.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>128 points</td>
<td>0.35</td>
<td>0.35</td>
<td>0.40</td>
<td>0.50</td>
</tr>
<tr>
<td>Part (8-bit) display</td>
<td>Part size: 48 x 48 dots</td>
<td>32 points</td>
<td>0.10</td>
<td>0.15</td>
<td>0.15</td>
<td>0.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 points</td>
<td>0.20</td>
<td>0.20</td>
<td>0.25</td>
<td>0.46</td>
</tr>
<tr>
<td></td>
<td></td>
<td>128 points</td>
<td>0.40</td>
<td>0.35</td>
<td>0.40</td>
<td>0.50</td>
</tr>
<tr>
<td>User alarm</td>
<td></td>
<td>255 points</td>
<td>0.3</td>
<td>0.3</td>
<td>0.35</td>
<td>0.70</td>
</tr>
<tr>
<td>Trend graph display</td>
<td>Graph sprite bar: 240 x 120 dots</td>
<td>1 point</td>
<td>0.18</td>
<td>0.33</td>
<td>0.35</td>
<td>0.35</td>
</tr>
<tr>
<td></td>
<td>No. of graphs: 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line graph display</td>
<td>Graph sprite bar: 240 x 120 dots</td>
<td>1 point</td>
<td>0.06</td>
<td>0.07</td>
<td>0.15</td>
<td>0.76</td>
</tr>
<tr>
<td></td>
<td>No. of graphs: 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No. of points: 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level display</td>
<td>Painting size: 160 x 160 dots</td>
<td>6 points</td>
<td>0.25</td>
<td>0.25</td>
<td>0.25</td>
<td>0.47</td>
</tr>
<tr>
<td>Date list display</td>
<td>No. of all lines: 128</td>
<td>1 point</td>
<td>3.42</td>
<td>4.67</td>
<td>3.74</td>
<td>12.9</td>
</tr>
<tr>
<td></td>
<td>No. of digits: 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No. of rows: 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Numeral display is 32 bit data)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch key (Momentary)</td>
<td>18 points</td>
<td>Momentary</td>
<td>0.87</td>
<td>1.1</td>
<td>0.5</td>
<td>1.88</td>
</tr>
<tr>
<td></td>
<td>32 points</td>
<td>0.7</td>
<td>1.11</td>
<td>1.4</td>
<td>2.4</td>
<td>0.7</td>
</tr>
<tr>
<td></td>
<td>64 points</td>
<td>0.0</td>
<td>1.44</td>
<td>1.6</td>
<td>5.7</td>
<td>0.0</td>
</tr>
</tbody>
</table>
### Display speed (unit: s)

<table>
<thead>
<tr>
<th>Sprite name</th>
<th>Setting conditions</th>
<th>No. set</th>
<th>Serial device</th>
<th>Random device</th>
<th>Cyclic</th>
<th>Transient</th>
<th>Cyclic</th>
<th>Transient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric display</td>
<td>No. of digits: 6</td>
<td>16 points M memorandum 0.23 0.23 M memorandum 0.36 0.39 0.37 0.30 0.30</td>
<td>32 points 0.25 0.37 0.59 0.20 0.72 0.37 0.30 0.30</td>
<td>64 points 0.26 0.63 0.66 0.24 1.50 0.40 0.40</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASCII display</td>
<td>No. of digits: 8</td>
<td>6 points M memorandum 0.20 0.20 M memorandum 0.46 0.48 M memorandum 0.46 0.48</td>
<td>32 points M memorandum 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30</td>
<td>64 points M memorandum 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment (bit) display</td>
<td>No. of comment characters: 10</td>
<td>128 points M memorandum 0.35 0.45 0.35 0.35 0.35 0.35 0.35 0.35</td>
<td>32 points M memorandum 0.30 0.30 0.30 0.30 0.30 0.30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lamp (bit) display</td>
<td>Lamp size: 48 x 48 dots</td>
<td>48 points M memorandum 0.20 0.20 0.20 0.20 0.20 0.20 0.20 0.20</td>
<td>48 points M memorandum 0.45 0.45 0.45 0.45 0.45 0.45 0.45 0.45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part (bit) display</td>
<td>Part size: 48 x 48 dots</td>
<td>64 points M memorandum 0.45 0.45 0.45 0.45 0.45 0.45 0.45 0.45</td>
<td>64 points M memorandum 0.45 0.45 0.45 0.45 0.45 0.45 0.45 0.45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User alarm</td>
<td></td>
<td>255 points 0.35 3.00 0.8 4.6 4.6 0.35 1.00 0.60 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33</td>
<td>1 point 0.18 0.30 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend graph display</td>
<td>Graph sprite bar: 240 x 120 dots</td>
<td>1 point 0.18 0.30 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33 0.33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line graph display</td>
<td>Graph sprite bar: 240 x 120 dots</td>
<td>1 point 0.40 0.46 2.32 2.71 2.93 4.66 0.3 2.52 0.63 0.63 0.63 0.63 0.63 0.63 0.63 0.63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level display</td>
<td>Painting size: 100 x 100 dots Painting pattern: Fill</td>
<td>6 points M memorandum 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data list display</td>
<td>No. of all lines: 128 No. of digits: 6 No. of rows: 3 (Numeric display is 32 bit data)</td>
<td>1 point 2.49 4.72 9.3 9.4 1.03 1.02 24.5 6.49 3.17 3.17 3.17 3.17 3.17 3.17 3.17 3.17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch key (Momentary)</td>
<td>18 points M memorandum 0.7 1.0 1.0 0.5 1.88 M memorandum 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50 0.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A - 6
### MELSEC-FX series and PCs of other manufactures

<table>
<thead>
<tr>
<th>Sprite name</th>
<th>Setting conditions</th>
<th>Display speed (unit: s)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No. set</td>
<td>MELSEC-FX2N series</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial device</td>
</tr>
<tr>
<td>Numeric display</td>
<td>No. of digits: 6</td>
<td>10 points</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 points</td>
</tr>
<tr>
<td>ASCII display</td>
<td>No. of digits: 8</td>
<td>6 points</td>
</tr>
<tr>
<td>Comment (bit) display</td>
<td>No. of comment characters: 10</td>
<td>32 points</td>
</tr>
<tr>
<td>Lamp (bit) display</td>
<td>Lamp size: 48 x 48 dots</td>
<td>32 points</td>
</tr>
<tr>
<td>Part (bit) display</td>
<td>Part size: 48 x 48 dots</td>
<td>32 points</td>
</tr>
<tr>
<td>Time until all dots are displayed</td>
<td>48 x 48 dots</td>
<td>54 points</td>
</tr>
<tr>
<td>User alarm</td>
<td>255 points</td>
<td>3.75</td>
</tr>
<tr>
<td>Trend graph display</td>
<td>Graph size: 240 x 120 dots</td>
<td>1 point</td>
</tr>
<tr>
<td>Line graph display</td>
<td>Graph size: 240 x 120 dots</td>
<td>1 point</td>
</tr>
<tr>
<td>Level display</td>
<td>Painting size: 160 x 160 dots</td>
<td>6 points</td>
</tr>
<tr>
<td>Date list display</td>
<td>No. of all lines: 128</td>
<td>1 point</td>
</tr>
<tr>
<td>Touch key (Momentary)</td>
<td>No. of digits: 32 points</td>
<td>16 points</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
</tr>
<tr>
<td></td>
<td></td>
<td>64 points</td>
</tr>
</tbody>
</table>
# Appendix 4. Functions Added to SW3NIW-A8GOTP, A8SYSP and Before

The functions added since SW1NIW-A8GOTP and A8SYSP up to SW3NIW-A8GOTP and A8SYSP are shown below.

Refer to the GOT800 series Operating Manual (Extended Manual) for the contents added as extended functions.

## 1. Added GOT types

<table>
<thead>
<tr>
<th>GOT type</th>
<th>SW2NIW-A8GOTP, A8SYSP</th>
<th>SW3NIW-A8GOTP, A8SYSP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Version A and later</td>
<td>Version D and later</td>
</tr>
<tr>
<td>A851GOT</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>A852GOT</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>A853GOT</td>
<td>×</td>
<td>×</td>
</tr>
</tbody>
</table>

○: Can be used  
×: Cannot be used

## 2. Added connection types

<table>
<thead>
<tr>
<th>Connection type</th>
<th>SW2NIW-A8GOTP, A8SYSP</th>
<th>SW3NIW-A8GOTP, A8SYSP</th>
</tr>
</thead>
<tbody>
<tr>
<td>MELSEC-FXCPU connection</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>MELSEC-A, OmA series computer link (RS-232C communication) connection</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Connection with a PC manufactured by OMRON (RS-422 communication)</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Connection with a PC manufactured by OMRON (RS-232C communication)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Connection with a PC manufactured by Yasukawa Electric (RS-422 communication)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Connection with a PC manufactured by Yasukawa Electric (RS-232 communication)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>CC-Link connection (Remote device station)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>CC-Link connection (Intelligent device station)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Connection with a PC manufactured Allen-Bradley (RS-232C communication)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Microcomputer connection (RS-422 communication)</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>Microcomputer connection (RS-232C communication)</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Bar-code connection</td>
<td>×</td>
<td>×</td>
</tr>
</tbody>
</table>

○: Can be used  
×: Cannot be used
### Added canvas characters

<table>
<thead>
<tr>
<th>Symbols and characters</th>
<th>SW2NIW-A8GOTP, A8SYS</th>
<th>SW2NIW-A8GOTP, A8SYS</th>
<th>SW3NIW-A8GOTP, A8SYS</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold fonts, shadow fonts, vertical fonts</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Outline fonts</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

○: Can be used  
x : Cannot be used

### Editing operations added to the graphics software

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Command</th>
<th>Functions added</th>
<th>SW2NIW-A8GOTP, A8SYS</th>
<th>SW3NIW-A8GOTP, A8SYS</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Version A and later</td>
<td>Version D and later</td>
<td>Version J and later</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Project</td>
<td>Option</td>
<td>Reduces the window size (50%, 75%)</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Display</td>
<td>Grid display intervals and grid color setting functions</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Save as</td>
<td>File type setting function</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Edit</td>
<td>Copy and paste</td>
<td>Copies and pastes all graphics and sprites simultaneously</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Range of increment is expanded to -10000 to 10000</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Rotate/flip</td>
<td>Characters rotate 90°</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Rotate 90°</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Change all devices</td>
<td>Changes bit setting from bit device to word device</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enlargement/reduction of BMP graphic data</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Graphics</td>
<td>Panel kit</td>
<td>Checks ON and OFF graphics of the panel kit with a sprite function</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>setting</td>
<td>Part</td>
<td>Verifies registered part numbers</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Move part</td>
<td>Verifies registered part numbers</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Utilize screen/delete</td>
<td>Adds the utilization function to the specified number of utilization destination screens</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Screen</td>
<td>Screen preview</td>
<td>Automatically displays comments/ parts that are ON in the comment (bit and part bit) functions</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Addition of a function that saves the window size for screen preview</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>

○: Can be used  
x : Cannot be used
### Added sprite functions

<table>
<thead>
<tr>
<th>Sprite function</th>
<th>Functions added</th>
<th>SW2NIW-A8GOTP, A8SYSP</th>
<th>SW3NIW-A8GOTP, A8SYSP</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numerical display</td>
<td>Displays the numeric values in outline fonts</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td>Data list display</td>
<td>Collects the status of multiple word devices at specified intervals and display numerically in a table format</td>
<td>o</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Lines and title display color setting function</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Displays numeric values with outline fonts</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Comment display</td>
<td>Displays comment characters in outline fonts</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Addition of a function that displays off-parts in the canvas screen, to the comment display (bit) function</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Addition of a function that specifies the number of the comment to be displayed when the screen preview, to the comment display (bit) function</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Part display</td>
<td>Addition of the off-part display function in the canvas screen, to the part display (bit) function</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Addition of a function that specifies the number of the part to be displayed when the screen preview, to the part display (bit) function</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Alarm list (user alarm display)</td>
<td>Displays the generation time simultaneously with message generation. Also, the memory protect function that stores the previous display when switching a screen</td>
<td>o</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Random device setting function</td>
<td>o</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Maximum number of settings for memory protect type 16 settings per project (total monitor points: 512 points)</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Displays detailed display screen which corresponds to a specified device</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Displays comment characters in outline fonts</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td>Alarm history display</td>
<td>Correlates comment characters to specified devices and displays the time when it was turned ON as well as the comments</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Displays detailed display screens with one-touch operation</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>LED display</td>
<td>Displays the lamp graphic in any size vertically and horizontally</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Changes the size of the lamp graphic character</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Display the lamp graphic characters in outline fonts.</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Panel meter indicator display</td>
<td>The line width of the panel meter indicator needle is changed to a 3-dot display</td>
<td>o</td>
<td>o</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Sets the current value of the specified device in the upper and lower limit settings for the panel meter indicator display</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Changes the size of panel meter indicator characters</td>
<td>x</td>
<td>x</td>
<td>o</td>
</tr>
<tr>
<td></td>
<td>Displays the panel meter indicator characters in outline fonts</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

O: Can be used  
X: Cannot be used
<table>
<thead>
<tr>
<th>Sprite function</th>
<th>Functions added</th>
<th>SW2NIW-A8GOTP, A8SYSF</th>
<th>SW3NIW-A8GOTP, A8SYSF</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend graph display</td>
<td>The memory protect function that stores the graph display when switching a screen</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Sets the current value of the specified device in the upper and lower limit settings for the graph display</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Line graph display</td>
<td>Sets the current value of the specified device in the upper and lower limit settings for the graph display</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Sets 2 devices per one point</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td>Bar graph display</td>
<td>Sets the current value of the specified device in the standard value and upper and lower limit settings for the graph display</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Level display</td>
<td>Sets the current value of the specified device in the standard value and upper and lower limit settings for the level display</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>The numbers of basic graphics for the touch keys are expanded to 45 kinds</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Sets the word device range to the operating conditions of the touch key functions</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Touch key</td>
<td>Changes the size of touch key graphic characters</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td>functions</td>
<td>Starts and interrupts hard copying in the touch key (extension) function</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Key window 1 and test window functions are added to the touch key (extension) function</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Displays the touch key graphic characters in outline fonts</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Changed to prohibit pressing three touch keys simultaneously</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Added to key code regarding two touch keys simultaneously</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Numerical inputs</td>
<td>Specifies the word device range to the operating conditions of numerical input function</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Hides the cursor when operating conditions are not met</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Sets ID numbers to the input areas</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Moves cursor in reference to the upper left coordinate</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Key window 1 displaying the current input value and input range is added</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Displays input cursor simultaneously when switching a screen</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Displays numerical input characters in outline fonts</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>ASCII input</td>
<td>Hides the cursor when operating conditions are not met</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>functions</td>
<td>Moves cursor in reference to the upper left coordinate</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Window screen display</td>
<td>Displays the screen window in any arbitrary size</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td>Password function</td>
<td>Sets a password for project data to protect the utility screen display. The characters used in the password are changed to alphanumeric (A to F).</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

O: Can be used
X: Cannot be used
<table>
<thead>
<tr>
<th>Sprite function</th>
<th>Functions added</th>
<th>SW2NIW-A8GOTP, A8YSY</th>
<th>SW3NIW-A8GOTP, A8YSY</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Version A and later</td>
<td>Version J and later</td>
<td>Version A and later</td>
</tr>
<tr>
<td>Hard-copy</td>
<td>Prints out the GOT screen currently displayed</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Sets whether or not to feed a page after printing out</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Operation</td>
<td>Performs input from outside and output to outside</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td>panel functions</td>
<td>Key functions for writing to a device, addition of values for screen switching function and keys for ASCII input using the operation panel</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>System</td>
<td>Area for system signal 1 of read device and complete signal for reading input data</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Information</td>
<td>Area for system signal 1 of read device and disable signal for key input</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>function</td>
<td>External output signal area for read device</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>System signal 1 area of a read device</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Addition of the bar code input disable signal and bar code input read completion signal</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Addition of the read cycle setting function</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Area for system signal 2 of write device. Also, numerical values input signal, report output signal, numerical values input data error detection signal, printer error detection signal</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Write device. Also, storage areas for numerical values input data, the values prior to the change of numerical values input data, the new numerical values input data (changed), the print report numbers, and the numerical values input information of cursor position</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Write device. Also, the storage area for external input information</td>
<td>X</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>System signal 2 area of a write device</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Status</td>
<td>Addition of the bar code input signal</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>monitoring</td>
<td>Writes specified values to the PC CPU when the specified conditions are met</td>
<td>O</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>function</td>
<td>Acceleration of the screen display speed which monitors the continuous bit devices</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Test function</td>
<td>Changes a device value while displaying the test window on the monitor screen</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Report function</td>
<td>Prints out the status of specified devices in a table format (real-time reporting)</td>
<td>X</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Saves the status of specified devices in a table format to a memory card, and print out in a batch (logging report)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

○: Can be used  
X: Cannot be used
Appendix 5. Diagrams Provided for the Touch Switch, Lamp Display and Panel Kit Functions

The following list shows the diagrams provided for the touch switch, lamp display and panel kit functions.

<table>
<thead>
<tr>
<th>SWITCH 1</th>
<th>SWITCH 2</th>
<th>SWITCH 3</th>
<th>SWITCH 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
<tr>
<td>SWITCH 5</td>
<td>SWITCH 6</td>
<td>SWITCH 7</td>
<td>SWITCH 8</td>
</tr>
<tr>
<td><img src="image5" alt="Diagram" /></td>
<td><img src="image6" alt="Diagram" /></td>
<td><img src="image7" alt="Diagram" /></td>
<td><img src="image8" alt="Diagram" /></td>
</tr>
<tr>
<td>SWITCH 9</td>
<td>SWITCH 10</td>
<td>SWITCH 11</td>
<td>SWITCH 12</td>
</tr>
<tr>
<td><img src="image9" alt="Diagram" /></td>
<td><img src="image10" alt="Diagram" /></td>
<td><img src="image11" alt="Diagram" /></td>
<td><img src="image12" alt="Diagram" /></td>
</tr>
<tr>
<td>SWITCH 13</td>
<td>SWITCH 14</td>
<td>SWITCH 15</td>
<td>SWITCH 16</td>
</tr>
<tr>
<td><img src="image13" alt="Diagram" /></td>
<td><img src="image14" alt="Diagram" /></td>
<td><img src="image15" alt="Diagram" /></td>
<td><img src="image16" alt="Diagram" /></td>
</tr>
<tr>
<td>SWITCH 17</td>
<td>SWITCH 18</td>
<td>SWITCH 19</td>
<td>SWITCH 20</td>
</tr>
<tr>
<td><img src="image17" alt="Diagram" /></td>
<td><img src="image18" alt="Diagram" /></td>
<td><img src="image19" alt="Diagram" /></td>
<td><img src="image20" alt="Diagram" /></td>
</tr>
<tr>
<td>SWITCH 21</td>
<td>SWITCH 22</td>
<td>SWITCH 23</td>
<td>SWITCH 24</td>
</tr>
<tr>
<td><img src="image21" alt="Diagram" /></td>
<td><img src="image22" alt="Diagram" /></td>
<td><img src="image23" alt="Diagram" /></td>
<td><img src="image24" alt="Diagram" /></td>
</tr>
</tbody>
</table>
List of touch switch diagrams for the touch switch function (Continued)

<table>
<thead>
<tr>
<th>SWITCH 25</th>
<th>SWITCH 26</th>
<th>SWITCH 27</th>
<th>SWITCH 28</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SWITCH 29</th>
<th>SWITCH 30</th>
<th>SWITCH 31</th>
<th>SWITCH 32</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Diagram" /></td>
<td><img src="image6" alt="Diagram" /></td>
<td><img src="image7" alt="Diagram" /></td>
<td><img src="image8" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SWITCH 33</th>
<th>SWITCH 34</th>
<th>SWITCH 35</th>
<th>SWITCH 36</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image9" alt="Diagram" /></td>
<td><img src="image10" alt="Diagram" /></td>
<td><img src="image11" alt="Diagram" /></td>
<td><img src="image12" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SWITCH 37</th>
<th>SWITCH 38</th>
<th>SWITCH 39</th>
<th>SWITCH 40</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image13" alt="Diagram" /></td>
<td><img src="image14" alt="Diagram" /></td>
<td><img src="image15" alt="Diagram" /></td>
<td><img src="image16" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SWITCH 41</th>
<th>SWITCH 42</th>
<th>SWITCH 43</th>
<th>SWITCH 44</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image17" alt="Diagram" /></td>
<td><img src="image18" alt="Diagram" /></td>
<td><img src="image19" alt="Diagram" /></td>
<td><img src="image20" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SWITCH 45</th>
<th>SWITCH 46</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image21" alt="Diagram" /></td>
<td><img src="image22" alt="Diagram" /></td>
</tr>
<tr>
<td>LAMP 1</td>
<td>LAMP 2</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>LAMP 5</td>
<td>LAMP 6</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>LAMP 9</td>
<td>LAMP 10</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>LAMP 13</td>
<td>LAMP 14</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>LAMP 17</td>
<td>LAMP 18</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>LAMP 21</td>
<td>LAMP 22</td>
</tr>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
</tbody>
</table>
List of lamp diagrams for the lamp display function (Continued)

<table>
<thead>
<tr>
<th>LAMP 25</th>
<th>LAMP 26</th>
<th>LAMP 27</th>
<th>LAMP 28</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td><img src="image2.png" alt="Diagram" /></td>
<td><img src="image3.png" alt="Diagram" /></td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAMP 29</th>
<th>LAMP 30</th>
<th>LAMP 31</th>
<th>LAMP 32</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Diagram" /></td>
<td><img src="image6.png" alt="Diagram" /></td>
<td><img src="image7.png" alt="Diagram" /></td>
<td><img src="image8.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAMP 33</th>
<th>LAMP 34</th>
<th>LAMP 35</th>
<th>LAMP 36</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image9.png" alt="Diagram" /></td>
<td><img src="image10.png" alt="Diagram" /></td>
<td><img src="image11.png" alt="Diagram" /></td>
<td><img src="image12.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAMP 37</th>
<th>LAMP 38</th>
<th>LAMP 39</th>
<th>LAMP 40</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image13.png" alt="Diagram" /></td>
<td><img src="image14.png" alt="Diagram" /></td>
<td><img src="image15.png" alt="Diagram" /></td>
<td><img src="image16.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAMP 41</th>
<th>LAMP 42</th>
<th>LAMP 43</th>
<th>LAMP 44</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image17.png" alt="Diagram" /></td>
<td><img src="image18.png" alt="Diagram" /></td>
<td><img src="image19.png" alt="Diagram" /></td>
<td><img src="image20.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAMP 45</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image21.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
### List of panel kit diagrams for the panel kit function

<table>
<thead>
<tr>
<th>Switch Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWITCH 1 to 7</td>
<td>With sprite function (The display color differs by number.)</td>
</tr>
<tr>
<td>SWITCH 11 to 17</td>
<td>With sprite function (The display color differs by number.)</td>
</tr>
<tr>
<td>SWITCH 21 to 27</td>
<td>With sprite function (The display color differs by number.)</td>
</tr>
<tr>
<td>SWITCH 31 to 37</td>
<td>With sprite function (The display color differs by number.)</td>
</tr>
<tr>
<td>SWITCH 50</td>
<td></td>
</tr>
<tr>
<td>SWITCH 51</td>
<td></td>
</tr>
<tr>
<td>SWITCH 52</td>
<td></td>
</tr>
<tr>
<td>SWITCH 53</td>
<td></td>
</tr>
<tr>
<td>SWITCH 54</td>
<td></td>
</tr>
<tr>
<td>SWITCH 55</td>
<td></td>
</tr>
<tr>
<td>FRAME 60</td>
<td></td>
</tr>
<tr>
<td>FRAME 61</td>
<td>With sprite function</td>
</tr>
</tbody>
</table>
List of panel kit diagrams for the panel kit function (Continued)

<table>
<thead>
<tr>
<th>FRAME 62</th>
<th>FRAME 63</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FRAME 64</th>
<th>FRAME 65</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Diagram" /></td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FRAME 66</th>
<th>METER 70</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Diagram" /></td>
<td><img src="image6.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

- With sprite function

<table>
<thead>
<tr>
<th>METER 71</th>
<th>METER 72</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7.png" alt="Diagram" /></td>
<td><img src="image8.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

- With sprite function

<table>
<thead>
<tr>
<th>CURSOR SET 81</th>
<th>CURSOR RESET 82</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image9.png" alt="Diagram" /></td>
<td><img src="image10.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

- With sprite function
<table>
<thead>
<tr>
<th>UP 83</th>
<th>DOWN 84</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td><img src="image2" alt="Image" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
<tr>
<td>CHECK 85</td>
<td>ALL CHECK 86</td>
</tr>
<tr>
<td><img src="image3" alt="Image" /></td>
<td><img src="image4" alt="Image" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
<tr>
<td>DELETE 87</td>
<td>ALL DELETE 88</td>
</tr>
<tr>
<td><img src="image5" alt="Image" /></td>
<td><img src="image6" alt="Image" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
<tr>
<td>RESET 89</td>
<td>DETAILS 90</td>
</tr>
<tr>
<td><img src="image7" alt="Image" /></td>
<td><img src="image8" alt="Image" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
<tr>
<td>STORE MEMORY 91</td>
<td>ALARM HISTORY KEY 93</td>
</tr>
<tr>
<td><img src="image9" alt="Image" /></td>
<td><img src="image10" alt="Image" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
</tbody>
</table>
List of panel kit diagrams for the panel kit function (Continued)

<table>
<thead>
<tr>
<th>ALARM HISTORY KEY 94</th>
<th>ABC KEY 100</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="ALARM HISTORY KEY 94 Diagram" /></td>
<td><img src="image" alt="ABC KEY 100 Diagram" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NUM KEY 101</th>
<th>ABC / NUM KEY 102</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="NUM KEY 101 Diagram" /></td>
<td><img src="image" alt="ABC / NUM KEY 102 Diagram" /></td>
</tr>
<tr>
<td>With sprite function</td>
<td>With sprite function</td>
</tr>
</tbody>
</table>

| KANA KEY 103 | |
|--------------||
| ![KANA KEY 103 Diagram](image) | |
| With sprite function |
When exported from Japan, this manual does not require application to the Ministry of Economy, Trade and Industry for service transaction permission.

Specifications subject to change without notice.